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Capabilities in Workbench

The following topics are discussed in this section.

Meshing Overview

Meshing Implementation in ANSYS Workbench

Types of Meshing

Conformal Meshing Between Parts

Meshing Overview

Philosophy

The goal of meshing in ANSYS Workbench is to provide robust, easy to use meshing tools that will simplify

the mesh generation process. These tools have the benefit of being highly automated along with having a

moderate to high degree of user control.

Physics Based Meshing

When the Meshing application is launched (that is, edited) from the ANSYS Workbench Project Schematic,

the physics preference will be set based on the type of system being edited. For analysis systems, the appro-

priate physics is used. For a Mechanical Model system, the Mechanical physics preference is used. For a

Mesh system, the physics preference defined in Tools> Options> Meshing> Default Physics Preference

is used.

Upon startup of the Meshing application from a Mesh system, you will see the Meshing Options panel

shown below. This panel allows you to quickly and easily set your meshing preferences based on the physics

you are preparing to solve. If you remove the panel after startup, you can display the panel again by clicking

the Options button from the Mesh toolbar.

1
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Physics Preference

The first option the panel allows you to set is your Physics Preference. This corresponds to the Physics

Preference value in the Details View of the Mesh folder. Setting the meshing defaults to a specified “physics”

preference sets options in the Mesh folder such as Relevance Center, midside node behavior, shape

checking, and other meshing behaviors.

Note

The Physics Preference is selectable from the Meshing Options panel only if the Meshing ap-

plication is launched from a Mesh component system or a Mechanical Model component system.

If the Meshing application is launched from an analysis system (whether it be via the Model cell

in a non-Fluid Flow analysis system or the Mesh cell in a Fluid Flow analysis system), you must

use the Details View of the Mesh folder to change the  Physics Preference. See Determination

of Physics, Analysis, and Solver Settings (p. 19) for more information.

Mesh Method

Setting the Physics Preference option also sets the preferred Mesh Method option for the specified physics.

All of the meshing methods can be used for any physics type, however we have found that some of our

meshers are more suitable for certain physics types than others. The preferred ANSYS Workbench Mesh

Methods are listed below grouped by physics preference.
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Note

• Changing the Mesh Method in the Meshing Options panel changes the default mesh

method for all future analyses, regardless of analysis type.

• For CutCell meshing, you should retain the default setting (Automatic).

Presented below are the ANSYS Workbench meshing capabilities, arranged according to the physics type

involved in your analysis.

• Mechanical: The preferred meshers for mechanical analysis are the patch conforming meshers (Patch

Conforming Tetrahedrons and Sweeping) for solid bodies and any of the surface body meshers.

• Electromagnetics: The preferred meshers for electromagnetic analysis are the patch conforming

meshers and/or the patch independent meshers (Patch Independent Tetrahedrons and MultiZone).

• CFD: The preferred meshers for CFD analysis are the patch conforming meshers and/or the patch inde-

pendent meshers. See Method Control (p. 122) for further details.

• Explicit Dynamics: The preferred meshers for explicit dynamics on solid bodies are the patch independent

meshers, the default sweep method, and the patch conforming mesher with Virtual Topologies. The

preferred meshers for explicit dynamics on surface bodies are the uniform quad/quad-tri meshers or

the quad dominant mesher when used with size controls and Virtual Topologies. See the Method Con-

trol (p. 122) section for further details.

Set Physics and Create Method

This option sets the Physics Preference for the current Mesh object in the Tree Outline for Mesh component

systems. It inserts a Method control, sets the scope selection to all solid bodies, and configures the definition

according to the Mesh Method that is selected on the panel. To enable this option, you must attach geometry

containing at least one solid body and remove any existing mesh controls.

Set Meshing Defaults

This option updates your preferences in the Options dialog box. The Options dialog box is accessible by

selecting Tools> Options from the main menu of the Meshing application.

If a Mesh Method has already been set for the current model and the Set Meshing Defaults option on the

Meshing Options panel is unchecked, the OK button on the Meshing Options panel will be grayed out

(unavailable). This is because in such cases where the Mesh Method has already been set, the Meshing

Options panel would be useful only for setting meshing defaults in the Options dialog box. Thus if you

uncheck Set Meshing Defaults, the Meshing Options panel cannot provide any additional functionality

and the OK button is disabled.

Display This Panel at Meshing Startup

This option controls whether the Meshing Options panel appears at startup of the Meshing application.

Meshing Implementation in ANSYS Workbench

The meshing capabilities are available within the following ANSYS Workbench applications. Access to a

particular application is determined by your license level.

3
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• The Mechanical application - Recommended if you plan to stay within the Mechanical application to

continue your work (preparing and solving a simulation). Also, if you are planning to perform a Fluid-

Structure Interaction problem with CFX, and desire to use a single project to manage your ANSYS

Workbench data, you should use the Mechanical application to perform your fluid meshing. This is most

conveniently done in a separate model branch from the structural meshing and structural simulation.

• The Meshing application - Recommended if you plan to use the mesh to perform physics simulations

in ANSYS CFX or ANSYS FLUENT. If you wish to use a mesh created in the Meshing application for a

solver supported in the Mechanical application, you can replace the Mesh system with a Mechanical

Model system. See Replacing a Mesh System with a Mechanical Model System (p. 17).

Note

In the 13.0 release, ANSYS AUTODYN runs inside the Mechanical application. The recommendation

is to use an Explicit Dynamics analysis system, in which meshing comes as part of that system.

As an alternative, you can also use this system to prepare a model for the traditional ANSYS

AUTODYN application (AUTODYN component system). For simple ANSYS AUTODYN models, you

can use the meshing tools within the traditional ANSYS AUTODYN application (AUTODYN com-

ponent system).

Types of Meshing

The following types of meshing are discussed in this section.

Meshing by Algorithm

Meshing by Element Shape

Meshing by Algorithm

This section describes types of meshing in terms of two meshing algorithms: “patch conforming” and “patch

independent”.

Patch Conforming

What is patch conforming meshing?

Patch conforming meshing is a meshing technique in which all faces and their boundaries (edges and vertices)

[patches] within a very small tolerance are respected for a given part. Mesh based defeaturing is used to

overcome difficulties with small features and dirty geometry. Virtual Topology can lift restrictions on the

patches, however the mesher must still respect the boundaries of the Virtual Cells.

Patch conforming meshing is invariant to loads, boundary conditions, Named Selections, results or any

scoped object. That is, when you change the scope of an object, you will not have to re-mesh.

Mesh Refinement is supported with all of the patch conforming meshers.

Applications

You can implement patch conforming meshing using settings related to any of the following mesh control

options. See the Method Control (p. 122) section for further details.

Solid Bodies:

• Patch Conforming Tetra

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.4

Capabilities in Workbench



• General Sweeping

• Thin Sweeping

• Hex Dominant

Surface Bodies:

• Quad Dominant

• All Triangles

Patch Independent

What is patch independent meshing?

Patch independent meshing is a meshing technique in which the faces and their boundaries (edges and

vertices) [patches] are not necessarily respected unless there is a load, boundary condition, or other object

scoped to the faces or edges or vertices (topology). Patch independent meshing is useful when gross defea-

turing is needed in the model or when a very uniformly sized mesh is needed. Virtual Topology can still be

used with patch independent meshing, however the boundaries of the Virtual Cells may not be respected

unless a scoped object exists on the Virtual Cells.

The unique set of faces (edges) and their boundary edges (vertices) consisting of all entities with contacts,

Named Selections, loads, boundary conditions, or results; spot welds; or surface bodies with differing thick-

nesses will be created and protected by the mesher. The boundaries at “protected topology” will not be

crossed.

Patch independent meshing is dependent on loads, boundary conditions, Named Selections, results or any

scoped object. You should therefore define all of your scoping dependencies prior to meshing. If you change

a scoping after meshing, you will need to re-mesh.

Mesh refinement is not supported with patch independent meshing.

Applications

You can implement patch independent meshing using settings related to any of the following mesh control

options. See the Method Control (p. 122) section for further details.

Solid Bodies:

• Patch Independent Tetra

• MultiZone

• CutCell

Surface Bodies:

• Uniform Quad/Tri

• Uniform Quad

5
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Note

• When determining protected topology, the CutCell mesh method evaluates the feature

angle, along with Named Selection definitions:

– If the Named Selection is a vertex, the vertex is preserved only if at least one of the edges

connecting the vertex:

→ is not filtered out depending on the feature angle.

→ is also defined as a Named Selection.

– If the Named Selection is an edge, the edge is preserved.

– If the Named Selection is a face or a collection of faces, the outer boundaries of the Named

Selection are preserved automatically (independent of the feature angle), while edges

inside the faces are filtered out depending on the feature angle.

– If the Named Selection is a body, features are preserved only if:

→ they are not filtered out depending on the feature angle.

→ the features are part of a Named Selection defined for face(s) and/or edge(s) of the

body.

• For the Uniform Quad/Tri and Uniform Quad mesh methods:

– Surface bodies with differing material definitions are also protected topology.

– Surface bodies with specified variable thickness are not protected. To prevent faces and

their boundaries from being meshed over, create an individual Named Selection for each

thickness.

Meshing by Element Shape

This section describes types of meshing in terms of element shapes. Applicable mesh control options are

presented for each element shape shown below. See the Method Control (p. 122) section for further details.

Tet Meshing

• Patch Conforming Tetrahedron Mesher

• Patch Independent Tetrahedron Mesher

Hex Meshing

• Swept Mesher

• Hex Dominant Mesher

• Thin Solid Mesher

Hex/Prism/Tet Hybrid Meshing

• MultiZone Mesher

Cartesian Meshing

• CutCell Mesher
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Quad Meshing

• Quad Dominant

• Uniform Quad/Tri

• Uniform Quad

Triangle Meshing

• All Triangles

Conformal Meshing Between Parts

When meshing in ANSYS Workbench, interfaces between parts are managed in a variety of ways. The first

is through a concept referred to as “multibody parts.” The following applies when meshing in ANSYS

Workbench:

• Parts are groups or collections of bodies. Parts can include multiple bodies and are then referred to as

multibody parts. If your geometry contains multiple parts then each part will be meshed with separate

meshes with no connection between them, even if they apparently share faces.

• You can convert a geometry which has multiple parts into one with a single part by using the Form

New Part functionality in the DesignModeler application. Simply select all of the bodies and then select

Tools > Form New Part. If you have an external geometry file that has multiple parts that you wish to

mesh with one mesh, then you will have to import it into the DesignModeler application first and perform

this operation, rather than importing it directly into the Meshing application.

• By default, every time you create a new solid body in the DesignModeler application, it is placed in a

new part. To create a single mesh, you will have to follow the instructions in the previous bullet point

to place the bodies in the same part after creation. Since body connections are dependent on geometry

attributes such as application of the Add Material and Add Frozen Boolean operations, it is advisable

that you combine bodies into a single part only if you want a conformal mesh.

• Multiple solid bodies within a single part will be meshed with conformal mesh provided that they have

topology that is “shared” with another of the bodies in that part. For a face to be shared in this way, it

is not sufficient for two bodies to contain a coincident face; the underlying representation of the geometry

must also recognize it as being shared. Normally, geometry imported from external CAD packages (not

the DesignModeler application) does not satisfy this condition and so separate meshes will be created

for each part/body. However, if you have used Form New Part in the DesignModeler application to

create the part, then the underlying geometry representation will include the necessary information on

shared faces when faces are conformal (i.e., the bodies touch).

• The Shared Topology tool within the DesignModeler application can be used to identify conformal

faces/edges, along with defining whether nodes should be conformal (same node shared between two

bodies), or coincident (separate nodes for separate bodies, but the locations could be identical).

Conformal Meshing and Mesh Method Interoperability

You can mix and match mesh methods on the individual bodies in a multibody part, and the bodies will be

meshed with conformal mesh as described above. Through this flexible approach, you can better realize the

value of the various methods on the individual bodies:

• For solid meshing, you can use a combination of these mesh methods:

– Patch Conforming Tetrahedron

– Patch Independent Tetrahedron
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– MultiZone

– Sweep

– Hex Dominant

• For surface meshing, you can use a combination of these mesh methods:

– Quad Dominant

– All Triangles

– Uniform Quad/Tri

– Uniform Quad

Note

CutCell cannot be used in combination with any other mesh method.

Refer to Direct Meshing (p. 239) for related information. For details about how the mesh methods interact,

refer to Interactions Between Mesh Methods (p. 261).

Non-conformal Meshing

For parts/bodies that are not within a multibody part, the Auto Detect Contact on Attach setting, which

is available in the Options dialog box under the Mechanical application's Connections category, defines

contact interfaces between parts. These contact regions can be used for mesh sizing, and/or are used by

the Mechanical APDL solvers to define the behavior between the parts. For structural solvers please see the

description of connections in the Mechanical help. For CFD solvers, these contact regions are used differently

for the ANSYS FLUENT and ANSYS CFX solvers.

These contact regions are not automatically resolved in ANSYS FLUENT. For ANSYS FLUENT to resolve them

directly as interfaces, you must explicitly define the contact regions as Named Selections using the INTERFACE

zone type. Refer to FLUENT Mesh Export (p. 23) for more information about defining Named Selections in

the Meshing application for export to ANSYS FLUENT mesh format.

These contact regions are used in ANSYS CFX as General Grid Interface (GGI) definitions. For details, refer to

the documentation available under the Help menu within CFX.

Note

• For related information, refer to Assemblies, Parts, and Bodies in the Mechanical help.

• To get duplicated nodes at the interface between parts, use the Non-conformal Meshing

approach, then use match mesh controls to make the duplicated nodes match. To get a

common interface for the two parts, use the Imprints method to create Shared Topology for

the part.

Comparing Effects of Mesh Methods on Different Types of Parts

Certain characteristics of meshes differ depending on whether an assembly of parts, a multibody part, or a

multibody part with imprint is being meshed:

• Assembly of parts—Mesh of one part has no relation to mesh of other part unless there is contact sizing,

and in this case the mesh is still not conformal.
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• Multibody part—Mesh at the interface between two bodies is conformal (same nodes). Since the nodes

are common, no contact is defined.

• Multibody part with imprint (non-matched)—Common faces between two bodies are imprinted. Mesh

does not have to be conformal, but it often is by default since the boundaries of the two faces are

similar. Contact is automatically created between these faces.

• Multibody part with imprint (matched)—Common faces between two bodies are imprinted. Mesh is

matched between the common faces. Contact is automatically created between these faces.

The following table compares various mesh methods and their effects when meshing these types of parts:

Multibody Part with Imprint

(Matched)

Multibody Part with Im-

print (Non-matched)
Multibody Part

Assembly

of Parts

Mesh

Meth-

od

Multibody part is meshed at the

same time. Mesh is matched

Multibody part is meshed

at the same time, but

Multibody part is

meshed at the

Each part is

meshed sep-

arately.

Patch

Con-

form-

ing

where match controls are

defined.

mesh does not need to be

conformal because the

same time to en-

sure conformal

mesh. faces are meshed separ-

ately.

Multibody part is meshed at the

same time.There is no guaran-

Multibody part is meshed

at the same time, but

Multibody part is

meshed at the

Each part is

meshed sep-

arately.

Gener-

al

Sweep tee that the mesh on the sourcemesh does not need to besame time to en-

faces will be matched.The meshconformal because thesure conformal

mesh. is likely to match if the sourcefaces are meshed separ-

ately. faces are map meshed, but will

not match if the source faces are

free meshed. Since side faces are

map meshed, the mesh on the

side faces is likely to match.

Multibody part is meshed at the

same time.There is no guaran-

Multibody part is meshed

at the same time, but

Multibody part is

meshed at the

Each part is

meshed sep-

arately.

Thin

Sweep

tee that the mesh on the sourcemesh does not need to besame time to en-

faces will be matched.The meshconformal because thesure conformal

mesh. is likely to match if the sourcefaces are meshed separ-

ately. faces are map meshed, but will

not match if the source faces are

free meshed. Since side faces are

map meshed, the mesh on the

side faces is likely to match.

Does not support match control.

Users can attempt matching

Multibody part is meshed

at the same time, but

Multibody part is

meshed at the

Each part is

meshed sep-

arately.

Hex

Domin-

ant through mapped face controlmesh does not need to besame time to en-

on common face or face sizings,conformal because thesure conformal

mesh. but there is no guarantee that

the mesh will be matched.

faces are meshed separ-

ately.

Multibody part is meshed at the

same time, but mesh is conform-

Multibody part is meshed

at the same time, but

Multibody part is

meshed at the

Each part is

meshed sep-

arately.

Patch

Inde-

pend-

ent

al if the Match Mesh Where

Possible control is set to Yes.

mesh is not conformal if

the Match Mesh Where

same time to en-

sure conformal

mesh.
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Multibody Part with Imprint

(Matched)

Multibody Part with Im-

print (Non-matched)
Multibody Part

Assembly

of Parts

Mesh

Meth-

od

Possible control is set to

No.

Does not support match control.

Users can attempt matching

Multibody part is meshed

at the same time. Mesh

Multibody part is

meshed at the

Each part is

meshed sep-

arately.

Mul-

tiZone

through mapped face controlwill generally be conform-same time to en-

on common face or face sizings,al, but it is not forced.sure conformal

mesh. but there is no guarantee that

the mesh will be matched.

Faces are meshed separ-

ately.

Does not support match control.Multibody parts are

meshed at the same time

Multibody parts are

meshed at the

Conformal

mesh at the

CutCell

and the mesh across parts

is conformal.

same time and the

mesh across parts

is conformal.

part level is

not suppor-

ted.
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Usage in Workbench

The Meshing application is a separate ANSYS Workbench application. The Meshing application is data-integ-

rated with ANSYS Workbench, meaning that although the interface remains separate, the data from the

application communicates with the native ANSYS Workbench data. The following topics are addressed in

this section:

Basic Meshing Application Workflows

Strategies for CFD/Fluids Meshing in ANSYS Workbench

Accessing Meshing Functionality

Overview of the Meshing Application Interface

Determination of Physics, Analysis, and Solver Settings

Working with Legacy Mesh Data

Exporting Meshes or Faceted Geometry

Extended ANSYS ICEM CFD Meshing

Working with Meshing Application Parameters

ANSYS Workbench and Mechanical APDL Application Meshing Differences

Basic Meshing Application Workflows

The following sections describe several basic workflows for using the Meshing application in ANSYS Work-

bench:

Overview of the Meshing Process in ANSYS Workbench

Overview of the Meshing Process for CFD/Fluids Analyses

Combining CFD/Fluids Meshing and Structural Meshing

Overview of the Meshing Process in ANSYS Workbench

The following steps provide the basic workflow for using the Meshing application as part of an ANSYS

Workbench analysis (non-Fluid Flow). Refer to the ANSYS Workbench help for detailed information about

working in ANSYS Workbench.

1. Select the appropriate template in the Toolbox, such as Static Structural. Double-click the template in

the Toolbox, or drag it onto the Project Schematic.

2. If necessary, define appropriate engineering data for your analysis. Right-click the Engineering Data

cell, and select Edit, or double-click the Engineering Data cell. The Engineering Data workspace appears,

where you can add or edit material data as necessary.

3. Attach geometry to your system or build new geometry in the DesignModeler application. Right-click

the Geometry cell and select Import Geometry... to attach an existing model or select New Geometry....

to launch the DesignModeler application.

4. Access the Meshing application functionality. Right-click the Model cell and choose Edit. This step will

launch the Mechanical application.

5. Once you are in the Mechanical application, you can move between its components by highlighting

the corresponding object in the Tree as needed. Click on the Mesh object in the Tree to access

Meshing application functionality and apply mesh controls.
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6. Define loads and boundary conditions. Right-click the Setup cell and select Edit. The appropriate ap-

plication for your selected analysis type will open (such as the Mechanical application). Set up your

analysis using that application's tools and features.

7. You can solve your analysis by issuing an Update, either from the data-integrated application you're

using to set up your analysis, or from the ANSYS Workbench GUI.

8. Review your analysis results.

Note

You should save your data periodically (File> Save Project). The data will be saved as a .wbpj
file. Refer to the ANSYS Workbench help for more information about project file management in

Workbench.

For more information:

• For information about using the Meshing application to import or export mesh files, refer to Working

with Legacy Mesh Data (p. 20) and Exporting Meshes or Faceted Geometry (p. 22).

• Fluids users of the DesignModeler, Meshing, and CFX applications should refer to Named Selections and

Regions for CFX (p. 291) for important information about region definitions.

• Fluids users of the DesignModeler, Meshing, and ANSYS FLUENT applications should refer to FLUENT

Mesh Export (p. 23) for important information about Named Selection support.

Overview of the Meshing Process for CFD/Fluids Analyses

This section describes the basic process for using the Meshing application to create a mesh as part of an

ANSYS Workbench CFD/fluids analysis. Refer to Strategies for CFD/Fluids Meshing in ANSYS Workbench (p. 15)

for information about different CFD/Fluids meshing strategies. Refer to the ANSYS Workbench help for detailed

information about working in ANSYS Workbench. There are four basic steps to creating a mesh:

Create Geometry

You can create geometry for the Meshing application from scratch in ANSYS Workbench DesignModeler

application, or import it from an external CAD file. The Meshing application requires you to construct solid

bodies (not surface bodies) to define the region for the 3D mesh (for 2D simulations a sheet body can be

used). A separate body must be created for each region of interest in the fluids simulation; for example, a

region in which you want the fluids solver to solve for heat transfer only must be created as a separate body.

Multiple bodies are created in the DesignModeler application by using the Freeze command; see Freeze in

the DesignModeler help for details.

It is best practice to explicitly identify any fluid regions in the model as fluids rather than solids.

For new users or new models it is often useful to first generate a default mesh, evaluate it, and then apply

the controls described in Define Mesh Attributes (p. 13) as appropriate to improve various mesh characteristics.

Define Named Selections

During the fluids simulation setup, you will need to define boundary conditions where you can apply specific

physics. For example, you may need to define where the fluid enters the geometry or where it exits. Although

it may be possible to select the faces that correspond to a particular boundary condition inside the solver

application, it is rather easier to make this selection ahead of time in either the CAD connection, the

DesignModeler application, or the Meshing application. In addition, it is much better to define the location
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of periodic boundaries before the mesh is generated to allow the nodes of the surface mesh to match on

the two sides of the periodic boundary, which in turn allows for a more accurate fluids solution. You can

define the locations of boundaries by defining Named Selections, which can assist you in the following ways:

• You can use Named Selections to easily hide the outside boundary in an external flow problem.

• You can assign Named Selections to all faces in a model except walls, and Program Controlled inflation

will automatically select all walls in the model to be inflation boundaries.

For more information:

• Fluids users of the DesignModeler, Meshing, and CFX applications should refer to Named Selections and

Regions for CFX (p. 291).

• Fluids users of the DesignModeler, Meshing, and ANSYS FLUENT applications should refer to FLUENT

Mesh Export (p. 23).

Define Mesh Attributes

The mesh generation process in the Meshing application is fully automatic. However, you have considerable

control over how the mesh elements are distributed. To ensure that you get the best fluids solution possible

with your available computing resources, you can dictate the background element size, type of mesh to

generate, and where and how the mesh should be refined. In general, setting up the length scale field for

your mesh is a three-step process, as outlined below:

• Assign a suitable set of global mesh controls.

• Override the default mesh type by inserting a different mesh method.

• Override the global sizing or other controls locally on bodies, faces, edges, or vertices and the regions

close to them by scoping local mesh controls.

Generate Mesh

When you are ready to compute the mesh, you can do so by using either the Update feature or the Generate

Mesh feature. Either feature computes the entire mesh. The surface mesh and the volume mesh are generated

at one time. The mesh for all parts/bodies is also generated at one time. For help in understanding the dif-

ference between the Update and Generate Mesh features, see Updating the Mesh Cell State (p. 269).

For information on how to generate the mesh for selected parts/bodies only, refer to Generating Mesh (p. 270).

The Previewing Surface Mesh (p. 271) and Previewing Inflation (p. 274) features are also available if you do not

want to generate the entire mesh at one time.

Once the mesh is generated, you can view it by selecting the Mesh object in the Tree Outline. You can

define Section Planes to visualize the mesh characteristics, and you can use the Mesh Metric feature to view

the worst quality element based on the quality criterion for a selected mesh metric.

Note

Fluids users should refer to Generation of Contact Elements (p. 267) for recommendations for defining

contact for fluids analyses.

Combining CFD/Fluids Meshing and Structural Meshing

In some applications, a CFD/fluids mesh and a structural mesh are required within the same workflow. For

these one-way coupling applications, the loading, solving, and postprocessing of the fluids meshed part(s)
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later occur in a Fluid Flow analysis system, while the loading, solving, and postprocessing of the structurally

meshed part(s) later occur in a Structural analysis system. The best approach for this kind of application is

to break the model into separate parts rather than use a continuous multibody part.

The following approach is recommended for these applications:

1. Attach the model to a Geometry (DesignModeler) system and use the Explode Part feature to create

independent parts within the model.

2. Link a Fluid Flow analysis system and a Structural analysis system to the Geometry system. The geo-

metries may be shared or not, depending on whether defeaturing needs to be done to one or the

other system. Dedicate the Fluid Flow analysis system to meshing the appropriate fluid domain for

the fluids application. Suppress the structural part(s) in the model. Dedicate the Structural analysis

system to meshing the appropriate structural part(s). Suppress the fluid part(s) in this model.

In this case, only the respective parts are meshed. The mesh of the Fluid Flow analysis system is shown

below on the left, and the mesh of the Structural analysis system is shown on the right.
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Note

• You can set up the workflow schematic in different ways depending on various factors,

including variations in the fluid/structural model, persistence, the desired multiphysics

simulation, and so on.

• The coupling of the solvers is also handled from the Project Schematic. For details, refer

to the discussion about creating and linking a second system in the ANSYS Workbench

help.

• For geometry persistence, both models will require updating when changing CAD

parameters.

Strategies for CFD/Fluids Meshing in ANSYS Workbench

ANSYS Workbench offers various strategies for CFD/Fluids meshing. For each strategy, certain defaults are

in place to target the particular needs of an analysis. The strategies and circumstances in which each of

them are appropriate are described below.

Tetra Dominant Meshing - Patch Conforming Tetra/Prism Meshing

The first strategy is to use conformal tetra/prism meshing plus the default Sweep method. This strategy is

recommended for models involving moderately clean CAD (for example, native CAD, Parasolid, ACIS, and

so on) for which you desire a tetra/hybrid dominant mesh.

Although the Patch Conforming Tetra mesh method is fully automated, it interacts with additional mesh

controls and capabilities as necessary, including:

• Advanced tetra and inflation layer technology

• Pinch controls for removing small features at the mesh level (offered as an alternative to Virtual Topo-

logies, which work at the geometry level)

• Advanced Size Function controls for providing greater control over mesh distribution

• Conformal swept regions

• Body of influence (BOI) for setting one body as a size source for another body
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Tetra Dominant Meshing - Patch Independent Tetra/Prism Meshing

An alternative for those desiring a tetra dominant mesh is Patch Independent Tetra/Prism meshing. This

approach is best for "dirty CAD"—CAD models with many surface patches (for example, IGES, CATIA V4, and

so on) and in cases with large numbers of slivers/small edges/sharp corners. It includes support for post in-

flation, as well as CAD simplification built-in to the tetra mesher.

Mapped Hex Meshing - All Hex Swept Meshing

This mapped hex approach (which includes both general Sweep and thin Sweep) is recommended for clean

CAD. It supports single source to single target volumes, and may require you to perform manual geometry

decomposition.

Benefits of this approach include:

• Support for Advanced Size Function controls

• Compatibility with Patch Conforming Tetra meshing

• Support for swept inflation

Mapped and Free Meshing - MultiZone Meshing

Best for moderately clean CAD, the MultiZone strategy for meshing provides multi-level sweep with auto-

matic decomposition of geometry into mapped (structured) and free (unstructured) regions. When defining

the MultiZone mesh method, you can specify a Mapped Mesh Type and a Free Mesh Type that will be

used to fill structured and unstructured regions respectively. Depending on your settings and specific

model, the mesh may contain a mixture of hex/prism/tetra elements.

The MultiZone mesh method and the Sweep mesh method described above operate similarly; however,

MultiZone has capabilities that make it more suitable for a class of problems for which the Sweep method

would not work without extensive geometry decomposition.

Additional benefits of this approach include:

• Support for 3D inflation

• Ability to selectively ignore small features

Hex Dominant Meshing - CutCell Meshing

CutCell meshes can be used in ANSYS FLUENT only.

CutCell is in principal a Patch Independent mesher, and it is mostly suitable for moderately clean CAD. It

results in a mesh of 80-95% hex cells, which often leads to very accurate solutions, providing the physics

can handle the relatively rapid size changes due to hanging-node configurations.

Additional benefits of this approach include:

• Support for Advanced Size Function controls

• Support for 3D inflation, although very thick inflation should be avoided

• Ability to selectively ignore features
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Accessing Meshing Functionality

You can access Meshing application functionality from the Model/Mesh cell in an analysis system, or from

the Mesh cell in a Mesh component system. Before using the steps provided in this section, you should be

familiar with the concepts of analysis systems and component systems in ANSYS Workbench.

Accessing Meshing Functionality from an Analysis System

The Model cell (Mesh cell in Fluid Flow analysis systems) allows you to access a meshing application or share

a mesh with another system. Model corresponds to the contents of the Model branch within the Mechanical

application and allows you to perform physics-based meshing capabilities, such as spot welds, contact, etc.

Mesh contains just node coordinates and mesh connectivity.

To launch the Meshing application from a Model cell in an analysis system (non-Fluid Flow):

1. From the Analysis Systems group of the ANSYS Workbench Toolbox, either double-click or drag an

analysis system onto the Project Schematic. As a result, a template for that type of analysis system

appears in the Project Schematic.

2. In the analysis system, right-click on the Geometry cell and choose New Geometry to create geometry

within the DesignModeler application, or choose Import Geometry to attach existing geometry.

3. Right-click the Model cell and choose Edit. This step will launch the Mechanical application. From the

Mechanical application, you can access the Meshing application controls by clicking on the Mesh object

in the Tree Outline.

To access meshing from a Mesh cell in a Fluid Flow analysis system:

1. From the Analysis Systems group of the ANSYS Workbench Toolbox, either double-click or drag a

Fluid Flow analysis system onto the Project Schematic. As a result, a template for that type of analysis

system appears in the Project Schematic.

2. In the analysis system, right-click on the Geometry cell and choose New Geometry to create geometry

within the DesignModeler application, or choose Import Geometry to attach existing geometry.

3. Right-click the Mesh cell and choose Edit. This step will launch the appropriate mesh application (e.g.,

the Meshing application, etc.).

Accessing Meshing Functionality from a Mesh Component System

To launch the Meshing application from a Mesh component system:

1. From the Component Systems group of the ANSYS Workbench Toolbox, either double-click or drag a

Mesh component system onto the Project Schematic. As a result, a template of a Mesh system appears

in the Project Schematic.

2. In the Mesh system, right-click on the Geometry cell and choose New Geometry to create geometry

within the DesignModeler application, or choose Import Geometry to attach existing geometry.

3. Right-click the Mesh cell and choose Edit. This step will launch the appropriate mesh application (e.g.,

the Meshing application, etc.).

Replacing a Mesh System with a Mechanical Model System

You can replace a Mesh component system with a Mechanical Model component system. This system can

then be shared with any analysis system. For details, refer to the description of Mechanical Model systems

in the ANSYS Workbench help.
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Overview of the Meshing Application Interface

The intuitive Meshing application interface, which is shown in Figure: Meshing Application Interface (p. 18),

facilitates your use of all meshing controls and settings.

Figure: Meshing Application Interface

The functional elements of the interface are described in the following table.

Note

The linked topics in the table contain supplemental information describing items in the Mechan-

ical application interface. Not all of the items described are available in the Meshing application

interface.

DescriptionWindow Component

This menu includes the basic menus such as File and Edit.Main Menu

This toolbar contains commonly used application commands.Standard Toolbar

This toolbar contains commands that control pointer mode or cause an action

in the graphics browser.

Graphics Toolbar

This toolbar contains task-specific commands that change depending on

where you are in the Tree Outline.

Context Toolbar
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DescriptionWindow Component

Not visible by default.This toolbar allows you to convert units for various

properties.

Unit Conversion Toolbar

Not visible by default.This toolbar contains options to manage Named Selec-

tions similar to how they are managed in the Mechanical application.

Named Selection Toolbar

This toolbar provides quick access to features that are intended to improve

your ability to distinguish edge and mesh connectivity in a surface body

model.

Graphics Options Toolbar

Outline view of the project. Always visible. Location in the outline sets the

context for other controls. Provides access to object's context menus. Allows

renaming of objects. Establishes what details display in the Details View.

Tree Outline

The Details View corresponds to the Outline selection. Displays a details win-

dow on the lower left panel which contains details about each object in the

Outline.

Details View

Displays and manipulates the visual representation of the object selected

in the Outline. This window displays:

Geometry Window (also

sometimes called the Graph-

ics window)
• 3D Geometry

• 2D/3D Graph

• Spreadsheet

• HTML Pages

Note

The Geometry window may include splitter bars for dividing

views.

Opens an objects reference help page for the highlighted object.These are

the same pages that are available in the Mechanical application.

Reference Help

The document tabs that are visible on the lower right portion of the window.Tabs

Brief in-context tip. Selection feedback.Status Bar

Application window has up to 3 splitter bars.Splitter Bar

Determination of Physics, Analysis, and Solver Settings

Most systems in ANSYS Workbench are defined by three primary attributes: physics type, analysis type, and

solver type. The method you use to launch the Meshing application functionality determines how default

physics, analysis, and/or solver settings are defined:

• Mesh systems, which are a type of component system, are unfiltered (physics, analysis, and solver). If

you launch the Meshing application from a Mesh component system, your preferences will be set to

the defaults you previously defined within the Meshing application. You can change the default

Physics Preference directly from the Meshing Options panel. See Meshing Overview (p. 1) for more

information.

• If you launch the Meshing application from an analysis system (whether it be via the Model cell in a

non-Fluid Flow analysis system or the Mesh cell in a Fluid Flow analysis system), your Physics, Analysis,
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and Solver settings will be set according to the selected type of analysis system. To change the  Physics

Preference, you must use the Details View of the Mesh folder.

Note

• To view the physics, analysis, and solver types that are defined for an analysis system, right-

click the Model cell (non-Fluid Flow analyses) or Mesh cell (Fluid Flow analyses) and select

Properties. This step will open the Properties window, where you can view the attributes.

For example, for an Electric system, the Properties window will show that Physics is Electric,

Analysis is Steady-State Electric Conduction, and Solver is Mechanical APDL.

• Mechanical Model systems, which are a type of component system, are unfiltered (physics

and solver). For details, refer to the discussion of Mechanical Model systems in the ANSYS

Workbench help.

For more information:

• For a list of analysis systems available in ANSYS Workbench and basic steps for building each type of

system, refer to the discussion of analysis systems in the ANSYS Workbench help.

• For details about the various types of non-Fluid Flow analyses and how to perform them, refer to the

discussion of analysis types in the Mechanical help.

• For details about Fluid Flow analyses and how to perform them, refer to the documentation available

under the Help menu within CFX or ANSYS FLUENT.

Working with Legacy Mesh Data

You can import legacy mesh files using the following methods. The method that is best for you depends

on the type of file that you want to import and how you intend to use it:

• Choose File> Import from the ANSYS Workbench Menu bar or click the Import button on the ANSYS

Workbench Toolbar to read legacy ANSYS Workbench mesh data

• Right-click the Mesh cell and choose Import Mesh File to import a read-only mesh for downstream

use

• Use the FE Modeler system to read a legacy mesh input file for reuse as a mesh or geometry for other

ANSYS Workbench systems

Importing Using File> Import or the Import Button

If you choose File> Import or click the Import button from ANSYS Workbench, you can import mesh files

that have an extension of .cmdb or .meshdat. Doing so creates a Mesh system in the ANSYS Workbench

Project Schematic. When the Mesh cell is edited, the mesh will open in the Meshing application where you

can edit it.

For more information about reading a simulation/mesh database (.dsdb/.cmdb) from previous ANSYS versions,

please refer to the discussion of importing legacy databases in the ANSYS Workbench help.

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.20

Usage in Workbench



Note

ANSYS Workbench no longer supports the CFX-Mesh method. Upon import of a legacy model

into Release 13.0, any CFX-Mesh method controls will be made inoperable, and you must either

delete the method manually or change it to a valid method type. If importing a *.cmdb file from

Release 10.0 that contains CFX-Mesh data, please first take the model into Release 11.0 and save

it to convert it to a supported format for use in Release 13.0. In either case the geometry will be

maintained, but the mesh method must be replaced.

Importing Read-only Meshes for Downstream Application Use

You can right-click a Mesh cell and choose Import Mesh File to browse to a mesh file that you want to

import, provided the file is of one of the following types:

• ANSYS CFX mesh file with extension .gtm or .cfx

• ANSYS ICEM CFD mesh file with extension .cfx, cfx5, or .msh

• ANSYS FLUENT mesh file with extension .cas or .msh

• ANSYS POLYFLOW mesh file with extension .poly, .neu, or .msh

Note

When you use this method, in the strictest sense you are not “importing” the mesh file. That is,

you will not be able to edit the file in the Meshing application using this method. Rather, you

are making the mesh available for downstream systems. To be able to edit these types of files in

the Meshing application, you must import the mesh into the FE Modeler application, and then

into another system. Refer to Importing Legacy Meshes for Edit Using FE Modeler (p. 22).

The Import Mesh File method is enabled when:

• No geometry is associated with the Geometry cell.

• No generated mesh is associated with the Mesh cell. (Imported meshes do not disable the Import Mesh

File menu item.)

• No incoming connections are associated with the Geometry cell or Mesh cell.

• No outgoing connections are associated with the Geometry cell.

• No outgoing connections from the Mesh cell are connected to the FE Modeler, Mechanical APDL, or

ANSYS AUTODYN applications.

When you import the mesh to the Mesh cell:

• The Geometry cell is deleted.

• The title of the cell changes from “Mesh” to “Imported Mesh.”

• The state of the Mesh cell is “Up to Date.”

• No incoming connections are allowed.

• Outgoing connections can be established with a Mechanical APDL, ANSYS AUTODYN, ANSYS CFX, ANSYS

FLUENT, ANSYS POLYFLOW, or FE Modeler system.

• The Geometry cell in the target system is deleted.
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• Using the reset command (right-clicking on the Imported Mesh cell and choosing Reset) deletes the

imported mesh.

Importing Legacy Meshes for Edit Using FE Modeler

You can import a legacy mesh for the purposes of editing it in the Meshing application, but the mesh must

come from an FE Modeler system. This is necessary because before it can be imported into the Meshing

application to edit, the mesh must be associated with a geometry. The FE Modeler application allows you

to import a mesh and create a geometry that will be associated with that mesh. For more information, please

see the FE Modeler help.

After you use an FE Modeler system to import a mesh and create a geometry from it, you must connect an

analysis system, Mechanical Model system, or Mesh system to the FE Modeler system. When this follow-on

system is edited, the mesh will open in the Meshing application.

Exporting Meshes or Faceted Geometry

A mesh generated by the Meshing application can be exported into the following file formats:

• Meshing File format (*.meshdat), suitable for import into ANSYS Workbench

• ANSYS FLUENT mesh format (*.msh), suitable for import into ANSYS FLUENT or TGrid

• POLYFLOW format (*.poly), suitable for import into POLYFLOW

• CGNS format (*.cgns), suitable for import into a CGNS-compatible application

• ICEM CFD format (*.prj), suitable for import into ANSYS ICEM CFD

To export a mesh:

1. Generate the mesh.

2. Select File> Export from the main menu.

3. In the Save As dialog box, choose a directory and specify a file name for the file. Then choose a file

type from the Save as type drop-down menu and click Save.

Note

• You can also use the Meshing application to export faceted geometry for use in TGrid. In

such cases you can skip step 1 above. A file with the extension .tgf is created, suitable for

import into TGrid.

• When the same entity is a member of more than one Named Selection, those Named Selec-

tions are said to be “overlapping.” If you are exporting a mesh into the ANSYS FLUENT,

POLYFLOW, CGNS, or ICEM CFD format (or faceted geometry into the TGrid format), and

overlapping Named Selections are detected, the export will fail and you must resolve the

overlapping Named Selections before proceeding. For details, see Showing Geometry in

Overlapping Named Selections (p. 276).

For details, refer to:

Mesh Application File Export

FLUENT Mesh Export

POLYFLOW Export

CGNS Export
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ICEM CFD Export

Exporting Faceted Geometry to TGrid

Mesh Application File Export

When you export a mesh file to Meshing File format (File> Export from the Meshing application main menu,

then Save as type Meshing File), a file with the extension .meshdat is created. The exported file can be

imported as a legacy file into ANSYS Workbench by either selecting File >Import from the Menu bar or

clicking the Import button on the Toolbar, and then selecting an Importable Mesh File. This will create a

Mesh System in the ANSYS Workbench Project Schematic.

FLUENT Mesh Export

When you export a mesh file to ANSYS FLUENT mesh format (File> Export from the Meshing application

main menu, then Save as type FLUENT Input Files), a mesh file with the extension .msh is created. The

exported mesh file is suitable for import into another product such as ANSYS FLUENT, or into TGrid outside

of ANSYS Workbench.

If the mesh file you export contains quadratic elements, all midside nodes will be dropped during export;

that is, all element types will be exported as linear element types for ANSYS FLUENT.

An orientation check/correction will be performed for 3D geometry models exported as 2D mesh such that

all 2D cells will have the same orientation. You do not need to manually correct the orientation of the geo-

metry face(s).

When the mesh file is exported to ANSYS FLUENT mesh format, the material properties of the bodies/parts

in the model must be translated to proper continuum zone types for use in ANSYS FLUENT. To provide this

information to ANSYS FLUENT, the following logic is used:

1. If Physics Preference (p. 57) is set to CFD and you do not use any of the methods described in steps 2

through 4 below to explicitly assign a body/part to be either solid or fluid (such that all zones would

be exported as SOLID), all zones are exported to ANSYS FLUENT mesh format as FLUID zones by default.

Note

An exception to the above involves models that include an enclosure. If you used the En-

closure feature in the DesignModeler application, the enclosure body will be assigned a

continuum zone type of FLUID by default.

2. For models created/edited in the DesignModeler application, a Fluid/Solid material property can be

assigned to a solid body or a multibody part (if the multibody part contains at least one solid body).

This material property assignment appears under Details of Body in the Details View of the Design-

Modeler application. When exported to ANSYS FLUENT mesh format, a body/part with a material

property of Solid will be assigned a continuum zone type of SOLID and a body/part with a material

property of Fluid will be assigned a continuum zone type of FLUID. This assignment, based on Flu-

id/Solid material property, overrides the default behavior described in step 1.

For multibody parts, you can change the material property for all bodies in one operation in the

DesignModeler application by modifying the Fluid/Solid property for the multibody part and the

modification will propagate to any solid bodies in the part. Similarly, you can modify the Fluid/Solid

property for a solid body that belongs to a multibody part, and the Fluid/Solid property for the

multibody part will be modified accordingly.
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Note

Refer to Figure: Multibody Part Containing All Fluid Bodies in the DesignModeler Applica-

tion (p. 32) for an example that illustrates where to set the Fluid/Solid material property.

3. Regardless of whether the model was created/edited in the DesignModeler application, body/part

names are considered next. You can rename bodies/parts in either the DesignModeler application or

the Meshing application. If a body/part name contains the string “fluid” (case-insensitive), the continuum

zone type of FLUID is assigned to it upon export to ANSYS FLUENT mesh format. This assignment,

based on body/part name, overrides any assignments that were made based on the default behavior

described in step 1 or on the Fluid/Solid setting in step 2.

4. Finally, Named Selections are considered. Named Selections can be defined for parts in either the

DesignModeler application or the Meshing application. To ensure that a Named Selection is assigned

the correct continuum zone type of SOLID or FLUID, the name of the Named Selection must include

the string “solid” or “fluid” as appropriate (case-insensitive). This assignment overrides any assignments

that were made based on the default behavior described in step 1, the Fluid/Solid setting in step 2,

or body/part names in step 3. Detailed guidelines for naming Named Selections are provided so that

if you choose to use Named Selections, you can ensure that ANSYS FLUENT zone types are assigned

correctly and predictably (for both continuum zone types and boundary zone types) in the exported

ANSYS FLUENT mesh file.

Note

• If there are multiple continuum zones or boundary zones of the same type in the

DesignModeler application or the Meshing application, each zone name in the exported

ANSYS FLUENT mesh file will contain the necessary prefix and an arbitrary number will

be appended to the name to make it unique. Refer to Example of ANSYS FLUENT Workflow

in ANSYS Workbench (p. 32) for an example that illustrates multiple zones of the same

type.

• When Named Selections defined in the DesignModeler application are required in the

Meshing application, you must set the appropriate geometry import options to ensure

the Named Selections will be transferred properly. Refer to Importing DesignModeler

Named Selections into the Meshing Application (p. 291) for details.

• For CutCell meshing, the names of parts, bodies, and Named Selections should be limited

to 64 characters.

For more information, refer to:

Classes of Zone Types in ANSYS FLUENT

Standard Naming Conventions for Naming Named Selections

Zone Type Assignment

Example of ANSYS FLUENT Workflow in ANSYS Workbench

Note

For additional information about importing files into ANSYS FLUENT or TGrid, refer to the docu-

mentation available under the Help menu within the respective product.
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Classes of Zone Types in ANSYS FLUENT

Zone type specifications in ANSYS FLUENT define the physical and operational characteristics of the model

at its boundaries and within specific regions of its domain. There are two classes of zone type specifications:

• Boundary zone types (sometimes called “face zones”)

• Continuum zone types (sometimes called “cell zones”)

Boundary zone type specifications, such as WALL or INLET_VENT, define the characteristics of the model at

its external or internal boundaries. Boundary zones are collections of faces in 3D, and collections of edges

in 2D. By default, a boundary zone of type WALL is created for the boundary of each body in the geometry

during export to ANSYS FLUENT mesh format. Continuum zone type specifications, such as FLUID or SOLID,

define the characteristics of the model within specified regions of its domain. By default, a continuum zone

is created for each body in the geometry during export to ANSYS FLUENT mesh format. (By default, continuum

zone types will be assigned as described in FLUENT Mesh Export (p. 23).)

If you do not want the default zone type assignments to be used, you can override them by defining Named

Selections and naming them according to the conventions provided.

Named Selections allow for user-defined boundary zones and continuum zones as follows:

1. All faces belonging to the same body in a Named Selection are placed into a single boundary zone.

2. All bodies belonging to the same part in a Named Selection are placed into a single continuum zone.

Note

For 2D models, you can group sheet surface bodies into a Named Selection, and the underlying

faces contained in the sheet surface bodies will be placed into a single continuum zone (as long

as the faces themselves are not contained in a Named Selection).

The following sections further describe boundary zone type and continuum zone type specifications and il-

lustrate their purposes in the definition of an example computational model involving simple geometry.

For details on how zones are named and how zone types are assigned during export, refer to Zone Type

Assignment (p. 28).

For an example that illustrates the basic workflow for using ANSYS Workbench to create a model in the

DesignModeler application, mesh it in the Meshing application, and export the mesh to ANSYS FLUENT,

refer to Example of ANSYS FLUENT Workflow in ANSYS Workbench (p. 32). In the example, Named Selections

are defined in the Meshing application and the correct ANSYS FLUENT zone names/types are assigned in

the exported FLUENT mesh file based on those definitions.

Comparing and Contrasting Boundary Zone Types and Continuum Zone Types

Boundary zone type specifications define the physical and operational characteristics of the model at those

topological entities that represent model boundaries. For example, if an INFLOW boundary zone type is as-

signed to a face entity that is part of three-dimensional model, the model is defined such that material flows

into the model domain through the specified face. Likewise, if a SYMMETRY boundary zone type is assigned

to an edge entity that is part of a two-dimensional model, the model is defined such that flow, temperature,

and pressure gradients are identically zero along the specified edge. As a result, physical conditions in the

regions immediately adjacent to either side of the edge are identical to each other.
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Continuum zone type specifications define the physical characteristics of the model within specified regions

of its domain. For example, if a FLUID continuum zone type is assigned to a body entity, the model is defined

such that equations of momentum, continuity, and species transport apply at mesh nodes or cells that exist

within the body. Conversely, if a SOLID continuum zone type is assigned to a body entity, only the energy

and species transport equations (without convection) apply at the mesh nodes or cells that exist within the

body.

Generally speaking, entities are assigned to zone type classes in ANSYS FLUENT as shown in the following

table:

Zone Type ClassEntityModel Dimension

ContinuumBody3D

BoundaryFace

ContinuumFace2D

BoundaryEdge

The Effect of Zone Type Specifications

As an example of the effect of zone type specifications on the specification of a computational model, consider

the geometry shown in Figure: Boundary Zone Type and Continuum Zone Type Specifications in ANSYS FLU-

ENT (p. 26), which consists of a single volume in the shape of a straight, elliptical cylinder. The geometry

includes one body, three faces, two edges, and two vertices.

Figure: Boundary Zone Type and Continuum Zone Type Specifications in ANSYS FLUENT

The geometry shown in Figure: Boundary Zone Type and Continuum Zone Type Specifications in ANSYS FLU-

ENT (p. 26) can be used to model many different types of transport problems, including fluid flow through

a straight, elliptical pipe and heat conduction through a solid, elliptical rod. The following table shows the

zone type specifications associated with the fluid flow problem using the geometry shown in Figure: Boundary

Zone Type and Continuum Zone Type Specifications in ANSYS FLUENT (p. 26).

Zone TypeZone ClassEntity

WALLBoundaryface.1
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Zone TypeZone ClassEntity

INFLOWBoundaryface.2

OUTFLOWBoundaryface.3

FLUIDContinuumbody.1

The following table shows the zone type specifications associated with the heat conduction problem using

the geometry shown in Figure: Boundary Zone Type and Continuum Zone Type Specifications in ANSYS FLU-

ENT (p. 26).

Zone TypeZone ClassEntity

WALLBoundaryface.1

SOLIDContinuumbody.1

Note

For additional information about boundary (face) zones and continuum (cell) zones in ANSYS

FLUENT, refer to the documentation available under the Help menu within ANSYS FLUENT.

Standard Naming Conventions for Naming Named Selections

If you want to override the default zone type assignments (described in FLUENT Mesh Export (p. 23)) by using

Named Selections, naming conventions have been provided for you to follow. Use these conventions when

defining Named Selections in either the DesignModeler application or the Meshing application. By following

these naming conventions consistently, you can ensure that ANSYS FLUENT zone types will be assigned

correctly and predictably in the exported ANSYS FLUENT file.

When naming Named Selections, it is best practice to specify the appropriate name from the list below exactly

as shown (case-insensitive). In cases where the name shown below contains an underscore character, a hyphen

is also acceptable (for example, both EXHAUST_FAN and EXHAUST-FAN will work). (Note, however, that although

the Meshing application allows both hyphens and underscore characters to be used when defining Named

Selections, the DesignModeler application allows only underscore characters.)

The name of each Named Selection is filtered upon export such that only allowable characters remain. Al-

lowable characters include all alphanumeric characters as well as the following special characters:

` ! $ % ^ & * _ + - = : < > . ? /

All other characters, including spaces, are invalid. If an invalid character is used, it is replaced by an underscore

(_) upon export.

In addition, the export process does allow for partial matches and special abbreviations, which are described

in Zone Type Assignment (p. 28).

AXIS

DEAD

EXHAUST_FAN

FAN

FLUID

INLET_VENT

INTAKE_FAN

INTERFACE
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INTERIOR

MASS_FLOW_INLET

OUTFLOW

OUTLET_VENT

PERIODIC

POROUS_JUMP

PRESSURE_FAR_FIELD

PRESSURE_INLET

PRESSURE_OUTLET

RADIATOR

RECIRCULATION_INLET

RECIRCULATION_OUTLET

SOLID

SYMMETRY

THIN

VELOCITY_INLET

WALL

Note

For details about the boundary (face) zone and continuum (cell) zone types in ANSYS FLUENT,

refer to the documentation available under the Help menu within ANSYS FLUENT.

Zone Type Assignment

This section describes zone naming and the zone type assignment process.

Zone Naming

By default, zones are named after the part and body from which they are derived. For example, part “part”

and body “solid body” will result in a zone name of “part-solid_body.” When the zone name is created:

• Any invalid characters (such as the space in “solid body”) are replaced by an underscore character

(“solid_body”).

• Names that begin with a digit are prefixed by “zone.”

• If the part name and the body name are identical, only the body name is used to create the zone name.

The same rule applies to single body parts.

If a zone was created for a Named Selection (as described in Classes of Zone Types in ANSYS FLUENT (p. 25)),

the name of the zone is set to the name of the Named Selection.

In cases where the zone naming process could lead to conflicting zone names (for example, in a situation

where the potential exists for a zone name that is already in use to be used to name a new zone), one of

the following approaches is used:

• If the zone type is not similar to the zone name in question, the zone type will be prefixed to the zone

name to make it unique. For example, an existing continuum zone named “fluid” and a new boundary

zone named “fluid” (with zone type WALL) will result in the boundary zone being renamed “wall-fluid.”

• If the zone type is similar to the zone name in question, a unique integer will be suffixed to the zone

name, preceded by an underscore character (_). For example, an existing continuum zone named “fluid”

and a second continuum zone named “fluid” (with zone type FLUID) will result in the second continuum
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zone being renamed “fluid_1.” Subsequent continuum zones named “fluid” (with zone type FLUID) will

be renamed “fluid_2,”“fluid_3,” and so on.

Zone Type Assignment Process

The zone type is derived from the zone name. To assign zone types, the string comparison operations detailed

below are performed during the export process. These string comparison operations, which correspond to

the naming conventions described in Standard Naming Conventions for Naming Named Selections (p. 27), are

applied in the order in which they are listed below (that is, at first an exact match is tested, after that a

partial match is tested, etc.) and are always case-insensitive. For example, fluid, Fluid, FLUid, and FluID are

all exact matches for the 'FLUID' string comparison and result in a zone type of FLUID being assigned.

When the search operation begins, it will start by searching the first portion (or sub-string) of the string and

if no match is found, it will search for a match anywhere in the string. For example, if a Named Selection

with the name wall_inlet_flange is defined, it will be exported as zone type WALL. The 'inlet' portion of the

name will have no effect on zone type assignment.

Once they are exported, names are all lowercase. The single quotation marks that are shown enclosing the

strings below are not considered during the string comparison operations.

1. Exact matches are checked:

'AXIS'
'DEAD'
'EXHAUST_FAN'
'FAN'
'FLUID'
'INLET_VENT'
'INTAKE_FAN'
'INTERFACE'
'INTERIOR'
'MASS_FLOW_INLET'
'OUTFLOW'
'OUTLET_VENT'
'PERIODIC'
'POROUS_JUMP'
'PRESSURE_FAR_FIELD'
'PRESSURE_INLET'
'PRESSURE_OUTLET'
'RADIATOR'
'RECIRCULATION_INLET'
'RECIRCULATION_OUTLET'
'SOLID'
'SYMMETRY'
'THIN'
'VELOCITY_INLET'
'WALL'

2. Partial matches are considered only if an exact match was not found in step 1:

'AXIS'
'DEAD'
{'EXHAUST' && 'FAN'}
'FAN'
'FLUID'
{'INLET' && 'VENT'}
{'INTAKE' && 'FAN'}
'INTERFACE'
'INTERIOR'
{'MASS' && 'FLOW' && 'INLET'}
'OUTFLOW'
{'OUTLET' && 'VENT'}
'PERIODIC'
{'POROUS' && 'JUMP'}
{'PRESSURE' && 'FAR' && 'FIELD'}
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{'PRESSURE' && 'INLET'}
{'PRESSURE' && 'OUTLET'}
'RADIATOR'
{'RECIRCULATION' && 'INLET'}
{'RECIRCULATION' && 'OUTLET'}
'SOLID'
'SYMMETRY'
{'VELOCITY' && 'INLET'}

3. String comparisons to the special abbreviations listed in the table below are performed if no match

was found in step 1 or step 2. If an exact match to one of the strings listed in the table is found, the

corresponding zone type is assigned:

This zone type is assigned...When a match for this string is found...

INTERFACE'CNDBY'

EXHAUST FAN'EXFAN'

INTERFACE'IFACE'

PRESSURE INLET'IN'

INTAKE FAN'INFAN'

INTERFACE'INTER'

INLET VENT'IVENT'

MASS FLOW INLET'MASFI'

PRESSURE OUTLET'OUT'

OUTLET VENT'OVENT'

PERIODIC'PER'

PRESSURE FAR FIELD'PFAR'

FLUID'POR'

POROUS JUMP'PORJ'

PRESSURE FAR FIELD'PRESF'

PRESSURE INLET'PRESI'

PRESSURE OUTLET'PRESO'

PRESSURE FAR FIELD'PRESS'

RADIATOR'RAD'

RECIRCULATION INLET'RINLT'

RECIRCULATION OUTLET'ROUT'

INTERFACE'SLIDE'

SYMMETRY'SYM'

SYMMETRY'SYMET'
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This zone type is assigned...When a match for this string is found...

VELOCITY INLET'VELF'

VELOCITY INLET'VELI'

4. Partial matches are considered if no match was found in steps 1, 2, or 3. If a partial match to one of

the strings listed in the following table is found, the corresponding zone type is assigned:

This zone type is assigned...When a match for this string is found...

EXHAUST FAN'EXHAUST'

VELOCITY INLET'INLET'

PRESSURE OUTLET'OUTLET'

THIN'THIN'

WALL'WALL'

5. If none of the string comparisons described in steps 1, 2, 3, or 4 result in a match, default zone types

are assigned as follows:

• Bodies (that is, continuum or cell zones) are assigned zone types as described in FLUENT Mesh Ex-

port (p. 23) (first, the Fluid/Solid material property setting is considered; next, body/part name;

and finally Named Selections).

• Boundaries of bodies (that is, boundary or face zones) are assigned zone type WALL.

Special Cases

Be aware of the following special cases related to zone type assignment:

• If Physics Preference (p. 57) is set to CFD and no other zone assignment has been explicitly defined, all

zones are exported as FLUID zones. See FLUENT Mesh Export (p. 23) for more information.

• If the model includes an enclosure from the DesignModeler application, the enclosure body is assigned

a continuum zone type of FLUID by default.

• A boundary zone type of INTERIOR is assigned automatically between two FLUID zones (sharing a

common boundary) at the time of mesh export. For this reason, you are not required to explicitly define

an INTERIOR zone in such cases.

• A boundary zone type of WALL is assigned automatically to a baffle, unless the baffle is part of a Named

Selection that was defined in the DesignModeler application or the Meshing application, and the name

of the Named Selection results in a different zone type assignment.

• A boundary zone type of WALL is assigned automatically between a FLUID zone and a SOLID zone at

the time of mesh export. For this reason, you are not required to explicitly define a WALL zone in such

cases. ANSYS FLUENT will automatically generate an additional WALL SHADOW zone when reading the

mesh file.

• Due to a limitation concerning the definition of rotational/translational periodicity in ANSYS Workbench,

the boundary zone type PERIODIC is always replaced by the boundary zone type WALL during the mesh

export process. (However, the zone name is kept.) The suggested workaround is to manually redefine

periodic boundary conditions in ANSYS FLUENT. For details, refer to the documentation available under

the Help menu within ANSYS FLUENT.

31
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Special Cases



Example of ANSYS FLUENT Workflow in ANSYS Workbench

This example illustrates the basic workflow you can follow to create a multibody part in the DesignModeler

application, mesh the model in the Meshing application, and export the mesh to ANSYS FLUENT. In the ex-

ample, the bodies are renamed in the DesignModeler application, and Named Selections are defined in the

Meshing application. Based on these definitions, ANSYS FLUENT zone names/types are assigned correctly

and predictably (for both continuum and boundary zones) in the exported FLUENT mesh file.

First, the model is imported into the DesignModeler application. The model consists of nine solid bodies

after import. In the DesignModeler application, a multibody part is formed, the bodies are renamed, and all

bodies are assigned a material property of fluid. (See FLUENT Mesh Export (p. 23) for more information about

the Fluid/Solid material property in the DesignModeler application.) Shared Topology is also used in this

example. Refer to Figure: Multibody Part Containing All Fluid Bodies in the DesignModeler Application (p. 32).

Figure: Multibody Part Containing All Fluid Bodies in the DesignModeler Application

Next, the model is edited in the Meshing application. The patch conforming mesh method is applied with

inflation, and Named Selections are defined for boundary zones. Virtual Topology is also used in this example

to provide geometry cleanup. Refer to Figure: Named Selections Defined in Meshing Application (p. 33).
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Figure: Named Selections Defined in Meshing Application

Finally, the model is edited in ANSYS FLUENT. As shown in Figure: Boundary Zone Names and Types Transferred

to ANSYS FLUENT (p. 34), the boundary zone names and types are transferred as expected.
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Figure: Boundary Zone Names and Types Transferred to ANSYS FLUENT

Similarly, continuum (or cell) zone names and types (in this case, all fluid) are transferred as expected. Refer

to Figure: Continuum Zone Names and Types Transferred to ANSYS FLUENT (p. 35).
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Figure: Continuum Zone Names and Types Transferred to ANSYS FLUENT

POLYFLOW Export

When you export a mesh file to POLYFLOW format (File> Export from the Meshing application main menu,

then Save as type POLYFLOW Input Files), a Patran-based mesh file with the extension .poly is created.

The exported mesh file is suitable for import into POLYFLOW.

Named Selections are not supported in the Patran-based format, so any Named Selections that were defined

will not appear in the POLYFLOW mesh. Instead, the information from the Named Selections will be mapped

into Material IDs for bodies and Load IDs for faces.

Element types that are supported in the exported POLYFLOW mesh are listed in the table below. Only linear

meshes are supported for POLYFLOW export.

Supported Element TypeDimension

8–node hexahedral3D

4–node tetrahedral

5–node pyramid

6–node wedge

3–node triangle2D
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Supported Element TypeDimension

4–node quadrilateral

Note

As an alternative, you can transfer a mesh from a Mesh system into a downstream POLYFLOW

system.

CGNS Export

When you export a mesh file to CGNS format (File> Export from the Meshing application main menu, then

Save as type CGNS Input Files), a CGNS mesh file with the extension .cgns is created. The exported mesh

file is suitable for import into a CGNS-compatible application.

Named Selections are supported in the CGNS file.

Element types that are supported in the exported CGNS mesh are listed in the table below. Only linear

meshes are supported for CGNS export.

Supported Element TypeDimension

8–node hexahedral3D

4–node tetrahedral

5–node pyramid

6–node wedge

3–node triangle2D

4–node quadrilateral

ICEM CFD Export

When you export from the Meshing application to ANSYS ICEM CFD format (File> Export from the Meshing

application main menu, then Save as type ICEM CFD Input Files), an ANSYS ICEM CFD project file with the

extension .prj, along with a geometry file (*.tin) and/or mesh file (*.uns) will be written. This export function-

ality is designed such that consistent results are obtained between this export and the Workbench Readers

option in ANSYS ICEM CFD.

ANSYS ICEM CFD part names that appear in the exported files are derived from the ANSYS Workbench

geometry part and body names. In the case of a single body part, only the body name is used.

Note

The concept of a part in ANSYS Workbench and a part in ANSYS ICEM CFD is not the same. For

information about parts in ANSYS Workbench, refer to Conformal Meshing Between Parts (p. 7)

in the Meshing application help and Assemblies, Parts, and Bodies in the Mechanical help. For

information about parts in ANSYS ICEM CFD, refer to the documentation available under the Help

menu within ANSYS ICEM CFD.

Anytime you plan to export from the Meshing application to ANSYS ICEM CFD format, it is best practice to

define the desired part and body names for your model in the DesignModeler application prior to meshing

the model in the Meshing application. This is recommended because the ANSYS ICEM CFD part names will
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be derived from the part and body names that are defined for the model when you initially open the model

in the Meshing application; the export process will ignore any renaming that occurs in the Meshing applic-

ation.

Note

As an alternative to the export process described here, you can save your ANSYS Workbench files

(*.mechdat or *.meshdat) and use the Workbench Readers option to load the files into ANSYS

ICEM CFD (as long as ANSYS Workbench and ANSYS ICEM CFD are installed on the same machine).

(Legacy formats such as *.dsdb and *.cmdb are also supported.) Any defined Named Selections

will be imported into ANSYS ICEM CFD as subsets and if they overlap, it will not result in a failure.

In cases where there is overlap, you can clean up the subsets in ANSYS ICEM CFD and then convert

them into parts. For details about handling imported ANSYS Workbench files in ANSYS ICEM CFD,

refer to the documentation available under the Help menu within ANSYS ICEM CFD.

Rules Followed By the Export Process

When exporting to ANSYS ICEM CFD format, these rules are followed:

Note

The series of examples that follows this list illustrates many of the rules listed here.

• To achieve unique ANSYS ICEM CFD part names in the ANSYS ICEM CFD format files, a unique integer

is suffixed to all ANSYS Workbench part/body names.

• A single body part in ANSYS Workbench will appear as <part_name>_<part_index> in the ANSYS ICEM

CFD format files.

• A multibody part in ANSYS Workbench will appear as <part_name>_<part_index>/<body_name>_<body_in-

dex> in the ANSYS ICEM CFD format files. The / character denotes hierarchy.

• Bodies that are in a multibody part in ANSYS Workbench are put into an ANSYS ICEM CFD assembly.

The structuring in the ANSYS ICEM CFD format files reflects the part/body structure present in ANSYS

Workbench.

• As long as they are not contained in Named Selections, faces that are shared between bodies in the

same multibody part in ANSYS Workbench are put into separate ANSYS ICEM CFD parts. This type of

shared face is named according to the bodies having the face in common, with the body names separated

by the # character.

• Entities that are contained in a Named Selection are put into a separate ANSYS ICEM CFD part.

Note

For the export to work properly, an entity can be contained in only one Named Selection. If

an entity is contained in more than one Named Selection, the export fails.

• For each body, an ANSYS ICEM CFD Material Point is created and put into the corresponding ANSYS

ICEM CFD part. The names of Material Points have the suffix _MATPOINT.

• If a mesh has been generated, it is exported along with the geometry. In such cases, these additional

rules are followed:
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As long as they are not contained in a Named Selection, node/line/surface mesh cells are associated

with the corresponding geometry part/body in ANSYS ICEM CFD.

–

– As long as they are not contained in a Named Selection, volume mesh cells are associated with the

Material Point part.

– Mesh cells that are associated with geometry entities that are contained in a Named Selection are

associated with the ANSYS ICEM CFD part that corresponds to that Named Selection.

The first example is a model consisting of four separate single body parts in ANSYS Workbench. The single

body parts are named fluid1, fluid2, fluid3, and fluid4. The table below shows the geometry in ANSYS

Workbench and the corresponding part names that will appear in ANSYS ICEM CFD:

Results in these part names in ANSYS ICEM

CFD...

This geometry in ANSYS Workbench...

A model consisting of four separate single body parts

named:

FLUID1_1fluid1

FLUID2_2fluid2

FLUID3_3fluid3

FLUID4_4fluid4

The figure below shows the model after it was meshed in the Meshing application:

Figure: Meshed Model (Four Separate Workbench Parts) Ready for Export to ANSYS ICEM CFD

Next, the model was exported from the Meshing application to ANSYS ICEM CFD format. In the figure below,

the corresponding .prj file has been opened in ANSYS ICEM CFD. Notice the names that are assigned to the

various entities in the ANSYS ICEM CFD format file:
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• Each body/part name has been suffixed with a unique integer to distinguish it from similarly named

bodies/parts. (Note that in this example, part_name is equal to body_name.)

• Each single body part in ANSYS Workbench appears as <part_name>_<part_index> in the ANSYS ICEM

CFD format files. For example, the part named fluid1 in ANSYS Workbench has a part name of FLUID1_1

in ANSYS ICEM CFD, which appears as FLUID1_1_1 in the ANSYS ICEM CFD format files after the

part_index is added.

• For each body in the ANSYS Workbench file (Fluid1, Fluid2, Fluid3, Fluid4), a Material Point has been

assigned (FLUID1_1_1_MATPOINT, FLUID2_2_1_MATPOINT, FLUID3_3_1_MATPOINT, FLUID4_4_1_MAT-

POINT).

Figure: Opening the .prj File (Four Separate Workbench Parts) in ANSYS ICEM CFD

The second example is a model consisting of one multibody part in ANSYS Workbench. The multibody part,

which is named Part 4, contains four bodies named fluid1, fluid2, fluid3, and fluid4. The table below shows

the geometry in ANSYS Workbench and the corresponding part names that will appear in ANSYS ICEM CFD:

Results in these part names in ANSYS ICEM CFD (the

/ character denotes hierarchy)...

This geometry in ANSYS Workbench...

A model consisting of one multibody part named

Part 4, containing four bodies named:

PART_4_1/FLUID1_3fluid1

PART_4_1/FLUID2_2fluid2

PART_4_1/FLUID3_1fluid3

PART_4_1/FLUID4_4fluid4
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Figure: Meshed Model (One Multibody Workbench Part) Ready for Export to ANSYS ICEM CFD

Next, the model was exported from the Meshing application to ANSYS ICEM CFD format. In the figure below,

the corresponding .prj file has been opened in ANSYS ICEM CFD. Notice the names that are assigned to the

various entities in the ANSYS ICEM CFD format file:

• Each body/part name has been suffixed with a unique integer to distinguish it from similarly named

bodies/parts.

• Each multibody part in ANSYS Workbench appears as <part_name>_<part_index>/<body_name>_<body_in-

dex> in the ANSYS ICEM CFD format files. For example, the fluid1 body in Part 4 in ANSYS Workbench

has a part name of PART_4_1/FLUID1_3 in the ANSYS ICEM CFD format files.

• The bodies that are in the multibody part in the ANSYS Workbench file (fluid1, fluid2, fluid3, and fluid4)

have been put into an ANSYS ICEM CFD assembly named Part_4.

• The faces that are shared between the various pairs of bodies have been named FLUID2_2#FLUID1_3,

FLUID3_1#FLUID2_2, and FLUID3_1#FLUID4_4.

• For each body in the ANSYS Workbench file (fluid1, fluid2, fluid3, fluid4), a Material Point has been as-

signed (FLUID1_3_MATPOINT, FLUID2_2_MATPOINT, FLUID3_1_MATPOINT, FLUID4_4_MATPOINT).
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Figure: Opening the .prj File (One Multibody Workbench Part) in ANSYS ICEM CFD

The third (and final) example involves a model for which four Named Selections are defined in the Design-

Modeler application. The model is meshed in the Meshing application, exported to ANSYS ICEM CFD format,

and opened in ANSYS ICEM CFD.

The first figure shows the model after it was meshed in the Meshing application.

Figure: Meshed Model (with Named Selections) Ready for Export to ANSYS ICEM CFD
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The next four figures show the entit(ies) in the model that are contained in each of the four Named Selections.

In the figure below, the Fluid1_Fluid2 Named Selection is highlighted.

Figure: Fluid1_Fluid2 Named Selection

In the figure below, the InterfaceSolidFluid2 Named Selection is highlighted.

Figure: InterfaceSolidFluid2 Named Selection

In the figure below, the SharedEdge Named Selection is highlighted.
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Figure: SharedEdge Named Selection

In the figure below, the SharedVertices Named Selection is highlighted.

Figure: SharedVertices Named Selection

Next, the model was exported from the Meshing application to ANSYS ICEM CFD format. In the figure below,

the corresponding .prj file has been opened in ANSYS ICEM CFD. Notice the names that are assigned to the

various entities in the ANSYS ICEM CFD format file:
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• Each body/part name has been suffixed with a unique integer to distinguish it from similarly named

bodies/parts.

• The bodies that are in the multibody part in the ANSYS Workbench file (Solid, Fluid1, and Fluid2) have

been put into an ANSYS ICEM CFD assembly named Part_1.

• The face that is shared between SOLID_1 and FLUID1_2 has been named SOLID_1#FLUID1_2.

• Because Fluid1_Fluid2, InterfaceSolidFluid2, SharedEdge, and SharedVertices are all Named Selections

in the ANSYS Workbench file, each of them has been put into a separate ANSYS ICEM CFD part.

• For each body in the ANSYS Workbench file (Solid, Fluid1, Fluid2, Solid), a Material Point has been as-

signed (SOLID_1_MATPOINT, FLUID1_2_MATPOINT, FLUID2_3_MATPOINT, and SOLID_2_1_MATPOINT).

Figure: Opening the .prj File (with Named Selections) in ANSYS ICEM CFD

Note

For additional information, refer to the documentation available under the Help menu within

ANSYS ICEM CFD.

Exporting Faceted Geometry to TGrid

You can use the Meshing application to export faceted geometry for use in TGrid:

1. Select File> Export from the main menu.

2. In the Save As dialog box, choose a directory and specify a file name for the file. Then choose TGrid

Faceted Geometry File from the Save as type drop-down menu and click Save.

As a result, a file with the extension .tgf is created. The exported file can be imported into TGrid, where you

can use such features as the TGrid wrapper utility.

Note

The .tgf file has the same format as a .msh file and will be recognized as a "Mesh File" when read

into TGrid 13.0 (File/Read/Mesh... menu item).

Upon export, TGrid zones are created according to geometry bodies and Named Selections. Part and body

names are used in the TGrid zone names to identify the parts and bodies from which the zones originated.
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Keep the following information in mind when exporting to TGrid:

• The quality of the exported facets is derived from the CAD system. You can use the Facet Quality option

(Tools > Options > DesignModeler > Graphics > Facet Quality) to control the quality of the exported

facets (the higher the setting, the higher the quality). However, be aware that higher settings create

large numbers of facets, which can slow down the Meshing application.

• The part, body, and Named Selection names that were present in the Meshing application are exported

in all lowercase characters for use in the corresponding TGrid zone names.

• Only part and body names that were imported into the Meshing application are used in the exported

zone name. For example, names that were initially defined in the DesignModeler application or initially

appeared in the Tree Outline when a CAD file was loaded directly into the Meshing application will be

used. Any subsequent renaming of parts and bodies that occurs in the Meshing application will not be

taken into account in the exported zone names.

• Vertices (regardless of whether they are contained in a Named Selection) are ignored.

• The name of each Named Selection is filtered upon export such that only allowable characters remain

in the name of the TGrid zone. Allowable characters include all alphanumeric characters as well as the

following special characters:

` ! $ % ^ & * _ + - = : < > . ? /

All other characters, including spaces, are invalid. If an invalid character is used, it is replaced by a hyphen

(-) upon export.

• When the same entity is a member of more than one Named Selection, those Named Selections are

said to be “overlapping.” If you are exporting faceted geometry into the TGrid format (or a mesh into

the ANSYS FLUENT, POLYFLOW, CGNS, or ICEM CFD format), and overlapping Named Selections are

detected, the export will fail and you must resolve the overlapping Named Selections before proceeding.

For details, see Showing Geometry in Overlapping Named Selections (p. 276).

• For CutCell meshing, the names of parts, bodies, and Named Selections should be limited to 64 charac-

ters.

The figures below illustrate the process of exporting geometry in faceted representation from the Meshing

application to TGrid. Figure: Part, Body, and Named Selection Names in the Meshing Application (p. 46) shows

the model in the Meshing application. The geometry consists of a multibody part named AeroValve, and

the three bodies that AeroValve contains are named Outletbody, Valve, and Inletbody. Notice that three

Named Selections have been defined and are highlighted in the Geometry window: Inlet, Outlet, and

Valve_opening.
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Figure: Part, Body, and Named Selection Names in the Meshing Application

Figure: Zone Names Transferred to TGrid (p. 46) shows TGrid's Surface Retriangulation panel after the exported

.tgf file is imported into TGrid.

Figure: Zone Names Transferred to TGrid
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Extended ANSYS ICEM CFD Meshing

The features described here extend Meshing application functionality through integration of the Meshing

application with ANSYS ICEM CFD, and enable you to use ANSYS Workbench to drive automation of ANSYS

ICEM CFD.

With this approach you can leverage advantages of ANSYS Workbench such as:

• Its capabilities for running design optimization and what-if scenarios using parameters

• The strength of its core product solvers

The following topics are discussed in this section:

Writing ANSYS ICEM CFD Files

Rules for Interactive Editing

Limitations of ANSYS ICEM CFD Interactive

Writing ANSYS ICEM CFD Files

The Write ICEM CFD Files control determines whether ANSYS ICEM CFD files are written, and includes options

for running ANSYS ICEM CFD interactively or in batch mode from an ANSYS ICEM CFD Replay file.

Note

The Write ICEM CFD Files control is available when you use any ANSYS ICEM CFD mesh method

that is available in the Meshing application (Patch Independent Tetra, MultiZone, Uniform Quad/Tri,

or Uniform Quad). However, the Interactive and Batch options are available only if ANSYS ICEM

CFD is installed. A warning is issued if you try to use one of these options and ANSYS ICEM CFD

cannot be found.

Options for Write ICEM CFD Files include:

No

No files are written. This is the default.

Yes

Writes ANSYS ICEM CFD files. Useful when you are working in ANSYS Workbench but you want to export

your project files for further mesh editing in ANSYS ICEM CFD. If this control is set to Yes, your ANSYS ICEM

CFD project (.prj), geometry (.tin), unstructured domain (.uns), and blocking (.blk) files will be saved during

mesh generation.

• If your ANSYS Workbench project file has been saved, your ANSYS ICEM CFD files will be written to the

ANSYS Workbench project directory. ANSYS Workbench creates a project folder as the top level folder

for each project, at the same level as the project file. The project folder will be named <file-
name>_files , where <filename> is a name you provide. The project file will be named <file-
name>.wbpj . Under the project folder is a design point subdirectory for each design point in the

project. The active design point is always design point 0 (dp0) and corresponds to the design point

labeled Current in the ANSYS Workbench GUI. Under each design point folder are system folders for

each system type in the project (i.e., Mechanical, FLUENT, etc.). Each system folder contains solver-spe-

cific files and folders, such as input files, model directories, engineering data, resources, etc. Following
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this structure, the ANSYS ICEM CFD files will be written to <filename>_files\dp0\glob-
al\MECH\SYS .

• If your ANSYS Workbench project file has not been saved, your ANSYS ICEM CFD files will be written to

the temporary ANSYS Workbench folder, as follows: %TEMP%\WB_<computer>\unsaved_pro-
ject_files\dp0\global\MECH\SYS .

Note

• Only appropriate files are written, based on the selected mesh method.

• Refer to the ANSYS Workbench help for more information about project file management in

ANSYS Workbench.

Interactive

Applicable only when ANSYS ICEM CFD is installed.

When the Interactive option is set and you select Generate Mesh, the Meshing application launches ANSYS

ICEM CFD in interactive mode. When you specify the Interactive option, you must also select an option for

ICEM CFD Behavior to determine whether the geometry and/or mesh is transferred to ANSYS ICEM CFD.

Typically you will run in interactive mode to set up an ANSYS ICEM CFD Replay script file (*.rpl) that can be

run later in either batch or interactive mode. You will begin by loading a generic Replay file. It is important

to use this default Replay file because the batch process requires the pre and post steps that are defined

within it. To load the default Replay file:

1. From within ANSYS ICEM CFD, select File > Replay Scripts > Replay Control and the Replay Control

window appears.

2. Click Load on the Replay Control window and the Open Script File window appears.

3. Click Open on the Open Script File window to load the default Replay file.

You can incorporate your custom commands into the Replay file by using the Replay Control feature or a

text editor. The Replay file will be associated with your ANSYS ICEM CFD project when you save the project

and exit ANSYS ICEM CFD.

After the mesh is returned to the Meshing application and the ANSYS Workbench project is saved, the Replay

file will be written to the ANSYS Workbench project directory. Later you can set Write ICEM CFD Files to

Batch and the mesh will be updated automatically in batch. You can change parameters on the ANSYS

Workbench project page and Update the mesh in batch from either the project page or from within the

Meshing application.

Refer to Rules for Interactive Editing (p. 49) and Limitations of ANSYS ICEM CFD Interactive (p. 49) for related

information.

For more information about Replay Control, refer to the documentation available under the Help menu

within ANSYS ICEM CFD.

Batch

Applicable only when ANSYS ICEM CFD is installed.
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Runs ANSYS ICEM CFD in batch mode from an existing Replay file. If you specify the Batch option, you must

also select an option for ICEM CFD Behavior to determine whether the geometry and/or mesh is transferred

to ANSYS ICEM CFD.

ICEM CFD Behavior

Determines ANSYS ICEM CFD behavior when running ANSYS ICEM CFD in Interactive or Batch mode:

• Post Operation - After the meshing operation completes, transfers both the geometry and mesh to

ANSYS ICEM CFD for editing.

• Override - Bypasses the meshing operation and transfers only the geometry to ANSYS ICEM CFD for

meshing and editing.

Rules for Interactive Editing

The final mesh must pass ANSYS Workbench shape and topology checks in order for the mesh to be returned

to ANSYS Workbench. This requirement imposes the following rules and guidelines for editing in ANSYS

ICEM CFD:

• Do not modify the geometry.

• Pay attention to face and volume part naming. Use the same naming conventions and do not adjust

the part naming.

• Pay attention to mesh quality. If the mesh quality becomes degraded, the mesh will not be returned

to ANSYS Workbench unless the Shape Checking (p. 85) control is set to None.

• Pay attention to mesh projections and associations. It is recommended that you do not change these;

however, with some practice changing them may be acceptable.

• Follow file naming conventions for proper archiving and batch interaction. Retain the default names.

Changing the names will break the association between the Replay file and the ANSYS Workbench

project.

Limitations of ANSYS ICEM CFD Interactive

Be aware of the following limitations when using ANSYS ICEM CFD Interactive:

• ANSYS ICEM CFD Interactive is designed to work at the part level. If you have assigned multiple ANSYS

ICEM CFD mesh methods (Patch Independent Tetra, MultiZone, Uniform Quad/Tri, or Uniform Quad) to

different bodies of a multibody part, the ANSYS ICEM CFD Interactive options specified for the ANSYS

ICEM CFD method control that appears lowest in the Tree will be honored. In other words, those ANSYS

ICEM CFD Interactive options will affect all bodies being meshed with ANSYS ICEM CFD methods regard-

less of whether a particular option is turned on for a particular body.

• Named Selections are not supported.

Working with Meshing Application Parameters

The term parameters in the Meshing application includes mesh input parameters (such as element size,

height of the initial inflation layer, and growth rate) as well as mesh output parameters (number of elements,

number of nodes, and mesh metric values).

A check box appears to the left of each field in the Details View that can be treated as a parameter. Clicking

the check box causes a P to appear in the box, which indicates that the field has been exposed as a para-

meter for use in the Parameter Workspace. Fields that cannot be parameterized do not contain a check box
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and are left-aligned to save space. The Parameter Workspace collects all specified parameters and lists them

in the Parameter Workspace grids for later use and/or modification.

Note

• If an object has a parameterized field, and that object definition is changed in a way that

makes that parameterization non-meaningful, the non-meaningful parameterization will not

be removed by the program. For example, if there is a parameterized Number of Divisions

sizing control defined in the Meshing application and you switch to the Element Size sizing

control and parameterize it, the Number of Divisions parameterization will not be removed

and will continue to appear in the Parameter Workspace grids. The presence of a non-

meaningful parameter in the grids has no harmful effect, but you can delete the parameter

manually if you do not want it to appear. To do so, return to the Meshing application and

uncheck the corresponding check box in the Details View.

• If a mesh control is suppressed, the parameter associated with the control will be deleted.

• If you parameterize the Element Size or Max Face Size control when toggling the Advanced

Size Function on and off, the parameterization of one control will have no effect on the

other. However, the value of one control will be copied to the other if it is not the default.

For more information about the relationship between the Element Size control and the Max

Face Size control, refer to Changes to the Details View When the Advanced Size Function Is

On (p. 55).

• If you are using a parameterized field in a Design Point study, you must specify a real value

for the field rather than using its default value.

• Refer to the ANSYS Workbench help for detailed information about the Parameter Workspace

and Design Points.

ANSYS Workbench and Mechanical APDL Application Meshing Differences

While the corresponding meshing algorithms originated from the meshing capabilities present in the

Mechanical APDL application, over time these algorithms have diverged from those in the PREP7 meshing.

The divergence was due to the different focus of early versions of the Mechanical application (then known

as DesignSpace), which was previously concerned with linear elastic materials, linear modal, linear buckling,

and steady-state heat transfer analyses. The ANSYS Workbench and its Meshing application are now being

transitioned to support a full general-purpose, finite element code that supports all levels of multiphysics

disciplines. The Shape Checking option found in the Advanced meshing control allows you to set the level

of shape checking the ANSYS Workbench will perform in generating the mesh. This does not mean that

elements generated by the default value of the Shape Checking control's Standard Mechanical setting

cannot be used to solve other idealizations. However, it does mean the default setting of the Shape

Checking control will produce meshes for the ANSYS Workbench that easily pass the requirements necessary

to fulfill the original DesignSpace product mission.

The default shape checking acceptance criterion that is used by the ANSYS Workbench was produced by

an extensive and thorough study that correlated different element shape metrics to the quality of the solution

achieved with a distorted mesh. The ANSYS Workbench shape parameters included many that PREP7

meshing uses in the shape-checking (SHPP command) portion of the meshing code. The study concluded

that the Mechanical APDL application, which supports many different types of element formulations, must

enforce stricter shape parameter values than the ANSYS Workbench, which only needed to support the

solid and shell elements for the aforementioned analyses. One particular shape metric predicted whether

the quality of the element would affect the numerical solution time and again. This metric was the calculation

of the Jacobian ratio at the integration points of the element. At a certain level of the Jacobian ratio, we
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determined that the element solution would degrade and give results that would produce an unacceptable

result. While many other shape metrics are used for the generation of the mesh in the ANSYS Workbench,

the Jacobian ratio is the primary metric used to determine the acceptability of the mesh.

When elements are imported into the ANSYS environment, the shape checking command is turned off. This

is done for two reasons:

1. The elements have already undergone extensive shape checking in the Workbench product.

2. As stated previously, the ANSYS environment requires different and much more conservative criteria

for a few element shapes and a few idealizations. However, in the vast majority of cases the metrics

used in the ANSYS Workbench are valid.

The major difference is that the Mechanical APDL application requires that the Jacobian ratio be valid at the

corner nodes of the elements. The Aggressive Mechanical setting of the Shape Checking control will check

the Jacobian ratios at the nodes.

The ANSYS Workbench's quality acceptance plan includes solving hundreds of problems where the numer-

ical solution is known. The solution produced by the ANSYS Workbench is compared to the analytical or

test solution of the model. Besides these engineering tests, the meshing process is tested against over a

thousand user models. These models are set up to seek out errors related to element distortion.

We feel that the current ANSYS Workbench shape metric will produce results that are minimally affected by

errors due to element distortions for linear static, modal, and transient analysis. It is suggested that the

Shape Checking control's Aggressive Mechanical setting be used if the mesh is intended for large deform-

ation or material nonlinear analysis inside the ANSYS environment.
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Mesh Controls Overview

When in the Mechanical application, your part or multibody part is automatically meshed at solve time. The

default element size is determined based on the size of the bounding box, which is the smallest box that

the part or assembly will fit in (for details, see the description of Initial Size Seed), as well as the proximity

of other topologies, body curvature, and the complexity of the feature. If necessary, the fineness of the mesh

is adjusted up to four times (eight times for an assembly) to achieve a successful mesh using the assembly's

bounding box first, then the part's bounding box in the second pass.

You can also create the mesh before solving. To do this, select Mesh from the Tree Outline and right-click

your mouse. From the context menu, choose Generate Mesh. You should keep in mind, that if you create

a mesh using the Patch Independent mesher, then change boundary conditions, the meshing will need to

be redone and the time spent in meshing will be wasted.

In addition, mesh controls are available to assist you in fine tuning the mesh to your analysis. These controls

are described in the sections that follow.

Mesh control overview topics include:

Global and Local Mesh Controls

Understanding the Influence of the Advanced Size Function

Global and Local Mesh Controls

If you want more control over the mesh, you can get it by using mesh control tools. Both global mesh

controls and local mesh controls are available. Global mesh controls are located in the Details View when

the Mesh object is selected in the Tree Outline. To access the local mesh control tools, highlight the Mesh

object, then either click the right mouse button and choose Insert> {<choose a mesh control tool>}, or

choose a mesh control from the Mesh Control context toolbar.

In general, in cases where a numeric value can be specified for an option but a value of 0 would not make

sense within the context of the option, specifying 0 resets the option to its default. For example, the Curvature

Normal Angle option accepts a value from 0 to 180, but since 0 does not make sense within its context,

specifying 0 resets Curvature Normal Angle to its default. On the other hand, setting Number of Retries

to -1 resets the option to its default because 0 is a valid value for Number of Retries.

Understanding the Influence of the Advanced Size Function

An important aspect of meshing in Workbench is the size function. The size function that the mesher uses

is determined by the setting of the Advanced Size Function feature. The Advanced Size Function feature

and the mesh method being used (see Use Advanced Size Function), which is available as a global mesh

control in the Sizing group, provides greater control over how the mesh size is distributed on a face or

within a body. Turning on the Advanced Size Function provides much more accurate sizing information to

the mesher.
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Meshing with the Advanced Size Function Off

When the Use Advanced Size Function control is off, the mesher uses the value of the element size property

to determine a starting point for the mesh size. The value of the element size property can be automatically

computed by the mesher (Default; refer to the description of the bounding box) or user-defined. When

meshing begins, edges are meshed with this size initially, and then they are refined for curvature and 2D

proximity. Next, mesh based defeaturing and pinch control execution occurs. The final edge mesh is then

passed into a least-squares fit size function, which guides face and volume meshing.

Meshing with the Advanced Size Function On

When the Advanced Size Function is on, the following factors contribute to the final mesh distribution ob-

tained by the mesher:

• The value of the Min Size (p. 64) option

• The value of the Max Face Size (p. 64) option

• The value of the Max Size (p. 65) option

• The value of the Growth Rate (p. 65) option

• The size source, which can be any of the following:

– Edge and face curvature, based on the normal angle variation between adjacent mesh elements in

2D (edge) or 3D (face)

– Edge and face proximity, based on the number of element layers created between a gap between

edges in 2D or between faces in 3D

– Local element sizing on selected edges, faces, or bodies

– Sphere of influence scoped to a selected body or vertex (sphere of influence cannot be scoped to

an edge or face when the Advanced Size Function is on)

– Body of influence scoped to a selected body

– Influence of a swept body

An advanced size function is computed when meshing begins. The mesher examines the size sources and,

based on the smallest size obtained at the location of the sources, the distance to each source, and the

growth rate, the smallest size at each point is selected and stored in a background grid. The mesher uses

the sizes from the background grid to generate a mesh. The background grid is refined automatically to

provide size distribution to the mesher. Default size functions are computed differently depending on

whether a model contains sheets only or contains one or more solids.

Note

• The influences of scoped local element sizing, sphere of influence scoped to a body, body

of influence scoped to a body, and existing meshes are always active when the Use Advanced

Size Function control is on. In contrast, you have explicit control over whether you want to

activate the influences of curvature, proximity, both, or neither (fixed).

• The advanced size function works within parts, but not across parts.

• When the advanced size function is on, the default pinch tolerance is 90% of the value of

Min Size. This differs from the tolerance used by the default mesh based defeaturing; refer

to Automatic Mesh Based Defeaturing (p. 99) for details.
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Overriding Advanced Size Function Minimum and Maximum Sizes

One of the most important values related to the advanced size function is minimum size (Min Size (p. 64)

control). Setting a value for Min Size that is too small may lead to an unnecessarily fine mesh and longer

meshing time. On the other hand, setting a value that is too large may mean that important features are

not captured by the mesh. You should also be concerned about setting a minimum size that is smaller than

the geometry tolerances or defeaturing tolerances as the mesher could refine the mesh smaller than

holes/gaps in the geometry, thereby making it difficult for meshing to be successful.

Although Min Size is set to a certain value, a smaller sized mesh may be obtained locally if:

• A Hard scoped size (on an edge, face, or body) has been assigned that is smaller than Min Size

• A body of influence or sphere of influence has been assigned, and the assigned size is smaller than Min

Size

In the two cases above, the size function will automatically reduce Min Size locally to ensure that the size

transition between the scoped entity and the surrounding mesh follows the prescribed size function Growth

Rate (p. 65).

However, you should also be aware of the following cases, in which the size function will NOT reduce the

Min Size locally:

• A case involving a geometric feature (edge, face) that is smaller than the Min Size (when Pinch is not

activated)

• A case involving a swept mesh in a multibody part, where the boundary of the swept mesh is smaller

than the Min Size due to a reduction of cross-sectional size in the swept region

For the case involving small geometric features, you must either remove the small features or assign scoped

sizes to them to ensure a smooth size transition. For the case involving a swept mesh in a multibody part,

you must add additional sizing controls to ensure a smooth size transition between swept regions where a

cross-sectional reduction results in a mesh size that is smaller than the Min Size.

Similarly, you can scope a Hard size that is larger than the values that are specified by the Advanced Size

Function's Max Face Size (p. 64) and Max Size (p. 65) options, as long as the size function produces a smooth

size transition away from the scoped entity.

Changes to the Details View When the Advanced Size Function Is On

The Details View changes when the Use Advanced Size Function control is on. Additional controls appear

that are dependent on the selected setting. In addition, the Element Size control is no longer exposed and

is replaced by the Min Size,  Max Face Size, and Max Size controls. (Max Size is hidden if there are no

solids in your model.) These controls are used by the Advanced Size Function independent of the Element

Size.

Similar to the Element Size control, the value of the Max Face Size control can be input by the user or

automatically computed by the mesher (Default; refer to the description of the bounding box). Furthermore,

if you specified a value for Element Size before setting the Use Advanced Size Function control to on,

that size value will be carried over to the Max Face Size control field (where you can modify it if desired).

Similarly, the Max Face Size control and Element Size control will share the same Default value.

For information about parameterization of the Element Size and Max Face Size controls, refer to Working

with Meshing Application Parameters (p. 49).
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Controls Exposed When the Advanced Size Function Is On

For information about the individual controls that are exposed in the Details View when Advanced Size

Function is on, see Use Advanced Size Function (p. 59).

Using the Advanced Size Function with Specialized Meshing

Keep the following information in mind when using the Advanced Size Function with specialized meshing:

• There are certain situations in which using the Advanced Size Function is highly recommended. For

example, for models involving 2D inflation or inflation on a swept body, a smoother transition of elements

growing away from the boundary cap is obtained when the Advanced Size Function is on. This is due

to the injection of the boundary cap information into the background grid. (Note that for 2D inflation,

this effect is applicable only to quadrilateral meshes. The Advanced Size Function does not support 2D

inflation for triangular meshes.)

• If you are using the Advanced Size Function with sweeping for a CFD problem and poor quality elements

are generated in the swept mesh, adding a local hard edge sizing control to the swept region is the

recommended approach to prevent the poor quality elements. However in some cases, particularly

those in which proximity is not needed, you can use an alternative approach:

– In the Global mesh sizing controls, set the value of Curvature Normal Angle to 90.

– Using Local mesh sizing controls, scope a body sizing control to the tet body and set the value of

Curvature Normal Angle to 18.

– (Optionally) in the Global mesh sizing controls, set the value of Relevance Center to Medium to

obtain a finer mesh in the swept region.

• In models with swept regions, the Advanced Size Function will affect the mesh gradation in the swept

region. You can override this effect by specifying any Sweep Bias value (including a value of 1), Sweep

Element Size value, or Sweep Num Divs value in the Details View when defining the Sweep method.

Usage Notes for the Advanced Size Function

Keep the following additional information in mind when using the Advanced Size Function:

• When the Advanced Size Function is on, Hard edge size information is injected into the background

grid during the meshing process. Transitions between Hard edges (or any edge to which Bias

Type/Bias Factor has been applied) and adjacent edges and face meshes may be abrupt. Edges with

Hard edge sizing or bias will also override the Max Face Size and Max Size properties.
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Global Mesh Controls

Global mesh controls are located in the Details View when the Mesh object is selected in the Tree Outline.

Global settings are categorized into the following groups and are available through drop-down menus:

Defaults Group

Sizing Group

Inflation Group

CutCellMeshing Group

Advanced Group

Defeaturing Group

Statistics Group

Defaults Group

The Defaults group allows you to control these options:

Physics Preference

Solver Preference

Relevance

Physics Preference

The Physics Preference option allows you to establish how Workbench will perform meshing based on the

physics of the analysis type that you specify. Available options are: Mechanical, Electromagnetic, CFD, and

Explicit. The value of the Physics Preference option sets the default for various meshing controls, as detailed

in the following table.

Note

• When Physics Preference is CFD, Solver Preference is Fluent, and the CutCell mesh

method is also activated, some defaults will differ from those that appear in the table. Refer

to CutCell Meshing (p. 228) for details.

• The solver options for the Mechanical Physics Preference appear within the Mechanical

application only, and only under certain circumstances. See Solver Preference (p. 59) for more

information.

• Refer to the Meshing Overview (p. 1) section for further details about physics based meshing.
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Solver Preference

Choosing CFD as your Physics Preference causes a Solver Preference option to appear in the Details View

of the Mesh folder. The value of Solver Preference can be CFX, Fluent, or POLYFLOW. Based on the value,

the Meshing application sets certain defaults that will result in a mesh that is more favorable to the CFX,

Fluent, or POLYFLOW solver, respectively. Inflation controls with defaults that are affected by the Solver

Preference setting include:

• Aspect Ratio (Base/Height)

• Collision Avoidance

• Transition Ratio

Within the Mechanical application only, choosing Mechanical as your Physics Preference also causes a

Solver Preference option to appear, providing the analysis system is a Transient Structural or Rigid Dynamics

system during the initial geometry attach. In such cases, Solver Preference can be set to either Mechanical

APDL or Rigid Body Dynamics. Controls with defaults that are affected by the Solver Preference setting

include:

• Element Midside Nodes

Other differences (such as what happens when you insert a Method control) are dependent on the behavior

of the geometry bodies and the Rigid Body Behavior setting. See Rigid Body Meshing (p. 251) for more in-

formation.

Refer to Physics Preference (p. 57) for more information about defaults that are set based on Physics Prefer-

ence and Solver Preference.

Relevance

The Relevance option allows you to control the fineness of the mesh for the entire model.

To indicate a preference toward high speed (-100) or high accuracy (+100) solutions, use the slider located

in the Details View next to the header details, Relevance. To see the slider, click the Relevance value. This

number is used in the report to document the relevance setting. The finer the mesh, the more accurate the

result. A coarse mesh is less accurate. Keep in mind, however, a finer mesh uses more elements, more time,

and ultimately, more system resources.

Sizing Group

The Sizing group allows you to control these options:

Use Advanced Size Function

Relevance Center

Element Size

Initial Size Seed

Smoothing

Transition

Span Angle Center

Minimum Edge Length

Use Advanced Size Function

The Use Advanced Size Function option provides greater control over sizing functions. Advanced size

functions control the following properties:
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• Angles between normals for adjacent mesh elements (curvature-type size functions)

• Number of mesh elements employed in the gaps between two geometric entities (proximity-type size

function)

• Gradation between minimum and maximum sizes based on a specified growth rate (all size functions)

Options for Use Advanced Size Function are Off, On: Proximity and Curvature, On: Proximity, On:

Curvature and On: Fixed. The default is Off, unless Physics Preference (p. 57) is set to CFD, in which case

the default is On: Curvature. The option you choose determines which refinement mechanisms are activated

in the Advanced Size Function, as described in the following sections.

Controls that are common to all types of advanced size function include Min Size, Max Face Size, Max Size,

and Growth Rate. The Min Size and Max Size specifications represent, respectively, the global minimum

and global maximum allowable element size. The Max Face Size specification represents the global maximum

allowable size of the elements created by the free surface meshers of the supported methods. The Growth

Rate represents the increase in element edge length with each succeeding layer of elements from the edge

or face. For example, a growth rate of 1.2 results in a 20% increase in element edge length with each suc-

ceeding layer of elements.

Advanced Size Function options are applicable to the following mesh methods:

Volume Meshing:

• General Sweep (Surface mesh only)

• Thin Sweep (Surface mesh only)

• Hex Dominant (Surface mesh only)

• Patch Conforming Tetrahedron

• Patch Independent Tetrahedron

• CutCell

Note

• The Advanced Size Function controls are passed to the Patch Independent Tetrahedron

method. That is, the Patch Independent Tetrahedron method does not use the same Advanced

Size Function algorithms; rather, this method interprets the controls and uses internal al-

gorithms to respect the user settings.

• The General Sweep, Thin Sweep, and Hex Dominant mesh methods use the Advanced Size

Function in the creation of the surface mesh, but the volume mesh does not use them.

Surface Meshing:

• Quad Dominant

• All Triangles

Note

For an overview of how using the Advanced Size Function influences mesh distribution, refer to

Understanding the Influence of the Advanced Size Function (p. 53).

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.60

Global Mesh Controls



Advanced Size Function topics include:

Curvature Size Function

Proximity Size Function

Fixed Size Function

Specifying Size Function Options

Curvature Size Function

The curvature size function examines curvature on edges and faces and computes element sizes on these

entities such that the size will not violate the maximum size or the curvature normal angle, which are either

automatically computed by the mesher or defined by the user.

The curvature size function is defined by the following properties:

• Curvature Normal Angle

• Min Size

• Max Face Size

• Max Size

• Growth Rate

The Curvature Normal Angle is the maximum allowable angle that one element edge is allowed to span.

The other controls are common to all types of advanced size functions.

For information about valid ranges and defaults for the size function controls discussed in this section, see

Specifying Size Function Options (p. 62).

Proximity Size Function

The proximity size function allows you to specify the minimum number of element layers created in regions

that constitute “gaps” in the model. For the purposes of specifying a proximity size function, a “gap” is

defined in one of two ways:

• The internal volumetric region between two faces

• The area between two opposing boundary edges of a face

The proximity size function is defined by the following properties:

• Proximity Accuracy

• Num Cells Across Gap

• Proximity Size Function Sources (CutCell mesh method only)

• Min Size

• Max Face Size

• Max Size

• Growth Rate

Proximity Accuracy controls the accuracy level of proximity size function calculations that are performed

between pairs of facets. The Num Cells Across Gap is the number of layers of elements to be generated in

the gaps. The other controls are common to all types of advanced size functions.

61
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Use Advanced Size Function



Note

The proximity size function does not recognize the proximity between certain entities in cases

involving voids in a model. For example, the proximity between a vertex and an edge on a face

in 2D (below left) is ignored if the triangle is a void in the rectangle. Similarly, the proximity

between a vertex or edge and a face in 3D (below right) is ignored if the prism and the block are

voids in a larger domain. The two-headed arrows in the figure indicate the areas where proximity

is ignored. (If these bodies were grouped into multibody parts, the proximity between the entities

would be respected.)

Figure: Proximity Size Function Limitation

For information about valid ranges and defaults for the size function controls discussed in this section, see

Specifying Size Function Options (p. 62).

Fixed Size Function

The fixed size function does not refine the mesh based on curvature or proximity. Rather, you specify min-

imum and maximum sizes and gradation is provided between sizes based on a specified growth rate.

The fixed size function is defined by the following properties:

• Min Size

• Max Face Size

• Max Size

• Growth Rate

All of these controls are common to all types of advanced size functions.

With the fixed size function, you must use size controls to control mesh sizes locally, as opposed to the

curvature and proximity size functions, which refine the sizes locally based on curvature and proximity of

features in the geometry.

Specifying Size Function Options

The value of the Use Advanced Size Function control (Off, On: Proximity and Curvature, On: Proximity,

On: Curvature, or On: Fixed) determines which size function options are available in the Details View. The
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default is Off, unless Physics Preference (p. 57) is set to CFD, in which case the default is On: Curvature. The

following options are available:

Curvature Normal Angle

Proximity Accuracy

Num Cells Across Gap

Proximity Size Function Sources

Min Size

Max Face Size

Max Size

Growth Rate

Curvature Normal Angle

Curvature Normal Angle is the maximum allowable angle that one element edge is allowed to span.

Available only when Use Advanced Size Function is set to either On: Proximity and Curvature or On:

Curvature. You can specify a value from 0 to 180 degrees or accept the default. (A value of 0 resets the

option to its default.) The default is calculated based on the values of the Relevance (p. 59) and Span Angle

Center (p. 67) options.

Proximity Accuracy

Proximity Accuracy allows you to control the accuracy level of proximity size function calculations that are

performed between pairs of facets. For each pair, the proximity algorithm begins with a base facet from

which it determines a search range. The search range is determined by calculating Max Face Size (p. 64) *

Num Cells Across Gap (p. 63) * Proximity Accuracy. The logic behind the search algorithm is that proximity

does not need to be detected beyond Max Face Size (p. 64) * Num Cells Across Gap (p. 63) since elements

with sizes of Max Face Size will be used in such regions. The Proximity Accuracy value acts as a controller.

The Proximity Accuracy control is available only when Use Advanced Size Function is set to either On:

Proximity and Curvature or On: Proximity. You can specify a value from 0 (faster, less accurate) to 1 (slower,

more accurate). The default is 0.5.

Num Cells Across Gap

Num Cells Across Gap is the minimum number of layers of elements to be generated in the gaps. Available

only when Use Advanced Size Function is set to either On: Proximity and Curvature or On: Proximity.

You can specify a value from 1 to 100 or accept the default. The default is calculated based on the value of

the Relevance (p. 59) option. If Relevance is 0, the default of Num Cells Across Gap is 3.

Keep the following information in mind:

• The value of Num Cells Across Gap is an estimate; it may not be exactly satisfied in every gap. When

using Mapped Face Meshing or sweeping, interval assignment may change the number of divisions

(i.e., elements or cells) in a gap.

• The value of Num Cells Across Gap is approximate for CutCell meshing. For example, if you specify 3

cells per gap on a narrow face, the final mesh may contain anything between 2-4 cells across the gap,

depending on the orientation in relation to the global X, Y, Z axis.

• In cases involving Patch Conforming tetra meshing and Swept meshing, the proximity size function

drives the surface mesh size distribution as follows. The value of Num Cells Across Gap is applicable

to both 3D proximity (i.e., the number of 3D elements/cells between two faces in a body) and 2D

proximity (i.e., the number of 2D elements/cells between two edges on a face), and the global Growth

Rate value is automatically taken into account in the gap. However, the 3D proximity size function affects

only the surface mesh in the gap, and assumes the volume mesh will use the global settings. Hence, if
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you define local mesh sizing on a body and specify local Element Size or local Growth Rate settings

that differ drastically from the global Advanced Size Function settings (or if inflation is specified), the

final number of cells across a 3D gap may deviate from the specified Num Cells Across Gap value.

• When Method is set to Automatic, the proximity calculation in swept bodies may result in an under-

refined mesh. You can use inflation layers or a scoped fixed size at such locations to produce a sufficient

number of elements/cells.

Proximity Size Function Sources

Proximity Size Function Sources determines whether regions of proximity between faces and/or edges

are considered when proximity size function calculations are performed. Available only when CutCell

meshing is activated and Use Advanced Size Function is set to either On: Proximity and Curvature or

On: Proximity. You can specify Faces and Edges, Faces, or Edges:

• Faces and Edges - This is the default. Considers face-face and edge-edge proximity. Face-edge proximity

is not considered.

• Faces - Considers face-face proximity between faces. Face-edge and edge-edge proximity are not con-

sidered (i.e., the trailing edges of wings will not be captured with this setting).

• Edges - Considers edge-edge proximity including edges across voids in a model. Face-face and face-

edge proximity are not considered.

In cases involving face-face proximity, the face normal orientation is ignored during the proximity calculation.

It is important to resolve all edges as much as possible for better feature capturing and for minimizing the

occurrence of non-manifold nodes. For this reason, it is recommended that you specify a setting of either

Faces and Edges or Edges. For many models, the Edges setting may be sufficient to resolve all proximity

situations. For large complex models, using either the Faces and Edges or Faces setting may result in longer

computation time.

Min Size

Min Size is the minimum size that the size function will return to the mesher. Some element sizes may be

smaller than this based on local feature sizes or other geometric anomalies. Available when Use Advanced

Size Function is on. Specify a value greater than 0 or accept the default.

Note

• For information about overriding Advanced Size Function sizes, refer to Overriding Advanced

Size Function Minimum and Maximum Sizes (p. 55).

• For information about the relationship between the Element Size control and the Min Size,

Max Face Size, and Max Size controls, refer to Changes to the Details View When the Advanced

Size Function Is On (p. 55).

Max Face Size

Max Face Size is the maximum size that the size function will return to the surface mesher. Element faces

may be larger than this size based on hard edge sizes or floating point arithmetic. Available when Use Ad-

vanced Size Function is on. Specify a value greater than 0 or accept the default. To determine the default,

an initial Max Face Size value is calculated and then scaled based on the value of the Relevance (p. 59)

option. If there are sheets in your model and your Physics Preference (p. 57) is set to Mechanical or Explicit,

an algorithm based on surface area is used to calculate the initial Max Face Size value. Otherwise, the initial
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Max Face Size value is calculated based on the value of the diagonal of the bounding box specified by the

Initial Size Seed (p. 66) control (applicable to Full Assembly and Active Assembly options only).

Note

• For information about overriding Advanced Size Function sizes, refer to Overriding Advanced

Size Function Minimum and Maximum Sizes (p. 55).

• If you parameterize the Element Size or Max Face Size control when toggling the Advanced

Size Function on and off, the parameterization of one control will have no effect on the

other. However, the value of one control will be copied to the other if it is not the default.

For more information about the relationship between the Element Size control and the Min

Size, Max Face Size, and Max Size controls, refer to Changes to the Details View When the

Advanced Size Function Is On (p. 55).

• Max Face Size is unavailable for CutCell meshing.

Max Size

Max Size is the maximum size that the size function will return to the mesher. Available when Use Advanced

Size Function is on. Specify a value greater than 0 or accept the default.

Note

• The Max Size option is hidden if there are no solids in your model.

• For information about overriding Advanced Size Function sizes, refer to Overriding Advanced

Size Function Minimum and Maximum Sizes (p. 55).

• For information about the relationship between the Element Size control and the Min Size,

Max Face Size, and Max Size controls, refer to Changes to the Details View When the Advanced

Size Function Is On (p. 55).

Growth Rate

Growth Rate represents the increase in element edge length with each succeeding layer of elements. For

example, a growth rate of 1.2 results in a 20% increase in element edge length with each succeeding layer

of elements. Available when Use Advanced Size Function is on. Specify a value from 1 to 5 or accept the

default. The default is calculated based on the values of the Relevance (p. 59) and Transition (p. 67) options.

Note

For sheet models, the Details View does not display the default value of Growth Rate.

Relevance Center

Relevance Center sets the gauge of the Relevance slider control in the Default group. Options are Coarse,

Medium, and Fine. The default value can be set automatically according to the Physics Preference setting

as described above under the Default Group.
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Element Size

Element Size allows you to specify the element size used for the entire model. This size will be used for all

edge, face, and body meshing. This option does not appear when Use Advanced Size Function (p. 59) is on.

Note

If you parameterize the Element Size or Max Face Size control when toggling the Advanced

Size Function on and off, the parameterization of one control will have no effect on the other.

However, the value of one control will be copied to the other if it is not the default. For more

information about the relationship between the Element Size control and the Min Size, Max

Face Size, and Max Size controls, refer to Changes to the Details View When the Advanced Size

Function Is On (p. 55).

Initial Size Seed

Initial Size Seed allows you to control the initial seeding of the mesh size for each part.

• Active Assembly (default) bases the initial seeding on the diagonal of the bounding box that encloses

only parts that are unsuppressed (“active” parts). With this choice, the mesh could change as you suppress

and unsuppress parts because the bounding box grows and shrinks.

• Full Assembly bases the initial seeding on the diagonal of the bounding box that encloses all assembly

parts regardless of the number of suppressed parts. As a result, the mesh never changes due to part

suppression.

• Part bases the initial seeding on the diagonal of the bounding box that encloses each particular indi-

vidual part as it is meshed. The mesh never changes due to part suppression. This option typically leads

to a finer mesh and is recommended for situations where the fineness of an individual part mesh is

important relative to the overall size of the part in the assembly. This option is not valid when Use Ad-

vanced Size Function (p. 59) is on.

Note

For information on how suppressing and unsuppressing bodies can affect a mesh, refer to Gener-

ating Mesh (p. 270).

Smoothing

Smoothing attempts to improve element quality by moving locations of nodes with respect to surrounding

nodes and elements. The Low, Medium, or High option controls the number of smoothing iterations along

with the threshold metric where the mesher will start smoothing.

Note

In cases in which Smoothing is set to High and CutCell meshing is being used, additional

smoothing of inflation layers occurs. This may slow down the prism generation process. Refer to

The CutCell Meshing Workflow (p. 231) for additional details on Smoothing settings and their effects

on CutCell meshing.
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Transition

Transition affects the rate at which adjacent elements will grow. Slow produces smooth transitions while

Fast produces more abrupt transitions.

Note

When Use Advanced Size Function (p. 59) is on, the Transition option is hidden for sheet models.

For assemblies containing both sheets and solids, the Transition option appears but its value is

ignored for the sheet geometry.

Span Angle Center

Span Angle Center sets the goal for curvature based refinement. The mesh will subdivide in curved regions

until the individual elements span this angle. The following choices are available:

• Coarse - 91
o
 to 60

o

• Medium - 75
o
 to 24

o

• Fine - 36
o
 to 12

o

Minimum Edge Length

Minimum Edge Length provides a read-only indication of the smallest edge length in the model.

Inflation Group

Inflation is useful for CFD boundary layer resolution, electromagnetic air gap resolution or resolving high

stress concentrations for structures. Inflation is supported for the following mesh methods:

Volume Meshing:

• Patch Conforming

• Patch Independent

• Sweep

Note

Inflation is supported for the sweep mesh method only when the Src/Trg Selection option

is set to either Manual Source or Manual Source and Target.

• MultiZone

• CutCell

Surface Meshing:

• Quad Dominant

• All Triangles
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Figure: Inflation into Volume Mesh Methods (p. 68) illustrates inflation into the patch conforming, patch inde-

pendent, sweep, and MultiZone mesh methods respectively.

Figure: Inflation into Volume Mesh Methods

Defining Global Inflation Controls

The Inflation group of global mesh controls appears in the Details View when the Mesh object is selected

in the Tree Outline. The options in the Inflation group provide global control over all inflation boundaries.

In most cases, the controls in the Inflation group apply to both 3D and 2D inflation. Additional information

that is specific to 2D inflation is noted where applicable.

Basic options include:

Use Automatic Inflation

Inflation Option

Transition Ratio

Maximum Layers

Growth Rate

Number of Layers

Maximum Thickness

First Layer Height

First Aspect Ratio

Aspect Ratio (Base/Height)

Inflation Algorithm

View Advanced Options

Note

Values that you set here will be populated to the local (scoped) inflation mesh controls. If you

subsequently make changes to the local inflation settings, the local settings will override the

global inflation control values that you set here.
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Defining Local Inflation Controls

Alternatively, you can use local inflation mesh controls to apply inflation to specific boundaries. The settings

of the local inflation controls will override global inflation control settings. For details, refer to Inflation

Control (p. 185).

Inflation and Mesh Method Controls

For steps to follow to assign inflation depending on the selected mesh method, refer to Inflation Con-

trols (p. 244). For general information on applying inflation controls in combination with the various mesh

method controls, refer to Mesh Control Interaction Tables (p. 261).

Use Automatic Inflation

You can set the Use Automatic Inflation control so that inflation boundaries are selected automatically

depending on whether or not they are members of Named Selections groups. The following options are

available:

None

Program Controlled

All Faces in Chosen Named Selection

Keep the following information in mind when using inflation:

• Automatic inflation is supported only for 3D inflation on volume models. It is not supported for 2D in-

flation on shell models. You cannot select Program Controlled (p. 69) or All Faces in Chosen Named Selec-

tion (p. 70) for the Use Automatic Inflation option to mesh a 2D model. To apply 2D inflation on a

shell model, use local inflation mesh controls instead.

• In the following scenarios, using inflation results in automatic suppression of the refinement control:

– When automatic inflation (either Program Controlled (p. 69) or All Faces in Chosen Named Selec-

tion (p. 70)) is used with refinement in the same model

– When local inflation is used with refinement in the same body or in the same part

• Using a mixture of local inflation and automatic inflation within the same part is not recommended.

When you mix local and automatic inflation, the local inflation settings will be used for the bodies to

which they are applied. The automatic inflation settings will create inflation only on those bodies that

do not have local inflation applied to them. The automatic inflation settings will ignore all bodies and

all attached faces to which local inflation settings are applied.

None

If you select None, inflation boundaries are not selected globally. Instead, the inflation boundaries that you

identify using the local inflation mesh controls are used. This is the default.

Program Controlled

If you select Program Controlled, all faces in the model are selected to be inflation boundaries, except for

the following:

• Faces in Named Selection(s)
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Note

By default, faces in Named Selections are not selected to be inflation boundaries when Use

Automatic Inflation is set to Program Controlled. However, you can select specific Named

Selections to be included in Program Controlled inflation. For details, see the discussion of

Named Selections and Program Controlled inflation in the Mechanical help.

• Faces in Contact region(s)

• Faces in Symmetry definition

• Faces that belong to a part/body that has a mesh method defined on it that does not support 3D inflation

definitions (i.e., mesh method is set to Sweep or Hex Dominant)

• Faces in sheet bodies

• Faces on bodies that have manual inflation controls

With Program Controlled automatic inflation, the mesher inflates in the following manner:

• For single body parts, the face will always inflate into the body.

• For multibody parts with a mix of fluid and solid parts:

– Faces on fluid region will inflate into fluid region; solid region will not be inflated.

– Faces on parts of the same material will not be inflated.

• For parts of the same material, shared faces will not be inflated.

The manner in which inflation is applied depends on values that you enter for the following options:

• Inflation Option (p. 71)

• Inflation Algorithm (p. 74)

• View Advanced Options (p. 77)

Note

• If you select Program Controlled as the value for the Use Automatic Inflation (p. 69) control,

you can view the surfaces that have been selected for inflation by using the Show Program

Controlled Inflation Surfaces feature.

• Program Controlled inflation is only supported for 3D models.

All Faces in Chosen Named Selection

If you select All Faces in Chosen Named Selection, a Named Selection field is displayed to let you scope

inflation to the Named Selection. The manner in which inflation is applied to the Named Selections group

depends on values that you enter for the following options:

• Inflation Option (p. 71)

• Inflation Algorithm (p. 74)

• View Advanced Options (p. 77)
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Inflation Option

The Inflation Option settings determine the heights of the inflation layers. The following options are available:

• Smooth Transition - This is the default. The Smooth Transition option uses the local tetrahedral element

size to compute each local initial height and total height so that the rate of volume change is smooth.

Each triangle that is being inflated will have an initial height that is computed with respect to its area,

averaged at the nodes. This means that for a uniform mesh, the initial heights will be roughly the same,

while for a varying mesh, the initial heights will vary.

Increasing the value of the Growth Rate control reduces the total height of the inflation layer. The total

height approaches an asymptotic value with respect to the number of inflation layers.

For details about the additional controls that appear when Smooth Transition is selected, refer to the

descriptions of the Transition Ratio (p. 72), Maximum Layers (p. 73), and Growth Rate (p. 73) controls.

Note

The Smooth Transition option works differently for the MultiZone mesh method. See Mul-

tiZone Support for Inflation (p. 213) for details.

• Total Thickness - The Total Thickness option creates constant inflation layers using the values of the

Number of Layers and Growth Rate controls to obtain a total thickness as defined by the value of the

Maximum Thickness control. Unlike inflation with the Smooth Transition option, with the Total

Thickness option the thickness of the first inflation layer and each following layer is constant.

For details about the additional controls that appear when Total Thickness is selected, refer to the

descriptions of the Number of Layers (p. 73), Growth Rate (p. 73), and Maximum Thickness (p. 73) controls.

• First Layer Thickness - The First Layer Thickness option creates constant inflation layers using the

values of the First Layer Height, Maximum Layers, and Growth Rate controls to generate the inflation

mesh. Unlike inflation with the Smooth Transition option, with the First Layer Thickness option the

thickness of the first inflation layer and each following layer is constant.

For details about the additional controls that appear when First Layer Thickness is selected, refer to

the descriptions of the First Layer Height (p. 74), Maximum Layers (p. 73), and Growth Rate (p. 73) controls.

• First Aspect Ratio - The First Aspect Ratio option creates inflation layers using the values of the First

Aspect Ratio, Maximum Layers, and Growth Rate controls to generate the inflation mesh.

Post inflation is not supported when Inflation Option is First Aspect Ratio.

For details about the additional controls that appear when First Aspect Ratio is selected, refer to the

descriptions of the First Aspect Ratio (p. 74), Maximum Layers (p. 73), and Growth Rate (p. 73) controls.

• Last Aspect Ratio - The Last Aspect Ratio option creates inflation layers using the values of the First

Layer Height, Maximum Layers, and Aspect Ratio (Base/Height) controls to generate the inflation

mesh.

Figure: Last Aspect Ratio Option (p. 72) illustrates this option. Using the First Layer Height control, you

can specify the height of the first inflation layer. Local base mesh size is used to find the offset height

for the last layer. For example, if you specify 20 for Aspect Ratio (Base/Height), the offset height of

the last layer will be 0.2 times the local base mesh size. Local growth rate is used to calculate the other

intermediate offset heights exponentially.
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Figure: Last Aspect Ratio Option

Post inflation is not supported when Inflation Option is Last Aspect Ratio.

For details about the additional controls that appear when Last Aspect Ratio is selected, refer to the

descriptions of the First Layer Height (p. 74), Maximum Layers (p. 73), and Aspect Ratio (Base/Height) (p. 74)

controls.

Transition Ratio

In basic terms, the Transition Ratio control determines the rate at which adjacent elements grow. It is the

volume-based size change between the last layer of elements in the inflation layer and the first elements

in the tetrahedron region (or hexahedron region for CutCell meshing). The value of Transition Ratio is an

ideal value and should produce accurate size change for inflation from a planar boundary. However, be

aware that areas of strong curvature will introduce an inaccuracy into the size change. If proximity detection

is activated, elements in proximity and elements with prism aspect ratios meeting the value defined by the

Maximum Height over Base (p. 81) control will ignore this transition ratio.

The Transition Ratio control is applicable only when Inflation Option (p. 71) is Smooth Transition. Valid

values for Transition Ratio are from 0 to 1. When Physics Preference (p. 57) is set to CFD and Solver Prefer-

ence (p. 59) is set to CFX, the default for Transition Ratio is 0.77. For all other physics preferences, including

CFD when Solver Preference is set to either Fluent or POLYFLOW, the default is 0.272.

The reason for this difference is because the Fluent and POLYFLOW solvers use a cell-centered scheme for

transition ratio. In a cell-centered scheme, the fluid flow variables are allocated at the center of the compu-

tational cell, and the mesh-element is the same as the solver-element. In contrast, the CFX solver uses a

vertex-centered scheme. In a vertex-centered scheme, the fluid flow variables are stored at the cell vertex,

and the solver-element is a “dual” of the mesh-element. This means that the vertex of the mesh-element is

the center of the solver-element. The difference between the two schemes is illustrated in the figure below.
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Maximum Layers

The Maximum Layers control determines the maximum number of inflation layers to be created in the

mesh. Valid values are from 1 to 1000. The default is 5 for solid bodies and 2 for surface bodies.

The Maximum Layers control is applicable only when Inflation Option (p. 71) is Smooth Transition, First

Layer Thickness, First Aspect Ratio, or Last Aspect Ratio.

Growth Rate

The Growth Rate control determines the relative thickness of adjacent inflation layers. As you move away

from the face to which the inflation control is applied, each successive layer is approximately one growth

rate factor thicker than the previous one. Valid values are from 0.1 to 5.0. The default is 1.2.

The Growth Rate control is applicable only when Inflation Option (p. 71) is Smooth Transition, First Layer

Thickness, Total Thickness, or First Aspect Ratio.

Number of Layers

The Number of Layers control determines the actual number of inflation layers in the mesh, except in places

where layers are removed locally for reasons of improving mesh quality (for example, in areas where inflation

layers would otherwise collide with each other). Valid values are from 1 to 1000. The default is 5 for solid

bodies and 2 for surface bodies.

The Number of Layers control is applicable only when Inflation Option (p. 71) is Total Thickness.

Maximum Thickness

The Maximum Thickness control determines the desired thickness of the inflation layer. You must enter a

value for this control, and it must be greater than 0.

The Maximum Thickness control is applicable only when Inflation Option (p. 71) is Total Thickness.
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First Layer Height

The First Layer Height control determines the height of the first inflation layer. This first inflation layer

consists of a single layer of prism elements that is formed against the faces of the inflation boundary. You

must enter a value for this control, and it must be greater than 0.

The First Layer Height control is applicable only when Inflation Option (p. 71) is First Layer Thickness or

Last Aspect Ratio.

First Aspect Ratio

By choosing the First Aspect Ratio option for the Inflation Option control, you can control the heights of

the inflation layers by defining the aspect ratio of the inflations that are extruded from the inflation base.

The aspect ratio is defined as the ratio of the local inflation base size to the inflation layer height. Use the

First Aspect Ratio control to specify the first aspect ratio to be used. Enter a value greater than 0. The default

is 5.

The First Aspect Ratio control is applicable only when Inflation Option (p. 71) is First Aspect Ratio.

Aspect Ratio (Base/Height)

By choosing the Last Aspect Ratio option for the Inflation Option control, you can control the heights of

the inflation layers by defining the aspect ratio of the inflations that are extruded from the inflation base.

The aspect ratio is defined as the ratio of the local inflation base size to the inflation layer height. Use the

Aspect Ratio (Base/Height) control to specify the aspect ratio to be used. Enter a value between 0.5 and

20. The default is 1.5 when Solver Preference (p. 59) is CFX, and 3 when Solver Preference (p. 59) is Fluent

or POLYFLOW.

The Aspect Ratio (Base/Height) control is applicable only when Inflation Option (p. 71) is Last Aspect Ratio.

Inflation Algorithm

The Inflation Algorithm control determines which inflation algorithm will be used. Options for Inflation

Algorithm are Pre and Post and are dependent upon the selected mesh method.

The following table shows which inflation algorithms are applicable to each mesh method. For information

on how the inflation algorithm is handled when a combination of mesh methods is being used, see Interactions

Between Mesh Methods (p. 261).

Note

The Inflation Algorithm control is hidden when CutCell meshing is active. Refer to The CutCell

Meshing Workflow (p. 231) for details.

Inflation AlgorithmMesh Method

PostPre

Yes, 3DYes, 3DPatch Conforming

Tetrahedrons

Yes, 3DN/APatch Independent

Tetrahedrons

N/AN/AHex Dominant
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Inflation AlgorithmMesh Method

PostPre

N/AYes, 2D. Occurs in the following manner:

1) source face is meshed with triangles, 2)

Sweep

inflation occurs on tri surface mesh, and

3) source is swept. Intervals on source and

target are fixed.

N/AThe value of Inflation Algorithm displays

as Pre but an O-grid-based algorithm

MultiZone

specific to MultiZone is used. As with the

Pre inflation algorithm, the surface mesh

is inflated first and then the rest of the

volume mesh is generated.

N/AYes, 2DQuad Dominant

N/AYes, 2DAll Triangles

Pre

When Pre is selected, the surface mesh will be inflated first, and then the rest of the volume mesh will be

generated. This is the default for all physics types.

Keep the following information in mind:

• Inflation Algorithm must be set to Pre for the Previewing Inflation (p. 274) feature to work.

• When Inflation Option (p. 71) is either First Aspect Ratio or Last Aspect Ratio, Inflation Algorithm is

set to Pre and is read-only.

• Hard points are not supported and may be ignored for 3D Pre inflation.

• Hard edges are not supported and may be ignored for Pre inflation.

• In some cases an additional smoothing attempt will be performed automatically. Refer to Smooth-

ing (p. 66) for details.

• Match controls on faces are supported with Pre inflation, regardless of whether inflation is set to Program

Controlled or has been set through any global or local inflation definition. In contrast, match controls

on edges are not supported with Pre inflation. Match controls (both faces and edges) are not supported

with Post inflation. For all these non-supported cases, ANSYS Workbench automatically suppresses/disables

the Match Control feature.

Pre Inflation and Different Numbers of Layers on Adjacent Faces

The Pre Inflation Algorithm does not support the definition of different numbers of inflation layers on

adjacent faces. For example, Figure: Different Numbers of Layers Are Respected (p. 76) shows a case in which

different numbers of inflation layers have been specified on two faces. Since the faces are not connected,

the different numbers of layers are respected.
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Figure: Different Numbers of Layers Are Respected

Now assume that the Inflation controls shown in Figure: Portion of Project Tree (p. 76) define four inflation

layers for the Inflation control, five inflation layers for the Inflation 2 control, and two inflation layers for

the Inflation 3 control, and that the controls are defined on adjacent faces.

Figure: Portion of Project Tree

In this case, although different numbers of inflation layers were defined, a two-layer (fewest number of layers

defined) inflation mesh is generated as shown in Figure: Different Numbers of Layers Are Not Respected (p. 76).

Figure: Different Numbers of Layers Are Not Respected

Post

When Post is selected, a postprocessing technique that works after the tetrahedral mesh is generated is

used. A benefit of this option is that the tetrahedral mesh does not have to be generated each time the in-

flation options are changed.

Keep the following information in mind:
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• Match controls on faces are supported with Pre inflation, regardless of whether inflation is set to Program

Controlled or has been set through any global or local inflation definition. In contrast, match controls

on edges are not supported with Pre inflation. Match controls (both faces and edges) are not supported

with Post inflation. For all these non-supported cases, ANSYS Workbench automatically suppresses/disables

the Match Control feature.

• Post inflation is not supported when there is a mixture of tetrahedron and non-tetrahedron mesh

methods applied to the bodies in a multibody part. If you want to apply Post inflation to a multibody

part, all bodies in the part must have a tetrahedron mesh method applied to them.

• Post inflation is not supported when Inflation Option (p. 71) is either First Aspect Ratio or Last Aspect

Ratio.

View Advanced Options

The View Advanced Options control determines whether advanced inflation options appear in the Details

View. Choices are No (default) and Yes. When this control is set to Yes, the following options are available:

Collision Avoidance

Maximum Height over Base

Growth Rate Type

Maximum Angle

Fillet Ratio

Use Post Smoothing

Smoothing Iterations

Note

In addition to viewing and/or modifying the advanced inflation options in the Details View, you

can view and/or modify them by using the Options dialog box.

Collision Avoidance

The Collision Avoidance control determines the approach that is to be taken in areas of proximity to avoid

collisions that may occur from marching inflated surface meshes from opposite sides into each other.

For 2D inflation, the Collision Avoidance control detects geometry limitations in faces that would otherwise

cause inflation mesh to overlap or cross face boundaries, or result in a space that is so small that it leads to

bad quality mesh for the remaining region of inflation mesh. When Collision Avoidance is set to Layer

Compression or Stair Stepping, the value of the Gap Factor (p. 81) control, along with the local mesh size,

will determine how much space will be adequate for the remaining region of inflation mesh.
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Note

• The option that you choose for Collision Avoidance is used only in areas of proximity. In

areas of proximity, if the option is set to Layer Compression, layer compression is performed;

if it is set to Stair Stepping, stair stepping is performed; if it is set to None, no collision

checking is performed. However, in all other problematic scenarios (for example, invalid

normals, quality failure, bad surface mesh, and so on), local stair stepping is performed re-

gardless of which option you choose.

• When Collision Avoidance is set to Layer Compression and local stair stepping occurs after

compression, poor quality pyramids may be introduced into the mesh. Because of this pos-

sibility, a warning message will appear whenever stair stepping occurs after compression.

The message will not identify the location of the stair stepping. However, the location of the

stair stepping with added pyramids often coincides with the location of the worst quality

element (specifically, when considering the Skewness metric). For this reason, using the

Meshing application's Mesh Metric feature to locate the worst quality element (based on

Skewness) is also likely to locate the pyramids.

• For CutCell meshing, Collision Avoidance is set to Layer Compression and is read-only.

Refer to the section on CutCell meshing for information unique to CutCell.

The following options are available:

• None - The None option does not check for layer collisions. Selecting this option speeds up inflation

layer computation time; however, it can result in an invalid mesh and mesh failures as a result. For these

reasons, this option is not recommended.

For 2D inflation, if a collision/proximity limitation is detected during layer creation, creation of inflation

layers stops with the previous layer. (Inflation stops completely; contrast with Stair Stepping below.)

• Layer Compression - The Layer Compression option compresses inflation layers in areas of collision.

In these areas, the defined heights and ratios are reduced to ensure the same number of layers

throughout the entire inflation region. Generally, this option is best for avoiding the creation of pyramids

in the mesh. Layer Compression is the default only when the Physics Preference is set to CFD and

the Solver Preference is set to Fluent; otherwise, the default is Stair Stepping.

For 2D inflation, if a collision/proximity limitation is detected during layer creation, inflation heights will

shrink locally. If Fix First Layer (p. 81) is set to Yes, the First Layer Height (p. 74) will not be scaled.

For details about the additional controls that appear when Layer Compression is selected, refer to the

descriptions of the Fix First Layer (p. 81) and Gap Factor (p. 81) controls.

• Stair Stepping - Rather than compressing the prism layers, with Stair Stepping the prism layers are

“stair stepped” in the proximity region to avoid collision and to maintain the gap defined by Gap

Factor (p. 81). The Stair Stepping approach to inflation growth locally reduces inflation layers to avoid

collisions, as well as bad quality elements in sharp or tight corners. The term “stair stepping” refers to

the steps created between one layer and the next. Using this approach, special logic is used to fill the

steps with pyramid and tetrahedron elements for prism steps, or prism, pyramid, and tetrahedron ele-

ments for hex steps. This special logic helps the mesher obtain a high-quality transition to the tetrahedral

mesh. Stair Stepping is the default, unless the Physics Preference is set to CFD and the Solver Pref-

erence is set to Fluent, in which case the default is Layer Compression.

For 2D inflation, if a collision/proximity limitation is detected during layer creation, creation of inflation

layers stops locally. (Contrast with None above.)
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An additional control, for Gap Factor, appears when Stair Stepping is selected.

The figures below illustrate how the Layer Compression and Stair Stepping options differ.

Figure: Layer Compression Option (Full Mesh View)
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Figure: Layer Compression Option (Detail View)

Figure: Stair Stepping Option (Full Mesh View)
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Figure: Stair Stepping Option (Detail View)

Fix First Layer

The Fix First Layer control determines whether the heights or ratios of the first inflation layer will be mod-

ified to avoid collision. Valid values are Yes and No. The default is No. This option will not allow the value

that is set for the First Layer Height (p. 74) control to be changed.

The Fix First Layer control is applicable only when Collision Avoidance (p. 77) is Layer Compression.

Gap Factor

The Gap Factor control allows maintenance of the gap between intersecting prisms. Valid values are from

0 to 2. The default is 0.5. A value of 1 means a gap equal to the ideal tet cell height based on base face

size in proximity to each other is maintained.

The Gap Factor control is applicable only when Collision Avoidance (p. 77) is Layer Compression or Stair

Stepping.

Maximum Height over Base

The Maximum Height over Base control sets the maximum allowable prism aspect ratio (that is, the ratio

of height over base of the base triangle). When the prism aspect ratio reaches this value, the height of the

prisms stops growing. That is, new prisms continue to form, but the heights of the prisms will not increase.

Valid values are from 0.1 to 5. The default is 1.0.
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For 2D inflation, the Maximum Height over Base control helps to maintain a good size ratio. Once the in-

flation height is greater than the local mesh size multiplied by the value of Maximum Height over Base,

the inflation height stops growing. New layers continue to form, but the heights of the inflation layers will

not increase. New layers that form will be equal to the inflation base size multiplied by the value of Maximum

Height over Base.

Growth Rate Type

The Growth Rate Type control determines the height of the inflation layers given the initial height and

height ratio. The following options are available:

• Geometric - This is the default. With this option, the prism height of a particular layer is defined by

h*r
(n-1)

, where h = initial height, r = height ratio, and n = layer number. The total height at layer n is:

h(1–r
n
)/(1–r).

• Exponential - With this option, the prism height of a particular layer is defined by h*e
(n-1)p

, where h =

initial height, p = exponent, and n = layer number.

• Linear - With this option, the prism height of a particular layer is defined by h(1+(n-1)(r-1)), where h =

initial height, r = height ratio, and n = layer number. The total height at layer n is: nh((n-1)(r-1)+2)/2.

Maximum Angle

The Maximum Angle control determines prism layer growth around angles and when prisms will adhere

(project) to adjacent surfaces/walls. If the inflated mesh involves extruding from one surface and not its

neighbor, and the angle between the two surfaces is less than the specified value, the prisms (sides) will

adhere (project) to the adjacent wall. Valid values are from 90 to 180 (degrees). Typically, a value between

120 and 180 is desirable. The default is 140. Refer to the figures below for examples of maximum angle.

For 2D inflation, the Maximum Angle control determines whether an edge that is adjacent to an inflation

edge can be imprinted with inflation mesh. If the angle between the two edges is smaller than the value of

Maximum Angle, the inflation mesh will be imprinted on the adjacent edge. On the other hand, if the angle

between the two edges is larger than the value of Maximum Angle, the inflation mesh will not be imprinted

on the adjacent edge.

In Figure: Maximum Angle = 140 (p. 82), the angle between the planes is 158.2 (21.8) degrees. Since the

maximum angle is less than the angle between the walls, the prism layers are capped with pyramids.

Figure: Maximum Angle = 140

In Figure: Maximum Angle = 180 (p. 83), the maximum angle exceeds the separation angle between the

surfaces, so the prism remains attached to the adjacent surface.
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Figure: Maximum Angle = 180

Fillet Ratio

The Fillet Ratio control determines whether a fillet proportional to the total height of a prism element will

be created when a prism element is generated in the corner zone of a tetrahedral mesh. Creating a fillet

proportional to the total height of the prism makes it possible to control the smoothness of the prism layer.

Valid values are from 0 to 1 (decimal values are allowed). A value of 0 means no fillets. The default is 1.

Refer to the figures below for examples of fillet ratio.

Note

For meshing corners with angles less than 60 degrees, there may not be space for a fillet.

Figure: Fillet Ratio = 0.0

In the figure below, the radius of the inner prism fillet is 0.5 times the height of the total prism thickness.

Figure: Fillet Ratio = 0.5
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Figure: Fillet Ratio = 1.0

Use Post Smoothing

The Use Post Smoothing control determines whether post-inflation smoothing will be performed.

Smoothing attempts to improve element quality by moving the locations of nodes with respect to surrounding

nodes and elements. Valid values are Yes and No. The default is Yes. When this control is set to Yes, the

Smoothing Iterations (p. 84) control appears in the Details View.

Smoothing Iterations

The Smoothing Iterations control determines the number of post-inflation smoothing iterations that will

be performed to improve the mesh. Valid values are from 1 to 20. The default is 5.

The Smoothing Iterations control is applicable only when Use Post Smoothing (p. 84) is Yes.

CutCellMeshing Group

The CutCellMeshing group of global mesh controls appears only when Physics Preference (p. 57) is set to

CFD and Solver Preference (p. 59) is set to Fluent.

The CutCellMeshing group allows you to control these options:

Active

Feature Capture

Tessellation Refinement

Active

The Active control determines whether CutCell meshing will be used and filters user interface components

appropriately. The following options are available:

• No - This is the default. CutCell meshing controls are not exposed.

• Yes - Exposes CutCell meshing controls and hides controls that are not applicable to CutCell. Refer to

CutCell Meshing (p. 228) for details about using the CutCell mesh method.

Feature Capture

The Feature Capture control determines which CAD features are captured for CutCell meshing. The following

options are available:

• Program Controlled - This is the default. A feature angle of 40 degrees is used to determine which

features are captured. If the shared faces on an edge form an angle smaller than (180 - 40) degrees, the

edge is selected for CutCell meshing.
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• Feature Angle - Exposes an additional Feature Angle field, where you can set a value from 0 to 90

degrees instead of using the default of 40. The smaller the angle, the higher the number of features

that are captured. If you specify a value greater than 90, a feature angle of 90 is used. Setting a negative

value resets the feature angle to its default, while setting the value to 0 captures all features.

Tessellation Refinement

The Tessellation Refinement control specifies the value to be used for tessellation (faceting) refinement

for CutCell meshing. The following options are available:

• Program Controlled - This is the default. Sets tessellation refinement to 10% of the value of Min

Size (p. 64). This is the recommended value for most CutCell meshing operations.

• Absolute Tolerance - Exposes an additional Absolute Tolerance field, where you can set a numerical

value for refinement. The recommended range is between 5 and 10% of the value of Min Size (p. 64).

A value on the lower end of the range may work better if you have problems with gaps.

• None - Sets tessellation refinement to the CAD program or DesignModeler application default setting.

To assist you in working with CutCell meshing, you may want to use the Show Missing Tessellations feature

prior to mesh generation.

Advanced Group

The Advanced group allows you to control these options:

Shape Checking

Element Midside Nodes

Straight Sided Elements

Number of Retries

Extra Retries For Assembly

Rigid Body Behavior

Mesh Morphing

The Advanced group of controls is inaccessible when the CutCell mesh method is active.

Shape Checking

The following options are available for shape checking:

• Standard Mechanical - Uses the default ANSYS Workbench shape checking criterion. This criterion has

proven to be effective for linear, modal, stress, and thermal problems. A unitless metric is used comparing

volume to edge
3
 for solid elements and area to edge length

2
 for shell elements. Jacobian ratio is also

used. If the Jacobian ratio is less than 0 or greater than the limit, then the metric is -1.0 and will cause

shape failure. Jacobian ratio is computed at integration points. This is the default when Physics Prefer-

ence is set to Mechanical.

• Aggressive Mechanical - Uses a shape checking criterion based on Jacobian ratio at nodes with a

tighter limit on both Jacobian ratio and ANSYS Workbench metric. This is much more restrictive than

the ANSYS Workbench criterion used in the Standard Mechanical option. This will usually produce

more elements, longer meshing times, and possibly mesh failures. This option is recommended if the

mesh is intended for large deformation or material nonlinear analysis.

• Electromagnetics - Uses a shape checking criterion based on element volume, face warping, and face

angle. This option is recommended for all electromagnetic simulations, and it is the default when

Physics Preference is set to Electromagnetic.
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• CFD - For non-CutCell meshing, uses a shape checking criterion based on element volume. For CutCell

meshing, uses a shape checking criterion based on orthogonal quality. This option is recommended for

all CFD simulations, and it is the default when Physics Preference is set to CFD.

• Explicit - Uses a shape checking criterion based on Jacobian ratio and element volume. This option is

recommended for all explicit dynamics simulations, and it is the default when Physics Preference is

set to Explicit.

• None - Turns off most shape checking. Minimal shape checking will still occur depending on the mesh

method being used so there is no guarantee that a mesh will be returned. The None option is intended

for troubleshooting and should be used with caution as it could lead to solver failures or incorrect

solution results.

For automatic meshing, shape checking ensures a quality mesh based on specific error limits. The following

table presents the shape checking limit criterion for each option. If the results of any test are outside of the

limits shown, the mesh will fail. For example, a Jacobian ratio greater than 40 computed at element nodal

points will cause a mesh failure when using the Aggressive Mechanical option.

ExplicitCFD (Cut-

Cell)

CFD (Non-

CutCell)

Electromag-

netics

Aggressive

Mechanical

Standard Mech-

anical

Criterion

Quality met-

ric not used

Quality

metric not

used

Quality

metric not

used

Quality met-

ric not used

Quality met-

ric not used

Quality metric not

used

Aspect Ra-

tio

< 0Quality

metric not

used

< 0< 10
-30

< 0< 0Element

Volume

Quality met-

ric not used

Quality

metric not

used

Quality

metric not

used

> 150Quality met-

ric not used

Quality metric not

used

Face Angle

Quality met-

ric not used

Quality

metric not

used

Quality

metric not

used

> 0.4Quality met-

ric not used

Quality metric not

used

Face Warp-

ing

> 1000 com-

puted at

Quality

metric not

used

Quality

metric not

used

Quality met-

ric not used

> 40 for

both 3-D

and 2-D;

> 40 for 3-D and

> 10 for 2-D; com-

puted at element

integration points

Jacobian

Ratio

element

nodal

points

computed

at element

nodal

points

Quality met-

ric not used

<=0; warn-

ing mes-

Quality

metric not

used

Quality met-

ric not used

Quality met-

ric not used

Quality metric not

used

Orthogonal

Quality

sage issued

when Ortho-

gonal Qual-

ity <=0.05
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ExplicitCFD (Cut-

Cell)

CFD (Non-

CutCell)

Electromag-

netics

Aggressive

Mechanical

Standard Mech-

anical

Criterion

Quality met-

ric not used

Quality

metric not

used

Quality

metric not

used

Quality met-

ric not used

< 0.85, for

one dimen-

sional ele-

ments

< 0.75, for one

dimensional ele-

ments

< 0.01, for two

dimensional ele-

ments

ANSYS

Workbench

Shape Met-

ric

< 0.02, for

two dimen-

< 10
-4

, for three

dimensional ele-

ments

sional ele-

ments

< 0.2, for

three di-

mensional

elements

Element Midside Nodes

The global Element Midside Nodes option allows you to control whether meshes are to be created with

midside nodes (quadratic elements) or without midside nodes (linear elements). Reducing the number of

midside nodes reduces the number of degrees of freedom. Choices for the global Element Midside Nodes

option include Program Controlled, Dropped, and Kept.

Examples are presented below. The heavy vertical line in each graphic represents the body boundary.

Program Controlled

Program Controlled is the default. For surface bodies and beam models, Program Controlled is identical

to the Dropped option described below. For solid bodies and 2-D models, Program Controlled is identical

to the Kept option described below.

Dropped

The Dropped option removes midside nodes on all elements. Examples shown below are for a solid body.

Kept

The Kept option retains midside nodes on elements created in the part or body. All elements will have

midside nodes.

87
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Kept



Note

• Both linear and quadratic elements are supported for 2–D axisymmetric models. This includes

support for 2–D linear and quadratic inflation layers on axisymmetric parts. You must set

Element Midside Nodes to Dropped to obtain linear elements in such cases.

• Both linear and quadratic elements are supported for 2–D shell and line models. This includes

support for 2–D linear and quadratic inflation layers on shell models. In addition, the Element

Midside Nodes setting is respected by mesh refinement, including models for which adaptivity

refinement is performed.

• When setting the Method control to a scoped body, you can change the setting of the Ele-

ment Midside Nodes option to control whether meshes are to be created on the scoped

body with midside nodes or without midside nodes. You do this by using the Element

Midside Nodes setting under Definition in the Details View. This setting will override the

setting of the global Element Midside Nodes option described here. See Method Controls

and Element Midside Nodes Settings (p. 122) for additional information.

Straight Sided Elements

The Straight Sided Elements option (which is displayed when solids are present in the model or if the

model includes an enclosure from the DesignModeler application), specifies meshing to straight edge elements

when set to Yes. You must set this option to Yes for Electromagnetic simulations.

Number of Retries

The global Number of Retries option specifies the number of times the mesher will try to re-mesh if

meshing fails due to poor mesh quality. The mesher will increase the fineness of the mesh with each retry

in an effort to obtain a good mesh. It is possible that the mesh will contain more elements than you intended.

If this is not acceptable, you should lower the number of retries.

The range for Number of Retries is from 0 to 4. The default is 4 unless the Physics Preference is set to

CFD, in which case the default is 0. If you change the default Number of Retries, subsequent changes made

to the Physics Preference will not change the Number of Retries value.
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Note

• For shell models, if the Advanced Size Function is on, the default values of Min Size (p. 64),

Max Face Size (p. 64), and Defeaturing Tolerance (p. 100) are reduced automatically with each

subsequent retry.

• Retries will not occur if you are using the Patch Independent Tetrahedron or MultiZone mesh

method in combination with any other solid mesh method to mesh bodies contained in the

same part, or if you are using Uniform Quad/Tri or Uniform Quad in combination with any

other surface mesh method to mesh bodies contained in the same part.

• If Number of Retries is set to 0 and a single body in a multibody part fails during direct

meshing, the mesher returns as much of the mesh as possible. Bodies with valid meshes will

have a meshed state while bodies with invalid or partial meshes will have an unmeshed state.

You can display and examine the partially meshed bodies and then apply more mesh controls

to correct any problems you find. If Number of Retries is set to a value greater than 0 and

any body fails to mesh, the mesher returns nothing for the given part. The return of a partial

mesh is applicable to the Quad Dominant, All Triangles, Uniform Quad/Tri, Uniform Quad,

Patch Independent Tetra, and MultiZone methods only. The Patch Conforming Tetra, Sweep

(general or thin), and Hex Dominant methods cannot return partial meshes.

• If you are performing direct meshing and at least one body of a particular part has been

meshed successfully, no additional retries will occur if the mesh of a subsequent body within

that same part fails.

• The Number of Retries option is also available in the Options dialog box, which you can

access by selecting Tools> Options from the main menu. Setting the global Number of

Retries option to -1 reads the value set on the Options dialog box and uses it as the default

number of retries.

Extra Retries For Assembly

The Extra Retries For Assembly option specifies whether the mesher should perform extra retries when

meshing an assembly if meshing would otherwise fail due to poor mesh quality. The default is Yes. These

retries are in addition to the number specified by the Number of Retries option. The mesher will increase

the fineness of the mesh with each additional retry in an effort to obtain a good mesh. If this is not acceptable,

you should set the option to No.

This control is also available in the Options dialog box, which you can access by selecting Tools> Options

from the main menu.

Rigid Body Behavior

The Rigid Body Behavior option determines whether a full mesh is generated for a rigid body, rather than

a surface contact mesh. Rigid Body Behavior is applicable to all body types. Valid values for Rigid Body

Behavior are Dimensionally Reduced (generate surface contact mesh only) and Full Mesh (generate full

mesh). The default is Dimensionally Reduced unless the Physics Preference is set to Explicit. For more

information, refer to Rigid Body Meshing (p. 251).

Mesh Morphing

When the Mesh Morphing feature is Enabled, you can specify that a morphed mesh is produced following

a geometry change rather than re-meshing the geometry.
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For this feature to operate properly, you cannot make any topological changes when you modify/deform

the geometry. In other words, the deformed geometry must have the same number of parts, bodies, faces,

edges, and/or vertices as your original geometry and also the same connectivity between these geometric

entities. The Mesh Morphing feature updates changes in nodes' coordinates, but it is not designed to ac-

commodate severely deformed geometries. If the topology is changed, or if any other severe deformations

occur when the Mesh Morphing feature is enabled, a warning message is produced that indicates that a

morph is not possible because of the modifications. However, in this instance, a complete re-mesh is auto-

matically performed.

If the geometry consists of multiple parts, Mesh Morphing will not operate unless all of the parts are already

meshed.

If you have enabled Mesh Morphing, you will also need to re-mesh manually whenever you change the

properties of the mesh in the Details View or when you add/remove/modify the mesh controls objects. These

changes will otherwise not be reflected in the mesh.

Defeaturing Group

The Defeaturing group allows you to use these features and controls:

Pinch

Loop Removal

Automatic Mesh Based Defeaturing

The Defeaturing group of controls is inaccessible when the CutCell mesh method is active.

Pinch

The Pinch feature lets you remove small features (such as short edges and narrow regions) at the mesh level

in order to generate better quality elements around those features. The Pinch feature provides an alternative

to Virtual Topology, which works at the geometry level. The two features work in conjunction with one an-

other to simplify meshing constraints due to small features in a model that would otherwise make it difficult

to obtain a satisfactory mesh.

When Pinch controls are defined, the small features in the model that meet the criteria established by the

controls will be “pinched out,” thereby removing the features from the mesh. You can instruct the Meshing

application to automatically create pinch controls based on settings that you specify, or you can manually

designate the entities to be pinched. Pinch controls can be applied to solid and shell models, with certain

restrictions as shown in the table below.

The Pinch feature is supported for the following mesh methods:

Volume Meshing:

• Patch Conforming

• Thin Solid Sweeping

• Hex Dominant Meshing

Surface Meshing:

• Quad Dominant

• All Triangles
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The table below shows the types of model (solid or shell), mesh methods, and pinch creation methods (auto

or manual) that are supported for each type of pinch control.

Pinch Creation

Method

Mesh MethodModel Type

Entities in

Pinch Control:

Master > Slave Manual

Pinch

Auto

Pinch

All Tri-

angles

Quad

Dom-

inant

Hex

Dom-

inant

Thin

Solid

Sweep-

ing

Patch

Con-

form-

ing

ShellSolid

XXXXXXXXXEdge > Edge

XXXXXXXXEdge > Vertex

XXXXXXXXXVertex > Vertex

XXXXFace > Edge

XXXXFace > Vertex

Examples of a Mesh With and Without Pinch

The figures below illustrate the effect of pinch controls on the mesh. The first figure shows where the pinch

controls have been defined in the model. The second and third figures show the meshes that are generated

without the pinch controls and with the pinch controls, respectively.

Figure: Locations of Pinch Controls
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Figure: Mesh Generated Without Pinch Controls

Figure: Mesh Generated With Pinch Controls

For More Information

For general information on applying pinch controls in combination with the various mesh method controls,

refer to Mesh Control Interaction Tables (p. 261).

Additional pinch topics include:

Pinch Control Automation Overview

How to Define Pinch Control Automation

How to Define or Change Pinch Controls Manually

Usage Information for Pinch Controls
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Pinch Control Automation Overview

The Defeaturing group of global mesh controls appears in the Details View when the Mesh object is selected

in the Tree Outline. By setting pinch options in the Defeaturing group, you can instruct the Meshing applic-

ation to automatically generate pinch controls according to your settings. The Meshing application can

generate the pinch controls based off of shell thickness (for surface models only), or by identifying small

features in the model that fall within a tolerance you specify.

Understanding the Automatic Pinch Control Algorithm

The Meshing application uses four major criteria for generating automatic pinch controls. These criteria (in

order of importance) include:

1. Capture geometry of sheet bodies.

2. Edges adjacent to flat surfaces are masters.

3. Cluster masters together so that they are adjacent to one another.

4. All things being equal, longer edges are masters.

Note

• The master geometry is the entity that retains the profile of the original geometry. The slave

geometry is the entity that changes in order to move towards the master geometry. Depending

on the tolerance, the pinch control will pinch out the entire slave entity or only a portion of

the slave entity into the master.

• The automatic pinch control algorithm supports only one master for each pinch control.

• Once the automatic pinch control algorithm has paired two edges to use as a master and a

slave in an automatic pinch control, the algorithm cannot use either of those same two edges

as master or slave in any other automatic pinch control. For example, in the geometry shown

in Figure: Automatic Pinch Control for Edges on Left; Manual Pinch Control Required for Edges

on Right (p. 94), an automatic pinch control has been created for the annotated slave (red)

edges and the master (blue) edge on the left side of the model. However, a pinch control

will not be created automatically for the very similar configuration of edges on the right side

of the model. For the Meshing application to be able to generate the mesh shown in Fig-

ure: Mesh Generated with Automatic Pinch Control and Manual Pinch Control on Similar Geo-

metry (p. 94), a manual pinch control had to be created for the edges on the right.
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Figure: Automatic Pinch Control for Edges on Left; Manual Pinch Control Required for Edges

on Right

Figure: Mesh Generated with Automatic Pinch Control and Manual Pinch Control on Similar

Geometry

The basic options for defining automatic pinch controls are described below.

Use Sheet Thickness for Pinch

The Use Sheet Thickness for Pinch control determines whether automatic pinch controls will be based on

the shell thickness of the model, rather than on a specified pinch tolerance. When the sheet thickness

method of automatic pinch control is used, the pinch algorithm uses a pinch tolerance equal to 1/2 of the

shell thickness.

Valid values are Yes and No. The default is No.
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Note

• The Use Sheet Thickness for Pinch control is available only for sheet (i.e., surface) models.

If your model contains a combination of surface and solid bodies, the Use Sheet Thickness

for Pinch control is available only if all solid bodies are suppressed.

• You cannot use the sheet thickness method of automatic pinch control for a surface model

that has no thickness defined or has a 0 (zero) thickness.

Pinch Tolerance

The Pinch Tolerance control allows you to specify a tolerance for the Meshing application to use when it

generates automatic pinch controls. Vertex-vertex pinch controls will be created on any edge with a length

less than the specified tolerance, and edge-edge pinch controls will be created on any face for which two

edges are within proximity according to the specified tolerance. For the Meshing application to automate

pinch control, you must specify a value for Pinch Tolerance unless Use Sheet Thickness for Pinch is set

to Yes. Specify a value greater than 0.0.

Note

• The value that you specify for Pinch Tolerance should be smaller than the mesh size around

the region in which the pinch control is being applied. For example, if an Edge Sizing control

has been placed on an edge, a Pinch Tolerance value that is greater than that edge sizing

may cause the mesher to fail.

• In general, the value that you specify for Pinch Tolerance should be greater than the value

that appears in the Sizing > Minimum Edge Length field. Exceptions to this guideline include

models without seam edges, such as elliptical prism, cylinder, and sphere models.

• Do not specify an overly high value for the Pinch Tolerance control. The Pinch feature allows

the mesher to mesh over geometry features as if they were not there, and a tolerance that

is set too high can cause inverted elements.

• When the Advanced Size Function is on, the default pinch tolerance is 90% of the value of

Min Size. This differs from the tolerance used by the default mesh based defeaturing; refer

to Automatic Mesh Based Defeaturing (p. 99) for details.

Generate Pinch on Refresh

The Generate Pinch on Refresh control determines whether pinch controls will be regenerated following

a change made to the geometry (such as a change made via a DesignModeler application operation such

as a merge, connect, etc.). If Generate Pinch on Refresh is set to Yes and you change the geometry, all

pinch controls that were created automatically will be deleted and recreated based on the new geometry.

If Generate Pinch on Refresh is set to No and you update the geometry, all pinch controls related to the

changed part will appear in the Tree Outline but will be flagged as undefined.

Valid values are Yes and No. The default is No.
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Note

Only Automatic pinch controls are regenerated. That is, if a pinch control has a Scope Method

of Manual (either because it was created manually or because you made a change to an Auto-

matic pinch control), the pinch control will never be regenerated on refresh. See Changing Pinch

Controls Locally (p. 183) for information about making changes to pinch controls.

How to Define Pinch Control Automation (p. 96) provides the steps for defining automatic pinch controls.

How to Define Pinch Control Automation

The following sections provide the steps for defining pinch control automation. Pinch can be automated

based on either shell thickness or a user-defined tolerance.

Note

Use of pinch control automation will delete all existing pinch controls that have a Scope Method

of Automatic before creating the new pinch controls.

Defining Pinch Control Automation Based on Shell Thickness

This section describes the steps for defining pinch control automation based on shell thickness. This procedure

applies to sheet (i.e., surface) models only.

To define pinch control automation based on shell thickness:

1. In the Details View of the Mesh folder, expand the Defeaturing group of controls.

2. Set Use Sheet Thickness for Pinch to Yes.

Notice that the value of the Pinch Tolerance control changes to Based on Sheet Thickness and is

grayed out.

3. Change the value of the Generate Pinch on Refresh control if desired.

4. Right-click on the Mesh folder and select Create Pinch Controls from the context menu.

A pinch control object is automatically inserted into the Tree for each region containing features that

meet the criteria established by the pinch control settings. To display details about an individual pinch

control, highlight it in the Tree and information about it appears in the Details View. For information

about making changes to this information, refer to Changing Pinch Controls Locally (p. 183).

Defining Pinch Control Automation Based on a Specified Pinch Tolerance

This section describes the steps for defining pinch control automation based on a tolerance that you specify.

To define pinch control automation based on pinch tolerance:

1. In the Details View of the Mesh folder, expand the Defeaturing group of controls.

2. Specify a value for Pinch Tolerance.

3. Change the value of the Generate Pinch on Refresh control if desired.

4. Right-click on the Mesh folder and select Create Pinch Controls from the context menu.
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A pinch control object is automatically inserted into the Tree for each region containing features that

meet the criteria established by the pinch control settings. To display details about an individual pinch

control, highlight it in the Tree and information about it appears in the Details View. For information

about making changes to this information, refer to Changing Pinch Controls Locally (p. 183).

How to Define or Change Pinch Controls Manually

As an alternative to defining pinch control automation, you can define local controls to pinch scoped entities.

You can also make changes to pinch controls, regardless of whether they were created automatically or

manually. For details, refer to Pinch Control (p. 181) in the local mesh controls section of the Meshing help.

Usage Information for Pinch Controls

Keep the following information in mind when using the Pinch feature:

• When pinch controls are defined, defeaturing occurs when the mesh is generated.

• The Pinch feature works on faces, edges, and vertices only; bodies cannot be pinched. Refer to the

table in Pinch (p. 90) for restrictions related to entity types.

• The automatic pinch control algorithm supports only one master for each pinch control. In manual

pinch controls, you can specify multiple faces or multiple edges to act as masters, but only one vertex

can act as master.

• When defining manual pinch controls, using the same master in more than one pinch control is suppor-

ted. This is true for all types of manual pinch controls: edge-edge, edge-vertex, vertex-vertex, face-edge,

and face-vertex. When multiple pinch controls use the same master, the aggregate of the pinch controls

is used to determine the pinch. Note that this behavior differs from that of other mesh controls when

multiples are specified. With other mesh controls, the control that appears lowest in the Tree is honored.

• If there are hard size constraints on a master, the pinch control will be skipped completely. If there are

hard size constraints on slaves, only the slaves with the constraints will be skipped. In either case, a

warning message will be issued.

• If your model contains multibody parts and you want pinch controls to operate on selected parts/bodies

only, you must first suppress the parts/bodies that you do not want the pinch controls to apply to. Then

follow the steps outlined in How to Define Pinch Control Automation (p. 96).

• If the geometry fails to mesh correctly due to the pinched features, an error message is generated and

a Named Selections > Problematic Geometry  object appears in the Tree. Select this object to view

the surfaces that did not mesh correctly.

• When a face contains an internal loop with a pinch control and the edges of the loop become a “single

internal edge” due to pinching, the surface mesher may completely ignore the “single” edge (that is,

the surface mesher may mesh over the edge). The reason that this may occur is that a pinch control

never changes the topology of a model. When a surface mesher collects all boundary edge meshes

before performing surface meshing, it considers the newly created “single” edge to be a regular edge

rather than a hard edge, which most users would expect. As a result, all edge meshes along the “single”

edge may be ignored.

• After pinch controls are generated:

– If you highlight a pinch control in the Tree, the pinch region is flagged in the Geometry window.

For more information, see the descriptions of Master Geometry and Slave Geometry pinch controls

in Pinch Control Automation Overview (p. 93).

– You can make changes to pinch controls whether they were generated automatically or created

manually. To do so, in the Mesh folder, highlight the Pinch object that you want to change. As a

result, the Details of the pinch appear in the Details View, where you can change its Scope and
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Definition. Making changes to a pinch that was generated automatically causes the value of the

Scope Method control to change from Automatic to Manual. For details about defining or changing

pinch controls manually, see Pinch Control (p. 181) in the local mesh controls section of the Meshing

help.

• If a pinch control has a pinch tolerance defined for it that falls below one or more Hard scoped size

controls, a warning will be issued. The warning will suggest that you either modify the pinch tolerance

or remove any pinch control(s) in close proximity to the Hard size control(s) in question; otherwise,

surface meshing may fail.

• There is no guarantee that features will be preserved when using pinch controls. For this reason, it is

best practice to check the mesh where pinch controls have been defined close to features. If a problem

exists in the mesh, flipping the master and slave entities will be sufficient to solve the problem in many

cases.

• Pinch controls can be used for models involving multiple complications in one location (such as slivers,

sharp angles, and short edges within the same pinch tolerance) as well as for models containing isolated

problem spots. However, when used in combination with the Advanced Size Function, pinch controls

are best used for isolated problems. For example, refer to the meshes in the figure below, which show

the results of applying pinch controls in combination with the Advanced Size Function. For the mesh

on the left, a Pinch Tolerance of 3e-3 and a Min Size of 6.e-3 were specified. For the mesh on the right,

a Pinch Tolerance of 3e-3 and a Min Size of 4.e-3 were specified. Neither is acceptable due to the

presence of high aspect ratio triangles in the mesh. In such cases, the use of Virtual Topology or defea-

turing within the DesignModeler application is recommended as an alternative to pinch.

Figure: Pinch Not Recommended for Models with Multiple Complications when the

Advanced Size Function is On

• In a face-edge pinch control, the mesh on the edges within the specified tolerance is “snapped” to the

master face. You must choose the master and slaves in such a way that the elements on the face whose

edges are defined as slaves will be stretched onto the master face. If the edges would be "squashed,"

no pinch will be created.

• When a face pinch control and a mapped face meshing control are applied to the same face, the

mesher attempts to generate a mapped mesh for the face. If the mesher cannot retain the mapped

mesh pattern, it will generate a free mesh instead.

• If you apply a match control and a face-edge pinch control to the same topology, the match control

will be suppressed and the reason (Overridden) will be reported in the Active read-only field in the

Details View.
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Loop Removal

The Defeaturing group of global mesh controls appears in the Details View when the Mesh object is selected

in the Tree Outline. The Meshing application automatically removes loops according to the criteria you

specify for the loop removal options in this group. Prior to meshing, you can use the Show Removable

Loops feature to preview the loops that will be removed according to the current settings.

The loop removal feature is supported for the following mesh methods:

Surface Meshing:

• Quad Dominant

• All Triangles

• Uniform Quad/Tri

• Uniform Quad

Note

• The loop removal controls are passed to the Uniform Quad/Tri and Uniform Quad methods

as described in Uniform Quad/Tri Method Control (p. 156).

• If you are meshing with loop removal on (using the Quad Dominant, Uniform Quad/Tri, or

Uniform Quad method), making changes to a loop after meshing (such as adding a load on

a loop) invalidates the mesh and you will need to re-mesh. It is recommended that you apply

loads to the model before meshing when using these controls. Refer to the discussion of

protected topology and Patch Independent meshing for related information.

The options for defining loop removal are described below.

Sheet Loop Removal

The Sheet Loop Removal control determines whether loops will be removed (i.e., meshed over) by the

mesher. When Sheet Loop Removal is set to Yes, the mesher removes any loop with a radius less than or

equal to the value of Loop Removal Tolerance.

Valid values are Yes and No. The default is No.

Loop Removal Tolerance

The Loop Removal Tolerance control sets the tolerance for loop removal. Any loop with a radius less than

or equal to the value of Loop Removal Tolerance will be meshed over by the mesher.

Specify a value greater than 0.0.

Automatic Mesh Based Defeaturing

The Defeaturing group of global mesh controls appears in the Details View when the Mesh object is selected

in the Tree Outline. The Meshing application automatically defeatures small features and dirty geometry

according to the Defeaturing Tolerance you specify here.

Automatic mesh based defeaturing is supported for the following mesh methods:
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Solid Meshing:

• Patch Conforming Tetrahedron

• Patch Independent Tetrahedron

• MultiZone

• Thin Sweep

• Hex Dominant

Surface Meshing:

• Quad Dominant

• All Triangles

• Uniform Quad/Tri

• Uniform Quad

For the Patch Independent Tetrahedron, MultiZone, Uniform Quad/Tri, and Uniform Quad methods, the

Defeaturing Tolerance you set here will be populated to the local (scoped) method controls. If you sub-

sequently make changes to the local settings, the local settings will override the global Defeaturing Tolerance

set here. See the descriptions of the individual methods for more information.

The options for defining automatic mesh based defeaturing are described below.

Automatic Mesh Based Defeaturing

Turns Automatic Mesh Based Defeaturing on or off. When Automatic Mesh Based Defeaturing is On

(default), features smaller than or equal to the value of Defeaturing Tolerance are removed automatically.

Defeaturing Tolerance

Only available when Automatic Mesh Based Defeaturing is On. Sets the global tolerance for defeaturing.

Specify a value greater than 0.0. Specifying a value of 0.0 resets the defeaturing tolerance to default.

When the Advanced Size Function is on, the default Defeaturing Tolerance differs depending on whether

sheets and/or solids are present:

• For sheet models, Defeaturing Tolerance is set to 75% of the value of Min Size.

• For solid models, Defeaturing Tolerance is set to 50% of the value of Min Size.

• For assemblies containing both sheets and solids, the Defeaturing Tolerance used for the sheets is

75% of the value of Min Size, and for the solids, 50%. However, the Default value that displays in the

Details View is the larger value (i.e., the value being used for sheets).

When the Advanced Size Function is off, the default Defeaturing Tolerance is handled differently depending

on the mesh method being used. See the descriptions of the individual methods for more information.
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Note

• If a user-defined value has been specified for Defeaturing Tolerance, that value will be used

for everything—sheets and solids.

• When specifying a value for Defeaturing Tolerance, do not specify a value greater than the

value of Min Size.

• If you add a hard size that is smaller than the Min Size, you must further reduce the Defea-

turing Tolerance with respect to the specified hard size (essentially, the hard size becomes

the new Min Size).

Statistics Group

The Statistics group lets you view and request information about these options:

Nodes

Elements

Mesh Metric

Nodes

The Nodes option provides a read-only indication of the number of nodes in the meshed model. If the

model contains multiple parts or bodies, you can view the number of nodes in an individual part or body

by highlighting it under the Geometry object in the Tree Outline.

Elements

The Elements option provides a read-only indication of the number of elements in the meshed model. If

the model contains multiple parts or bodies, you can view the number of elements in an individual part or

body by highlighting it under the Geometry object in the Tree Outline.

Mesh Metric

The Mesh Metric option allows you to view mesh metric information and thereby evaluate the mesh quality.

Once you have generated a mesh, you can choose to view information about any of the following mesh

metrics: Element Quality (p. 106), Aspect Ratio for triangles or quadrilaterals, Jacobian Ratio (p. 108), Warping

Factor  (p. 110), Parallel Deviation (p. 113), Maximum Corner Angle  (p. 114), Skewness (p. 114), and Orthogonal

Quality (p. 117). Selecting None turns off mesh metric viewing.

When you select a mesh metric, its Min, Max, Average, and Standard Deviation values are reported in the

Details View, and a bar graph is displayed under the Geometry window. The graph is labeled with color-

coded bars for each element shape represented in the model's mesh, and can be manipulated to view spe-

cific mesh statistics of interest.

Note

If the model contains multiple parts or bodies, you can view the mesh metric information for an

individual part or body. To do so, return to the Tree Outline. Under the Geometry object, click

on the specific part or body of interest. In response, the Nodes, Elements, Min, Max, Average,

and Standard Deviation values for the selected metric and part/body are reported in the Details

View. (The graph is not available at the part/body level.)
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Accessing Mesh Metric Information

To access mesh metric information:

1. Generate the mesh. You can view mesh metric information for any mesh that was successfully generated

using the Generate Mesh, Preview Surface Mesh, or Preview Inflation feature.

2. Click on the Mesh object in the Tree Outline.

3. In the Details View, expand the Statistics folder.

By default, the total number of Nodes and Elements in the meshed model is reported in the Details

View.

4. For the Mesh Metric control, select the metric of interest from the drop-down menu.

By default, the Min, Max, Average, and Standard Deviation values for the selected metric are reported

in the Details View. In addition, a bar graph is displayed under the Geometry window.

Viewing Advanced Mesh Statistics

When you select a mesh metric, a bar graph is displayed as shown in Figure: Mesh Metrics Bar Graph (p. 102).

For this illustration, the Element Quality mesh metric was selected in the Details View, so the bar graph

displays the minimum to maximum Element Quality values over the entire mesh.

Figure: Mesh Metrics Bar Graph

In Figure: Mesh Metrics Bar Graph (p. 102), the X-axis represents the value of the selected mesh metric. Using

the Y-Axis Option setting described in Using the Bar Graph Controls (p. 105), you control whether the Y-axis

represents the number of elements within a particular quality factor range (the default), or the percentage

of the total volume represented by the elements within a particular quality factor range. In Figure: Mesh

Metrics Bar Graph (p. 102), the Y-axis represents the number of elements. The alternative would be for the Y-

axis to represent the percentage of the total volume. Keep in mind that a model could have a large number

of poorly shaped elements that are confined to a small local area. The total volume of these elements might
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not be significant compared to the volume of the entire model. As a result, the bar corresponding to this

low quality factor may not be significant. The Mesh Metric option displays the selected mesh metric without

qualifying the elements for acceptability.

Additional characteristics of the bar graph include:

• The graph is displayed only when a mesh metric is selected. If you set Mesh Metric to None, the graph

is not displayed. Alternatively, you can click the Metric Graph button on the toolbar to hide/show the

graph.

• Resuming a model retains the last-saved state of the graph.

• Clicking the Controls button accesses the graph controls described in Using the Bar Graph Controls (p. 105).

• The location of an individual bar along the X-axis is the mid-point of the range of metric values covered

by that bar.

• Clicking an individual bar on the graph (or in the column of white space above the bar) changes the

view in the Geometry window. The geometry becomes transparent and only those elements meeting

the criteria values corresponding to the selected bar are displayed, as shown in Figure: Geometry View

After Selecting an Individual Bar (p. 103). (The option to click in the column above the bar is helpful if the

graph contains very short bars that are difficult to click.)

Figure: Geometry View After Selecting an Individual Bar

• If you click and hold the cursor on an individual bar or column, you see a tooltip showing the metric

value associated with the bar, along with either a number of elements or the percent of total volume

represented by the elements (depending on the Y-Axis Option setting). For example, in Figure: Clicking

and Holding on an Individual Bar (p. 104), 0.176 is the mid-point of the range of metric values covered

by the selected bar, and there are 10 elements with values that fall within that range. The 10 elements

are displayed in the Geometry window.
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Figure: Clicking and Holding on an Individual Bar

• To select multiple bars, hold the CTRL key and click all desired bars. All elements corresponding to all

selected bars are displayed in the Geometry window.

• To return the Geometry window to the full mesh view (no transparency; all elements are displayed),

click on empty white space on the graph. Empty white space does not include the column of white space

above a bar, as clicking in this area selects the bar and displays only those elements associated with it.

• If you click in a column for which there are 0 elements, all that is displayed in the Geometry window

is the transparent geometry.

• The graph can be filtered based on element types. See Using the Bar Graph Controls (p. 105) for more

information.

• The graph respects slice planes and hiding of bodies in the Geometry window. For example, if you hide

a body and then click an individual bar to view the elements corresponding to the selected bar, elements
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in the hidden body are not displayed in the Geometry window, even if they meet the criteria that the

bar represents.

• To zoom the graph, hold the ALT key and use your mouse to define a selection box on the graph (i.e.,

click on the graph and drag the mouse downward and to the right to define the area to zoom; then

release the mouse button). To reset the graph to its initial view, hold the ALT key, click on the graph

and drag the mouse downward and to the left; then release the mouse button.

• The values of the X-axis and Y-axis labels on the graph correspond to the visible ranges, rather than to

global values. For example, the value 198 in Figure: Clicking and Holding on an Individual Bar (p. 104) is

the maximum end of the range for the Y-axis, based on the current content of the graph. If you zoom

the graph or define a new range of values to display as described in Using the Bar Graph Controls (p. 105),

the values of the X-axis and Y-axis labels change accordingly along with the content of the graph.

Using the Bar Graph Controls

When you click the Controls button on the graph, the graph is replaced by the controls page as shown in

Figure: Bar Graph Controls Page (p. 105). Clicking the X button applies any changes on the controls page and

returns you to the graph.

Figure: Bar Graph Controls Page

From the controls page shown in Figure: Bar Graph Controls Page (p. 105), you can set the following values:

• Y-Axis Option - Determines what the heights of the bars represent. Options include Number of Elements

and Percent of Volume/Area. The default is Number of Elements.

• Number of Bars - Determines the number of bars to include in the graph. You can enter any whole

number greater than or equal to 0. The default is 10. When you click Update Y-Axis, the Min and/or

Max values for the Y-Axis are recomputed so that the graph and the Y-Axis values on the controls

page reflect the new number of bars.

• Range - Defines a range for the selected metric to display only those elements that fall within the

specified range.

– X-Axis - Specify a Min and/or Max value. To locate and estimate the number of worst elements in

the mesh, adjust the Min and Max values to the lower or upper end of the quality criterion (depend-
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ing on metric) and click Update Y-Axis. (Determining the distribution and location of all the bad

elements at one time is helpful in cases where you may need to re-import your model into the

DesignModeler application to remove the corresponding problematic geometry.) Click Reset to return

to the X-Axis defaults. (Note: Negative values are acceptable.)

– Y-Axis - Specify a Min and/or Max value. By lowering the Max value, you can clip the Y-axis for

easier visualization of small bars, especially as they relate to different element types. Click Reset to

return to the Y-Axis defaults.

• List of element types - Determines which element types to include in the graph. Element types that do

not appear in the mesh are read-only on the controls page. Select the element types that you want to

include in the graph, or click Select All to include all available element types in the graph. By default,

all available element types are selected.

Calculation Details

For information about the calculations that are performed for each metric, refer to:

Element Quality

Aspect Ratio Calculation for Triangles

Aspect Ratio Calculation for Quadrilaterals

Jacobian Ratio

Warping Factor

Parallel Deviation

Maximum Corner Angle

Skewness

Orthogonal Quality

Element Quality

A quality factor is computed for each element of a model (excluding line and point elements). The Element

Quality option provides a composite quality metric that ranges between 0 and 1. This metric is based on

the ratio of the volume to the edge length for a given element. A value of 1 indicates a perfect cube or

square while a value of 0 indicates that the element has a zero or negative volume.

Aspect Ratio Calculation for Triangles

The aspect ratio for a triangle is computed in the following manner, using only the corner nodes of the

element (Figure: Triangle Aspect Ratio Calculation (p. 107)):

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.106

Global Mesh Controls



Figure: Triangle Aspect Ratio Calculation
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1. A line is constructed from one node of the element to the midpoint of the opposite edge, and another

through the midpoints of the other 2 edges. In general, these lines are not perpendicular to each

other or to any of the element edges.

2. Rectangles are constructed centered about each of these 2 lines, with edges passing through the ele-

ment edge midpoints and the triangle apex.

3. These constructions are repeated using each of the other 2 corners as the apex.

4. The aspect ratio of the triangle is the ratio of the longer side to the shorter side of whichever of the

6 rectangles is most stretched, divided by the square root of 3.

The best possible triangle aspect ratio, for an equilateral triangle, is 1. A triangle having an aspect ratio of

20 is shown in Figure: Aspect Ratios for Triangles (p. 107).

Figure: Aspect Ratios for Triangles

1 20

Aspect Ratio Calculation for Quadrilaterals

The aspect ratio for a quadrilateral is computed by the following steps, using only the corner nodes of the

element (Figure: Quadrilateral Aspect Ratio Calculation (p. 108)):
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Figure: Quadrilateral Aspect Ratio Calculation
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1. If the element is not flat, the nodes are projected onto a plane passing through the average of the

corner locations and perpendicular to the average of the corner normals. The remaining steps are

performed on these projected locations.

2. Two lines are constructed that bisect the opposing pairs of element edges and which meet at the

element center. In general, these lines are not perpendicular to each other or to any of the element

edges.

3. Rectangles are constructed centered about each of the 2 lines, with edges passing through the element

edge midpoints. The aspect ratio of the quadrilateral is the ratio of a longer side to a shorter side of

whichever rectangle is most stretched.

4. The best possible quadrilateral aspect ratio, for a square, is one. A quadrilateral having an aspect ratio

of 20 is shown in Figure: Aspect Ratios for Quadrilaterals (p. 108).

Figure: Aspect Ratios for Quadrilaterals

1 20

Jacobian Ratio

Jacobian ratio is computed and tested for all elements except triangles and tetrahedra that (a) are linear

(have no midside nodes) or (b) have perfectly centered midside nodes. A high ratio indicates that the mapping

between element space and real space is becoming computationally unreliable.

Jacobian Ratio Calculation

An element's Jacobian ratio is computed by the following steps, using the full set of nodes for the element:

1. At each sampling location listed in the table below, the determinant of the Jacobian matrix is computed

and called RJ. RJ at a given point represents the magnitude of the mapping function between element
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natural coordinates and real space. In an ideally-shaped element, RJ is relatively constant over the

element, and does not change sign.

RJ Sampling LocationsElement Shape

Integration points10-node tetrahedra

base corner nodes and near apex node (apex RJ factored so that a pyramid

having all edges the same length will produce a Jacobian ratio of 1)

5-node or 13-node

pyramids

corner nodes and centroid8-node quadrilaterals

all nodes and centroid20-node bricks

corner nodesall other elements

2. The Jacobian ratio of the element is the ratio of the maximum to the minimum sampled value of RJ.

If the maximum and minimum have opposite signs, the Jacobian ratio is arbitrarily assigned to be -

100 (and the element is clearly unacceptable).

3. If the element is a midside-node tetrahedron, an additional RJ is computed for a fictitious straight-

sided tetrahedron connected to the 4 corner nodes. If that RJ differs in sign from any nodal RJ (an ex-

tremely rare occurrence), the Jacobian ratio is arbitrarily assigned to be -100.

4. If the element is a line element having a midside node, the Jacobian matrix is not square (because the

mapping is from one natural coordinate to 2-D or 3-D space) and has no determinant. For this case,

a vector calculation is used to compute a number which behaves like a Jacobian ratio. This calculation

has the effect of limiting the arc spanned by a single element to about 106°.

A triangle or tetrahedron has a Jacobian ratio of 1 if each midside node, if any, is positioned at the average

of the corresponding corner node locations. This is true no matter how otherwise distorted the element

may be. Hence, this calculation is skipped entirely for such elements. Moving a midside node away from the

edge midpoint position will increase the Jacobian ratio. Eventually, even very slight further movement will

break the element (Figure: Jacobian Ratios for Triangles (p. 109)). We describe this as “breaking” the element

because it suddenly changes from acceptable to unacceptable- “broken”.

Figure: Jacobian Ratios for Triangles

1 30 1000

Any rectangle or rectangular parallelepiped having no midside nodes, or having midside nodes at the mid-

points of its edges, has a Jacobian ratio of 1. Moving midside nodes toward or away from each other can

increase the Jacobian ratio. Eventually, even very slight further movement will break the element (Figure: Jac-

obian Ratios for Quadrilaterals (p. 110)).
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Figure: Jacobian Ratios for Quadrilaterals

1 30 100

A quadrilateral or brick has a Jacobian ratio of 1 if (a) its opposing faces are all parallel to each other, and

(b) each midside node, if any, is positioned at the average of the corresponding corner node locations. As

a corner node moves near the center, the Jacobian ratio climbs. Eventually, any further movement will break

the element (Figure: Jacobian Ratios for Quadrilaterals (p. 110)).

Figure: Jacobian Ratios for Quadrilaterals

1 30 1000

Warping Factor

Warping factor is computed and tested for some quadrilateral shell elements, and the quadrilateral faces of

bricks, wedges, and pyramids. A high factor may indicate a condition the underlying element formulation

cannot handle well, or may simply hint at a mesh generation flaw.

Warping Factor Calculation for Quadrilateral Shell Elements

A quadrilateral element's warping factor is computed from its corner node positions and other available

data by the following steps:

Note

When computing the warping factor for a quadrilateral shell element, the Meshing application

assumes 0 thickness for the shell. In contrast, the defined shell thickness is included when the FE

Modeler application computes the warping factor. Because of this difference in computation, the

warping factor value reported by the Mesh Metric control in the Meshing application and the

warping factor value reported by the FE Modeler Mesh Metrics tool will differ.

1. An average element normal is computed as the vector (cross) product of the 2 diagonals (Figure: Shell

Average Normal Calculation (p. 111)).
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Figure: Shell Average Normal Calculation

2. The projected area of the element is computed on a plane through the average normal (the dotted

outline on Figure 4-19: Shell Element Projected onto a Plane).

3. The difference in height of the ends of an element edge is computed, parallel to the average normal.

In Figure: Shell Element Projected onto a Plane (p. 111), this distance is 2h. Because of the way the average

normal is constructed, h is the same at all four corners. For a flat quadrilateral, the distance is zero.

Figure: Shell Element Projected onto a Plane

h

4. The “area warping factor” ( Fa
w

) for the element is computed as the edge height difference divided by

the square root of the projected area.

5. For all shells except those in the “membrane stiffness only” group, if the thickness is available, the

“thickness warping factor” is computed as the edge height difference divided by the average element

thickness. This could be substantially higher than the area warping factor computed in 4 (above).

6. The warping factor tested against warning and error limits (and reported in warning and error messages)

is the larger of the area factor and, if available, the thickness factor.

7. The best possible quadrilateral warping factor, for a flat quadrilateral, is zero.
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Figure: Quadrilateral Shell Having Warping Factor (p. 112) shows a “warped” element plotted on top of a flat

one. Only the right-hand node of the upper element is moved. The element is a unit square, with a real

constant thickness of 0.1.

When the upper element is warped by a factor of 0.01, it cannot be visibly distinguished from the underlying

flat one.

When the upper element is warped by a factor of 0.04, it just begins to visibly separate from the flat one.

Figure: Quadrilateral Shell Having Warping Factor

0.0 0.01 0.04

0.1 1.0 5.0

Warping of 0.1 is visible given the flat reference, but seems trivial; however, it is well beyond the error limit

for a membrane shell. Warping of 1.0 is visually unappealing. This is the error limit for most shells.

Warping beyond 1.0 would appear to be obviously unacceptable; however, SHELL181 permits even this

much distortion. Furthermore, the warping factor calculation seems to peak at about 7.0. Moving the node

further off the original plane, even by much larger distances than shown here, does not further increase the

warping factor for this geometry. Users are cautioned that manually increasing the error limit beyond its

default of 5.0 for these elements could mean no real limit on element distortion.

Warping Factor Calculation for 3-D Solid Elements

The warping factor for a 3-D solid element face is computed as though the 4 nodes make up a quadrilateral

shell element with no real constant thickness available, using the square root of the projected area of the

face as described in 4 (above).

The warping factor for the element is the largest of the warping factors computed for the 6 quadrilateral

faces of a brick, 3 quadrilateral faces of a wedge, or 1 quadrilateral face of a pyramid. Any brick element

having all flat faces has a warping factor of zero (Figure: Warping Factor for Bricks (p. 113)).
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Figure: Warping Factor for Bricks

0.0 approximately 0.2 approximately 0.4

Twisting the top face of a unit cube by 22.5° and 45° relative to the base produces warping factors of about

0.2 and 0.4, respectively.

Parallel Deviation

Parallel deviation is computed using the following steps:

1. Ignoring midside nodes, unit vectors are constructed in 3-D space along each element edge, adjusted

for consistent direction, as demonstrated in Figure: Parallel Deviation Unit Vectors (p. 113).

Figure: Parallel Deviation Unit Vectors

2. For each pair of opposite edges, the dot product of the unit vectors is computed, then the angle (in

degrees) whose cosine is that dot product. The parallel deviation is the larger of these 2 angles. (In

the illustration above, the dot product of the 2 horizontal unit vectors is 1, and acos (1) = 0°. The dot

product of the 2 vertical vectors is 0.342, and acos (0.342) = 70°. Therefore, this element's parallel de-

viation is 70°.)

3. The best possible deviation, for a flat rectangle, is 0°. Figure Figure: Parallel Deviations for Quadrilater-

als (p. 113) shows quadrilaterals having deviations of 0°, 70°, 100°, 150°, and 170°.

Figure: Parallel Deviations for Quadrilaterals

0� 70� 100�

150� 170�
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Maximum Corner Angle

Maximum corner angle is computed and tested for all except Emag or FLOTRAN elements. Some in the finite

element community have reported that large angles (approaching 180°) degrade element performance,

while small angles don't.

Maximum Corner Angle Calculation

The maximum angle between adjacent edges is computed using corner node positions in 3-D space. (Midside

nodes, if any, are ignored.) The best possible triangle maximum angle, for an equilateral triangle, is 60°.

Figure: Maximum Corner Angles for Triangles (p. 114) shows a triangle having a maximum corner angle of 165°.

The best possible quadrilateral maximum angle, for a flat rectangle, is 90°. Figure: Maximum Corner Angles

for Quadrilaterals (p. 114) shows quadrilaterals having maximum corner angles of 90°, 140° and 180°.

Figure: Maximum Corner Angles for Triangles

60˚ 165˚

Figure: Maximum Corner Angles for Quadrilaterals

90˚ 140˚ 180˚

Skewness

Skewness is one of the primary quality measures for a mesh. Skewness determines how close to ideal (i.e.,

equilateral or equiangular) a face or cell is (see Figure: Ideal and Skewed Triangles and Quadrilaterals (p. 115)).
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Figure: Ideal and Skewed Triangles and Quadrilaterals

The following table lists the range of skewness values and the corresponding cell quality.

Cell QualityValue of Skewness

degenerate1

bad (sliver)0.9 — <1

poor0.75 — 0.9

fair0.5 — 0.75

good0.25 — 0.5

excellent>0 — 0.25

equilateral0

According to the definition of skewness, a value of 0 indicates an equilateral cell (best) and a value of 1 in-

dicates a completely degenerate cell (worst). Degenerate cells (slivers) are characterized by nodes that are

nearly coplanar (collinear in 2D).

Highly skewed faces and cells are unacceptable because the equations being solved assume that the cells

are relatively equilateral/equiangular.

Two methods for measuring skewness are:

• Based on the equilateral volume (applies only to triangles and tetrahedra).

• Based on the deviation from a normalized equilateral angle. This method applies to all cell and face

shapes, e.g., pyramids and prisms.
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Equilateral-Volume-Based Skewness

In the equilateral volume deviation method, skewness is defined as

Skewness = 
Optimal Cell Size - Cell Size

Optimal Cell Size

where, the optimal cell size is the size of an equilateral cell with the same circumradius.

Quality grids have a skewness value of approximately 0.1 for 2D and 0.4 for 3D. The table above provides a

general guide to the relationship between cell skewness and quality.

In 2D, all cells should be good or better. The presence of cells that are fair or worse indicates poor boundary

node placement. You should try to improve your boundary mesh as much as possible, because the quality

of the overall mesh can be no better than that of the boundary mesh.

In 3D, most cells should be good or better, but a small percentage will generally be in the fair range and

there are usually even a few poor cells.

Note

The Equilateral-Volume-Based Skewness quality metric applies to any mesh element that includes

a triangular face. For triangular and tetrahedral elements, all faces of which are strictly triangular,

the Equilateral-Volume-Based Skewness metric applies directly. For wedge or pyramidal elements,

which include combinations of triangular and quadrilateral faces, the Meshing application computes

both Equilateral-Volume-Based Skewness metrics (for the triangular faces) and Normalized

Equiangular Skewness metrics (for the quadrilateral faces and 3-D element, itself ) and reports the

maximum computed metric as the element skewness. As a result, Equilateral-Volume-Based

Skewness metrics reported for meshes that contain wedge and/or pyramidal elements may include

skewness values attributable to Normalized Equiangular Skewness computations.

Normalized Equiangular Skewness

In the normalized angle deviation method, skewness is defined (in general) as

max 
θ θ

θ
θ θ

θ
max

, min−
−

−







e

e

e

e180

where

θmax = largest angle in the face or cell

θmin = smallest angle in the face or cell

θe = angle for an equiangular face/cell (e.g., 60 for a triangle, 90 for a square)

For a pyramid, the cell skewness will be the maximum skewness computed for any face. An ideal pyramid

(skewness = 0) is one in which the 4 triangular faces are equilateral (and equiangular) and the quadrilateral

base face is a square. The guidelines in the table above apply to the normalized equiangular skewness as

well.
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Orthogonal Quality

The range for orthogonal quality is 0-1, where a value of 0 is worst and a value of 1 is best.

The orthogonal quality for cells is computed using the face normal vector, the vector from the cell centroid

to the centroid of each of the adjacent cells, and the vector from the cell centroid to each of the faces. Fig-

ure: Vectors Used to Compute Orthogonal Quality for a Cell (p. 117) illustrates the vectors used to determine

the orthogonal quality for a cell.

Figure: Vectors Used to Compute Orthogonal Quality for a Cell

The orthogonal quality for a cell is computed as the maximum of the following quantities computed for

each face i:

ur ur

ur ur

⋅
� �� �� �� �

where 
uru� �

 is the face normal vector and 
ur� �

 is a vector from the centroid of the cell to the centroid of that

face.

and

ur

ur

ur

ur

⋅
� �� �	 		 	

where 
uru
 �

 is the face normal vector and 
ur�


 is a vector from the centroid of the cell to the centroid of the

adjacent cell that shares the face.

117
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Normalized Equiangular Skewness



Note

• When the cell is located on the boundary, the vector 
ur��

 across the boundary face is ignored

during the quality computation.

• When the cell is separated from the adjacent cell by an internal wall (e.g., a baffle), the vector
ur��

 across the internal boundary face is ignored during the quality computation.

• When the adjacent cells share a parent-child relation, the vector 
ur� �

 is the vector from the

cell centroid to the centroid of the child face while the vector 
ur��

 is the vector from the cell

centroid to the centroid of the adjacent child cell sharing the child face.

The orthogonal quality for faces is computed using the edge normal vector and the vector from the face

centroid to the centroid of each edge. Figure: Vectors Used to Compute Orthogonal Quality for a Face (p. 118)

illustrates the vectors used to determine the orthogonal quality for a face.

Figure: Vectors Used to Compute Orthogonal Quality for a Face

The orthogonal quality for a face is computed as the maximum of the following quantity computed for each

edge i:

ur

ur

ur

ur

⋅
� 	� 	
 

 


where 
uru� �

 is the edge normal vector and 
ur
�

 is a vector from the centroid of the face to the centroid of the

edge.
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Note

Orthogonal quality in the Meshing application (and ANSYS FLUENT) is equivalent to orthoskew

in TGrid, except that the scale is reversed:

Orthoskew = 1 – Orthogonal Quality

The orthoskew values may not correspond exactly with the orthogonal quality values as the

computation depends on boundary conditions on internal surfaces (WALL vs. INTERIOR/FAN/RADI-

ATOR/POROUS-JUMP). In all cases, the orthogonal quality value in ANSYS FLUENT should provide

more accurate results than the value in the Meshing application. Also, for CutCell meshes, the

elements in the Meshing application are “traditional” (hex/tet/wedge/pyramid) elements while

CutCell meshes that are exported from the Meshing application to ANSYS FLUENT are exported

in polyhedral format.
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Local Mesh Controls

Local mesh controls are available when you highlight a Mesh object in the tree and choose a tool from

either the Mesh Control drop-down menu, or from first choosing Insert in the context menu (displayed

from a right mouse click on a Mesh object). You can specify the scoping of the tool in the tool's Details

View under Method to either a Geometry Selection or to a Named Selection.

Note

Be aware of the following items regarding mesh control tools:

• For most mesh controls, the latest control that you add on a particular geometry overrides

any prior controls that you already have added on that geometry. For example, if you apply

a Sizing control setting of 0.5 to faces A,B,C then apply a setting of 1.0 to face B, faces A and

C will retain the 0.5 setting, but the setting for face B will be 1.0. This is also useful when

you want to force sweep many bodies of a multibody part and only tet mesh one or specify

special sweeping options on one. For example, you can select all 1000 parts and then override

one or 10 part(s) instead of picking 999 (990) and then selecting one (10).

Exceptions include the Uniform Quad, Uniform Quad/Tri, MultiZone, and All Tetrahedrons -

Patch Independent controls. For information about how these controls interact with other

controls, refer to Mesh Control Interaction Tables (p. 261), Interactions Between Mesh Meth-

ods (p. 261), and Interactions Between Mesh Methods and Mesh Controls (p. 263).

• If you suppress a mesh control tool, the Suppress symbol appears ("x" adjacent to the name

of the tool) and Suppressed is set to Yes in the Details View of the tool. Situations can occur

when you do not suppress a mesh control tool, and the Suppress symbol appears adjacent

to the tool but Suppressed is set to No in the Details View of the tool. In these situations,

refer to the mesh control's Active read-only field for the reason why the tool is suppressed.

Examples are a control applied to a uniform surface body mesh (not supported), a control

scoped to suppressed geometry, or a Contact Sizing control scoped to a suppressed Contact

Region.

The following local mesh controls are available:

Method Control

Sizing Control

Contact Sizing Control

Refinement Control

Mapped Face Meshing Control

Match Control

Pinch Control

Inflation Control

Gap Tool
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Method Control

The Method control is valid only for a body. The default value selects meshing methods that provide a

successful automated mesh. By default, the application attempts to use auto sweeping for solid models and

quadrilateral element generation for surface body models. If a model is not sweepable, the Patch Conforming

mesher under Tetrahedrons is used. You can change these defaults using the Meshing Options panel.

To set the values for the Method control, click Mesh on the Tree Outline, right-click to view the menu, and

select Insert> Method. You can also click Mesh on the Tree Outline, select the Mesh Control button on

the Context Toolbar, and select Method.

Note

• Refer to Conformal Meshing Between Parts (p. 7) for information about mesh method inter-

operability.

• The Method control is not supported for CutCell meshing.

In the Details View, you can set Method based on whether you want to apply the method to a solid body

or a surface body. For more information, refer to:

Method Controls and Element Midside Nodes Settings

Setting the Method Control for Solid Bodies

Setting the Method Control for Surface Bodies

Method Controls and Element Midside Nodes Settings

When setting the Method control to a scoped body, you can control whether meshes are to be created on

the scoped body with midside nodes or without midside nodes by using the Element Midside Nodes setting

under Definition in the Details View. When setting the Element Midside Nodes option for a scoped body,

choices include Use Global Setting, Dropped, and Kept.

If you select Use Global Setting, Element Midside Nodes will be handled as dictated by the global Element

Midside Nodes option. The remaining choices—Dropped and Kept—have the same descriptions as their

counterparts under the global Element Midside Nodes option. Setting Element Midside Nodes to Dropped

or Kept for a scoped body will override the setting of the global Element Midside Nodes option.

Mixed Order Meshing

Mixed order meshing is supported across bodies for the following mesh methods:

• For solid meshing:

– Patch Conforming Tetrahedron

– Patch Independent Tetrahedron

– MultiZone

– General Sweep

– Thin Sweep

– Hex Dominant

• For surface meshing:

– Quad Dominant
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– All Triangles

– Uniform Quad/Tri

– Uniform Quad

This means that when scoping one of these mesh methods to bodies in a multibody part, you can set the

Element Midside Nodes option to Kept (resulting in higher order elements) for some bodies and to Dropped

(resulting in lower order elements) for others. In such cases, all of the elements in a lower order body that

are adjacent to a higher order body will be higher order elements, thereby creating one layer of quadratic

elements at the interface face. These elements will be higher order at the interface face but with dropped

midside nodes where adjacent to the linear elements in the mesh.

Note

• Mixed order meshing is not supported if you are performing Direct Meshing (p. 239). To use

mixed order meshing, all of the bodies in the part must be meshed at the same time.

• To use mixed order meshing with the Patch Independent Tetrahedron, MultiZone, Uniform

Quad/Tri, or Uniform Quad mesh methods, all of the bodies in the part must be meshed with

the same mesh method [that is, either all Patch Independent Tetrahedron, all MultiZone, or

all Uniform Quad(/Tri)].

The figures below illustrate an example of mixed order meshing. To obtain the mesh shown in Figure: Mixed

Order Meshing of a Multibody Part (p. 124), the global Element Midside Nodes option was set to Kept, resulting

in a mesh of quadratic tet elements for the topmost body. The sweep method was applied to the remaining

bodies, with the Element Midside Nodes option set to Dropped on the Sweep Method control. This resulted

in a mesh of primarily linear hex/wedge elements for the swept bodies, with the hex/wedge elements that

are attached to the common interface being mixed order (see Figure: Mixed Order Elements (p. 125)).
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Figure: Mixed Order Meshing of a Multibody Part

Figure: Mixed Order Elements (p. 125) shows the mixed order hex/wedge elements that are attached to

quadratic pyramid elements at the interface. On the Mesh Metrics bar graph, mixed order elements are

displayed as quadratic element types.
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Figure: Mixed Order Elements

Setting the Method Control for Solid Bodies

The options described below are available for solid bodies.

Automatic Method Control

Tetrahedrons Method Control

Hex Dominant Method Control

Sweep Method Control

MultiZone Method Control

Automatic Method Control

If you select the Automatic Method control (default), the body will be swept if possible. Otherwise, the

Patch Conforming mesher under Tetrahedrons is used.

Tetrahedrons Method Control

If you select the Tetrahedrons method, an all tetrahedral mesh is created. An Algorithm setting is displayed

allowing you to choose how the tetrahedral mesh is created based on your choice of one of the following

options:

Patch Conforming Algorithm for Tetrahedrons Method Control

Patch Independent Algorithm for Tetrahedrons Method Control

Patch Conforming Algorithm for Tetrahedrons Method Control

The Patch Conforming Tetra mesh method is a Delaunay tetra mesher with an advancing-front point insertion

technique used for mesh refinement. The Patch Conforming Tetra mesh method provides:
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• Support for 3D inflation

• Built-in pyramid layer for conformal quad-tet transition

• Built-in growth and smoothness control. The mesher will try to create a smooth size variation based on

the specified growth factor.

Keep the following information in mind when using the Patch Conforming Tetra mesh method:

• For problematic geometry given by the Patch Conforming Tetra mesher or regions that self intersect,

you can possibly remedy the problem by adding an extremely large face sizing control in the region of

the self intersection. However, best practice would be to remove the problematic geometry in the

DesignModeler application or your CAD system.

• When Patch Conforming Tetra meshing (with Physics Preference of CFD) fails due to lack of available

memory, an error message will be issued. However, this error message will not identify insufficient

memory as the cause. Because meshing will stop before the memory limit is reached, you may not notice

any unusual behavior.

• For information about the Element Midside Nodes option, refer to Method Controls and Element Midside

Nodes Settings (p. 122).

Patch Independent Algorithm for Tetrahedrons Method Control

The Patch Independent mesh method for tetrahedrons is based on the following spatial subdivision algorithm:

This algorithm ensures refinement of the mesh where necessary, but maintains larger elements where possible,

allowing for faster computation. Once the "root" tetrahedron, which encloses the entire geometry, has been

initialized, the Patch Independent mesher subdivides the root tetrahedron until all element size requirements

(that is, the prescribed local mesh sizes) are met.

At each subdivision step, the edge length of the tetrahedron (=size) is divided by 2. This means that the

prescribed sizes should all differ by factors that are an integer power of 2. The size of the root tetra is set

to the smallest given size multiplied by 2
n
. All other prescribed sizes are approximated by subdividing the

root tetra. Refer to the series of figures below, which illustrate the process that is followed by the Patch In-

dependent tetra mesher.

Figure: Geometry Input to Patch Independent Tetra Mesher
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At this point, the Patch Independent tetra mesher balances the mesh so that elements sharing an edge or

face do not differ in size by more than a factor of 2.

Figure: Full Tetrahedron Enclosing the Geometry

Figure: Full Tetrahedron Enclosing the Geometry in Wire Frame Mode
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Figure: Cross-Section of the Tetrahedron

After this is done, the Patch Independent tetra mesher makes the mesh conformal; that is, it guarantees that

each pair of adjacent elements will share an entire face. The mesh does not yet match the given geometry,

so the mesher next rounds the nodes of the mesh to the prescribed points, prescribed curves, or model

surfaces. The Patch Independent tetra mesher then "cuts away" all of the mesh, which cannot be reached

by a user-defined material point without intersection of a surface.

Figure: Mesh After Capture of Surfaces and Separation of Useful Volume

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.128

Local Mesh Controls



Figure: Final Mesh Before Smoothing

Finally, the mesh is smoothed by moving nodes, merging nodes, swapping edges and in some cases, deleting

bad elements.

Figure: Final Mesh After Smoothing

The Patch Independent mesh method includes the following settings:

• Element Midside Nodes - Refer to Method Controls and Element Midside Nodes Settings (p. 122).

• Defined By - Choices are Max Element Size and Approx Number of Elements.

• Max Element Size - The size of the initial element subdivision. The default value depends on whether

Use Advanced Size Function (p. 59) is on or off:

– If Advanced Size Function is on, the default value of Max Element Size is inherited from the global

Max Size value.

– If Advanced Size Function is off, the default value of Max Element Size is inherited from the global

Element Size value.
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In either case, you can change the value if you want to apply a specific value locally. In such cases, the

maximum size comes from the larger value of the global controls (that is, Max Size or Element Size,

as described above) OR, the largest scoped body size or face size that Patch Independent is also scoped

to. A scoped edge size is not respected if it is larger than either the global size or the size on an attached

face.

With the Patch Independent mesh method, scoped body sizing is supported as follows:

– If a local body size is defined and it is smaller than the global maximum size, the scoped body size

will be assigned inside the volume.

– If the global maximum size is smaller than any scoped body, face or edge sizing, the global maximum

size (Element Size when Advanced Size Function is off; Max Size when Advanced Size Function is

on) will be changed to be the same as the largest sizing within the mesher. For example, if Patch

Independent is defined on two bodies, and the setup is as follows:

→ Global Max Size = 4

→ Local body size scoped to Body1 = 8

→ No local body size is scoped to Body2

The Patch Independent maximum size will be 8, and the global Max Size of 4 will be used for the

sizing of Body2.

Note

The maximum element size inside the volume of Body2 could grow to 8. Since setting

local sizings affects the largest element size in the model, it is recommended to avoid

setting local sizes that are larger than the global maximum size.

• Approx Number of Elements - Prescribes an approximate number of elements for the mesh. The default

is 5.0E+05. Specifying a prescribed number of elements for the Patch Independent method is applicable

only if the method is being applied to a single part.

• Feature Angle - Specifies the minimum angle at which geometry features will be captured. If the angle

between two faces is less than the specified Feature Angle, the edge between the faces will be ignored,

and the nodes will be placed without respect to that edge. If the angle between two faces is greater

than the Feature Angle, the edge should be retained and mesh aligned and associated with it (note

the edge could be ignored due to defeaturing, etc.). You can specify a value from 0 (capture most edges)

to 90 (ignore most edges) degrees or accept the default of 30 degrees.

• Mesh Based Defeaturing - Ignores edges based on size. Off by default. If set to On, a Defeaturing

Tolerance field appears where you may enter a numerical value greater than 0.0. By default, the value

of this local Defeaturing Tolerance field is the same as the global Defeaturing Tolerance (p. 100). If you

specify a different value here, it will override the global value. Specifying a value of 0.0 here resets the

tolerance to its default. If multiple Patch Independent tetra mesh method controls are defined with

different tolerances, the smallest tolerance is respected.

There are several basic cases, including the following:

– A small hole with a diameter smaller than the tolerance as shown below.
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No edges are dropped. You should defeature manually in this case.

– Two approximately parallel spaced edges (fillet or chamfer), as shown below.

To determine whether a face is a fillet/chamfer, the Patch Independent mesher evaluates the face's

geometric features. To be considered a fillet/chamfer:

→ A face must be at least twice as long as it is wide.

→ A fillet/chamfer has either three or four sides (that is, two long sides and one or two short sides),

all with angles <= 135 degrees.

In the case of a fillet, which is a curved or rounded face, the angle between the fillet and a face at-

tached to one of its long sides is 0 degrees (not 180 degrees). In contrast, a chamfer is a planar face

and the angle between the chamfer and a face attached to one of its long sides is larger than 0

degrees.

For defeaturing of fillets/chamfers, the mesher considers the fillet/chamfer face as well as the faces

adjacent to it (i.e., the faces attached to its long sides). The dihedral angles between these faces are

evaluated to determine whether the attached edges of adjacent faces will be respected (that is,

whether nodes will be placed with respect to the edges at the long sides of the fillet/chamfer).

There are three dihedral angles occurring at a fillet/chamfer:

→ One dihedral angle occurs between the two faces “touching,” or adjacent to, the fillet/chamfer

face. When this angle is compared with the Feature Angle, the angle is measured between the

face normals at the imaginary edge where the two faces (virtually) meet.

→ Two dihedral angles occur between the fillet/chamfer face and the respective faces “touching,”

or adjacent to, the two long sides of the fillet/chamfer. The angles are evaluated as the angles

between the face normals at the common edge of the fillet/chamfer and the attached face.

Defeaturing occurs as follows:
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→ If the angle between the two faces adjacent to the fillet/chamfer face is greater than the Feature

Angle, and the angles between the fillet/chamfer face and the faces attached to its long sides

are less than the Feature Angle, and the minimum fillet/chamfer width is greater than the De-

featuring Tolerance, both long sides/edges are respected.

→ If the angle between the two faces adjacent to the fillet/chamfer face is greater than the Feature

Angle, and the angles between the fillet/chamfer face and the faces attached to its long sides

are less than the Feature Angle, and the minimum fillet/chamfer width is less than the Defea-

turing Tolerance, only one long side/edge is respected.

→ If only one angle between the fillet/chamfer face and the faces attached to its long sides is

greater than the Feature Angle, only one long side/edge is respected.

→ If none of the angles are greater than the Feature Angle, none of the long sides/edges are re-

spected.

The following series of figures illustrates fillet/chamfer detection. In this example, a cross-section is

revolved. The top and bottom of the section are identical, except the bottom has fillets/chamfers

at each corner and the top does not. Because the definition of a fillet/chamfer is somewhat general,

two cases are presented, each with a different angle of revolution. The angle of revolution is 5 degrees

in the first case, as shown below. In this case, only the small faces fit the criteria of fillets/chamfers.

In the second case, the angle of revolution is 180 degrees, as shown below. In this case, all faces fit

the criteria of fillets/chamfers, except for the front/back faces of the extrusion.
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The figure below shows the angles that are considered for fillet/chamfer detection, and the small

faces that are found to be fillets/chamfers.

As described earlier, the angles that are considered for a given fillet/chamfer are 1) the angle between

adjacent fillet/chamfer faces and 2) the two angles attached to the fillet/chamfer. Notice the angles

in the figure below.
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Notice the settings shown below, with Feature Angle set to 30 and Mesh Based Defeaturing

turned off.

In the figure below, the highlighted edges are the edges that are ignored with the settings shown

above. All edges are captured except for locations where the angle between faces or adjacent fil-

let/chamfer faces (two bottom edges) is 20 degrees. Changing the Feature Angle to a value below

20 will result in the mesher capturing those edges, while increasing the angle will result in more

edges being ignored.

In the settings shown below, Feature Angle is changed to 80 but the other settings used before

are retained.
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In the figure below, the highlighted edges are the edges that are ignored with the settings shown

above. All edges are ignored except for those at angles of 90 degrees, both with or without fil-

lets/chamfers.

Now consider the settings shown below. Here the Feature Angle is set back to 30, but Mesh Based

Defeaturing is turned on. Both the Defeaturing Tolerance and the Min Size Limit are set to 2.5

mm, which is larger than the bottom fillets/chamfers.

In the figure below, the highlighted edges are the edges that are ignored with the settings shown

above. The same edges as before are ignored due to the feature angle, but in addition every other

edge along the bottom fillets/chamfers is ignored.
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The last part of this example involves the case in which the angle of revolution is 180 degrees. Once

again the Feature Angle is set to 80 but Mesh Based Defeaturing is turned off.

In the figure below, the highlighted edges are the edges that are ignored. With the settings shown

above and the longer extrusion, more faces are found to be fillets/chamfers when compared to the

case of the shorter extrusion. In comparison, the bottom section is identical as all faces are found

to be fillets/chamfers (so the meshing behavior does not change). However, with the inclusion of

all faces on top being considered chamfers, the meshing behavior does change.
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The following series of figures shows examples of the Patch Independent Tetrahedron mesher with

various settings. Figure (a) shows the base geometry.

Figure: Example (a) Showing Base Geometry

Figures (b) through (f ) below show examples of the Patch Independent Tetrahedron mesher under the

conditions noted.
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Figure: Example (b) Min Size Limit (Described Below) Set to 1

Figure: Example (c) Min Size Limit (Described Below) Set to 0.5
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Figure: Example (d) Defeaturing Tolerance Set to 1

Figure: Example (e) Defeaturing Tolerance Set to 1 and Midside Nodes Dropped
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Figure: Example (f) Defeaturing Tolerance Set to 1 and Min Size Limit Set to 0.5

• Curvature and Proximity Refinement and Min Size Limit - When Curvature and Proximity Refinement

is set to Yes, the mesh is automatically refined based on geometry curvature and proximity. This will

result in larger elements on flat planar faces and smaller elements in areas of high curvature or within

small gaps. In addition, a Min Size Limit field is displayed, in which you enter a numerical value. (The

default of Curvature and Proximity Refinement is Yes, unless Physics Preference is set to Explicit,

in which case the default is No.)

Curvature or proximity based refinement will subdivide the elements until this Min Size Limit is reached.

However, projection to geometry and smoothing may push the size even smaller for some elements.

The Min Size Limit prevents curvature or proximity based refinement from generating elements that

are too small. The default value of Min Size Limit depends on whether Use Advanced Size Function (p. 59)

is on or off:

– If Advanced Size Function is on, the default value of Min Size Limit is inherited from the global Min

Size control. You can change the value if you want to apply a specific value locally.

– If Advanced Size Function is off, you must specify a value for Min Size Limit.
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• Num Cells Across Gap - (Displayed only when Curvature and Proximity Refinement is set to Yes.)

The number of cells desired in narrow gaps. This sets the goal for the proximity based refinement. The

mesh will subdivide in tight regions toward this goal, but the refinement is limited by the Min Size

Limit. It will not override this limit. The default value depends on whether Use Advanced Size Func-

tion (p. 59) is on or off:

– If Advanced Size Function is on, the default value of Num Cells Across Gap is inherited from the

global Num Cells Across Gap value.

– If Advanced Size Function is off, the default value of Num Cells Across Gap is 3.

In either case, you can change the value if you want to apply a specific value locally.

• Curvature Normal Angle - (Displayed only when Curvature and Proximity Refinement is set to Yes.)

Sets the goal for the curvature based refinement. The mesh will subdivide in curved regions until the

individual elements span this angle. This refinement is also limited by the Min Size Limit. You can
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specify a value from 0 to 180. The default value depends on whether Use Advanced Size Function (p. 59)

is on or off:

– If Advanced Size Function is on, the default value of Curvature Normal Angle is inherited from the

global Curvature Normal Angle value.

– If Advanced Size Function is off, the default value of Curvature Normal Angle will be computed

based on the values of the Relevance (p. 59) and Span Angle Center (p. 67) global options.

In either case, you can change the value if you want to apply a specific value locally.
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Figure: Example (a) Showing Base Geometry

Figure: Example (b) Default Patch Independent Tetrahedron Mesher
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Figure: Example (c) Patch Independent Tetrahedron Mesher with Min Size Limit Set to

Capture Curvature

• Smooth Transition - Determines whether the Octree volume mesh generated from the Patch Independ-

ent mesh method should be kept or whether it should be replaced with a Delaunay volume mesh

starting from the Patch Independent surface mesh. Options are On or Off (default). If set to On, the

volume mesh will be a Delaunay mesh. If set to Off, the volume mesh will be an Octree mesh.

Figure: Effect of Smooth Transition Setting (p. 144) illustrates the effect of setting Smooth Transition to

Off (Octree volume mesh on the left) or On (Delaunay volume mesh on the right).

Figure: Effect of Smooth Transition Setting

• Growth Rate - Represents the increase in element edge length with each succeeding layer of elements.

For example, a growth rate of 1.2 results in a 20% increase in element edge length with each succeeding

layer of elements. Specify a value from 1.0 to 5.0 or accept the Default. When set to Default, the value

is the same as the global growth rate if Use Advanced Size Function (p. 59) is On. If Use Advanced Size

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.144

Local Mesh Controls



Function is Off, the Default is set differently based on whether Smooth Transition is Off (default is

2.0) or On (default is 1.2).

Note

If Smooth Transition is set to Off, the growth rate is very approximate since the volume is

filled with an Octree meshing approach which requires 2-to-1 transitions. Thus in such cases,

the growth rate relates only to when the transitions occur through the mesh.

• Minimum Edge Length - Read-only indication of the smallest edge length in the part.

• Match Mesh Where Possible - The Match Mesh Where Possible control is applicable to contact

definitions between faces. Options are Yes and No. The default is Yes. If contact is defined by a single

face that topologically belongs to two different bodies, setting this option to Yes has no effect. However,

if there are independent faces on the two bodies, setting this option to Yes causes the Patch Independent

mesh method to create nodes on both sides of the contact. The nodes are not connected but have

identical coordinates.

• Write ICEM CFD Files - Sets options for writing ANSYS ICEM CFD files. Refer to Writing ANSYS ICEM CFD

Files (p. 47) for details.

Notes on Element Size Settings for the Patch Independent Mesher

Keep these notes in mind when using the Patch Independent mesher:

• If you are specifying element sizes with the Patch Independent mesher, you may notice that some element

edge lengths are less than the size that you have entered. For example, if your element size is 1, the

resulting elements in a uniform tetrahedron mesh will have tetrahedron with edges of length 3
1/2

/2

and edges of length 1. A single tetrahedron in this mesh will have two edges of length 1 and four edges

of length 3
1/2

/2. Two of the three dimensions of the bounding box of this tetrahedron will have length

of 1 while the other dimension will have the length of 0.5. This correlates to an element size of 1.

Figure: Element Edge Lengths Smaller Than Specified Element Size

• If you are using Curvature and Proximity Refinement, you may notice that your elements are always

less than the maximum size specified. Element growth rates with this mesher are always based on

powers of 2. For instance if your minimum size limit is set to 1 and your maximum element size limit
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is set to 5, and you have curvature in your model that warrants curvature based mesh refinement down

to the minimum element size, you will see that the largest elements are not size 5 but size 4. This

happens because in order to maintain elements at the minimum size limit, the initial tetrahedron must

be some power of 2 larger than the minimum element size, which in this example case is 1.

• Small features of Named Selections will be checked in comparison to element size settings prior to

meshing. If the minimum element size seems to be too big to capture the essential features of the

geometry, a warning will be issued if small entities could cause the mesher to fail.

Notes on Scoping for the Patch Independent Mesher

You can use the Patch Independent tetra mesh method in combination with other solid mesh methods in

a multibody part, and the bodies will be meshed with conformal mesh. Refer to Conformal Meshing Between

Parts (p. 7) for information about conformal meshing and mesh method interoperability.

Notes on Virtual Topologies and the Patch Independent Mesher

Virtual topologies may affect the success of meshing with the Patch Independent tetra mesh method. Because

virtual topologies are often a coarse approximation of the original faces or edges, the resulting small inac-

curacies (gaps and overlaps) may cause the Patch Independent tetra mesher to miss some parts of the

boundary of the virtual topology. As a result, the mesher may not accurately model the respected topology

and may fail.

Since in general, the Patch Independent tetra mesh method does not require the use of virtual topologies

to clean up the geometry, you can remove some of the problematic virtual topology and use Named Selections

for boundary conditions instead, as appropriate.

Miscellaneous Notes for the Patch Independent Mesher

The Patch Independent tetra mesh method does not support mesh connections, pinch controls, match

controls, or mapped face meshing controls.

Hex Dominant Method Control

If you select the Hex Dominant method, a free hex dominant mesh is created. If you are interested in a hex

mesh, this option is recommended for bodies that cannot be swept. To preview any bodies that can be

swept, click Mesh on the Tree Outline and right-click the mouse. Select Show> Sweepable Bodies from

the context menu to display bodies that fulfill the requirements of a sweepable body (other than axis

sweeping).

The Hex Dominant mesh method includes the following settings:

• Element Midside Nodes - Refer to Method Controls and Element Midside Nodes Settings (p. 122).

• Free Face Mesh Type - Determines the shape of the elements used to fill the body. Allows you to

choose Quad/Tri or All Quad. The default is Quad/Tri.

Hex dominant meshing adds the most value under the following conditions:

• Meshing bodies with large amounts of interior volume.

• Meshing bodies that transition from sweepable bodies in a body that has been decomposed for

sweeping. However, it is better to use Body/Face Sizing to obtain more uniform face meshing, which

leads to more hexes by volume.

Hex dominant meshing adds little value under the following conditions:
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• Meshing thin complicated bodies (like a cellular phone case). The number of elements may actually in-

crease compared to a tetrahedron mesh since the element size must be much smaller for this class of

body when using hex dominant meshing to create well shaped hexes.

• A body is sweepable or can easily be decomposed to multiple sweepable bodies. The quality of a swept

mesh is usually superior to that of a hex dominant mesh.

• Models where fast transition of the mesh can result in poor solution accuracy (e.g. CFD models). The

Hex dominant approach can have very fast transitions at the core of the volume.

Note

• Mesh Matching for cyclic symmetry is not supported for hex dominant meshing.

• Workbench assists you in determining if hex dominant meshing is applicable to your situation.

When you apply the Hex Dominant option on a body or group of bodies, Workbench calcu-

lates the normalized volume to surface area ratio. If it detects a ratio less than 2, Control

Message appears in a highlighted row under Definition in the Details View. If you click Yes,

Click To Display, a warning message states that a low percentage of hex elements or poorly

shaped hex elements may result. Suggestions are included for alternative meshing schemes.

The normalized volume to surface area ratio is defined by the following expression:

(Volume of body/(Surface area of body)
3/2

)/factor

where factor, the ratio for a unit sphere = (4/3 π)/(4 π)
3/2

• Adaptive refinement starting from a hex dominant mesh will result in re-meshing of the

structure with tetrahedrons.

• If you apply a local Sizing control to a solid body with a Method control set to Hex Dominant

or Sweep, or to a sheet body with a Method control set to Quadrilateral Dominant, a near

uniform quadrilateral mesh will result on all affected faces on a body meshed with Hex

Dominant, on the source face meshed with Sweep, and on all affected faces meshed with

Quadrilateral Dominant. To obtain even more of a uniform quadrilateral mesh, set the Be-

havior of the Sizing control to Hard.

Sweep Method Control

If you select the Sweep method, a swept mesh is forced on “sweepable” bodies (including axis-sweepable

bodies, which are not displayed when you use the Show Sweepable Bodies feature). The mesher will fail

if a swept mesh cannot be generated on a body with a Sweep Method control.

Use the Sweep option for any of the following situations:

• A swept mesh is required.

• You want a swept mesh on a model that revolves around an axis where the source and target faces

share topology.

When you choose the Sweep option, the Details View expands to include additional settings, many of which

are unique to this option. For basic usage that involves obtaining a swept mesh, the procedure is to apply

a Method Control to one or more bodies, set Method to Sweep, and accept the default values of the

various settings.
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For advanced or specialized usage such as meshing thin models or axis sweeping, adjust the settings as

needed. The following is a description of each of these settings.

• Element Midside Nodes - Refer to Method Controls and Element Midside Nodes Settings (p. 122).

• Src/Trg Selection - Defines the source and target selection type according to the following choices:

– Automatic - The program determines the best source and target for the body.

– Manual Source - You select the source and the program determines the target. This choice is useful

when there are multiple source target pairs and you want to specify the source in order to get the

correct bias through the sweep direction. Another application is when your cross section is changing

and the mesh quality would be better when sweeping from one side vs. another.

– Manual Source and Target - The sweeper will revolve the mesh around common edges/vertices.

This choice is useful when you want to sweep a body where the source and target faces share vertices

and/or edges.

– Automatic Thin - This choice is for thin models and thin sheet metal parts, or any application where

you want one hex or wedge through the thickness, in preparation for using the Mechanical APDL

application's SOLSH190 element. (See the description for this element in the Element Reference

within the Mechanical APDL help.) For this choice, the face with the largest face area is selected as

the master source and the algorithm determines the rest of the source faces. For multibody parts,

only one division through the thickness is possible. For single body parts, you can define multiple

elements through the thickness using the Sweep Num Divs control. Biasing is not available. An

Element Option setting is included that instructs the solver to use the Solid Shell element where

possible, or to always use a Solid element.

– Manual Thin - The same restrictions apply as described above for Automatic Thin. However, with

this choice, you can do any of the following:

→ Pick one source face and allow the program to determine the rest.

→ Pick all of the source faces and allow the program to do nothing but mesh the source faces and

sweep them to the target.

→ Pick multiple source faces and mesh one target face.
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Note

→ The Sweep mesh method does not support the Manual Source, Manual Source and

Target, or Manual Thin settings for Src/Trg Selection if Sweep is applied to more

than one part, even if you suppress all of the other parts.

→ In some cases, the thin model sweeper may want to swap source and target faces

based on meshing conditions in neighboring bodies. In such cases, a warning message

will be issued to alert you.

For example, if you are mixing a patch independent mesh method (i.e., Patch Inde-

pendent tetra or MultiZone) with the thin model sweeper to mesh bodies in a

multibody part, the thin model sweeper may need to swap the source and target

faces in order to respect protected topology in the neighboring bodies. If there is

protected topology on both sides of the body that is scoped for thin sweep, the side

with the largest number of faces is selected as the source face.

→ To make source/target face selection easier, select View > Annotations from the

Main Menu to toggle the visibility of annotations in the Geometry window. For ex-

ample, after scoping Sweep to a body, the body will be displayed using a blue solid

annotation. Select View > Annotations to turn off the annotations; then select the

source/target faces. For picking internal faces, the Hide Faces right mouse button

option may help you to see inside a body. For example, you can select external faces

in the Geometry window and then use the Hide Faces option to hide the selected

faces (making it easier to select the internal faces).

Refer to Considerations for Selecting Source Faces for the Thin Model Sweeper (p. 200) for details.

• Free Face Mesh Type - Determines the shape of the elements used to fill the swept body (pure hex,

pure wedge, or a combination of hex/wedge). Allows you to choose All Tri, Quad/Tri, or All Quad

meshing when Src/Trg Selection is Automatic, Manual Source, or Manual Source and Target. Allows

you to choose Quad/Tri or All Quad meshing when Src/Trg Selection is Automatic Thin or Manual

Thin. The default in all cases is Quad/Tri.

Note

– If the source face is also a side face of another body, the face will always be quad mapped.

– When Free Face Mesh Type is set to either Quad/Tri or All Quad and the source face

can be mapped meshed, the face will sometimes be mapped meshed even if it means

applied sizing controls (such as Contact Sizing, Sphere of Influence, etc.) will be ignored.

– In some cases when Src/Trg Selection is set to Automatic, the source face that is selected

by the software must be quad mapped in order for the sweep method to be successful.

In these cases, the value that is specified for Free Face Mesh Type may be ignored.

• Type - Allows you to specify a Number of Divisions or Element Size through the sweep direction.

When sweeping generalized bodies that share faces, the Element Size is a soft constraint on interval

assignment and the Number of Divisions is a hard constraint. If you have conflicting Number of Divi-

sions constraints, the sweeper will fail and yield a message. To obtain a regular mesh in the sweep

direction, the guiding edges must have consistent lengths. You can define virtual split edges to achieve

consistent lengths for these edges (see Creating Virtual Split Edges (p. 285)). Also see Sizing Control (p. 157)

for more information.

149
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setting the Method Control for Solid Bodies



• Sweep Bias Type - Specify bias in the same manner as edge biasing for the Bias Type setting in a

Sizing mesh control. There is no graphical feedback for biasing on a Method control. Biasing direction

is based from the source to the target.

• The Constrain Boundary setting is available for multibody parts only (both for general sweeping and

thin sweeping). Specify whether you want to allow the mesher to split the elements at the boundary

of a swept mesh region to aid in meshing. You can choose Yes (constrain boundary; no splitting is al-

lowed) or No (do not constrain boundary; splitting is allowed). Choosing Yes prevents tets from entering

the swept body. The default is No.

Note

• For gasket simulations, set the Stiffness Behavior of the body to Gasket and proceed with

adjusting mesh settings as described in the Gasket Mesh Control section located under Using

Gaskets in the Mechanical Application help.

• In models with swept regions, the Advanced Size Function will affect the mesh gradation in

the swept region. You can override this effect by specifying any Sweep Bias value (including

a value of 1), Sweep Element Size value, or Sweep Num Divs value in the Details View when

defining the sweep method.

• There is a system limitation when using the sweep method with the Advanced Size Function.

The Advanced Size Function may have nodes slightly off because the spacing is queried. The

sweeper then tries to match that spacing, which may lead to unexpected mesh results.

• If you apply a local Sizing control to a solid body with a Method control set to Hex Dominant

or Sweep, or to a sheet body with a Method control set to Quadrilateral Dominant, a near

uniform quadrilateral mesh will result on all affected faces on a body meshed with Hex

Dominant, on the source face meshed with Sweep, and on all affected faces meshed with

Quadrilateral Dominant. To obtain even more of a uniform quadrilateral mesh, set the Be-

havior of the Sizing control to Hard.

MultiZone Method Control

The MultiZone mesh method, which is a patch independent meshing technique, provides automatic decom-

position of geometry into mapped (sweepable) regions and free regions. When the MultiZone mesh method

is selected, all regions are meshed with a pure hexahedral mesh if possible. To handle cases in which a pure

hex mesh will not be possible, you can adjust your settings so that a swept mesh will be generated in

structured regions and a free mesh will be generated in unstructured regions.

For example, using the Sweep mesh method, you would need to slice the part below into five bodies as

shown to obtain a pure hex mesh:
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Figure: Sweep Method Would Require Slicing to Obtain Pure Hex Mesh

In contrast, using the MultiZone mesh method requires no slicing. MultiZone automates the geometry

decomposition and generates the pure hex mesh shown in Figure: MultiZone Generates Pure Hex Mesh without

Slicing (p. 151).

Figure: MultiZone Generates Pure Hex Mesh without Slicing

When you choose the MultiZone mesh method, the Details View expands to expose various settings, including

several that are unique to MultiZone. For basic usage that involves obtaining a MultiZone mesh, the pro-

cedure is to apply a Method Control to one or more bodies, set Method to MultiZone, and accept the

default values of the various settings.
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For advanced or specialized usage, adjust the settings as needed. The following is a description of each of

these settings.

• Mapped Mesh Type - Determines the shape of the elements used to fill structured regions according

to the following choices (the default is Hexa):

– Hexa - A mesh of all hexahedral elements is generated for the part the method is scoped to.

– Hexa/Prism - A mesh of hexahedral and prism/wedge elements is generated for the part the

method is scoped to. The main difference between the Hexa/Prism option and the Hexa option is

that for swept regions, the surface mesh can allow triangles for quality and transitioning. (The triangles

are later extruded to prisms/wedges.)

• Free Mesh Type - Specifying a value for Free Mesh Type will instruct MultiZone to allow a free mesh

if it is not possible (without slicing) to generate a pure hex or hex/prism mesh. The value of Free Mesh

Type determines the shape of the elements used to fill unstructured regions according to the following

choices (the default is Not Allowed):

– Not Allowed - Choose this option if you require a mapped mesh.

– Tetra - Regions of the model that cannot be meshed with a mapped mesh will be filled with a tet-

rahedral mesh. Figure: Free Mesh Type = Tetra (p. 152) shows a MultiZone mesh that was generated

when Free Mesh Type was set to Tetra. Notice the upper section that was able to be mapped

meshed, and the lower section that was free meshed because it could not be mapped meshed. Refer

to Patch Conforming Algorithm for Tetrahedrons Method Control (p. 125) for more information.

Figure: Free Mesh Type = Tetra

– Hexa Dominant — Regions of the model that cannot be meshed with a mapped mesh will be filled

with a hex dominant mesh. Figure: Free Mesh Type = Hexa Dominant (p. 153) shows a MultiZone mesh

that was generated when Free Mesh Type was set to Hexa Dominant. Notice the upper section

that was able to be mapped meshed, and the lower section that was free meshed because it could

not be mapped meshed. Refer to Hex Dominant Method Control (p. 146) for more information.
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Figure: Free Mesh Type = Hexa Dominant

– Hexa Core - Regions of the model that cannot be meshed with a mapped mesh will be filled with

a hexa core mesh. Hexa Core meshes can be generated where the majority of the volume is filled

with a Cartesian array of hexahedral elements essentially replacing the tetras. This is connected to

the remainder of a prism/tetra hybrid by automatic creation of pyramids. Hexa Core allows for re-

duction in number of elements for quicker solver run time and better convergence. Figure: Free Mesh

Type = Hexa Core (p. 153) shows a MultiZone mesh that was generated when Free Mesh Type was

set to Hexa Core. Notice the upper section that was able to be mapped meshed, and the lower

section that was free meshed because it could not be mapped meshed.

Figure: Free Mesh Type = Hexa Core

• Element Midside Nodes - Refer to Method Controls and Element Midside Nodes Settings (p. 122). The

default is Use Global Setting.

• Src/Trg Selection - Defines the source and target selection type according to the following choices

(the default is Automatic):

– Automatic - The program determines the best source and target for the body. The Automatic option

works for simple configurations only.

– Manual Source - You select the faces that will be used as sources (and targets). MultiZone treats

all sources/targets as sources, as imprinting can occur from either side. For additional details, refer

to the description of Source below.

Note

MultiZone does not support the Manual Source setting if MultiZone is applied to more

than one part, even if you suppress all of the other parts.
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• Source - Select the faces that need to be imprinted for proper geometry decomposition. The faces you

select can be either “sources” or “targets,” but all of them will be treated as sources by MultiZone, as

shown in Figure: Source Face Selection for MultiZone (p. 154).

Note

To make source face selection easier, select View > Annotations from the Main Menu to

toggle the visibility of annotations in the Geometry window. For example, after scoping

MultiZone to a body, the body will be displayed using a blue solid annotation. Select View

> Annotations to turn off the annotations; then select the source faces. For picking internal

faces, the Hide Faces right mouse button option may help you to see inside a body. For

example, you can select external faces in the Geometry window and then use the Hide

Faces option to hide the selected faces (making it easier to select the internal faces).

Figure: Source Face Selection for MultiZone

• Mesh Based Defeaturing - “Filters” edges in/out based on size and angle. Off by default. If set to On,

a Defeaturing Tolerance field appears where you may enter a numerical value greater than 0.0. By

default, the value of this local Defeaturing Tolerance field is the same as the global Defeaturing Toler-

ance (p. 100). If you specify a different value here, it will override the global value. Specifying a value of

0.0 here resets the tolerance to its default.

• Minimum Edge Length - Read-only indication of the smallest edge length in the model.

• Write ICEM CFD Files - Sets options for writing ANSYS ICEM CFD files. Refer to Writing ANSYS ICEM CFD

Files (p. 47) for details.

Note

For detailed information about MultiZone, refer to MultiZone Meshing (p. 212). For general inform-

ation on applying MultiZone in combination with other mesh method controls, refer to Mesh

Control Interaction Tables (p. 261).

Notes on Scoping for the MultiZone Mesh Method
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You can use the MultiZone mesh method in combination with other solid mesh methods in a multibody

part, and the bodies will be meshed with conformal mesh.

If a multibody part contains some bodies that are scoped to be meshed with MultiZone and other bodies

that are not scoped with any mesh method, these other bodies will be meshed with the default mesh

method.

Refer to Conformal Meshing Between Parts (p. 7) for information about conformal meshing and mesh

method interoperability.

Setting the Method Control for Surface Bodies

The options described below are available for surface bodies.

Quadrilateral Dominant Method Control

Triangles Method Control

Uniform Quad/Tri Method Control

Uniform Quad Method Control

Quadrilateral Dominant Method Control

If you select the Quadrilateral Dominant method (default), the body is free quad meshed. The Quadrilat-

eral Dominant mesh method includes the following settings:

• Element Midside Nodes - Refer to Method Controls and Element Midside Nodes Settings (p. 122).

• Free Face Mesh Type - Available for most analyses and can be set to either Quad/Tri (default) or All

Quad.

Note

• If you are using the Quadrilateral Dominant mesh method with inflation and the Advanced

Size Function is on, the mesh size of the last inflation layer will be used for the corresponding

Quadrilateral Dominant boundary mesh size.

• If you apply a local Sizing control to a solid body with a Method control set to Hex Dominant

or Sweep, or to a sheet body with a Method control set to Quadrilateral Dominant, a near

uniform quadrilateral mesh will result on all affected faces on a body meshed with Hex

Dominant, on the source face meshed with Sweep, and on all affected faces meshed with

Quadrilateral Dominant. To obtain even more of a uniform quadrilateral mesh, set the Be-

havior of the Sizing control to Hard.

• If you are meshing a multibody part that contains a mix of line bodies and surface bodies,

all surface bodies and all line bodies that share edges with surface bodies will be meshed

with the selected surface mesh method. Any remaining line bodies (where only vertices are

shared with surface bodies) will always be meshed with the Quadrilateral Dominant mesh

method.

Triangles Method Control

If you select the Triangles method, an all triangle mesh is created. For information on the Element Midside

Nodes option, refer to Method Controls and Element Midside Nodes Settings (p. 122).
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Uniform Quad/Tri Method Control

If you select the Uniform Quad/Tri method, a uniform mesh of quads and triangles is created over the entire

part of the selected body, depending on values that you enter for the following input fields.

Note

The same input fields also are applicable to the Uniform Quad method.

Element Midside Nodes - Refer to Method Controls and Element Midside Nodes Settings (p. 122).

Element Size - Allows you to specify the element size used for the selected geometry.

Control Messages - (appears only when Method controls are applied to uniform sheets) Displays an error

message when the Method control is applied to a part that contains virtual topology.

Mesh Based Defeaturing - “Filters” edges in/out based on size and angle. Can be On or Off. By default,

this local Mesh Based Defeaturing setting is the same as the setting of the global Automatic Mesh Based

Defeaturing (p. 100) control. When Mesh Based Defeaturing is On, a Defeaturing Tolerance field appears

where you may enter a numerical value greater than 0.0. By default, the value of this local Defeaturing

Tolerance field is the same as the global Defeaturing Tolerance (p. 100). If you specify a different value here,

it will override the global value. A recommended setting is at least one-half the value set for Element Size

to assure a successful mesh. Specifying a value of 0.0 here resets the tolerance to its default.

Note

When the global Automatic Mesh Based Defeaturing (p. 100) control is on but the Advanced Size

Function is off, the default defeaturing performed for Uniform Quad/Tri includes defeaturing

based on the dihedral angle between the faces as well as edge length defeaturing based on the

smallest element size set by the user.

Sheet Loop Removal - Removes holes on surface bodies based on size. If set to Yes, a Loop Removal Tol-

erance field appears where you may enter a numerical value greater than 0.0. By default, the value of this

local Loop Removal Tolerance field is the same as the global Loop Removal Tolerance (p. 99). If you specify

a different value here, it will override the global value. The mesh simply paves over holes smaller than the

Loop Removal Tolerance setting.

Minimum Edge Length - Read-only indication of the smallest edge length in the part.

Write ICEM CFD Files - Sets options for writing ANSYS ICEM CFD files. Refer to Writing ANSYS ICEM CFD

Files (p. 47) for details.

Usage Information for the Uniform Quad/Tri Mesh Method Control

The following information is applicable to both the Uniform Quad/Tri and Uniform Quad mesh method

controls.

• These controls are sensitive to the scoping of all other objects in Workbench. If you add a load or support

to a group of faces, the part with either of these controls may need to be re-meshed. If you change the

scoping of the load, the part may need to be re-meshed if the faces or edges are not captured by the

mesh. The mesh however, is not made obsolete when adding or changing the scoping of a result. It is

recommended that you apply loads to the model before meshing when using either of these controls.

These controls differ from the other mesh control tools in Workbench. The remaining mesh control
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tools are invariant to loading and mesh every selected face. Every surface body is not meshed when

using either of these controls.

• Do not use the string "problematic geometry" in the names of any Named Selection.

• Using either of these controls may allow meshing over very small bodies in a multibody part. This may

lead to a solver error if a body load is associated with that body. If this is the case, you must suppress

the body before solving your model.

• Surface bodies with specified variable thickness are not protected topology. To prevent faces and their

boundaries from being meshed over, create an individual Named Selection for each thickness.

• The Uniform Quad and Uniform Quad/Tri mesh methods do not support mesh connections or pinch

controls.

• You can use the Uniform Quad and Uniform Quad/Tri mesh methods in combination with other surface

mesh methods in a multibody part, and the bodies will be meshed with conformal mesh. If you select

the Uniform Quad or Uniform Quad/Tri mesh method to mesh a multibody part that contains a mix

of line bodies and surface bodies, all surface bodies and all line bodies that share edges with surface

bodies will be meshed with the selected method. Any remaining line bodies (where only vertices are

shared with surface bodies) will be meshed with the Quadrilateral Dominant mesh method. Refer to

Conformal Meshing Between Parts (p. 7) for more information about conformal meshing and mesh

method interoperability.

• Once a uniform sheet mesh is created, deleting boundary conditions will not cause the mesh to become

obsolete.

Caution

Multiple environments with different loadings may over-constrain the Uniform Quad/Tri and

Uniform Quad meshers such that the mesher may not be able to return a mesh for the given

inputs. If discretization error is not an issue, the mesher will be less constrained if you duplicate

the model and change the environment instead of adding multiple environments under the same

model.

Uniform Quad Method Control

If you select the Uniform Quad method, a uniform mesh of all quads is created over the entire part of the

selected body, depending on values that you enter for the same input fields described for the Uniform

Quad/Tri option.

In some cases, the Uniform Quad option will create some triangular meshes. If this occurs, it will be reported

in a mesh feedback message in the message pane.

Sizing Control

The sizing control sets:

• The element size for a selected body, face, or edge.

• The number of divisions along an edge.

• The element size within a user-defined “sphere of influence” that can include a selected body, face,

edge, or vertex. This control is recommended for local mesh sizing. The control must also be attached

to a coordinate system if it is to be scoped to anything other than a vertex.
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• The element size within a user-defined “body of influence.” The body of influence will influence the

mesh of the body to which it is scoped, but the body of influence itself will not be meshed.

For more information, refer to:

Using the Local Sizing Control

Notes on Element Sizing

Using the Local Sizing Control

The basic steps for using the local Sizing control are presented here.

1. Select a body, face, edge, or vertex.

2. From the Mesh Control toolbar, choose Sizing.

or

Right-click on the selected object and choose Insert> Sizing.

3. Specify options under Details of “Sizing” in the Type field. The value of Type can be Element Size,

Sphere of Influence, Body of Influence, or Number of Divisions. The available choices depend on the

topology you selected in step 1 above.

For details on defining local mesh sizing for the various topologies, refer to:

Defining Local Mesh Sizing on a Body

Defining Local Mesh Sizing on a Face

Defining Local Mesh Sizing on an Edge

Defining Local Mesh Sizing on a Vertex

Descriptions of Local Sizing Control Options

Defining Local Mesh Sizing on a Body

The following table provides an overview of how to define local mesh sizing on a body. Refer to Descriptions

of Local Sizing Control Options (p. 160) for details about the individual options that appear in the table.

3. Specify values for the applicable options. Applicable

options are dependent on the settings of Behavior and

Use Advanced Size Function.

2. Specify Behavior.1. Specify Type.

Element Size • Element Size• Soft

• • Growth RateHard

• Curvature Normal Angle

N/ASphere of Influence • Sphere Center

• Sphere Radius

• Element Size

N/ABody of Influence • Element Size

• Growth Rate
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Defining Local Mesh Sizing on a Face

The following table provides an overview of how to define local mesh sizing on a face. Refer to Descriptions

of Local Sizing Control Options (p. 160) for details about the individual options that appear in the table.

3. Specify values for the applicable options. Applicable

options are dependent on the settings of Behavior and

Use Advanced Size Function.

2. Specify Behavior.1. Specify Type.

Element Size • Element Size• Soft

• • Growth RateHard

• Curvature Normal Angle

N/ASphere of Influence • Sphere Center

• Sphere Radius

• Element Size

Defining Local Mesh Sizing on an Edge

The following table provides an overview of how to define local mesh sizing on an edge. Refer to Descriptions

of Local Sizing Control Options (p. 160) for details about the individual options that appear in the table.

3. Specify values for the applicable options. Applicable

options are dependent on the settings of Behavior and

Use Advanced Size Function.

2. Specify Behavior.1. Specify Type.

Element Size • Growth Rate• Soft

• • Curvature Normal AngleHard

• Element Size

• Bias Type

• Bias Factor

N/ASphere of Influence • Sphere Center

• Sphere Radius

• Element Size

Number of Divisions • Growth Rate• Soft

• • Curvature Normal AngleHard

• Number of Divisions

• Bias Type

• Bias Factor

Defining Local Mesh Sizing on a Vertex

The following table provides an overview of how to define local mesh sizing on a vertex. Refer to Descriptions

of Local Sizing Control Options (p. 160) for details about the individual options that appear in the table.
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2. Specify values for the applicable options.1. Specify Type.

Sphere of Influence • Sphere Radius

• Element Size

Descriptions of Local Sizing Control Options

Use the options described below to further define local mesh sizing. The choices that are available depend

on the selected topology, as noted in the individual option descriptions.

Element Size

If you selected a body, face, or edge, Element Size (default) is one of the available options in the Type field.

Enter a positive value (decimals are allowed) in this field. Smaller values generate more divisions. A value of

"0" instructs the sizing control to use its defaults.

Additional details about the Element Size option differ depending on whether Use Advanced Size Func-

tion (p. 59) is on or off.

The following series of figures shows the effect of the sizing control applied to a face.

Element Size set to

0.5.

Element Size default.

When Use Advanced Size Function (p. 59) is on, the description of Element Size is as follows:

• For an edge, Element Size is the maximum size on the edge. It overrides Max Face Size (p. 64).

• For a face, Element Size is the maximum size on the face, which is then propagated down to the edges.

The value of Element Size overrides Max Face Size (p. 64).

• For a body, Element Size is the maximum size on the body, and the maximum sizes on faces and edges

of the body. If the body size setting is Hard, the value of Element Size overrides Max Face Size (p. 64)

and Max Size (p. 65). For a Soft body size, if Element Size is smaller than Max Face Size or Max Size,

it overrides Max Face Size or Max Size; otherwise, Element Size is Max Face Size or Max Size (i.e.,

the smallest size will be the maximum size on the body).
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Sphere of Influence

Sphere of Influence is an available option in the Type field if you selected a body, face, edge, or vertex and

Use Advanced Size Function (p. 59) is off. (If scoping to a body and Use Advanced Size Function (p. 59) is off,

the body must be a sheet or solid body.) If Use Advanced Size Function (p. 59) is on, Sphere of Influence

can be scoped to a body or a vertex.

Although the Behavior option is not available for Sphere of Influence, Sphere of Influence behaves as a

Hard setting. That is, in the vicinity of a Sphere of Influence, the Sphere of Influence sizing overrides pre-

existing sizing information regardless of whether the pre-existing sizes are larger or smaller than the Sphere

of Influence sizing. This is in contrast to the Body of Influence option, which behaves as a Soft setting.

For bodies, faces, and edges, Sphere of Influence allows you to apply mesh sizing within the confines of a

sphere in space that you define as follows:

1. Create a local coordinate system whose origin you intend to be the center of the sphere.

2. Select this coordinate system in the Sphere Center field.

3. Enter the radius of the sphere in the Sphere Radius field.

4. Enter a value in the Element Size field. The element size will be applied to all topologies within the

confines of the sphere. For example, if you are applying the element size to a face, the size will also

be applied to the edges of that face, and to the vertices of those edges, but only within the confines

of the sphere. An example is shown below.

If you selected a vertex, the only option available in the Type field is Sphere of Influence. The description

is the same as presented above except that the center of the sphere is the vertex. There is no need to create

or use a local coordinate system to define the center of the sphere. After applying element size to a vertex

using Sphere of Influence, the element size is applied to all topologies connected to that vertex, such as

all edges and faces containing that vertex, if they fall within the sphere. An example is shown below.
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Body of Influence

The Body of Influence option is available in the Type field if you selected a body and Use Advanced Size

Function (p. 59) is on. (Body of Influence is not active when Use Advanced Size Function (p. 59) is off.) Using

this option, you can set one body as a source of another body (that is, a Body of Influence). The Body of

Influence will influence the mesh density of the body that it is scoped to, but it will not be a part of the

model geometry nor will it be meshed. Body of Influence bodies are noted in the Details View of each

prototype.

Although the Behavior option is not available for Body of Influence, Body of Influence behaves as a Soft

setting. That is, in the vicinity of a Body of Influence, the Body of Influence sizing overrides pre-existing

sizing information only if the pre-existing sizes are larger than the Body of Influence sizing. This is in contrast

to the Sphere of Influence option, which behaves as a Hard setting.

Keep the following notes in mind when using Body of Influence:

• If your source body is a sphere, it is best for you to use the Sphere of Influence option instead of Body

of Influence. Body of Influence is intended for non-spherical bodies.

• In general, users are discouraged from defining a Body of Influence and a Sphere of Influence such

that the regions of influence overlap. In cases where elements fall within overlapping bodies/spheres

of influence, elements will be created using the Sphere of Influence sizing that appears lowest in the

Tree.

• You cannot apply loads, mesh controls, etc. on bodies of influence. Bodies of influence are used only

to influence the size function and therefore only size function attributes can be applied to them.

• You can suppress and unsuppress bodies of influence.

• If you are using Body of Influence with Match Control, be aware that the body of influence will not

be copied from one matched entity to the other. As a workaround, you can copy the body in the

DesignModeler application and use both bodies as your source.

Number of Divisions

If you selected an edge, the options available in the Type field are Element Size and Sphere of Influence,

along with the Number of Divisions option. Choosing Number of Divisions and entering a value in the

Number of Divisions field is an alternative to choosing Element Size if you are interested in having the

mesh be sized according to a discrete number of divisions along an edge. If you set Number of Divisions

to a value greater than 1000, the number of divisions will not be drawn on the edge in the Geometry window.

Behavior

For bodies, faces, or edges only, you can specify a Behavior option of either Soft (default) or Hard. (The Be-

havior option is not available for Sphere of Influence or Body of Influence.) The effect of the Behavior

setting is influenced by whether Use Advanced Size Function (p. 59) is on or off, as follows:

Regardless of whether Use Advanced Size Function (p. 59) is on or off:

• Choosing the Hard option for edges means that the size or number of divisions is fixed on the edge

and cannot be changed by the meshing algorithm and the likelihood of a mesh failure increases.

• Choosing the Soft option for edges, faces, and bodies means that the size control will be affected by

proximity, curvature, and local re-meshing during the meshing process.

If Use Advanced Size Function (p. 59) is off:

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.162

Local Mesh Controls



• Choosing Hard on a face/body means that curvature pre-refinement is not performed on the edges of

the face/body, but the edge can be split by the mesher.

Interval assignments are handled as follows:

• Regardless of whether Use Advanced Size Function (p. 59) is on or off, choosing Soft on a face/body

means that the edges are only seeded with this information in interval assignment; no additional con-

straints are placed on the mesher. A soft constraint in interval assignment places a higher weight to

meet that number of divisions on the edge in the interval solver.

When hard size constraints are placed on faces or bodies that will be swept/mapped, the edges of those

faces/bodies will receive soft edge sizes to guide the interval solver.

Keep these notes in mind when using the Behavior option:

• If Use Advanced Size Function (p. 59) is on, Hard sizes do not respect the Growth Rate; the mesher will

try to maintain a uniform size on the entity. If Use Advanced Size Function (p. 59) is on and a Soft size

is specified, the specified Growth Rate will be used.

• You should avoid the use of local Hard size controls on faces and bodies in combination with the Ad-

vanced Size Function if the specified local size falls between the values of the Advanced Size Function's

minimum size (Min Size (p. 64)) and maximum size (Max Face Size (p. 64) or Max Size (p. 65), as applicable)

options. In such cases use local Soft size controls instead, and the Soft controls will act like a maximum

size.

• If the Tree contains multiple size controls for the same entity, the last size control for that entity is always

honored.

When Use Advanced Size Function (p. 59) is on, the smallest size that the last size control specifies for

the entity overrides all other size controls. In this way, the smallest size will be the maximum size on

the entity. This is true unless a Hard size control is used. When size controls are applied to entities of

differing dimensions (for example, a face and an edge), a Hard size control will override all others and

the sizing will propagate from the Hard size outward.

• The Uniform Quad, Uniform Quad/Tri, and MultiZone mesh methods do not support the Behavior option.

Growth Rate

You may specify a growth rate for the scoped soft size of an entity (body, face, or edge only). The description

of the scoped Growth Rate is the same as that of the global growth rate that you can set in the Details

View when the Mesh object is selected in the Tree Outline. However, the growth rate you specify for a

scoped entity must always be smaller than or equal to the specified global growth rate. Growth Rate is not

available for Sphere of Influence. Specifying a growth rate for a face or body affects the growth on the

face or on the boundary of the body, and its effect continues outside of the scoped entity as well.

Curvature Normal Angle

You may specify Curvature Normal Angle for a scoped entity (body, face, or edge only). Curvature Normal

Angle is the maximum allowable angle that one element edge is allowed to span. Available only when Use

Advanced Size Function is set to either On: Proximity and Curvature or On: Curvature. You can specify

a value from 0 to 180 degrees to override the global setting (where a value of 0 resets the option to its de-

fault). The default for the global setting is calculated based on the values of the Relevance (p. 59) and Span

Angle Center (p. 67) options.
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Bias Type and Bias Factor

For edges only, use Bias Type to adjust the spacing ratio of nodes on an edge. This feature is useful for any

engineering problem where nodes need to be clustered on an edge or group of edges, or if there is a need

to bias the mapped mesh of a face towards a specific direction with respect to the edges of the face. Bias

Type can be used with all meshers except Patch Independent and Uniform Quad/Tri. To use Bias Type,

choose one of the four pre-determined patterned options depicted pictorially from the Bias Type drop

down menu:

Then specify a Bias Factor, which is defined as the ratio of the largest edge to the smallest edge.

Note

If Behavior is set to Hard, then the number of divisions and the bias cannot be changed by the

mesher. If Behavior is set to Soft, then the edge divisions can be changed but the edge will be

initially meshed with the specified Bias Factor.

Notes on Element Sizing

Keep the following notes in mind when using the Sizing control:

• Visual aids are available to assist you. When you pick an edge, the edge length is displayed. A circle is

displayed adjacent to the cursor whose diameter indicates the current setting in the Element Size field.

The scale ruler is displayed below the graphic and provides a good estimate of the scale of the model.

Also, if you specify a bias, and if you set Element Size to a value other than Default, the size control

will be displayed graphically with the initial mesh density (including any specified bias) in the Geometry

window.

• When Applying Sizes to Faces: Faces adjacent to a face that has a scoped size control applied to it

respect the source as part of the size function. Meshes on the adjacent faces will transition smoothly

to the size on the scoped face. When size controls that have differing sizes are on adjacent entities, the

adjacent topology receives the smallest size.

• When Applying Sizes to Edges: If possible, the meshing algorithm places the requested number of

divisions on the specified edge. Otherwise, the algorithm adjusts the number to allow a successful mesh

generation.

• When Sweeping: Consider the following when applying size controls to source and target geometry:

– If your sizing controls are scoped to either the source or target face, the mesher will transfer the

size control to the opposite face. If you have a size control on both faces, the size on one of the

faces will be used. That face is automatically determined by the software. However the size on the

edges of the target face will not be affected if no sizes are explicitly defined on these edges.

– Edge sizing applied to a target face is respected only if Behavior is Hard.

– If you have a sphere of influence on a possible source or target face, the face with the most spheres

will be chosen as the source face. The edge mesh of the source face affected by the sphere of influ-

ence will not affect the target face. This may prevent the model from sweeping with acceptable

element quality. To avoid this, place the sphere of influence on the edges of both the source and

target face.
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– Applying sizes, regardless of type (that is, size, number of divisions, sphere of influence), to the edges

of possible source and target faces will only affect the faces that use these edges.

If you want to control a side area, the problem must be properly constrained such that the interval as-

signment does not override your size control. The divisions on the edge may decrease in order to make

the body sweepable. When using a meshing process other than swept meshing, the divisions can only

increase. When applying a size to a part that is sweepable, the resulting mesh may have fewer divisions

on the edge than specified due to the interval assignment logic of the sweepers.

When sweeping a model, if you use the Sphere of Influence sizing control and the sphere is not

touching the edges of a side area or is totally enclosed in the body, the sphere will have no effect.

When sweeping a closed torus (shown below) with an applied size on the face of the torus, the number

of divisions that will result on the torus is governed by the arc length between the caps of the surface

on the inside of the torus.

Figure: Sweeping a Closed Torus

Figure: Resulting Mesh for Closed Torus

• Using the Sphere of Influence sizing control may not have any effect on the generated mesh if the

control is scoped to the Body of a Line Body.

• In general, users are discouraged from defining a body of influence and a sphere of influence such that

the regions of influence overlap. In cases where elements fall within overlapping bodies/spheres of in-

fluence, elements will be created using the Sphere of Influence sizing that appears lowest in the Tree.
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• Regardless of the value for the sizing control you set, other factors such as edge and face curvature

and the proximity of small features may override the effect of the sizing control.

• Within MultiZone (and throughout ANSYS Workbench in general), parallel edge assignments are handled

automatically for mapped faces. That is, for a mapped face, there are two sets of parallel edges. If you

increase or decrease the sizing on one edge, the same increase or decrease occurs automatically on

the other edge to ensure a mapped mesh is possible. If a model contains a row of mapped faces (such

as the sides of a box), you can set a number of elements on one edge and the same number of elements

will be forced on all side/parallel edges.

When you scope bias settings to edges, they are applied according to the following priority:

1. Double bias edge

2. Single bias edge

3. No bias edge

This means that if a model contains a number of parallel edges with scoped edge sizes, the size control(s)

with the double biasing will take highest priority, then single biasing, then no biasing.

For additional information that is specific to MultiZone and element sizing, see MultiZone Support for

Defined Edge and Face Sizings (p. 214).

• If you apply a local Sizing control to a solid body with a Method control set to Hex Dominant or

Sweep, or to a sheet body with a Method control set to Quadrilateral Dominant, a near uniform

quadrilateral mesh will result on all affected faces on a body meshed with Hex Dominant, on the source

face meshed with Sweep, and on all affected faces meshed with Quadrilateral Dominant. To obtain

even more of a uniform quadrilateral mesh, set the Behavior of the Sizing control to Hard.

• If several sizing controls are attached to the same edge, face, or body, the last control is applied. If a

sizing control is placed on an edge and then another is placed on a face or body that contains that

edge, the edge sizing takes precedence over the face or part sizing.

• If you have adjusted the element size, then changed length units in a CATIA, ACIS, or Autodesk Mech-

anical Desktop model, when you choose Update or Clear Generated Data at a Model or Project node

in the Tree Outline, you may need to re-adjust the element size. The sizing control does not automatically

re-adjust to match this situation.

• When using CutCell Meshing (p. 228), the Sphere of Influence, Body of Influence, and Number of Divi-

sions options for Type are not supported. This means that no local vertex sizing is supported and only

the Element Size option is supported for local body, face, and edge sizing. If any unsupported controls

are defined prior to CutCell activation, they are suppressed when CutCell is activated.

Contact Sizing Control

Contact Sizing creates elements of relatively the same size on bodies from the faces of a face to face or

face to edge contact region. This control generates spheres of influence internally with automatic determin-

ation of radius and size (if Relevance is selected for Type). You may want to apply a method control on

sweepable bodies to force the elements to be tetrahedron in the case where the sweeper is not providing

enough local sizing near your contact region. Your swept mesh may be quite dense if the contact size is

small on the source and target faces of the body. You may also see very little effect on swept bodies in the

case where a contact size is applied to a very small region of a large source face. You can apply contact

sizing using either of the following procedures:

• Choose Contact Sizing from the Mesh Control drop-down menu, or from the context menu through

a RMB click on a Mesh object (Insert> Contact Sizing). Select a specific contact region under Scope
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in the Details View, then under Type, choose Relevance for a relative size (and enter a value or use the

slider), or Element Size (and enter a value) for an absolute size.

• Drag a Contact Region object onto the Mesh object, then in the Details View, under Type, choose

Relevance for a relative size (and enter a value or use the slider), or Element Size (and enter a value)

for an absolute size.

Note

The Contact Sizing control is not supported for CutCell meshing.

Refinement Control

Refinement controls specify the maximum number of meshing refinements that are applied to the initial

mesh. Refinement controls are valid for faces, edges, and vertices.

Refinement controls are not available when using the MultiZone, Patch Independent Tetra, Uniform

Quad/Tri, Uniform Quad, or CutCell mesh methods.

In the following scenarios, the refinement control is automatically suppressed when used with inflation:

• When automatic inflation (either Program Controlled (p. 69) or All Faces in Chosen Named Selection (p. 70))

is used with refinement in the same model

• When local inflation is used with refinement in the same body or in the same part

To use refinement controls, click Mesh on the Tree Outline, and right-click to view the menu. Select Insert>

Refinement. You can also click Mesh on the Tree Outline, and select the Mesh Control button on the

Context Toolbar. Select Refinement.

In the Details View, specify a Refinement number between 1 and 3, where 1 provides minimal refinement,

and 3 provides maximum refinement. If you attach several controls to the same entity, the last control applied

takes precedence.

Some refinement controls can override or affect other refinements that are on connected topology. A face

refinement control overrides a refinement control on any of the face's edges or vertices. An edge refinement

control overrides a refinement control on either of the edge's vertices. Basically, a refinement control will

lower the value of an overridden control by its own value. For example, consider a face with a refinement

control of 1 and one of the face's edges with a refinement control of 2. One of the edge's vertices has a re-

finement control of 2. In this example, the face control reduces the value of the edge control by 1. It also

reduces the value of the vertex control by 1. The edge control now has a value of 1, so it reduces the vertex's

control by 1. Now the vertex has a value of zero, so it has no effect.

Note

If you apply a Refinement control to a part that was either swept meshed or hex dominant

meshed, then delete the Refinement control, the intermediate tetrahedral mesh will be retained

unless you invalidate the state of the part (for example, by clearing the database). An intermediate

tetrahedral mesh is created when you try to refine non-tetrahedral solid elements.
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Mapped Face Meshing Control

Mapped face meshing controls attempt to generate a mapped mesh on selected faces. The Meshing applic-

ation determines a suitable number of divisions for the edges on the boundary face automatically. If you

specify the number of divisions on the edge with a Sizing control, the Meshing application attempts to

enforce those divisions.

To set the mapped face meshing controls, highlight Mesh in the Tree Outline, and right-click to view the

menu. Select Insert> Mapped Face Meshing. You can also click Mesh in the Tree Outline, and select the

Mesh Control Context Toolbar, then select Mapped Face Meshing from the drop-down menu.

Note

To assist you in defining mapped face meshing controls, you can use the Show Mappable Faces

feature to select all mappable faces automatically and highlight them in the Geometry window.

There are basic and advanced mapped face meshing controls. Mapped Face Meshing is supported for the

following mesh methods:

Volume Meshing:

• Sweep

• Patch Conforming

• Hex Dominant Meshing

• MultiZone (basic controls only)

Surface Meshing:

• Quad Dominant

• All Triangles

• Uniform Quad/Tri (basic controls only)

• Uniform Quad (basic controls only)

Mapped face meshing topics include:

Setting Basic Mapped Face Meshing Controls

Understanding Advanced Mapped Face Meshing Controls

Notes on the Mapped Face Meshing Control

Note

For general information on applying mapped face meshing controls in combination with the

various mesh method controls, refer to Mesh Control Interaction Tables (p. 261).

Setting Basic Mapped Face Meshing Controls

This section describes the steps for setting basic mapped face meshing controls.
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To set basic mapped face meshing controls:

1. Insert a mapped face meshing control by highlighting Mesh in the Tree and right-clicking to view the

menu. Select Insert> Mapped Face Meshing.

2. Select the face that you want to be mapped meshed.

3. For the Definition> Method control, choose Quadrilaterals or Triangles: Best Split. (The Triangles:

Best Split option is available only for sheet models.)

4. For the Definition> Radial Number of Divisions control, specify the number of divisions across the

annular region when sweeping. (The Radial Number of Divisions option is activated when the Mapped

Face Meshing control is scoped to faces made up of two loops.) You can specify a value from 1 to

1000. The default is 0.

5. For the Definition> Constrain Boundary control, specify whether you want to allow the mesher to

split the boundary of a mapped mesh region to aid in meshing of adjacent faces. You can choose Yes

(constrain boundary; no splitting is allowed) or No (do not constrain boundary; splitting is allowed).

The default is No. See Notes on the Mapped Face Meshing Control (p. 175) for related information.

6. Generate the mesh by right-clicking the Mesh object in the Tree and selecting Generate Mesh.

Understanding Advanced Mapped Face Meshing Controls

When you apply advanced mapped face meshing controls to a face, the Meshing application divides the

face into one or more mappable regions and creates a mapped mesh in each region. Advanced mapped

face meshing controls are subject to restrictions related to vertex types and restrictions related to edge

mesh intervals.

The advanced Mapped Face Meshing controls are supported for the following mesh methods only:

Volume Meshing:

• Sweep

• Patch Conforming

• Hex Dominant Meshing

Surface Meshing:

• Quad Dominant

• All Triangles

Advanced mapped face meshing topics include:

Restrictions Related to Vertex Types

Restrictions Related to Edge Mesh Intervals

Selecting Faces and Vertices

Effect of Vertex Type on Face Meshes

Setting Advanced Mapped Face Meshing Controls

Note

For general information on applying mapped face meshing controls in combination with the

various mesh method controls, refer to Mesh Control Interaction Tables (p. 261).
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Restrictions Related to Vertex Types

To constitute a submappable face, a face must possess only End, Side, Corner, and Reversal vertices. In ad-

dition, the total number of End vertices, NE, must satisfy the following equation:

NE = 4 + NC + 2NR

where NC and NR are the total numbers of Corner and Reversal type vertices, respectively, on the face. That

is, for every Corner type vertex, the face must possess an additional End vertex, and for every Reversal vertex,

the face must possess two additional End vertices.

Note

You cannot specify Reversal vertices. Reversal vertices are used internally by the Meshing applic-

ation to determine whether the face is mappable.

The shape of the mesh generated by means of the advanced mapped face meshing controls depends on

the type and arrangement of vertex types on the face. As an example of the effect of vertex types, consider

the face shown in Figure: Inside Corner Vertex (p. 170), which consists of a planar L-shaped face, one corner

of which is truncated at an angle.

Figure: Inside Corner Vertex

In Figure: Inside Corner Vertex (p. 170), the inside corner vertex (C) is designated as a Corner vertex, therefore,

in order to be submappable, the face must possess five End type vertices (A, B, D, E, and F). The advanced

mapped face mesh control divides the face into the following two mapped regions:

• A, B, C, H, F, G

• C, D, E, H
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Note

If you enforce an advanced mapped face mesh control on a face, the Meshing application evaluates

the face with respect to its vertex type designations. If the vertex types do not meet the criteria

outlined above, the Meshing application attempts to change the vertex types so that the face is

submappable.

For most submappable faces, there are multiple configurations of vertex types that satisfy the

vertex type criteria. Each vertex type configuration results in a unique node pattern for the

submapped mesh. When the Meshing application automatically changes vertex types, it attempts

to employ the configuration that minimizes distortion in the mesh. To enforce a specific node

pattern on a submapped mesh, manually select the vertices such that they meet the advanced

mapped mesh control vertex type criteria outlined above. (See Selecting the Vertex Type and

Picking Vertices (p. 171).)

Restrictions Related to Edge Mesh Intervals

If you specify a bias on the edge of a face before applying an advanced mapped face mesh control to the

face, you must specify the bias on all parallel edges of the face.

Selecting Faces and Vertices

To use advanced mapped mesh controls on a face, you must do the following:

• Select the face upon which the vertex types are to be defined

• Select the vertex type (using the Specified Sides, Specified Corners, and Specified Ends controls)

• Pick the vertices to which the vertex type specification is to be applied

Selecting the Face

The Meshing application vertex types are specific to the faces upon which they are set. Therefore, to specify

the type designation of an individual vertex, you must first select a face to be associated with that vertex.

An individual vertex may possess as many vertex type designations as the number of faces to which it is

attached. For example, it is possible for a vertex to possess a Side type designation with respect to one face

and an End type designation with respect to another, as long as two separate Mapped Face Meshing controls

are defined for the two faces. For more information, refer to Setting Advanced Mapped Face Meshing Con-

trols (p. 174).

Selecting the Vertex Type and Picking Vertices

The structure of any face mesh in the vicinity of an individual vertex on its boundary is a function of the

vertex type. There are three vertex types that you can specify.

• End

• Side

• Corner
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Figure: Face Vertex Types

An individual vertex may possess only one vertex type designation. For example, you cannot designate a

vertex as type “side” and also designate that same vertex as type “end.” For more information, refer to Setting

Advanced Mapped Face Meshing Controls (p. 174).

Each vertex type differs from the others in the following ways:

• The number of face mesh lines that intersect the vertex

• The angle between the edges immediately adjacent to the vertex

The following table summarizes the characteristics of the vertex types shown in Figure: Face Vertex Types (p. 172).

Note

If a face has only 4 vertices and 4 edges, the maximum for the range of the angle of a Side vertex

type is 179°, and the acceptable range shifts accordingly.

Range of Angle Between EdgesIntersecting Grid

Lines

Vertex Type

0° — 135°0End

136° — 224°1Side

225° — 314°2Corner

315° — 360° (You cannot specify Reversal vertices.The range for

Reversal vertices is used internally by the Meshing application to

determine whether the face is mappable.)

3Reversal

The following sections describe the general effect of the End, Side, and Corner vertex types on the shape

of the face mesh in the vicinity of a specified vertex.

End Vertex Type

When you specify a vertex as the End vertex type (Specified Ends control), the Meshing application

creates the face mesh such that only two mesh element edges intersect at the vertex (see (a) in Figure: Face

Vertex Types (p. 172)). As a result, the mapped and submapped face mesh patterns on both sides of the

End vertex terminate at the edges adjacent to the vertex. Assigning the End vertex type to a vertex

whose adjacent edges form an angle greater than 180° will likely result in mesh failure.

Side Vertex Type

When you specify a vertex as the Side vertex type (Specified Sides control), the Meshing application

creates the face mesh such that three mesh element edges intersect at the vertex (see (b) in Figure: Face

Vertex Types (p. 172)). The Meshing application treats the two topological edges that are adjacent to the

vertex as a single edge for the purposes of meshing.
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Corner Vertex Type

When you specify a vertex as the Corner vertex type (Specified Corners control), the Meshing application

creates the face mesh such that four mesh element edges intersect at the vertex (see (c) in Figure: Face

Vertex Types (p. 172)). Assigning the Corner vertex type to a vertex whose adjacent edges form an angle

less than 180° will create an unnecessarily bad quality mesh (although the mesh will be valid).

Effect of Vertex Type on Face Meshes

As an example of the general effects of vertex types on face meshes, consider the planar face shown in

Figure: Seven-sided Planar Face (p. 173). The following two examples illustrate the effects of different vertex

type specifications applied to vertices C, F, and G on the shape of the resulting mesh.

Figure: Seven-sided Planar Face

In Figure: Example Face Mesh—Side Inside Corner Vertex (p. 174), vertices C, F, and G are specified as Side vertices;

therefore, the Meshing application treats sides BCD and EFGA as if each were a single edge. As a result, the

entire face represents a mappaple region, and the Meshing application creates a single checkerboard pattern

for the mesh.
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Figure: Example Face Mesh—Side Inside Corner Vertex

In Figure: Example Face Mesh—Corner Inside Corner Vertex (p. 174), vertices C, F, and G are specified as Corner,

Side, and End type vertices, respectively. As a result, the face is submappable, and the Meshing application

creates two separate checkerboard patterns for the mesh. The upper-left submapped region is defined by

the polygon ABCHFG. The lower-right submapped region is defined by CDEH. For both regions, the node at

point H serves as an End type vertex for the purposes of mesh creation.

Figure: Example Face Mesh—Corner Inside Corner Vertex

Setting Advanced Mapped Face Meshing Controls

This section describes the basic steps for setting advanced mapped face meshing controls.

To set advanced mapped face meshing controls:

1. Insert a mapped face meshing control by highlighting Mesh in the Tree and right-clicking to view the

menu. Select Insert> Mapped Face Meshing.
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2. Select the face upon which the vertex types are to be defined by scoping the face in the Mapped

Face Meshing Details View. (Refer to Selecting the Face (p. 171) for more information.)

3. For the Definition> Method control, choose Quadrilaterals or Triangles: Best Split.

4. Enter additional Definition settings, as desired, in the Details View.

5. Use the Specified Sides, Specified Corners, and Specified Ends controls in the Advanced section of

the Details View to select the desired vertices in the Geometry window and apply your selections. To

do so, pick the desired vertex/vertices in the Geometry window and then click on the Specified Sides,

Specified Corners, or Specified Ends control to assign the vertex/vertices to the desired vertex type.

(Refer to Selecting the Vertex Type and Picking Vertices (p. 171) for more information.)

Note

If you select a vertex by mistake and want to de-select it, click the control in question in

the Advanced section of the Details View, clear the selection by clicking in an “empty”

portion of the Geometry window, and then click Apply. For example, assume that you

mistakenly selected 1 vertex for the Specified Corners control. To clear the selection:

• In the Specified Corners control in the Advanced section of the Details View, click on

your selection (that is, the text “1 Vertex”).

The Apply/Cancel buttons will appear in the Specified Corners control and the vertex

will be highlighted in green in the Geometry window.

• Click in an empty portion of the Geometry window.

• Click Apply in the Specified Corners control.

Note

An individual vertex may possess as many vertex type designations as the number of faces

to which it is attached. For example, it is possible for a vertex to possess a Side type desig-

nation with respect to one face and an End type designation with respect to another, as

long as two separate Mapped Face Meshing controls are defined for the two faces. Con-

versely, a single Mapped Face Meshing control cannot specify the same vertex as more

than one vertex type. That is, you cannot designate a vertex as type Side and also designate

that same vertex as type End in a single Mapped Face Meshing control. If you attempt to

do so, the second and any subsequent assignments for that vertex will result in the control

being highlighted in yellow in the Advanced section of the Details View, and you will not

be able to generate a mesh. If this occurs, use the procedure noted above to de-select the

unwanted vertex assignment(s).

6. Generate the mesh by right-clicking the Mesh object in the Tree and selecting Generate Mesh.

Notes on the Mapped Face Meshing Control

Keep the following notes in mind when using the Mapped Face Meshing control:

• The blue status icon that may appear in the Tree Outline indicates that a mapped mesh cannot be

provided on the scoped topology. One of three scenarios triggers the icon:

1. The face cannot be map meshed.
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2. The quality of the mapped mesh was not acceptable and a free mesh was generated.

3. If Constrain Boundary is set to Yes, the mesher will fail if the boundary of a mapped mesh needs

to be modified.

• To assist you in working with Mapped Face Meshing, you may want to use the Show Mappable Faces,

Show Sweepable Bodies, and/or Preview Surface Mesh features. The Show Mappable Faces feature

selects all mappable faces automatically and highlights them in the Geometry window. By using the

Show Sweepable Bodies feature, you can find out whether bodies are sweepable (before and after

modifying vertex types). By using the Preview Surface Mesh feature, you can verify that your mesh

settings are correct.

• For a faceted surface made up of two loops to be map meshed, a Mapped Face Meshing control must

be scoped to it.

• When the Mapped Face Meshing control is scoped to faces made up of two loops, the Radial Number

of Divisions field is activated. This specifies the number of divisions across the annular region when

sweeping. Refer to Setting Basic Mapped Face Meshing Controls (p. 168) for more information.

• When sweeping:

– If the sweep method is applied to a body and a Mapped Face Meshing control is defined for either

the body's source or target face, the sweep mesher will fail if a mapped mesh cannot be obtained

for the face.

– When a side face has a Mapped Face Meshing control, the mapped mesher will loosen its tolerances

on determining whether a face is mappable.

– When sweeping and using advanced mapped meshing controls, you must set vertex types for both

the source and target faces.

• When a face has only 4 vertices and 4 edges, and a Mapped Face Meshing control is applied, the only

factor that will determine a successful mapped mesh is element quality.

Note

It is often helpful to use the Show Vertices option to ensure edges are complete and do

not have unintended segmentation. If an edge is segmented, it could mean that a face you

think should be successfully mapped actually has 5 vertices and 5 edges. To help resolve

such issues, you can define a virtual edge or use advanced mapped meshing controls.

• An effective technique for mapped meshing on surface bodies is to select all faces on the body and let

the mesher determine which faces should be map meshed and which faces should be free meshed.

• The Mapped Face Meshing control is not supported for CutCell meshing.

Mapped Face Meshing Limitations

The Mapped Face Meshing control attempts to generate a mapped mesh on all selected faces. It does this

through either one or multiple mapped regions (also called submappable regions). Be aware of the following

limitations when using Mapped Face Meshing:

• Circular faces are not supported.

• Triangular faces (i.e., faces with three vertices) are not supported.

• Faces with internal cutout regions cannot be submapped. Exceptions include a face having only one

cutout, as long as the face is square-like with a square-shaped hole, or an annulus.
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Match Control

The Match Control matches the mesh on two faces or two edges in a model. The Meshing application

provides two types of match controls—cyclic and arbitrary.

The Match Control is supported for the following mesh methods:

Volume Meshing:

• Sweep

• Patch Conforming

Surface Meshing:

• Quad Dominant

• All Triangles

Keep the following information in mind when using the match control feature:

• Edge meshes are matched for sheet, 2D, and 3D bodies. Face meshes are matched across bodies. Match

controls cannot be applied across multiple parts.

• The two faces or edges that you select must be topologically and geometrically the same (that is, after

rotation or translation, they are an exact match).

• Use care when defining match controls. Although a face or edge in a model may look like it is the same

as another face or edge in the model and therefore would be honored by matching, in many cases the

two entities are not the same and the match fails.

• Multiple match controls may be associated with a single entity, resulting in conflicts among match

controls. If a conflict occurs, the Meshing application issues an error message, and matching fails. For

example, a match control conflict may occur if the two faces adjacent to an edge have two different

match controls applied to them.

• A match control can only be assigned to one unique face pair. Assigning the same face as High/Low

Geometry in more than one match control is not supported. If multiple match controls assign the same

face as a High/Low Geometry entity, the match control that appears lowest in the Tree is honored.

• Match controls are not respected with refinement or adaptivity.

• When match is used with the Advanced Size Function, the effect of a sizing on the high or low side will

be transferred through the Advanced Size Function bidirectionally from the high side to the low side

and vice versa. This means that if the low side has a sizing control and the high side does not, the Ad-

vanced Size Function will use the low sizing control on the high side.

• Match controls on faces are supported with Pre inflation, regardless of whether inflation is set to Program

Controlled or has been set through any global or local inflation definition. In contrast, match controls

on edges are not supported with Pre inflation. Match controls (both faces and edges) are not supported

with Post inflation. For all these non-supported cases, ANSYS Workbench automatically suppresses/disables

the Match Control feature.

• Match controls on faces are not supported for sheet models meshed with the Quad Dominant mesh

method.

• Match controls are not enforced when previewing inflation.

• You cannot apply a match control to topology on which a face-edge pinch, mesh connection, or symmetry

control has been applied. In cases involving a match control and a pinch control, the match control will
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be suppressed and the reason (Overridden) will be reported in the Active read-only field in the Details

View. In cases involving match with either mesh connection or symmetry, an error message will be issued.

• Match controls are not supported for CutCell meshing.

• Match controls can be used with thin sweeping, as shown in the figures below. In the figure on the left,

a match control was applied to the top and bottom faces. In the figure on the right, a match control

was applied to the side faces.

Match control topics include:

Cyclic Match Control

Arbitrary Match Control

Note

For general information on applying match controls in combination with the various mesh

method controls, refer to Mesh Control Interaction Tables (p. 261).

Cyclic Match Control

The cyclic matching process involves copying the mesh of the first selected face or edge in the Match

Control (the High Geometry Selection scoped in the Details View of the Match Control) to the second

selected face or edge in the control (the scoped Low Geometry Selection).

To apply the Match Control, select the high and low faces or edges of interest, in that order. Then, choose

Match Control from the Mesh Control drop down menu, or from the context menu through a RMB click

on a Mesh object (Insert> Match Control). In the Details View, you must then select Cyclic as the Trans-

formation type and a coordinate system with its z-axis aligned to the axis of rotation for the geometry. A

small blue status icon ( ) appears to the left of the Match Control object icon in the Tree Outline if the

Match Control fails on the face or edge pair.

When a cyclic Match Control is used together with Sizing controls, the controls on the high side have the

higher precedence. Whatever controls are on the high face or edge will be honored on the low face or edge

in the Match Control. Sizing controls applied to the low face or edge will be honored only if the high side

does not have the same controls, and only if the sizing is applied directly on the low topology (that is, applying

the sizing on connected topologies will have no effect).

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.178

Local Mesh Controls



Note

The Meshing application inserts match controls for periodic regions automatically. See the Match

Meshing and the Symmetry Folder (p. 251) section for more information.

Arbitrary Match Control

This feature lets you select two faces or two edges in a model to create a match control that will consequently

generate exactly the same mesh on the two faces or edges. However, unlike cyclic match controls, which

require you to select a coordinate system with its z-axis of rotation aligned to the geometry's axis of rotation,

for arbitrary match controls the two faces or edges to be matched can be arbitrarily located, and the match

control is based on two coordinate systems that you select.

The steps for defining an arbitrary match control are presented here.

To define an arbitrary match control:

1. Insert a Match Control object in the Tree Outline by selecting the desired face(s) or edge(s) in the

Geometry window, right-clicking, and choosing Insert> Match Control.

Note

If you select two faces or two edges, the first is automatically assigned to be the High

Geometry Selection and the second is assigned to be the Low Geometry Selection. If you

select only one face or edge, it is automatically assigned to be the High Geometry Selection.

2. If you did not already do so in step 1, select the low geometry face or edge in the Geometry window

and click on Low Geometry Selection in Details> Scope.

Note

As an alternative to steps 1 and 2, you can insert a Match Control object by right-clicking

on the Mesh object and choosing Insert> Match Control from the context menu, or by

clicking Mesh Control on the toolbar and choosing Match Control from the menu. Then

scope the high and low geometry selections and continue with the steps below.

3. Change the value of the Transformation control to Arbitrary.

4. Choose the coordinate systems for the selected high and low geometry entities. The applicable settings

in the Details View are:

• High Coordinate System: Choose the coordinate system for the face/edge assigned by the High

Geometry Selection control.

• Low Coordinate System: Choose the coordinate system for the face/edge assigned by the Low

Geometry Selection control.
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Note

All the coordinate systems currently defined for the model appear in the High Coordinate

System and Low Coordinate System drop-down menus. You may choose coordinate systems

from the list, or you may need to define additional coordinate systems. In order for the

match control to be honored, the coordinate systems that you choose must be defined

such that a valid transformation matrix can be calculated. In other words, the two coordinate

systems must be created such that when the coordinates of every point of the Low Geo-

metry Selection in the Low Coordinate System are placed into the High Coordinate

System, the two faces/edges match exactly. Refer to the Coordinate Systems Overview in

the Mechanical help for information on coordinate systems and how to create them.

5. By default, the Control Messages control is set to No and is read-only. It is activated only when a

message is generated.

6. Generate the mesh by right-clicking on the Mesh object and selecting Generate Mesh from the context

menu.

Note

When a match is successful, the number of elements in the matched faces/edges will be

the same, and there will be a direct one-to-one mapping between their nodes. If the mesh

is generated but the match was unsuccessful, a small blue status icon ( ) displays to the

left of the Match Control object icon in the Tree Outline.

The figures below show an example of arbitrary mesh matching. Figure: Coordinate Systems for Arbitrary Mesh

Matching (p. 180) shows the selected coordinate systems, and Figure: Matched Mesh (p. 181) shows the resulting

matched mesh. Edge and face sizings were also applied.

Figure: Coordinate Systems for Arbitrary Mesh Matching
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Figure: Matched Mesh

Pinch Control

The Pinch control lets you remove small features (such as short edges and narrow regions) at the mesh

level in order to generate better quality elements around those features.

When Pinch controls are defined, the small features in the model that meet the criteria established by the

controls will be “pinched out,” thereby removing the features from the mesh. You can instruct the Meshing

application to automatically create pinch controls based on settings that you specify (as described in Pinch

Control Automation Overview (p. 93)), or you can manually designate the entities to be pinched, as described

below in Defining Pinch Controls Locally (p. 181).

Local pinch control topics include:

Defining Pinch Controls Locally

Changing Pinch Controls Locally

For an overview of pinch controls and details on pinch control automation, refer to Pinch (p. 90). For general

information on applying pinch controls in combination with the various mesh method controls, refer to

Mesh Control Interaction Tables (p. 261). For general information about pinch control usage, see Usage Inform-

ation for Pinch Controls (p. 97).

Defining Pinch Controls Locally

This section describes the steps for defining pinch controls locally.

To define pinch controls locally:

1. Click the Mesh folder in the Tree Outline. Right-click and select Insert > Pinch from the context menu.

Or

Click Mesh Control on the toolbar and choose Pinch from the menu.

A pinch control object is inserted into the Tree.

2. In the Geometry window, pick one or more faces, one or more edges, or one vertex that you want to

define as the master(s). (A master geometry is an entity that retains the profile of the original geometry.)

Refer to Pinch (p. 90) for a table that summarizes the valid entities you can pick for each type of pinch

control.

3. Use either of these methods to apply your selection:
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Right-click in the Geometry window to display the context menu and select Set As Pinch Master.•

• Click in the Master Geometry field in the Details View.

The pinch region is flagged in the Geometry window. The color of each selected entity changes to

blue to identify it as master geometry. If you want to adjust your selections, you can re-pick geometry

and then apply the new selections to overwrite the existing master geometry. If using the context

menu method to apply selections, you can also pick additional geometry and select Add To Pinch

Master to add the geometry to the existing master geometry. Also see Changing Pinch Controls Loc-

ally (p. 183).

4. In the Geometry window, pick one or more edges or vertices that you want to define as the slave(s).

(A slave geometry is an entity that changes in order to move towards the master geometry. Depending

on the tolerance, the pinch control will pinch out the entire slave entity or only a portion of the slave

entity into the master. Faces cannot be defined as slaves.)

5. Use either of these methods to apply your selection:

• Right-click in the Geometry window to display the context menu and select Set As Pinch Slave.

• Click in the Slave Geometry field in the Details View.

The color of each selected edge/vertex changes to red to identify it as slave geometry. If you want to

adjust your selections, you can re-pick geometry and then apply the new selections to overwrite the

existing slave geometry. If using the context menu method to apply selections, you can also pick ad-

ditional geometry and select Add To Pinch Slave to add the geometry to the existing slave geometry.

Also see Changing Pinch Controls Locally (p. 183).

6. Change the value of the Suppressed control if desired.

By default, the value of Suppressed is No. If you change the value to Yes, this pinch control has no

effect on the mesh (that is, the small features you picked for this pinch control are not removed and

will affect the mesh). In addition, an Active control with a read-only setting of No, Suppressed appears

under the Suppressed control when Suppressed is set to Yes.

7. Change the value of the Tolerance control if desired.

By default, the value of Tolerance is based on the global pinch control tolerance. If you specify a dif-

ferent value here, it overrides the global value.

8. Change the value of the Snap to Boundary control if desired.

By default, the value of Snap to Boundary is Yes. Snap to Boundary is applicable only for pinch

controls in shell models for which a face has been defined as the master geometry and one or more

edges are defined as the slave(s). In such cases, when the value of Snap to Boundary is Yes and a

slave edge is very close to the boundary of the master face, nodes from the slave edge are projected

onto the boundary of the master face. The joined edge will be on the master face along with other

edges on the master face that fall within the defined pinch control tolerance. Refer to the figures below

to see the effect of the Snap to Boundary setting.

Note

When you define a pinch control locally, the value of Scope Method is Manual (read-only). If

you make changes to a pinch control that was created through pinch control automation, the

value of the Scope Method field for that pinch control changes from Automatic to Manual.

Figure: Snap to Boundary Set to Yes (p. 183) shows the mesh when Snap to Boundary is set to Yes (default).
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Figure: Snap to Boundary Set to Yes

Figure: Snap to Boundary Set to No (p. 183) shows the mesh for the same model when Snap to Boundary is

set to No.

Figure: Snap to Boundary Set to No

Changing Pinch Controls Locally

This section describes the steps for changing pinch controls locally. You can make changes to pinch controls

regardless of whether they were created automatically or manually. You can select multiple pinch controls

to make the same changes to all selected pinch controls at one time.
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To change pinch controls locally:

1. In the Tree Outline, select the pinch control(s) that you want to change.

2. In the Geometry window, pick one or more faces, one or more edges, or one vertex that you want to

define as master(s). Refer to Pinch (p. 90) for a table that summarizes the valid entities you can pick

for each type of pinch control.

3. Use either of these methods to apply your selection:

• Right-click in the Geometry window to display the context menu and select Set As Pinch Master

or Add To Pinch Master.

• Click in the Master Geometry field in the Details View.

The pinch region is flagged in the Geometry window. The color of each selected entity changes to

blue to identify it as master geometry. If you want to further adjust your selections, you can re-pick

geometry and then apply the new selections to overwrite or add to the existing master geometry. To

add to the geometry, you must use Add To Pinch Master in the context menu.

4. In the Geometry window, pick one or more edges or vertices that you want to define as slave(s). (Faces

cannot be defined as slaves.)

5. Use either of these methods to apply your selection:

• Right-click in the Geometry window to display the context menu and select Set As Pinch Slave

or Add To Pinch Slave.

• Click in the Slave Geometry field in the Details View.

The color of each selected edge/vertex changes to red to identify it as slave geometry. If you want to

further adjust your selections, you can re-pick geometry and then apply the new selections to overwrite

or add to the existing slave geometry. To add to the geometry, you must use Add To Pinch Slave in

the context menu.

6. Change the value of the Suppressed control if desired.

By default, the value of Suppressed is No. If you change the value to Yes, this pinch control has no

effect on the mesh (that is, the small features you picked for this pinch control are not removed and

will affect the mesh). In addition, an Active control with a read-only setting of No, Suppressed appears

under the Suppressed control when Suppressed is set to Yes.

7. Change the value of the Tolerance control if desired.

By default, the value of Tolerance is based on the global pinch control tolerance. If you specify a dif-

ferent value here, it overrides the global value.

8. Change the value of the Snap to Boundary control if desired.

By default, the value of Snap to Boundary is Yes. Snap to Boundary is applicable only for pinch

controls in shell models for which a face has been defined as the master geometry and one or more

edges are defined as the slave(s). In such cases, when the value of Snap to Boundary is Yes and a

slave edge is very close to the boundary of the master face, nodes from the slave edge are projected

onto the boundary of the master face. The joined edge will be on the master face along with other

edges on the master face that fall within the defined pinch control tolerance. Refer to Figure: Snap to

Boundary Set to Yes (p. 183) and Figure: Snap to Boundary Set to No (p. 183) to see the effect of the setting.
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Note

If you make changes to a pinch control that was created through pinch control automation, the

value of the Scope Method field for that pinch control changes from Automatic to Manual.

Inflation Control

Inflation is useful for CFD boundary layer resolution, electromagnetic air gap resolution or resolving high

stress concentrations for structures. It is supported for the mesh methods listed in the section Inflation

Group (p. 67). You can use local inflation mesh controls to apply inflation to specific boundaries. When an

inflation control is scoped to a solid model, every scoped geometry must have a boundary defined for it.

The settings of the local inflation controls will override global inflation control settings.

You can define local inflation controls either by inflating a method or by inserting individual inflation controls.

Inflating a Method

1. Insert a mesh method.

2. Associate (scope) the desired bodies with the method.

3. Right-click on the method and choose Inflate This Method from the menu.

Note

For example, if you click the right mouse button on a Tetrahedrons method control, or on

a Sweep method control and specify the source, an Inflate This Method menu option is

available. Choosing this option inserts an inflation control on every body to which the

Tetrahedrons meshing method with the selected Algorithm is applied, or on every face

to which the Sweep method is applied. Similarly, an inflation control will be inserted into

the Tree Outline for each body/face. (Sweeping with inflation is the same as inflation with

tetrahedrons except that with sweeping you pick faces and edges instead of bodies and

faces.)

4. Highlight one of the inflation controls that was inserted into the Tree Outline.

5. Change the value of the Suppressed control if desired.

By default, the value of Suppressed is No. If you change the value to Yes, this inflation control has

no effect on the mesh. In addition, an Active control with a read-only setting of No, Suppressed appears

under the Suppressed control when Suppressed is set to Yes.

6. Use either of these methods to specify the inflation boundaries:

• In the Details View, set Boundary Scoping Method to Geometry Selection, pick the entities in

the Geometry window, and click the Boundary field in the Details View to Apply.

• In the Details View, set Boundary Scoping Method to Named Selections, select a Named Selection

from the Boundary drop-down, and press Enter.
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Note

– To select multiple Named Selections to be used as inflation boundaries, press and

hold the CTRL key while selecting the Named Selections from the Boundary drop-

down, and then press Enter.

– If none of the predefined Named Selections include the correct topology to be used

as an inflation boundary, no Named Selections will be available in the drop-down.

For example, if you scoped a surface body with the method in step 2, a Named Se-

lection containing an edge must exist. Otherwise, you cannot select anything from

the drop-down.

7. Specify additional inflation options as desired. For descriptions of additional options, refer to Inflation

Group (p. 67).

8. Repeat steps 4 through 7 for each inflation control in the Tree Outline.

Inserting Individual Inflation Controls

1. Optionally, select the desired bodies or faces in the Geometry window.

2. Use either of these methods to insert the inflation control:

• Click Mesh Control on the toolbar and choose Inflation from the menu.

• Right-click in the Geometry window and choose Insert > Inflation from the menu.

3. If you selected the bodies or faces in step 1, go directly to step 4. If not, use either of these methods

to scope inflation to the desired bodies or faces:

• In the Details View, set Scoping Method to Geometry Selection, pick the entities in the Geometry

window, and click the Geometry field in the Details View to Apply.

• In the Details View, set Scoping Method to Named Selection, and select a Named Selection from

the Named Selection drop-down.

4. Change the value of the Suppressed control if desired.

By default, the value of Suppressed is No. If you change the value to Yes, this inflation control has

no effect on the mesh. In addition, an Active control with a read-only setting of No, Suppressed appears

under the Suppressed control when Suppressed is set to Yes.

5. Use either of these methods to specify the inflation boundaries:

• In the Details View, set Boundary Scoping Method to Geometry Selection, pick the entities in

the Geometry window, and click the Boundary field in the Details View to Apply.

• In the Details View, set Boundary Scoping Method to Named Selections, select a Named Selection

from the Boundary drop-down, and press Enter.
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Note

– To select multiple Named Selections to be used as inflation boundaries, press and

hold the CTRL key while selecting the Named Selections from the Boundary drop-

down, and then press Enter.

– If none of the predefined Named Selections include the correct topology to be used

as an inflation boundary, no Named Selections will be available in the drop-down.

For example, if you selected a face in step 1, a Named Selection containing an edge

must exist. Otherwise, you cannot select anything from the drop-down.

6. Specify additional inflation options as desired. For descriptions of additional options, refer to Inflation

Group (p. 67).

Notes on Defining 2D Local Inflation

In most cases, the controls in the Inflation group apply to both 3D and 2D inflation. Special considerations

for defining 2D local inflation are described here.

The ability to define 2D (face) inflation is not supported for CutCell meshing.

When defining 2D local inflation, only two options are available for the Inflation Option control: First Layer

Thickness and Total Thickness. (Smooth Transition, First Aspect Ratio, and Last Aspect Ratio are not

supported.)

• If you select First Layer Thickness, you must set values for First Layer Height (p. 74), Maximum Lay-

ers (p. 73), and Growth Rate (p. 73). The value of Growth Rate is used to calculate the heights of the

successive layers, as follows:

Growth Rate = hn+1 / hn

where hn = height of layer n

• If you select Total Thickness, you must set values for Number of Layers (p. 73), Growth Rate (p. 73), and

Maximum Thickness (p. 73). The first layer height is computed based on these three values. The heights

of the successive layers are computed using the same formula shown above under First Layer Thickness.

If you are using the Quadrilateral Dominant mesh method with inflation and the Advanced Size Function is

on, the mesh size of the last inflation layer will be used for the corresponding Quadrilateral Dominant

boundary mesh size.

Notes on Local Inflation Controls

To make inflation boundary selection easier, select View > Annotations from the Main Menu to toggle the

visibility of annotations in the Geometry window. For example, after scoping inflation to a body, the body

will be displayed using a blue solid annotation. Select View > Annotations to turn off the annotations; then

select the desired faces as boundaries. For picking internal faces, the Hide Faces right mouse button option

may help you to see inside a body. For example, you can select external faces in the Geometry window and

then use the Hide Faces option to hide the selected faces (making it easier to select the internal faces).

Multiple Inflation controls can be scoped to the same body or face with different inflation options on the

faces/edges.
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If the mesh method is Automatic, the Patch Conforming tetrahedron method will be used for inflation on

a body and the Sweep method will be used for inflation on a face.

In the following scenarios, using inflation results in automatic suppression of the refinement control:

• When automatic inflation (either Program Controlled (p. 69) or All Faces in Chosen Named Selection (p. 70))

is used with refinement in the same model

• When local inflation is used with refinement in the same body or in the same part

For information on setting global inflation controls and descriptions of all of the individual inflation controls,

refer to Inflation Group (p. 67). For steps to follow to assign inflation depending on the selected mesh

method, refer to Inflation Controls (p. 244). For general information on applying inflation controls in combin-

ation with the various mesh method controls, refer to Mesh Control Interaction Tables (p. 261).

Gap Tool

The Gap Tool is applicable to Electromagnetic simulations where a refined mesh is required across an air

gap in order to obtain accurate solutions. Typical applications are refined meshing in the air gap enclosure

region of an actuator, or the air gap enclosure region between a rotor and a stator of a rotating machine.

The tool identifies face/face pairs in a multibody part and creates gap sizing controls for meshing. Within a

Gap Tool object, you can specify settings for sizing on the bodies adjacent to the gap and for refinement

of the mesh in the air gap.

Note

All Gap Tool controls and settings discussed in the following procedure are displayed only when

the model includes an enclosure from the DesignModeler application.

Using the Gap Tool

The steps for using the Gap Tool are presented here.

To use the Gap Tool:

1. Insert a Gap Tool object in the tree using one of the following procedures:

• Choose Mesh Control> Gap Tool on Mesh context toolbar.

• Click right mouse button on Mesh object (or any mesh control tool object)> Insert> Gap Tool.

2. Enter the width of the gap region between bodies (in your working units or as an existing CAD para-

meter). This entry represents the range for multiple gaps, or equals a single gap distance that varies

about a certain tolerance. Your mesh density in the air gap is a direct function of the Gap Distance

so your gap size should be quite accurate.
1

The applicable settings in the Details View are the following:

• Define By: Choose Range (default) if you will be entering numerical values, or CAD Parameters

if you will be entering parameters to define the values.

• Minimum: The lower end of the range for multiple gaps, or the single gap distance.

• Maximum: (Optional) The upper end of the range for multiple gaps, or the single gap distance

tolerance.
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After you set the gap distance, a crosshair appears adjacent to the cursor in the Geometry window.

The crosshair is surrounded by a circle. The radius of the circle is a graphical indication of the maximum

gap distance. The radius will change if you change this distance. The circle also appropriately adjusts

when the model is zoomed in or out.

3. Click the right mouse button on the Gap Tool object and choose Create Gap Sizes from the context

menu. Workbench searches the model to find all occurrences of face pairs separated by the gap distance

you specified. All face pairs within an absolute distance from the minimum gap distance to the max-

imum gap distance will have controls generated. Each occurrence of the gap face pairs is inserted as

a Gap Sizing object under the Gap Tool object. By changing to Wireframe mode (Graphics toolbar)

and clicking through each Gap Sizing object, you can visually inspect the selected gap face pairs for

use in mesh refinement.

Note

If you open a version 9.0 database file that includes Gap Sizing objects, Gap Tool object(s)

are created automatically. These Gap Tool object(s) are reported in the tree with a yellow

lightning bolt status, meaning that the items are not in a valid state.

4. Right mouse click on Mesh object and choose Generate Mesh from the context menu.

5. Use the following controls to adjust the degree of sizing and mesh refinement, as needed, for the gap

face pairs. These controls appear in the Details View of the Gap Tool object.

• Gap Aspect Ratio: Slider control that adjusts the aspect ratio of elements in the gap between

faces. The ratio represents the length of an element edge parallel to the face pairs, to the width

of the element perpendicular to the face pairs. A lower ratio (for example, 1:1) will produce signi-

ficantly more elements than a higher ratio (for example, 4:1), but will generate better quality ele-

ments. A good compromise is a value of 3:1 (default).

• Gap Density: Controls the number of elements spanning the width of the air gap between the

face pairs. The Coarse option (default) attempts to place at least two elements through the gap

width, the Fine option attempts to place three to four elements through the gap width.

• Generate on Update: Controls whether the Gap Sizing objects are regenerated when the simulation

is updated from the geometry. By default the Gap Sizing objects are regenerated at their default

settings. You may choose to not update a Gap Sizing object by selecting No. The No option will

freeze the Gap Sizing object's face pairs and settings. This option will only work properly if there

are no topology changes for the face pairs during a geometry update. The Generate on Update

feature default setting is most applicable to rotating machines where the gap distance is constant

but the Gap Sizing object face pairs may change due to alignment. For linear devices (actuators),

the No option may be preferred since the gap distance may change during a geometry update,

but the face pairs will likely remain unchanged.
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Note

For many applications, a typical Gap Aspect Ratio setting of 3:1 and Gap Density set to

Coarse will produce good results. You may need to adjust the Curv/Proximity setting (refer

to the description of Curvature and Proximity Refinement for related information) in order

to get a mesh. If this does not work, you may need to adjust the Gap Aspect Ratio or Gap

Density settings or apply other size controls to the model.

The Generate on Update field should be set to No to generate gap sizing controls with

multiple gap distances. Use multiple Gap Tool objects in this situation.

Note

Make sure that your maximum gap size is the actual gap size. A gap size that is

too large will cause a meshing failure or incorrect size distribution.

1 - Algorithmic Notes

The size on the face pairs in regions that lie within the specified gap distance is determined

as follows:

Size = dG*GA

where:

dG = the maximum Gap Distance

GA = the Gap Aspect Ratio

Mesh refinement occurs across the gap on tetrahedron that lie within the gap.

If you have a very small gap, keep in mind that the original size on the faces of the bodies

adjacent to the gap will be computed as described above. These elements may be difficult

or impossible to refine if the gap is very small.
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Options

You can control the behavior of functions in the Meshing application through the Options dialog box. For

more information, refer to:

Accessing the Options Dialog Box

Common Settings Option on the Options Dialog Box

Meshing Options on the Options Dialog Box

Accessing the Options Dialog Box

To access the Meshing application options:

1. From the main menu, choose Tools> Options. An Options dialog box appears and the options are

displayed on the left.

2. Click on a specific option (for example, Meshing).

3. Change any of the option settings by clicking directly in the option field on the right. You will first see

a visual indication for the kind of interaction required in the field (examples are drop-down menus,

secondary dialog boxes, direct text entries).

4. Click OK.

Note

• To cancel your changes and restore the default settings, click Reset on the Options dialog

box.

• Option settings within a particular language are independent of option settings in another

language. If you change any options from their default settings, then start a new Workbench

session in a different language, the changes you made in the original language session are

not reflected in the new session. You are advised to make the same option changes in the

new language session.

Common Settings Option on the Options Dialog Box

The following Common Settings option appears in the Options dialog box:

Geometry Import

The Geometry Import category includes the following:

• Compare Parts on Update: When you choose the Refresh Geometry context menu option (right-click

on the Geometry tree object or anywhere in the Geometry window), if no changes to the body are

detected, then the body is not re-meshed.
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Note

A change that you make to the Compare Parts on Update option in one application is not

seen by other applications that are running. For example, if you change this option from

within Mechanical or Meshing, and DesignModeler is running, the option change is not seen

in DesignModeler.

Meshing Options on the Options Dialog Box

The Meshing application options that appear in the right side of the Options dialog box are further divided

into the following categories: Meshing, Virtual Topology, Sizing, and Inflation.

Meshing

• Show Meshing Options Panel at Startup: Controls whether the Meshing Options panel appears at

startup of the Meshing application. Choices are Yes and No. The default value is Yes.

• Relevance: Allows setting of the default mesher, known as relevance. The Details View default is 0, but

it can be changed here. The range is from -100 (high speed solution, coarser mesh, less accuracy) to

+100 (slower speed solution, finer mesh, higher accuracy).

• Allow Direct Meshing: Allows/disallows direct meshing. Choices are Yes and No. The default value is

Yes. Refer to Direct Meshing (p. 239) for details.

• Unmeshable Areas: Highlights the problematic areas encountered when meshing. There is no counterpart

setting in the Details View. The choices are:

– Show First Failed (default)

– Show All Failed

This only affects Patch Conforming methods.

• Number of Retries: Sets the default for the Number of Retries control in the Advanced group under

the Details View. Refer to Number of Retries (p. 88) for details.

• Extra Retries For Assembly: Sets the default for the Extra Retries For Assembly control in the Advanced

group under the Details View. Choices are Yes (default) and No. Refer to Extra Retries For Assembly (p. 89)

for details.

• Number of CPUs : Specifies the number of processors to be used by the meshing operation. There is

no counterpart setting in the Details View. Specifying multiple processors will enhance the performance

of the Uniform Quad, Uniform Quad/Tri, Patch Independent Tetra, and MultiZone mesh methods.

This option has no effect when other mesh methods are being used. You can specify a value from 0 to

256 or accept the default. The default is 0, which means the number of processors will be set automat-

ically to the maximum number of available CPUs. The Number of CPUs  option is applicable to same

machine parallel (SMP) meshing (multiple cores; not supported for clusters).

• Default Physics Preference: Sets the default option for the Physics Preference in the Details View of

a Mesh object. Choices are Mechanical, Electromagnetics, CFD, and Explicit.

• Default Method: Sets the default Method setting in the Details View of a Method control object.

Choices are Automatic (Patch Conforming/Sweeping), Patch Independent, and Patch Conforming.

When the geometry is attached, the default method of all options except Automatic will be scoped to

all parts in the assembly. The Automatic option has no effect.
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Note

Changing the Default Method changes the default mesh method for all future analyses, re-

gardless of analysis type.

• Verbose Messages from Meshing: Controls the verbosity of messages returned to you. If set to On

and you are meshing a subset of bodies, the message “These bodies are going to be meshed” appears,

and you can click the right mouse button on the message to see the bodies. The default is Off. Regardless

of the setting, when meshing completes and any bodies failed to mesh, the message “These bodies

failed to be meshed” appears, and you can click the right mouse button to see them.

Virtual Topology

• Merge Edges Bounding Manually Created Faces: Sets the default value for the Merge Face Edges?

setting in the Details View of a Virtual Topology object. Choices are Yes and No. The default value is

Yes.

Sizing

• Use Advanced Size Function: Sets the default value for the Use Advanced Size Function setting in

the Details View of a Mesh object. Choices are Off (the default), On: Proximity and Curvature, On:

Proximity, On: Curvature, and On: Fixed.

Inflation

Inflation-related options that can be set on the Options dialog box include:

• Maximum Height over Base

• Gap Factor

• Growth Rate Type

• Maximum Angle (Degrees)

• Fillet Ratio

• Use Post Smoothing

• Smoothing Iterations
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Specialized Meshing

You can use the meshing features in Workbench to perform various types of specialized meshing. For more

information, refer to:

Mesh Sweeping

MultiZone Meshing

CutCell Meshing

Direct Meshing

Inflation Controls

Mesh Refinement

Mixed Order Meshing

Air Gap Meshing

Contact Meshing

Winding Body Meshing

Wire Body Meshing

Pyramid Transitions

Match Meshing and the Symmetry Folder

Rigid Body Meshing

Thin Solid Meshing

CAD Instance Meshing

Meshing and Hard Entities

Baffle Meshing

Mesh Sweeping

This method of meshing complements the free mesher. If a body's topology is recognized as sweepable,

the body can be meshed very efficiently with hexahedral and wedge elements using this technique. The

number of nodes and elements for a swept body is usually much smaller than ones meshed with the free

mesher. In addition, the time to create these elements is much smaller.

Workbench will automatically check to see if the body fulfills the topological requirements for sweeping. It

will then choose two faces that are topologically on the opposite sides of the body. These faces are called

the source and target faces. Workbench will mesh the source face with quadrilateral and triangular faces

and then copy that mesh onto the target face. It then generates either hexahedral or wedge elements con-

necting the two faces and following the exterior topology of the body.

Note

• This information applies to general sweeping. For requirements and usage information spe-

cific to thin model sweeping, see Thin Model Sweeping (p. 199).

• For descriptions of the sweep option settings, see Sweep Method Control (p. 147).

Requirements for General Sweeping

A body cannot be swept if any of these conditions exist:
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• There is a completely contained internal void in the body.

• A source and target pair cannot be found. That is, the sweeper cannot find at least one path from a

source surface to a target surface connected by edges or closed surfaces.

• If a Sizing control is used on a body with hard edge sizing and the source and target faces contain

hard divisions which are not the same for each respective edge.

When sweeping it is only necessary to apply hard divisions to one leg of the sweep path. If the path has

multiple edges, you should apply your controls to that path.

If the sweep path is shared by another body and that path lies on the body's source or target face then

more hard divisions may be needed to constrain the sweeper.

When using Virtual Topology with sweeping, avoid creating virtual cells that result in a fully closed surface.

Fully closed surfaces cause difficulties for the swept mesher and may result in poor meshes. When selecting

adjacent faces for inclusion in a virtual cell, it is best to use Virtual Topology to merge some (but not all) of

the faces. A good approach is to use Virtual Topology for the smaller faces, but omit any larger faces from

the virtual cell.

To preview any bodies that can be swept meshed, click Mesh on the Tree Outline and right-click the mouse.

Select Show> Sweepable Bodies from the context menu to display bodies that fulfill the requirements of

a sweepable body. However, even if these requirements are met, the shape of the body may at times still

result in poorly shaped elements. In these cases, the tetrahedron mesher is used to mesh the body.

The Show Sweepable Bodies feature only displays bodies that can be swept where the source and target

are not adjacent on an axis. It cannot automatically determine axis-sweepable bodies. However, more en-

hanced sweeping capability, including axis-sweeping, is available by using the Sweep option of the Method

mesh control.

For help in diagnosing problems when using the Sweep method, refer to the description of the Edge Color

Option toolbar in the Mechanical help. This toolbar provides access to features that are intended to improve

your ability to distinguish edge and mesh connectivity.

Other Characteristics of General Sweeping

Other characteristics of sweeping include the following:

• The general sweeper ignores the Num Cells Across Gap setting, which is used to help define the

proximity size function.

• Hard entities are not supported for the general sweeper.

• If the sweep method is applied to a body and a Mapped Face Meshing control is defined for either

the body's source or target face, the sweep mesher will fail if a mapped mesh cannot be obtained for

the face.

• The source and target faces do not have to be flat or parallel.

• If the topology of the source and target face is the same, the sweeping operation will often succeed

even if the shape of the source face is different from the shape of the target face. However, drastically

different shapes can cause element shape failures.

• Sweeping does not require your model to have a constant cross section. However, the best results are

obtained for constant or linearly varying cross sections.
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Figure: Axis Sweep Representation

Figure: Edge Only Sweep Path

Figure: Edge Plus Closed Surface Sweep Path

Rules Followed By the General Sweeper

In deciding which area should be designated as the source area for general sweeping, the program uses

the following rules, in the order as listed below. The sweeper will check all the rules until it finds a rule to

use. Once a higher order rule is used, all the lower rules will not be considered. For example, if none of the

first five rules apply, it will check against rule 6. In this case, if a face is a plane (flat) and the other face is

not a plane (not flat), the flat face will be picked as the source and the test will be terminated.

1. Manually set control - specify both source and target: The source and target for sweeping will be

exactly as the user specifies. This is the fastest way of meshing. It will eliminate searching for a possible

source and target. For axis-sweeping, this method must be used. If a face is a source of another body

and is not picked as a source of the current body, the aforementioned face will be used as a source.

2. Manually set control - specify source: Once the user specifies a source area, the program will try to

find the target suitable to the source. The source will be exactly as specified.

3. Mapped Face Mesh control: The program finds the face with a Mapped Face Mesh control applied

to it.

4. Number of loops: The face with the largest number of loops will be picked as source face.

5. Number of lines: The face with the largest number of lines will be picked as source face.

6. Flat face: A flat face has higher priority for being a source face.

7. Less sharing: In most cases, a face might be used by one or a maximum of two bodies. If every one

is flat (plane), the one used by the least number of bodies (that is, used by just one body) will be

picked as source face.
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8. Larger area: The largest area will be picked as the source.

Topological Requirements of the General Sweeper

The general sweeper must have at least one path between the source face and target face. The side faces

of the sweep do not need to be singular but they must all be sub-mappable and have single loops. The

source face cannot be a closed analytic such as a full cylinder, torus or sphere. However, partial analytics

are acceptable as source and target faces.

Note

Pro/ENGINEER creates unique topological models that no other CAD system creates. In all other

CAD systems, non-periodic faces can have only 1 exterior topological loop. On the other hand,

models in Pro/ENGINEER can have non-periodic faces with multiple exterior loops. This type of

topology does not pose a problem for the free meshers in the Meshing application. However, it

does pose a problem for the general sweeper. As noted above, side faces of the sweep must have

single loops. They cannot have multiple exterior loops because if they do, a single path from the

source to the target cannot be determined.

Importing the model into the DesignModeler application breaks the face with multiple exterior

loops into multiple faces with single loops because the DesignModeler kernel does not support

the Pro/ENGINEER topology. Exporting the model from Pro/ENGINEER to IGES or STEP format will

also resolve this issue.

Figure: Example (a) Showing Invalid Closed Cylindrical Face as Source Face
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Figure: Example (b) Valid Open Cylindrical Face as Source Face

Figure: Example (c) Multiple Connected Side Faces

Thin Model Sweeping

Similar to the behavior of the general sweeper, the thin model sweeper creates a structured hexahedral/wedge

mesh, but for a thin model. It meshes one side of the thin solid (the source), and then sweeps the mesh to

the other side (the target). Unlike the general sweeper, the thin model sweeper does not require a topolo-

gical one-to-one match of source to target; the model may have multiple source and/or target surfaces.
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(Refer to Topological Requirements of the Thin Model Sweeper (p. 200) for examples.) In addition, the thin

model sweeper can perform some edge defeaturing and thus can mesh models that have reasonably small

features.

Requirements and usage information specific to the thin model sweeper include the following:

• The model must be thin—if the model is too thick, the thin model sweeper algorithm may fail.

• The source(s) and target(s) cannot touch each other.

• The model must have an obvious “side” that is perpendicular to the source and target; all of the side

areas must connect directly from source to target.

• Mesh controls defined on the target may not be respected.

• Multibody parts are supported.

• For multibody parts, only one division through the thickness is possible. For single body parts, you can

define multiple elements through the thickness using the Sweep Num Divs control in the Details View

of the Sweep Method. (See steps below.)

• The thin model sweeper ignores the Num Cells Across Gap setting, which is used to help define the

proximity size function. Using the proximity size function in combination with the thin model sweeper

may lead to an unnecessarily long computation time.

• If two bodies intersect to make a “T” connection, the thin model sweeper does not require that a mapped

mesh control be defined at the junction of the two bodies.

• The Preview Source and Target Mesh and Preview Surface Mesh features do not support the thin

model sweeper.

Considerations for Selecting Source Faces for the Thin Model Sweeper

The thin model sweeper meshes one side of a thin solid (the source), and then sweeps the mesh to the

other side (the target). You can control which side the mesher uses as the source by selecting source faces

manually. (To do so, set the Src/Trg Selection control to Manual Thin as described below.)

For most geometries, you can select just 1 of the faces in the complete set of faces that you want to be

used as the source set, and the mesher will properly identify the other faces that are a part of that source

set. However, for more complicated models (such as those containing multibody parts), you need to select

all source faces in the source set in order for the mesher to be successful in finding the complete set of

source faces.

A general rule of thumb is if you can select a single face and then extend the selection to its limits, the

mesher can also identify the proper complete set of source faces. (For details about extending selections,

refer to the description of the Extend Selection command in the Mechanical help.) If the geometry contains

sharp angles that make the limit extension selection difficult, it will also be difficult for the mesher to use a

single face for the source face definition, and you should select the complete set of source faces.

Topological Requirements of the Thin Model Sweeper

The thin model sweeper supports M source faces to N target faces, where M and N can be any positive

whole numbers. Between source faces and target faces, there must be "side faces." The angles between side

faces and either source faces or target faces must be sharp enough that the faces are NOT considered to

be smoothly connected. Therefore, a knife with a thin blade would not be appropriate for thin model

sweeping because the cutting edge (i.e., blade) does not form a "side face." During the thin model sweeping

meshing process, the features (vertices, edges, and faces) on the target may not be preserved and therefore,

users should avoid applying boundary conditions to the target. The side faces must connect to both source

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.200

Specialized Meshing



and target. No edges or vertices are allowed on side faces. In this sense, no hard edges on side faces are

allowed. Side edges must connect directly from source to target. Users may use virtual topology to eliminate

some features.

Figure: Example (a) N Source to 1 Target or 1 Target to N Source Topology

Figure: Example (b) N Source to N Target Topology
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Figure: Example (c) 1 Source to N Target Mesh

Figure: Example (d) N Source to 1 Target Mesh
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Figure: Example (e) N Source to N Target Mesh

Use Virtual Topology to create a single edge between source and target faces.

Figure: Using Virtual Topology to Create Single Edge Between Source/Target Faces
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Mesh Controls and the Thin Model Sweeper

Mesh Controls applied on the target faces/edges are ignored. Only mesh controls applied to the source

faces/edges are respected.

In example (a) below, the Mapped Face Control is ignored because it is applied to the target face.

Figure: Example (a) Mapped Face Control Applied to Target Is Ignored

In example (b) below, the Mapped Face Control is respected because it is applied to the source face.

Figure: Example (b) Mapped Face Control Applied to Source Is Respected

Thin Model Sweeping for Single Body Parts

This section provides the basic steps for using thin model sweeping to mesh a single body part.
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To use the Thin Model Sweeper to mesh a single body part:

1. Click the Mesh object in the Tree and select Insert> Method from the context menu.

2. Scope the Method control to the thin body.

3. In Details> Definition, set Method to Sweep.

4. Set Src/Trg Selection to Manual Thin or Automatic Thin.

Although Automatic Thin may work for simple cases, you may need to select Manual Thin depending

on the complexity of the model.

5. If you selected Manual Thin, scope the source face(s), keeping in mind the recommendations provided

in Considerations for Selecting Source Faces for the Thin Model Sweeper (p. 200).

6. Enter additional sweep option settings, as desired, in the Details View. These may include Free Face

Mesh Type, Sweep Num Divs, and Element Option. For descriptions of these options, see Sweep

Method Control (p. 147).

7. Define other mesh controls, as desired.

8. Generate the mesh.

Figure: Thin Solid Sweeper Used to Mesh a Single Body Part (p. 205) shows a model of a timing cover that consists

of a single body. The thin solid sweeper was used to mesh the body. To obtain this mesh, Free Face Mesh

Type was set to Quad/Tri, Sweep Num Divs was set to 2, and Element Option was set to Solid Shell.

Figure: Thin Solid Sweeper Used to Mesh a Single Body Part

Figure: Thin Solid Sweeper Used to Mesh a Single Body Part: Detail (p. 206) shows detail of the timing cover. The

Sweep Num Divs setting of 2 is apparent in this view.
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Figure: Thin Solid Sweeper Used to Mesh a Single Body Part: Detail

Thin Model Sweeping for Multibody Parts

This section provides the basic steps for using thin model sweeping to mesh multibody parts. You can define

thin sweep for each thin body in the multibody part.

To use the Thin Model Sweeper to mesh a multibody part:

1. Select a thin body in the Geometry window, right-click, and select Insert> Method.

2. Set Method to Sweep.

3. Set Src/Trg Selection to Manual Thin or Automatic Thin.

Although Automatic Thin may work for simple cases, you may need to select Manual Thin depending

on the complexity of the model.

4. If you selected Manual Thin, scope the source face(s) of the thin body, keeping in mind the recom-

mendations provided in Considerations for Selecting Source Faces for the Thin Model Sweeper (p. 200).

5. Enter additional sweep option settings for the thin body, as desired, in the Details View. These may

include Free Face Mesh Type and Element Option. For descriptions of these options, see Sweep

Method Control (p. 147).

6. If the part contains multiple thin bodies, repeat step 1 through step 5 for each.

7. If the part contains any thick sweepable bodies, repeat step 1 through step 5 for each, but set Src/Trg

Selection to Automatic, Manual Source, or Manual Source and Target (depending on complexity

of the model).

8. If the part contains any non-sweepable bodies, define mesh methods for each, if desired. If the mesh

methods are left undefined, the Meshing application will determine the most appropriate methods to

use for the non-sweepable bodies.

9. Define other mesh controls, as desired.

10. Generate the mesh.

Figure: Thin Solid Sweeper Used to Mesh a Multibody Part (p. 207) shows a model of a bracket that consists of

four bodies. The thin solid sweeper was used to mesh the bodies. To obtain this mesh, Free Face Mesh

Type was set to Quad/Tri and Element Option was set to Solid.
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Figure: Thin Solid Sweeper Used to Mesh a Multibody Part

Additional Considerations for Using the Thin Model Sweeper

This section describes several models and scenarios to consider before using the thin model sweeper.

The first example involves a multibody part that models a laminated composite material, as shown below.

Defining source faces for such models may be confusing.
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Figure: Thin Solid Sweeper and Laminated Composite Models

The part contains nine bodies. Assume that the Manual Thin option for Src/Trg Selection will be applied

to each of them. With the Manual Thin option, source faces must be defined for each selected body (i.e.,

each body must have at least one face selected as its source face). There are different ways that you can

select faces to meet this requirement, and it is logical to assume that defining nine source faces (one for

each body) is one way that will work. However, in cases of laminated composites, we recommend that you

specify every other face as a source face.

Consider the figure below, in which nine faces (indicated by arrows) are defined as source faces for the nine

bodies. As illustrated by the figure, Body 1 has two faces defined as source faces, and the same is true for

bodies 2 through 8. This source face definition causes ambiguity for the thin sweep mesher, which will have

trouble determining a target face in bodies 1 through 8 and may fail.
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Figure: Ambiguous Source Face Definition for Laminated Composite Model

Now look at the figure below. Here every other face has been selected as a source face, for a total of five.

With this source face definition, each body still has one face selected to be its source face, so the requirement

for Manual Thin source face selection has been met. With this source face definition, the thin sweep

mesher will have no problem determining target faces for each of the bodies.
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Figure: Recommended Source Face Definition for Laminated Composite Model

Note

For cases in which the Automatic Thin option can be used, an alternative method to consider

is to apply the Manual Thin option to only one body, define its source face, and apply the

Automatic Thin option to the remaining bodies.

Before using thin solid sweeping, remember that the mesher meshes one side of faces and then sweeps the

mesh to the second side of faces. Consider Figure: Thin Solid Sweeper Limitation (p. 211), which shows a

model containing three plates. In the thin sweep operation, the edges that are common to two source faces

are present on the source side. If the edges are different on the opposite side, the mesher will use the nodes

from the source side in the mesh on the opposite side anyway. Thus, if there are features on the non-source

side that are unique and need to be captured, you should not use the thin solid sweeping approach, as the

mesher will ignore these features.

In Figure: Thin Solid Sweeper Limitation (p. 211), there is no valid way to mesh the middle plate with the thin

solid sweep method, as there is an imprint coming from both the plate above and the plate below the

middle plate, unless:

1. The plate is decomposed (sliced) to ensure all target face(s) have a corresponding source face.

2. The multibody part is broken into single parts (non-conformal mesh at common interfaces).

3. Some other mesh method is used. (In Figure: Thin Solid Sweeper Limitation (p. 211), a tet mesh method

is used.)
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4. The source and target faces have similar pairs, and the source faces are selected properly (described

below).

Figure: Thin Solid Sweeper Limitation

Figure: Adding Face Projections (Splits) in the DesignModeler Application (p. 211) illustrates an alternative approach

to meshing the model above. In the DesignModeler application, the Projection feature allows face(s) to be

split so that the source and target pairs will align. (For this model, the Edges on Face type of projection was

used.)

Figure: Adding Face Projections (Splits) in the DesignModeler Application

With the addition of the face splits, the model can be meshed successfully with the thin solid sweep method

by applying the Manual Thin option for Src/Trg Selection to all three bodies, and defining the top surface

of each body as its source faces, as shown below. In this example, two faces are selected as source faces for

the body on the left, three for the middle body, and two for the body on the right. Defining the source faces

in this way ensures that everything is meshed from one side of the multibody part to the other.
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Figure: Defining Source Faces when Face Splits Are Present

Figure: Three Plates Model Meshed with Thin Solid Sweeper (p. 212) shows the meshed model.

Figure: Three Plates Model Meshed with Thin Solid Sweeper

MultiZone Meshing

The MultiZone mesh method, which is a patch independent meshing technique, provides automatic decom-

position of geometry into mapped (structured/sweepable) regions and free (unstructured) regions. It auto-

matically generates a pure hexahedral mesh where possible and then fills the more difficult to capture regions

with unstructured mesh. The MultiZone mesh method and the Sweep mesh method operate similarly;

however, MultiZone has capabilities that make it more suitable for a class of problems for which the Sweep

method would not work without extensive geometry decomposition.

MultiZone meshing topics include:

MultiZone Overview

MultiZone Algorithms

Using MultiZone

MultiZone Limitations and Hints
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MultiZone Overview

The MultiZone mesh method provides the following benefits:

• Improved source face handling:

– In traditional sweeping approaches, there is a source face that is meshed and then extruded to the

target. In MultiZone, the source and target are interchangeable.

– A source can consist of multiple faces.

• Automatic geometry decomposition:

– Geometry is decomposed first at 2D level and then at 3D level.

– 2D decomposition can simplify geometry and improve success of hex meshing.

– 3D topology is constructed based on 2D topology; unique heuristic approaches are used for the

construction of the 3D blocks that do not force the traditional limitations of sweeping algorithms.

• Mapped and free meshing in the same body

• Inflation on a combination of source and/or side faces

The MultiZone mesh method supports the following feature interactions:

• Support for inflation, including Program Controlled (p. 69) inflation

• Support for virtual topology

• Support for embedded entities (hard points and hard edges) on surfaces

• Support for multibody parts

• Support for defined edge and face sizings

• Support for baffle meshing

MultiZone Support for Inflation

The Inflation Option (p. 71) for the MultiZone mesh method is set to Smooth Transition by default. The

approach Smooth Transition uses for computing each local initial height for MultiZone differs from the

approach used for tet mesh methods. This is because an inflated tet mesh contains different types of volume

elements (i.e., tets and prisms where the ratio takes into consideration the difference in volume based on

element shape), while in an inflated MultiZone mesh the elements generally will be the same type.

When the Smooth Transition option is used with MultiZone, the O-Grid edge length varies based on the

number of elements, and the local initial height is a constant as computed by Transition Ratio (p. 72) * loc-

al_mesh_size. As with other mesh methods when Smooth Transition is used, the inflation layers are created

using the values of the Transition Ratio (p. 72), Maximum Layers (p. 73), and Growth Rate (p. 73) controls.

Note

Unlike other mesh methods where inflation layers can peel back if sufficient room for all layers

is not available, the MultiZone mesh method uses an inflation technique (referred to as O-Grid)

that generates a sub-topology for the entire inflation region. This O-Grid region needs to have

sufficient room, or the inflation meshing will be unsuccessful due to the mesh overlapping. Because

of this, the default values for Smooth Transition inflation could be very aggressive depending

on the model. Reducing the number of layers or switching to a different type of inflation definition

may be more suitable for many models.

213
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

MultiZone Overview



MultiZone Support for Defined Edge and Face Sizings

MultiZone creates a secondary topology, called the blocking topology, and uses any defined edge and face

sizings to influence the blocking topology. By controlling source faces and side faces within MultiZone and

assigning proper edge and face sizings as desired, you can ensure MultiZone will be able to provide the

proper size for the different sweep paths.

Note

Within MultiZone (and throughout ANSYS Workbench in general), parallel edge assignments are

handled automatically for mapped faces. That is, for a mapped face, there are two sets of parallel

edges. If you increase or decrease the sizing on one edge, the same increase or decrease occurs

automatically on the other edge to ensure a mapped mesh is possible. If a model contains a row

of mapped faces (such as the sides of a box), you can set a number of elements on one edge

and the same number of elements will be forced on all side/parallel edges.

When you scope bias settings to edges, they are applied according to the following priority:

1. Double bias edge

2. Single bias edge

3. No bias edge

This means that if a model contains a number of parallel edges with scoped edge sizes, the size

control(s) with double biasing will take highest priority, then single biasing, then no biasing.

Note

In general, if there is an edge in the direction of inflation, it is always best to use edge sizing for

boundary layers rather than inflation.

MultiZone Algorithms

The MultiZone mesh method, which is based on the blocking approach used in ANSYS ICEM CFD Hexa,

starts by automatically blocking out surfaces. If the surface blocking can form a closed volume, then the

volume may be filled automatically with a number of structured, swept, or unstructured blocks. The structured

blocks can be filled with Hexa or Hexa/Prism elements and the unstructured blocks can be filled with Tetra,

Hexa Dominant, or Hexa Core elements depending on your settings, as described in MultiZone Method

Control (p. 150).

The blocking algorithm and the meshing algorithm used to generate a MultiZone mesh are detailed below.

MultiZone Blocking Algorithm

The blocking algorithm used to generate a MultiZone mesh can be described as follows. The series of figures

illustrates the process, assuming the geometry shown in Figure: Blocking Algorithm—Sample Geometry (p. 215).
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Figure: Blocking Algorithm—Sample Geometry

1. Creates automatic surface blocking (2D) by performing a surface analysis. In this step the algorithm:

• Uses the Uniform Quad and Uniform Quad/Tri mesh methods to generate 2D blocking.

• Uses mapped controls to try to force mapping. In general, surfaces with four sides are mapped

(structured) and other surface patches are free (unstructured).

• Uses source face selection to try to imprint faces into the source/target faces. (MultiZone treats

all sources/targets as sources, as imprinting can occur from either side. For additional details, refer

to MultiZone Source Face Selection Tips (p. 219).)

Figure: Blocking Algorithm—Step 1: 2D Blocking

2. Creates a MultiZone (3D) structure. In this step the algorithm:

• Processes surface blocks to match swept sections.

• Connects surface blocks to create volume blocking (3D).

• Resolves the volume region with structured, swept, and unstructured blocks. Mapped faces become

structured blocks and free faces become unstructured blocks.
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Figure: Blocking Algorithm—Step 2: 3D Blocking

3. O-Grid creates boundary blocks automatically, and the algorithm extrudes O-Grid to create inflation.

Figure: Blocking Algorithm—Step 3: Inflation

MultiZone Meshing Algorithm

The meshing algorithm used to generate a MultiZone mesh can be described as follows:

• Assigns intervals by transferring sizing from the topology to blocking.

• Meshes structured faces (those that can be mapped meshed) using transfinite interpolation and unstruc-

tured (free) faces with all quadrilateral or a combination of quadrilateral/triangle elements.

• Interpolates, sweeps, and fills the volume mesh for the structured, swept, and unstructured blocks re-

spectively. (The structured blocks can be filled with Hexa or Hexa/Prism elements and the unstructured

blocks can be filled with Tetra, Hexa Dominant, or Hexa Core elements depending on your settings,

as described in MultiZone Method Control (p. 150).)

Using MultiZone

To help you to determine whether the MultiZone mesh method is the most appropriate method for your

problem and to ensure blocking is constructed properly, you must consider the following characteristics of

the problem:

• Sources
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• Sweep paths (i.e., side faces)

• Intersections (i.e., levels)

To classify a MultiZone problem, consider which faces will be sources and in turn, which sources will cause

imprinting. (Note that imprinting, which is described in MultiZone Source Face Imprinting Guidelines (p. 219),

has its own classifications that further define the problem.)

In Figure: Classifying the Problem: Sources (p. 217), four faces have been selected as sources (the two faces

highlighted in green, and two hidden planar faces at the base of the block and the cylinder).

Figure: Classifying the Problem: Sources

You must also consider the sweep path, or sides, of the mesh. This includes how many potential sweep

directions exist in the problem and if there is more than one, how imprints should be handled. See Fig-

ure: Classifying the Problem: Handling of Paths and Imprints (p. 217).

Figure: Classifying the Problem: Handling of Paths and Imprints

A collective set of attached faces in a body is a source, and the simplest problem (such as a box) has two

sets of sources. All faces that are not sources are side faces, and they make up the path. In a simple box

example, the box could be swept in any one of three directions, but it is the source selection that determines

the path. If no source is selected, MultiZone determines the path arbitrarily.

The model shown in Figure: Classifying the Problem: Sweep Path (p. 218) shows one clear sweep direction. The

green faces are the side faces.
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Figure: Classifying the Problem: Sweep Path

You must also consider the number of intersections, or levels, the problem has in relation to the sweep

direction. In the MultiZone mesh method, the maximum number of allowable levels is 100. Levels are resolved

before sources and sweep paths. Furthermore, in problems involving more than three levels, the problem

is resolved at each individual level first. You can aid in this process by splitting the geometry to create levels

as needed.

In a simple box example, the box has two levels but could be swept in any one of three directions. MultiZone

should work for most cases involving two or three levels, providing the path and imprinting cases in the

specific problem are supported. For cases involving more than three levels, there are additional factors to

consider. For example:

• Imprints cannot be done through multiple levels. If the imprinting has to go through multiple levels,

the geometry should be sliced.

• Side faces need to be mappable. For multiple levels, the software may have difficulty determining how

to properly map the side faces to get a proper swept mesh (see Internal Cutout Loops (p. 223)).

In Figure: Classifying the Problem: Levels (p. 218), there are four levels in the sweep direction.

Figure: Classifying the Problem: Levels

For more information, refer to:

MultiZone Source Face Selection Tips

MultiZone Source Face Imprinting Guidelines

Using Virtual Topology to Handle Fillets in MultiZone Problems
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MultiZone Source Face Selection Tips

When you choose the MultiZone mesh method, the Details View expands to expose various settings, one

of which is Src/Trg Selection. Src/Trg Selection, which defines the source and target selection type for the

MultiZone mesh method, can be set to either Automatic (the default) or Manual Source. Because the

Automatic option works for simple configurations only, it is likely that you will need to change the setting

to Manual Source and manually select the faces that will be used. Keep these points in mind when selecting

faces:

• MultiZone does not support the Manual Source setting for the Src/Trg Selection option if MultiZone

is applied to more than one part, even if you suppress all of the other parts.

• The faces you select can be either “sources” or “targets.” MultiZone does not distinguish between

source and target faces, and instead treats them all as sources.

• To do imprinting of face loops, all swept section faces (that is, those that are perpendicular to the sweep

direction) should be selected.

• Unstructured blocking is enforced for source faces since imprinting is not supported on structured faces.

Therefore, to resolve a structured region no source faces should be selected.

• An unstructured mesh will be forced on the selected source faces in general. Depending on the geometry,

you can add mapped face meshing controls to these faces to get mapped meshing.

• In a multibody part, source faces must be specified for the swept regions only. Structured regions are

decomposed automatically. Mapped face meshing controls can help to resolve structured regions.

• At an interface in a multibody part (in which two bodies share the same face), there is not always a

distinction of which body the face belongs to. When using MultiZone in such cases, setting the face

to be inflated may affect both bodies because both bodies are meshed with MultiZone at the same

time.

• To make source face selection easier, select View > Annotations from the Main Menu to toggle the

visibility of annotations in the Geometry window. For example, after scoping MultiZone to a body, the

body will be displayed using a blue solid annotation. Select View > Annotations to turn off the annota-

tions; then select the source faces. For picking internal faces, the Hide Faces right mouse button option

may help you to see inside a body. For example, you can select external faces in the Geometry window

and then use the Hide Faces option to hide the selected faces (making it easier to select the internal

faces).

Refer to Figure: Source Face Selection for MultiZone (p. 154) for more information.

MultiZone Source Face Imprinting Guidelines

Imprinting has its own classifications that further define the problem. Models often exhibit combinations of

these different situations when trying to sort out the sweep paths between pairs of source face(s).

When selecting source faces, it is important to recognize that the pairs of source faces need to have proper

matches. If source faces cannot be paired, imprinting needs to be done by the software to create proper

pairs. The software supports only certain types of imprinting, so it is important to understand these cases.

Imprinting classifications include:

Internal Loops

Boundary Loops

Multiple Internal Loops

Multiple Connected Internal Loops

Internal Cutout Loops
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Parallel Loops

Intersecting Loops

It is also important to note that if you set the Free Mesh Type to anything other than Not Allowed, some

of the imprinting will not be done, as this can lead to some problems in the creation of the free blocks.

Internal Loops

Internal loops are internal regions that imprint to other faces, such as the fins in the rotor model shown

below.

Figure: Source Imprinting Classifications: Internal Loops

Boundary Loops

Boundary loops are splits in a face that extend to the boundary, such as those shown in the model below.
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Figure: Source Imprinting Classifications: Boundary Loops

Multiple Internal Loops

Some models exhibit multiple internal loops, such as those in the model below.

Figure: Source Imprinting Classifications: Multiple Internal Loops
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Multiple Connected Internal Loops

Some models exhibit multiple connected internal loops, such as those in the model of the circuit board

below. The MultiZone method has been applied to the underlying board, which is highlighted in blue. The

Edge Coloring By Connection feature is on in this view.

Figure: Source Imprinting Classifications: Multiple Connected Internal Loops View 1

In the figure below, the body corresponding to the underlying board was selected and meshed. In this view,

both the Edge Coloring By Connection and Show Vertices features are on.
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Figure: Source Imprinting Classifications: Multiple Connected Internal Loops View 2

Internal Cutout Loops

Some models exhibit internal cutout loops, in which there are three sets of source faces:

• Top source faces

• Middle source faces (internal cutouts)

• Bottom source faces

A simple cutout situation exhibits these characteristics:

• The sets of top faces and bottom faces are connected by complete side faces (that is, faces on the side

have boundary edges on both top and bottom)

• There can be multiple internal cutouts, but they must be located at the same level. In other words, the

middle source faces of all of the internal cutouts must be at the same level.

The figure below shows a model in which the boundary is at a higher level than the cutout regions. This

type of simple cutout case is supported, as the side faces are directly connected to the top and bottom

source faces.
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Figure: Source Imprinting Classifications: Internal Cutout Loops (Simple Cutout Case)

The case shown in the figure below is also supported. Although there are multiple internal cutouts, the

middle source faces of all of the cutouts are at the same level.

Figure: Source Imprinting Classifications: Internal Cutout Loops (Multiple Cutout Case)

However, in cases in which the internal cutouts are at multiple levels or the sides do not provide a clear

connected path, MultiZone will not be successful unless you set the Free Mesh Type to something other

than Not Allowed, or you perform manual geometry decomposition. Refer to the figure below for an example

showing cutouts at multiple levels.
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Figure: Internal Cutout Loops: Cutouts at Multiple Levels

In the figure above, notice that cutouts at different levels are meshed at the same level with regard to the

grid lines.

When there is no clear connected path because side faces do not extend from top source faces to bottom

source faces (as shown in the figure below), MultiZone will not be successful.

Figure: Internal Cutout Loops: Side Faces Do Not Provide Clear Connected Path

Parallel Loops

Some models exhibit parallel loops, such as those in the model below. If the software can match all pairs

these models should work; however, the angle between pairs can cause problems (due to difficulties finding

the pairs), and if there are non-matched pairs they will cause problems. For non-matched pairs, virtual topo-

logies may solve the problem.
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Figure: Source Imprinting Classifications: Parallel Loops

Intersecting Loops

Two views of a model with intersecting loops are shown below. Notice that the sources on the top and

bottom would intersect when being imprinted. These types of cases are not supported yet. You can use

geometry decomposition as a workaround.

Figure: Source Imprinting Classifications: Intersecting Loops View 1
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Figure: Source Imprinting Classifications: Intersecting Loops View 2

Using Virtual Topology to Handle Fillets in MultiZone Problems

The presence of fillets in a model can cause problems for MultiZone, since arguably a fillet could be either

a side face or a source face. Ideally, a fillet should be split in half, with one half going to the source face and

the other half going to the side face. Alternatively, the fillet should be removed. For simplicity, however,

assigning the fillet to the side face through a Virtual Topology operation is the best solution.

In addition, inflation is generally recommended to improve the high angled elements that would be formed

along the edge that is shared between the source and side faces. Inflation allows the mesh to transition

away from the boundary and reduce the angle. See Figure: Fillets and Inflation (p. 227).

Figure: Fillets and Inflation

MultiZone Limitations and Hints

Be aware of the following limitations and hints when using MultiZone:

• Advanced mapped face meshing controls (side/end/corner) are not supported.

• Advanced size function controls, sphere of influence, etc. are not supported.

• Pinch controls and mesh connections are not supported.

• Some inflation cases are not supported; for example, when the inflation does not form a closed loop

(which would lead to non-conformal mesh that is not allowed). In these cases the inflation will be

skipped.

• The Show Sweepable Bodies feature is not supported.
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• There is no access to underlying blocks except by writing out the ANSYS ICEM CFD files.

• When using the MultiZone mesh method on geometries where the sources are spherical and unstruc-

tured (that is, the source cannot be mapped), you may want to set the Mapped Mesh Type to

Hexa/Prism instead of Hexa. In such cases, using the Hexa mesh type may result in very poor quality

face mesh on the sources, which sometimes leads to mesh failures.

• For help in diagnosing problems when using the MultiZone method, refer to the description of the

Edge Color Option toolbar in the Mechanical help. This toolbar provides access to features that are

intended to improve your ability to distinguish edge and mesh connectivity.

For additional information, refer to Interactions Between Mesh Methods and Mesh Controls (p. 263) (Patch Inde-

pendent Mesh Methods table).

CutCell Meshing

CutCell Cartesian meshing is a general purpose meshing method designed for ANSYS FLUENT. The CutCell

meshing algorithm is suitable for a large range of applications, and due to the large fraction of hex cells in

the mesh, often produces better results than tetrahedral methods. The CutCell method uses a patch inde-

pendent volume meshing approach (surface mesh automatically created from boundary of volume mesh)

without the need for manual geometry cleanup or decomposition, thereby reducing the turnaround time

required for meshing.

The CutCell method is useful for meshing fluid bodies in single body parts and multibody parts; it cannot

be used to mesh assemblies of parts, nor a collection of loosely closed surface patches. CutCell may encounter

problems capturing very acute internal and external face angles, such as the trailing edges of fins and acute

wheel-ground intersections.

CutCell is supported in the Meshing application only; it is not supported in the Mechanical application.

Furthermore, if CutCell is active in a Mesh system and you replace the Mesh system with a Mechanical

Model system, you will not be able to use CutCell in the Mechanical Model system.

CutCell meshing topics include:

The CutCell Meshing Process

The CutCell Meshing Workflow

The CutCell Meshing Process

The CutCell meshing process involves the following approach:

1. Size functions are defined.

2. The initial size of the Cartesian grid is computed based on the minimum and maximum size set for

the size functions.

3. A uniform Cartesian grid is created within the bounding box for the geometry.

4. The size function values are computed and the grid is then adaptively refined based on the local size

function values.

Figure: Mesh After Refinement (p. 229) shows the mesh after refining the initial grid based on size functions.
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Figure: Mesh After Refinement

5. The cells intersected by the geometry are marked. Only nodes on marked cells are considered for

projection. The nodes are projected to the geometry (corner, edge, and face in order of reducing pri-

ority).

Figure: Mesh After Projection (p. 229) shows the mesh after node projection.

Figure: Mesh After Projection

6. The edges intersected by the geometry are identified. Mesh edges to be preserved/recovered are de-

termined, and are used to construct mesh faces. Once the mesh faces are identified, cells are decom-

posed to recover these faces. The cells are decomposed based on a number of templates.

7. The mesh outside of any body is removed.

8. The quality of the cells thus generated is improved.

9. Cells are separated into cell zones based on the respective bodies.

Figure: Cells Separated After Decomposition (p. 230) shows the cells separated into respective cell zones

after decomposition.
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Figure: Cells Separated After Decomposition

10. The boundary mesh is recovered and separated based on the underlying geometry.

• Faces whose adjacent neighboring cells are in different cell zones automatically constitute the

boundary mesh.

• The neighboring cells of a face on an internal baffle are in the same cell zone. In such cases, faces

close to and nearly parallel to the baffle surface are recovered to represent the baffle surface.

• As each cell zone is a closed region, the mesh boundary is conformal.

The boundary zone types are assigned based on the Named Selections defined on the (underlying)

geometry faces. Figure: CutCell Mesh After Boundary Recovery (p. 230) shows the CutCell mesh after the

boundary mesh is recovered.

Figure: CutCell Mesh After Boundary Recovery
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When the CutCell mesh is exported to ANSYS FLUENT, a cell zone type of either FLUID or SOLID is as-

signed to each body based on the value of the Fluid/Solid material property that was assigned to the

body in the DesignModeler application. An exception to this rule occurs if the name of a body contains

the string "fluid" (case-insensitive). In such cases, the body is assigned a cell zone type of FLUID. In this

way, the presence of the string "fluid" in the body's name overrides the Fluid/Solid material property

setting.

When Use Automatic Inflation (p. 69) is set to Program Controlled (p. 69), the logic used to determine

which faces in the model are selected to be inflation boundaries is dependent on the Fluid/Solid

material property setting. For this reason, the Program Controlled option will not work for a body

that was assigned a cell zone type of FLUID based on the presence of the string “fluid” in its name.

The CutCell Meshing Workflow

This section describes the workflow for using the CutCell mesh method, which is different from the workflow

for the other Meshing application mesh methods. Rather than applying it locally by inserting a mesh method

control, you apply the CutCell mesh method globally to mesh a single body part or a multibody part. CutCell

cannot be used in combination with any other mesh method.

The recommended workflow for CutCell meshing is as follows:

1. Set global CutCell meshing and sizing controls. This includes:

• Set prerequisites.

• Activate the CutCell mesh method.

• Set CutCell meshing options.

• Set sizing options.

2. Set global inflation controls.

3. Generate the CutCell mesh.

4. Apply scoped inflation controls.

5. Generate the inflation mesh.

6. Export the mesh.

Setting Prerequisites

CutCell has its own group of global mesh controls, called the CutCellMeshing group. The first step to using

CutCell is to set the following prerequisites, which will allow you access to the CutCellMeshing group:

1. Set Physics Preference (p. 57) to CFD.

2. Set Solver Preference (p. 59) to Fluent.

The CutCellMeshing group of global controls appears in the Details View.
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Note

• When Physics Preference is set to CFD and CutCell meshing is being used, a shape checking

algorithm based on orthogonal quality is used. Orthogonal quality, which is the recommended

quality criterion for CFD simulations, can be used for all types of meshes including CutCell

and polyhedral. Note that the skewness quality criterion is not recommended for CutCell

meshes.

• Orthogonal quality in the Meshing application (and ANSYS FLUENT) is equivalent to orthoskew

in TGrid, except that the scale is reversed:

Orthoskew = 1 – Orthogonal Quality

The orthoskew values may not correspond exactly with the orthogonal quality values as the

computation depends on boundary conditions on internal surfaces (WALL vs. INTERIOR/FAN/RA-

DIATOR/POROUS-JUMP). In all cases, the orthogonal quality value in ANSYS FLUENT should

provide more accurate results than the value in the Meshing application. Also, for CutCell

meshes, the elements in the Meshing application are “traditional” (hex/tet/wedge/pyramid)

elements while CutCell meshes that are exported from the Meshing application to ANSYS

FLUENT are exported in polyhedral format.

• If you use the Meshing Options panel to change your Physics Preference from CFD to an-

other preference, the CutCell mesh method will be disabled.

Activating the CutCell Mesh Method

Now that prerequisites are set and you have access to the CutCellMeshing group, you can activate the

CutCell mesh method. Activating the method will expose the CutCell meshing controls and hide controls

that are not applicable to CutCell:

1. In the CutCellMeshing group of global controls in the Details View, set Active (p. 84) to Yes.

After activating CutCell, you will continue to have access to the following mesh controls with the noted

exceptions and additions that are unique to CutCell. The unique controls are discussed in more detail in

the appropriate workflow steps:

• Most Advanced Size Function controls are supported.

– Proximity Size Function Sources (p. 64) control is applicable only to CutCell.

– Max Face Size (p. 64) is not supported.

• Some local (scoped) size controls are supported.

– When setting local size controls, the Sphere of Influence, Body of Influence, and Number of Divi-

sions options for Type are not supported. This means that no local vertex sizing is supported and

only the Element Size option is supported for local body, face, and edge sizing. If any unsupported

controls are defined prior to CutCell activation, they are suppressed when CutCell is activated.

• 3D inflation controls are supported. This includes global and local (scoped) controls.

– By default, Inflation Option (p. 71) is set to Smooth Transition and Transition Ratio (p. 72) is set to

0.272. If you set Transition Ratio prior to activating CutCell meshing, your setting will be ignored

for CutCell but will be restored if you subsequently deactivate CutCell and return to another mesh

method.

– The Inflation Algorithm (p. 74) control, which is used to select either the Pre or Post inflation algorithm

for other mesh methods, is hidden when CutCell is active. CutCell inflation is neither Pre nor Post.
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Rather, it may be considered a hybrid of the two, in that the technology used is like that of the Pre

algorithm, but inflation occurs Post mesh generation. If you set Inflation Algorithm prior to activ-

ating CutCell meshing, your setting will be ignored for CutCell but will be restored if you sub-

sequently deactivate CutCell and return to another mesh method.

– Collision Avoidance (p. 77) is set to Layer Compression and is read-only. Note, however, that layer

compression is used in areas of proximity and bad normals. In other problematic scenarios (for ex-

ample, non-manifold nodes, bad surface mesh, and so on), local stair stepping is performed. As a

result of local stair stepping, poor quality cells may be introduced into the mesh. Because of this

possibility, a warning message will appear whenever stair stepping occurs. The message will not

identify the location of the stair stepping; however, it often coincides with the location of the worst

quality cells. For this reason, using the Mesh Metric (p. 101) feature to locate the worst quality cells

is also likely to locate the areas where stair stepping occurred. To avoid stair stepping, make sure

that the correct faces have been picked for inflation and that small features are properly resolved,

as stair stepping also may be related to bad resolution of acute angles.

• Statistics controls are supported.

Controls and features that are inaccessible when CutCell is active include:

• The global Advanced group of controls

• The global Defeaturing group of controls

• The following local (scoped) controls:

– Method

– Contact Sizing

– Refinement

– Mapped Face Meshing

– Match

– Pinch

– 2D (face) Inflation

• Rigid bodies

• Symmetry—In the case of the Symmetry feature, it is accessible when CutCell meshing is active but it

will not be respected. If you attempt to use Symmetry with CutCell, a warning message is issued.

• The following RMB menu options:

– Preview> Inflation

– Preview> Source and Target Mesh

– Preview> Surface Mesh

– Show> Mappable Faces

– Show> Removable Loops

– Show> Sweepable Bodies
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Note

For supported mesh methods, the Preview Surface Mesh feature helps you to verify that your

mesh settings are correct by allowing you to visualize and examine the surface mesh prior to

generating the full mesh. The inaccessibility of Preview Surface Mesh for CutCell does not

present an obstacle for internal flow problems, as you can easily see the mesh. However, since

external flow problems involve a void, the following alternatives are recommended:

• Use a Section Plane to look at the surface from the inside. This may be sufficient for simple

models.

• For more complex models, define a Named Selection that includes all of the internal

boundaries of the model, except those for which a Named Selection already exists. You can

then view the surface mesh by viewing the Named Selection.

Setting CutCell Meshing Options

Now that the CutCell mesh method is active, you can define global CutCell meshing options:

1. Select the appropriate option for Feature Capture (p. 84).

2. Select the appropriate option for Tessellation Refinement (p. 85).

Setting Sizing Options

Now that global CutCell meshing options are set, you can set sizing options.

When the CutCell mesh method is active, Use Advanced Size Function (p. 59) is set to On: Curvature by

default. If you change the value of Use Advanced Size Function to On: Proximity and Curvature or On:

Proximity, the Proximity Size Function Sources (p. 64) control appears. The Proximity Size Function Sources

control is applicable only to CutCell meshing, and its value determines whether regions of proximity between

faces, edges, or both are considered when proximity size function calculations are performed.

The remainder of this section describes points to remember when setting size function options. Refer to Use

Advanced Size Function (p. 59) for details about setting additional size function options.

Effect of the Smoothing Option:

The setting of the Smoothing (p. 66) option controls the quality threshold at which the CutCell mesher will

start smoothing. The table below presents the Smoothing options that are available in the Meshing applic-

ation (Low, Medium, and High) and their corresponding quality limits. All cells below the specified quality

limit will be considered for improvement.
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Note

Orthogonal quality in the Meshing application is equivalent to orthoskew in TGrid, except that

the scale is reversed:

Orthoskew = 1 – Orthogonal Quality

Orthogonal Quality Limit (with

Inflation)

Orthogonal Quality Limit (without

Inflation)
Smoothing Option

0.010.1Low

0.050.15Medium

0.10.2High

Refer to Orthogonal Quality (p. 117) for more information.

Rules for Computing Min Size and Max Size:

CutCell meshing uses the following rules for computing Min Size and Max Size values. In general, the Max

Size value is computed based on the Min Size value, such that a 2^n ratio is maintained:

1. Default Max Size = Default Min Size * 128.

2. The ratio between Min Size and Max Size can be any one of the powers of two from 0 to 13 (shown

in the table below). Thus, 14 levels of difference between Min Size and Max Size are allowed:

2^7 = 1282^0 = 1

2^8 = 2562^1 = 2

2^9 = 5122^2 = 4

2^10 = 10242^3 = 8

2^11 = 20482^4 = 16

2^12 = 40962^5 = 32

2^13 = 81922^6 = 64

Note

The value of Max Size cannot be greater than 2^13 * Min Size. If the value you set for Max

Size is too high, Max Size is set to its maximum limit (2^13 * Min Size) automatically.

3. Max Size may be converted to the power of two that is nearest to the intended value of Max Size,

where the intended value of Max Size is either the default value or the user input value of Max Size.

Consider this example, which shows the Min Size and Max Size values at each step in the given sequence:

1. Activate CutCell. Default Min Size = 5, so default Max Size = 5 * 128 = 640.

Min Size, Max Size = Default(5.0), Default(640.0)

2. If you set Min Size to any one of {0.0625, 0.125, 0.25, 0.5, 1, 2, 4, ... 512, ... 2^n}, then Max Size = 512

(not default). For example, if you set Min Size = 1, (Min Size, Max Size) = (1, 512).

3. Set Max Size = 40,000, Max Size = 8192 based on the maximum limit rule described above.
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Min Size, Max Size = 1, 8192

4. Set Max Size = 48.5, Max Size is converted to the nearest power of two, so Max Size = 64.

Min Size, Max Size = 1, 64

5. Set Max Size = 47.5, Max Size is converted to the nearest power of two, so Max Size = 32.

Min Size, Max Size = 1, 32

6. Set Min Size = 0.25, Max Size = 32.

Min Size, Max Size = 0.25, 32

7. Set Min Size = 0, Min Size = Default(5.0) and Max Size = 40.

Min Size, Max Size = Default(5.0), 40

8. Deactivate CutCell, user input values for Min Size and Max Size are 0, 47.5 respectively.

Min Size, Max Size = Default(0.0123), 47.5

Setting Global Inflation Controls

Now that CutCell meshing and sizing controls are set, the next step in the CutCell meshing workflow is to

set global inflation controls. If you were to set global inflation controls after the CutCell mesh had been

generated, a re-mesh of the CutCell mesh would be triggered (i.e., the cached mesh would be discarded

and a full re-mesh would occur the next time you generated the mesh). For this reason, it is important to

set global inflation controls in advance of CutCell mesh generation.

Refer to Inflation Group (p. 67) for details about setting global inflation options.

Note

• Attempting to grow thicker prism layers in areas where the aspect ratio of the base to the

prism cap is very large may result in an invalid mesh. In such cases (e.g., external flow prob-

lems), it is recommended to use aspect ratio based growth to avoid problems with invalid

meshes.

• CutCell may not properly capture acute angles. If there are very acute angles in the geometry,

it is likely that the CutCell surface mesh will become very jagged. At these locations, the

surface mesh is not smooth and hence inflation layer generation may fail due to poor quality.

To avoid these problems, try using the DesignModeler application to add chamfers or fillets

to very sharp edges prior to meshing.

Generating the CutCell Mesh

The next step in the CutCell meshing workflow is to generate the CutCell mesh:

1. Select the Mesh object or any mesh control object.

2. Right-click to display the context menu, or choose the Mesh drop down menu from the toolbar.

3. Select Generate Mesh in the menu. The part is meshed. The mesh is displayed when you select the

Mesh object.
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Note

• Although Generate Mesh is valid, the options to generate the mesh on selected bodies or

parts are invalid and therefore inaccessible.

• When you make changes to inflation settings after generating the CutCell mesh, each sub-

sequent re-mesh will proceed as follows:

– If the changes involve local (scoped) inflation settings, meshing begins with the initial

(cached) mesh and inflates from there. See Applying Scoped Inflation Controls (p. 238) for

more information.

– If the changes involve global inflation settings, meshing begins anew (from the very be-

ginning without the use of the initial mesh). See Setting Global Inflation Controls (p. 236)

for more information.

As CutCell meshing is patch independent, the generated mesh goes through the following validation checks

to confirm the mesh is valid and is not missing mesh at any location. During validation CutCell considers

factors such as number of elements/faces/nodes associated to the mesh (including initial mesh vs. inflated

mesh), number of elements/faces/nodes associated to entities contained in Named Selections, orthogonal

quality measures, and number of inflation layers:

• The following conditions must be met, or the returned mesh is considered to be invalid and an error

is issued:

– Orthogonal quality must be > 0 for all volume elements.

– Each body must contain at least one element.

• If any of the following conditions exist, the returned mesh is considered to be valid but a warning is

issued:

– The initial mesh is returned but inflation failed.

– Orthogonal quality for one or more volume elements is <=0.05.

– A Named Selection does not contain any element or exterior face.
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Note

• In models consisting of a multibody part, CutCell meshing may not accurately capture the

geometry at the interface between two or more bodies. In such cases a warning is issued.

• The CutCell mesher may not be able to support cases where surfaces form a cross. For ex-

ample, the four bodies in the image below form a cross as depicted by the thick lines. In

such cases, the feature recovery/surface recovery along the center line (shown as the center

point in the 2D image below) may be poor.

• Refer to Troubleshooting (p. 293) for additional tips and strategies for handling problems that

may occur during CutCell meshing.

Applying Scoped Inflation Controls

The next step in the CutCell meshing workflow is to apply scoped inflation controls.

Inflation is a post process for the CutCell mesher after it has created the hexahedron elements. As described

above, a benefit of this approach is that the hexahedral mesh does not have to be generated each time

local (scoped) inflation options are changed. You can add/delete/modify/suppress your local inflation settings,

and the meshing process will begin with the initial mesh and inflate from there.

To add boundary layers to a face using the CutCell mesher:

1. Select the body and insert an Inflation control.

2. Select the faces to be inflated (i.e., the faces that you want the inflation layers to grow away from).

3. Enter additional settings, as desired, in the Details View.

Note

• CutCell meshing does not support 2D inflation (i.e., inflation scoped to faces with edges se-

lected as boundaries).

• CutCell meshing does not support inflation on both sides of a face zone. If you apply inflation

to a face zone that is shared by two cell zones, the desired inflation will not occur. Inflation

on both sides of a baffle is also not supported.

• If multiple inflation controls are defined and different numbers of layers are defined in them,

the smallest defined number of layers will be respected for CutCell meshing.
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Generating the Inflation Mesh

The next step in the CutCell meshing workflow is to generate the inflation mesh:

1. Select the Mesh object or any mesh control object.

2. Right-click to display the context menu, or choose the Mesh drop down menu from the toolbar.

3. Select Generate Mesh in the menu. The part is meshed. The mesh is displayed when you select the

Mesh object.

Note

In cases in which Smoothing (p. 66) is set to High and CutCell meshing is being used, additional

smoothing of inflation layers occurs. This may slow down the prism generation process.

Exporting the Mesh

The mesh is ready for export.

Points to remember when exporting the CutCell mesh:

• Names of parts, bodies, and Named Selections should be limited to 64 characters.

• If you encounter a problem when using CutCell in the Meshing application, you can export the faceted

geometry to TGrid where you can display, interrogate, and repair the faceted data.

• When you export a CutCell mesh to ANSYS FLUENT, the mesh is exported in polyhedral format.

• When the CutCell mesh is exported to ANSYS FLUENT, a cell zone type of either FLUID or SOLID is as-

signed to each body based on the value of the Fluid/Solid material property that was assigned to the

body in the DesignModeler application. An exception to this rule occurs if the name of a body contains

the string "fluid" (case-insensitive). In such cases, the body is assigned a cell zone type of FLUID. In this

way, the presence of the string "fluid" in the body's name overrides the Fluid/Solid material property

setting.

When Use Automatic Inflation (p. 69) is set to Program Controlled (p. 69), the logic used to determine

which faces in the model are selected to be inflation boundaries is dependent on the Fluid/Solid ma-

terial property setting. For this reason, the Program Controlled option will not work for a body that

was assigned a cell zone type of FLUID based on the presence of the string “fluid” in its name.

Direct Meshing

Using direct meshing, you can selectively pick bodies and mesh them incrementally. After meshing a body,

you can mesh the entire part or assembly or continue meshing individual bodies. Along with the Generate

Mesh feature, the Preview Surface Mesh, Preview Source and Target Mesh, and Preview Inflation ease

of use features support direct meshing.

The following mesh methods are supported:

• For solid meshing:

– Patch Conforming Tetrahedron

– Patch Independent Tetrahedron

– MultiZone
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– Sweep

– Hex Dominant

• For surface meshing:

– Quad Dominant

– All Triangles

– Uniform Quad/Tri

– Uniform Quad

Keep the following information in mind when using direct meshing:

• Direct meshing is enabled by default. You can use the Allow Direct Meshing option to disable it. See

Disabling Direct Meshing (p. 243) for information about Meshing application behaviors when direct

meshing is disabled.

• There is no history available for direct meshing. You must manually re-mesh bodies in the desired se-

quence for any geometry update or re-mesh operation.

• When using direct meshing, only the boundary box of the body currently being meshed is used to

compute the defeaturing tolerance. As a result, your mesh may differ depending on whether you gen-

erate the mesh directly (i.e., body by body), for an entire part, or for an entire assembly.

• When using the Preview Surface Mesh, Preview Source and Target Mesh, or Preview Inflation feature

during direct meshing, the previewed mesh will be discarded when you perform a subsequent preview

or full mesh operation. The previewed mesh will not be used to seed the subsequent mesh operation.

• After meshing, the meshed status icon appears in the Tree Outline for a meshed body within the Geo-

metry folder, or for a multibody part whose child bodies are all meshed. If you make changes after

meshing that invalidate the mesh for an individual body (such as adding sizing to the body), you will

need to re-mesh that body only.

• In a multibody part, if any child bodies have been meshed and refined, another child body is unmeshed,

and you subsequently mesh the unmeshed body, the mesh state of all refined bodies in the part will

be invalidated and re-meshed during mesh generation. Similarly, if one body is unmeshed and refinement

is needed on another, generating the mesh will result in meshing and refinement of the entire part. In

addition to cases involving refinement, this behavior applies in cases where post inflation is used.

• When meshing a body that is part of a symmetry object, mesh connection object, match control, or

pinch control, all bodies that the control is applied to need to be meshed at the same time. Also, if a

body that is part of a symmetry object, mesh connection object, match control, or pinch control fails

to mesh, the body will have an invalid mesh state that will propagate to all other bodies that are part

of the respective object/control.

• Direct meshing is boundary constrained. That is, if you add a size control to a face that is adjacent to

an up-to-date body, the edges of that face will be recovered from the existing mesh. Due to the

boundary constraints, the mesher cannot split the edges to aid in meshing and will fail if it attempts

to do so.

• When you mix mesh methods in multibody parts, the manner in which topology shared by multiple

bodies is protected depends on whether adjacent bodies are being meshed with Patch Independent

methods (Patch Independent Tetrahedron, MultiZone, Uniform Quad/Tri, or Uniform Quad) and/or Patch

Conforming methods (Patch Conforming Tetrahedron, Sweep [general or thin], or Hex Dominant):

– The interface between a Patch Conforming method and a Patch Conforming method is not protected.

– The interface between a Patch Conforming method and a Patch Independent method is completely

protected.
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– Only the boundary is protected at the interface between a Patch Independent method and a Patch

Independent method.

• You can use the Verbose Messages from Meshing option to control the verbosity of messages returned

to you. Depending on the setting, before meshing a message reports the subset of bodies that is going

to be meshed and/or after meshing a message reports the subset of bodies that failed to mesh.

• Mixed order meshing is not supported for direct meshing.

• Refer to Number of Retries (p. 88) for information about direct meshing and retries.

• Refer to Conformal Meshing Between Parts (p. 7) for information about conformal mesh and mixing

and matching mesh methods on the individual bodies in a multibody part.

• Size controls on neighboring bodies are not considered if you are performing direct meshing. This lim-

itation is applicable to all mesh methods that support direct meshing; however, its impact may differ

depending on the methods being used.

For example, consider the simple model below, which consists of two boxes to which the Patch Inde-

pendent Tetra mesh method has been applied. A local size control that defines a much smaller Element

Size than the global size has been scoped to the top face of the box on the left.

Figure: Two Boxes with Sizing on One Face

When the mesh is generated in one step (i.e., for the entire part rather than body by body), there is a

smooth transition from the fine element size to the coarse element size, as shown in Figure: Mesh Gen-

erated for Entire Part (p. 242).
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Figure: Mesh Generated for Entire Part

However, the mesh will differ if direct (i.e., body by body) meshing is performed. Figure: Direct Meshing:

Left Body First (p. 242) shows the mesh when the body on the left is meshed first, and the body on the

right is meshed second. In this case although the results are different than those in the figure above,

the mesh may still be acceptable because the impact of the local size control on the left body has influ-

enced the boundary mesh of the right body.

Figure: Direct Meshing: Left Body First

In Figure: Direct Meshing: Right Body First (p. 243), the body on the right was meshed first, and the body

on the left was meshed second. When this meshing sequence is used, the mesh on the right body does
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not recognize the size control that is scoped to the body on the left. This results in a coarse mesh on

the right body with the transition region occurring on the left body.

Figure: Direct Meshing: Right Body First

Disabling Direct Meshing

Set the Allow Direct Meshing option to No to disable direct meshing. The Meshing application behaves as

follows when direct meshing is disabled:

• If you make changes after meshing that invalidate the mesh for an individual body in a multibody part

(such as adding sizing to the body), the mesh for all bodies in the part is invalidated and you will need

to re-mesh all bodies.

• If one body is suppressed and you mesh the other bodies, unsuppressing the suppressed body invalidates

the mesh for the other bodies.

• The Generate Mesh, Preview Surface Mesh, and Clear Generated Data RMB menu options are un-

available for individual bodies in multibody parts in the Tree Outline. To use these features for a multibody

part, you must right-click at the part level in the Tree Outline.

• There is no Parts> flyout menu for the Generate Mesh, Preview Surface Mesh, and Clear Generated

Data RMB menu options in the Geometry window. If you select one of these options, the action is

performed on the entire part.
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Note

• In some cases, the mesh may be generated in a direct fashion (i.e., body by body) even if

direct meshing is currently disabled. For example, if you use direct meshing to mesh some

of the bodies in a part, then disable direct meshing, and then generate the mesh and the

mesh process does not invalidate any bodies, the mesh is generated using direct meshing

processes. To avoid this behavior, you can use the Clear Generated Data feature or force a

change of the mesh state on the part. Non-direct meshing will be used for all subsequent

meshing.

• Mesh method interoperability is supported regardless of whether direct meshing is enabled

or disabled. Refer to Conformal Meshing Between Parts (p. 7) for information about mesh

method interoperability.

Inflation Controls

Inflation is useful for CFD boundary layer resolution, electromagnetic air gap resolution or resolving high

stress concentrations for structures.

The following sections provide the high-level steps to follow to assign inflation depending on the selected

mesh method.

For information on setting global inflation controls and descriptions of all of the individual inflation controls,

refer to Inflation Group (p. 67). Alternatively, you can use local inflation mesh controls to apply inflation to

specific boundaries. For details, refer to Inflation Control (p. 185). For general information on applying inflation

controls in combination with the various mesh method controls, refer to Mesh Control Interaction Tables (p. 261).

Inflation Controls With Sweeper

Inflation is a pre process for the sweeper. The source face is meshed and then inflated before sweeping with

the sweeper.

Note

• Inflation is supported only on the source face(s) of the sweep (that is, inflation on the side

faces). Inflation away from the source face(s) is not supported.

• You do not have to select a source face for sweeping with inflation. You can simply pick

faces for inflation and the Meshing application will internally place a Sweep method on the

adjacent bodies using the inflated faces as the sources (unless another method already exists).

To add boundary layers to a source face for sweeping:

1. Apply a Method control to a body.

2. Set Method to Sweep.

3. Set Src/Trg Selection to Manual Source or to Manual Source and Target.

4. Scope the source (and target if Manual Source and Target was selected).

5. Set Free Face Mesh Type to All Quad, All Tri, or Quad/Tri. Your selection determines the shape of

the elements used to fill the swept body (pure hex, pure wedge, or a combination of hex/wedge re-

spectively). The boundary region of the source/target faces will always be meshed with quad layers.
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Refer to Figure: Sweep Method With Inflation: Hex Fill (p. 245) and Figure: Sweep Method With Inflation:

Wedge Fill (p. 246).

6. Enter additional sweep settings, as desired, in the Details View.

7. Select the source face and insert an Inflation control.

8. Select the outer boundary edges of the source face for inflation (i.e., the edges that you want inflation

to grow away from).

9. Enter additional inflation settings, as desired, in the Details View.

10. Mesh the body.

Note

If the target face has a different number of edges than the source face, the bias of the boundary

layer may not be transferred correctly.

To obtain the mesh shown in Figure: Sweep Method With Inflation: Hex Fill (p. 245), Free Face Mesh Type was

set to All Quad. Notice the boundary region is meshed with quad layers.

Figure: Sweep Method With Inflation: Hex Fill

To obtain the mesh shown in Figure: Sweep Method With Inflation: Wedge Fill (p. 246), Free Face Mesh Type

was set to All Tri. Notice the boundary region is meshed with quad layers.
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Figure: Sweep Method With Inflation: Wedge Fill

Inflation Controls With Patch Conforming Mesher

Inflation can be either a pre process or a post process for the patch conforming mesher.

To add boundary layers to a face using the Patch Conforming Mesher:

1. Apply a Method control to a body.

2. Set Method to Tetrahedrons.

3. Set the tetrahedrons Algorithm to Patch Conforming.

4. Select the body and insert an Inflation control.

5. Select the faces to be inflated (i.e., the faces that you want the inflation layers to grow away from).

6. Enter additional settings, as desired, in the Details View.

7. Mesh the body.

Inflation Controls With Patch Independent Mesher

Inflation is a post process for the patch independent mesher after it has created the tetrahedron elements.

To add boundary layers to a face using the Patch Independent Mesher:

1. Apply a Method control to a body.

2. Set Method to Tetrahedrons.

3. Set the tetrahedrons Algorithm to Patch Independent.

4. Set the Min Size Limit.

5. Select the body and insert an Inflation control.

6. Select the faces to be inflated (i.e., the faces that you want the inflation layers to grow away from).

7. Enter additional settings, as desired, in the Details View.
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8. Mesh the body.

Inflation Controls With MultiZone

To add boundary layers to a face using the MultiZone Mesher:

1. Apply a Method control to a body.

2. Set Method to MultiZone.

3. Select the body and insert an Inflation control.

4. Select the faces to be inflated (i.e., the faces that you want the inflation layers to grow away from).

5. Enter additional settings, as desired, in the Details View.

6. Mesh the body.

For more information, see MultiZone Support for Inflation (p. 213).

Inflation Controls With Quadrilateral Dominant or All Triangles Mesher

Inflation is a pre process for the quadrilateral dominant mesher or all triangles mesher.

To add boundary layers to a face using the Quadrilateral Dominant or All Triangles Mesher:

1. Apply a Method control to a body.

2. Set Method to Quadrilateral Dominant or Triangles.

3. Select the body and insert an Inflation control.

4. Select the edges to be inflated (i.e., the edges that you want inflation to grow away from).

5. Enter additional settings, as desired, in the Details View.

6. Mesh the body.

Inflation Handling Between Bodies With Different Methods

The inflation handling between bodies where one body is meshed with the sweep method and one body

is meshed with the patch conforming tetrahedral method requires some special consideration to ensure

inflation layers propagate through the common interface. There are two such cases to consider:

• The case in which the common interface of two bodies is also a source/target face of the swept body

• The case in which the common interface of two bodies is also a side face of the swept body

The model below will be used to explain the first case, in which the common interface of two bodies is also

a source/target face of the swept body.
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Figure: Swept Body Shares Source/Target Face With Tet Body

In this case, inflation on the patch conforming tetrahedral method needs to be defined off the faces of the

wall (not common interface), or by using Program Controlled inflation (which ignores faces in Named Selections

and common interfaces between bodies). The swept body needs the source face to be selected, and 2D in-

flation needs to be defined on the source face. Since 2D inflation does not support the Smooth Transition

option, it is best to use another option so that the inflation between bodies will properly align.

Figure: Defining Inflation for a Swept Body Sharing Source/Target Face With Tet Body

After properly setting up the model and ensuring the inflation of the tet body and the swept body have

similar near-wall spacings, a mesh can be generated where the inflation layers will pass from one body to

the next with proper connections on the common interface, as shown below.
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Figure: Detail of Proper Connections on the Common Interface

The model below will be used to explain the second case, in which the common interface of two bodies is

also a side face of the swept body.

Figure: Tet Body Surrounds Swept Body

In this case, inflation on the patch conforming tetrahedral method needs to be defined off the faces of the

wall (not common interface), or by using Program Controlled inflation (which ignores faces in Named Selections

and common interfaces between bodies). To properly align the inflated tet mesh to the side faces of the

swept body, a biasing needs to be used along the sweep direction. Since the biasing along the sweep direction

uses a different formulation than the inflation biasing, the following notes may be helpful.

The sweep bias ratio is the ratio of largest edge to smallest edge along sweep path, the growth ratio for

inflation is a factor of the growth from the first element to the second element, etc. These relate as described

below. The equation to get the inflation growth rate to align to the swept body is:

Ir = Sb
(1/N-1)

where

Sb = Sweep Bias

N = Number of Divisions along sweep

Ir = Inflation Growth Rate
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Also, to get proper alignment between the first layer of inflation and sweep, you need to use the first layer

height of the swept mesh as first layer height for sweep.

Since the first layer height is computed by the software from the length of the sweep path, the sweep bias,

and the number of divisions along the sweep, and there is no easy way to get the length of the sweep path,

it is recommended to mesh the swept body first, measure the first layer height, and use this value as input

for the First Layer Height option when defining inflation controls. The inflation growth rate can then be

calculated using the formula above. This leads to well-aligned layers between the sweep and tet regions,

as shown below.

Figure: Detail of Well-aligned Layers Between the Swept and Tet Regions

Inflation and Baffles

The Meshing application provides support for meshing 0–thickness walls, or baffles, as non-manifold faces

of a solid body. Inflation is supported. See Baffle Meshing (p. 257) for more information.

Mesh Refinement

Mesh refinement is a postprocess in the mesh generation process in which the elements on the selected

topology are split. This is useful for local mesh sizing control. See the Refinement Control (p. 167) section for

more information.

Mixed Order Meshing

Mixed order meshing is supported across bodies for certain mesh methods. See Method Controls and Element

Midside Nodes Settings (p. 122) for more information.

Air Gap Meshing

The Gap Tool is useful for capturing the physics in the air gap for electromagnetic analyses when using the

patch conforming tet mesher. Anisotropic ( stretched ) elements will be created in the air gap with this

method.

When using the patch independent tet mesher, isotropic elements can be created in the air gap by setting

the defeaturing tolerance to be a number less than your gap distance and by setting the number of elements

across the gap.

If you want hexes in your air gap, it will probably be necessary to slice the air gap into sweepable bodies

in the DesignModeler application.
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Contact Meshing

Enhancing convergence or quality of results for structural contact analysis may require the use of contact

sizing to create similarly sized meshes where faces and bodies are coming in contact. See the Contact Sizing

Control (p. 166) section for more information.

For information about using contact meshing for rigid bodies, refer to Rigid Body Meshing (p. 251).

Winding Body Meshing

Winding body meshing creates special element types depending on the attributes given to bodies in the

DesignModeler application. No mesh controls are supported for winding bodies because of the nature of

the required mesh.

Wire Body Meshing

Wire body meshing meshes the wire bodies in an assembly, respecting any mesh controls applied to the

edges of the wire body.

Pyramid Transitions

Pyramid transitions occur when a swept or hex dominant body abuts, that is, shares faces with, a body

meshed with tetrahedrons. The mesher will try to insert the pyramids into the body meshed with tetrahedrons.

If that is not possible, the hexahedron at the boundary will be split into pyramids and tetrahedrons to create

a conformal mesh between the two bodies. Pyramids will also be formed at the interface of an end cap of

inflation on quad surface mesh and a tet body.

Match Meshing and the Symmetry Folder

Cyclic mesh matching, which controls mesh matching for a part that is symmetric about a cylindrical axis,

can be used for matching face meshes or matching edge meshes. Mesh matching is supported for the patch

conforming tet mesher, the sweeper, and the patch conforming surface body methods (quad dominant and

all triangles). When symmetric and anti-symmetric objects exist in the Periodic folder, match face mesh

controls will be created internal to the mesher. If the mesher cannot match the mesh on the objects in the

symmetry folder, it will return a failure code.

For an overview of the cyclic match control, see Cyclic Match Control (p. 178). For general information on

applying match controls in combination with the various mesh method controls, refer to Mesh Control Inter-

action Tables (p. 261).

Rigid Body Meshing

Rigid body meshing simplifies the representation of a model by reducing it to the contact regions and the

centroid of the model. In other words, when a part is defined as a rigid body, the mesher knows to mesh

only the contact regions, and to create a single mass element at the centroid of the model. (The centroid

is represented by an Inertial Coordinate System. Refer to the discussion of Rigid Bodies in the Mechanical

help for more information.)

Rigid body meshing can be used for both 2D and 3D contact. For 2D models, only the edges of the rigid

surface in contact are meshed because the surface mesh is not needed for the analysis. Similarly, for 3D

models, only the faces of the rigid body in contact are meshed because the volume mesh is not needed.
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The elements used to mesh the contact surfaces can be quadrilateral or triangular in shape, with or without

midside nodes.

The following surface mesh methods can be applied to rigid bodies:

• Quadrilateral Dominant

• Triangles

Rigid body contact meshing respects mapped face controls and sizing controls. If 2D inflation is applied,

inflation layers are generated for the surfaces in contact.

If a method control is scoped to a rigid body, the Method control is set to Quadrilateral Dominant by

default, but you can change the value to Triangles. When Method is set to Quadrilateral Dominant, an

additional option called the Free Face Mesh Type control is available for most analyses and can be set to

either Quad/Tri (default) or All Quad.

For Transient Structural, Rigid Dynamics, and Explicit Dynamics analyses, certain default behaviors related

to rigid body meshing differ depending on analysis type and solver. Additionally, the Free Face Mesh Type

option is replaced by the Rigid Face Mesh Type option to determine the default element shape for rigid

body face meshing. The table below provides information you should be aware of when selecting one of

these analysis types from the Toolbox and adding it to a Workbench project.

Rigid Body Meshing: Default Behaviors for Rigid Dynamics,Transient Structural, and Explicit Dynamics

Analyses

Rigid Face

Mesh Type

Rigid Body

Behavior

Straight

Sided Ele-

ments

Element Mid-

side Nodes

SolverStandard Analysis

Type

All Tri (Read-

only)

Dimensionally

Reduced

Not applicableDropped

(Read-only)

Rigid Body Dy-

namics

Rigid Dynamics

Quad/TriDimensionally

Reduced

NoProgram Con-

trolled

Mechanical

APDL

Transient Structural

Quad/TriFull MeshNot applicableDroppedAUTODYNExplicit Dynamics

Quad/TriFull MeshNot applicableDroppedLS-DYNAExplicit Dynamics

(LS-DYNA Export)

For information about generating a full mesh on rigid bodies instead of a surface mesh, refer to the description

of the Rigid Body Behavior (p. 89) control.

Using 2D Rigid Body Contact Meshing

This section describes the basic steps for using 2D rigid body contact meshing.

To define a 2D rigid body for contact meshing:

1. Open the model in the Mechanical application.

2. In the Tree, expand the Geometry object so that the body objects are visible.

3. Click on the body that you want to define as the rigid body.

4. In the Details> Definition view for the body, change the value of the Stiffness Behavior control to

Rigid.
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Note

When you change the Stiffness Behavior to Rigid, an Inertial Coordinate System object

is added to the Tree automatically. This Inertial Coordinate System represents the centroid

of the body.

5. If desired, change the value of the Element Midside Nodes control.

6. Generate the mesh by right-clicking on the Mesh object in the Tree and selecting Generate Mesh.

Note

The mesh for the 2D rigid body is created only in the contact region (edges in contact). See

the figure below for an example.

In the figure below, which shows a model of a slab and a cylinder, the cylinder has been defined as a rigid

body. When the mesh is generated, the cylinder is meshed with line elements as shown.

Figure: 2D Rigid Body Contact Meshing

Using 3D Rigid Body Contact Meshing

This section describes the basic steps for using 3D rigid body contact meshing.

To define a 3D rigid body for contact meshing:

1. Open the model in the Mechanical application.

2. In the Tree, expand the Geometry object so that the body objects are visible.

3. Click on the body that you want to define as a rigid body.

4. In the Details> Definition view for the body, change the value of the Stiffness Behavior control to

Rigid.
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Note

When you change the Stiffness Behavior to Rigid, an Inertial Coordinate System object

is added to the Tree automatically. This Inertial Coordinate System represents the centroid

of the body.

5. If you wish to control the mesh method, insert a mesh method by right-clicking on the Mesh object

in the Tree and selecting Insert> Method.

Note

The Automatic method appears in the Details View.

6. In the Details View, scope the mesh method to the rigid body.

Note

By default, the Method control is set to Quadrilateral Dominant for rigid bodies, but you

can change the value to Triangles. When Method is set to Quadrilateral Dominant, an

additional option called the Free Face Mesh Type control is available and can be set to

either Quad/Tri (default) or All Quad.

7. If desired, change the value of the Element Midside Nodes control.

8. Generate the mesh by right-clicking on the Mesh object in the Tree and selecting Generate Mesh.

Note

The mesh for the 3D rigid body is created only in the contact region (faces in contact).

Thin Solid Meshing

Thin solid meshing is useful for thin solid bodies where one element through the thickness is desired. This

meshing also takes advantage of the Mechanical APDL application's SOLSH190 element.

• It may be advantageous to use a Sizing control on the faces/body along with Mapped Face Meshing

controls to give a uniform mesh.

• Virtual Topology may be necessary to satisfy the topological criterion for thin solid meshing.

CAD Instance Meshing

The Meshing application supports pattern instances that have been defined for part features or assembly

components in a CAD system, such as Pro/ENGINEER, Parasolid, or Solid Edge. These instance definitions

remain in the CAD system. When a model with instances is read in to Workbench, the geometry is read once

and then copied for each instance. Similarly, when meshing, the Meshing application generates the mesh

once and then copies it for each instance. Support for pattern instances provides these benefits:

• Improved geometry import speed because only one instance of a part is read in
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• Improved meshing speed because only one instance of a part is meshed; copies of the first instance's

mesh are used for the remaining instances

Keep the following information in mind when working with instances:

• Instances of bodies are not supported. Single body part instancing is supported, as well as certain vari-

ations of instancing of multibody parts (for example, if you are using the None or Imprints option for

Shared Topology Method). For more information, refer to the discussion of feature modeling's effect

on instance data in the DesignModeler help.

• If you apply a mesh control to a part that is instanced, each instance must have the same control applied

to it or the part will be meshed individually. For example, if your model consists of four parts that are

instanced but only one part has an edge sizing control applied to it, that part will be meshed individually

and the other three parts will be meshed once and instanced.

• Instancing is not supported for the following controls. Each part that has any of these controls applied

to it will be meshed individually, regardless of whether the control in question is applied to all instances:

– Sphere of influence sizing

– Body of influence sizing

– Contact sizing

– Gap sizing

– Match controls

– Rigid body meshing (presence of any rigid bodies in the part)

– Mesh morphing

• You can use the Extend Selection command to select a set of instances, which can be useful for per-

forming tasks such as applying loads or creating a Named Selection. To select a set of instances, first

select one instance, then click the Extend Selection drop-down menu and choose Extend to Instances.

Extend to Instances searches for all remaining instances that are defined for the currently selected in-

stance. The Extend to Instances menu option is enabled only when pattern instances are defined in

the current model.

• Because the mesh is copied from the first instance to the remaining instance, it follows that each instance

will be meshed with the same number of nodes and elements. To confirm this, after CAD instances are

successfully meshed, click the Geometry object in the Tree Outline. Then click the Worksheet toolbar

button. When the Worksheet appears, click on the Nodes heading, which sorts the data on that column

and allows you to view the matching numbers of nodes and elements for each instance.

• Error handling for instances is also copied. For example, if the mesher fails on one instance, all instances

will fail; however, you will receive a warning message for each instance. Refer to Figure: Error Handling

for Instances (p. 256), which shows a model containing eight identical pistons.
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Figure: Error Handling for Instances

Meshing and Hard Entities

The two types of hard entities are hard edges and hard points. Hard entities are usually defined in the

DesignModeler application or a CAD system.

A hard point is an embedded point in a face or edge. Hard points are captured by nodes during the meshing

process. Hard points are not supported for the following mesh methods or controls:

• General sweeping

• 3D inflation

A hard edge is an embedded edge in a face. There are two main types of embedded edges:

• An edge in which one vertex of the edge touches the face boundary, but the other vertex does not

touch a face boundary

• An edge in which neither of the vertices touches the face boundary

Hard edges are not supported for the following mesh methods or controls:
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• General sweeping

• 2D or 3D inflation

Note

• If the methods and controls listed above are required in your mesh, you must go back to

the DesignModeler application and edit the model to remove the hard entities.

• Other mesh methods have certain limitations in how hard points and hard edges are handled.

For more information, refer to Limitations of Using Hard Entities with Other Mesh Controls (p. 257).

Spot Welds

Spot welds are used to connect individual surface body parts together to form surface body model assemblies,

just as contact is used for solid body part assemblies. Spot welds are usually defined as hard points in the

DesignModeler application or a CAD system:

• When a model is imported into the Meshing application, the mesher simply treats the hard points as

embedded points.

• Upon import to the Mechanical application, spot welds are automatically generated where hard points

are defined in the model.

For related information, refer to Point in the DesignModeler help and Spot Welds in the Mechanical help.

Limitations of Using Hard Entities with Other Mesh Controls

Limitations of hard entities include the following:

• 3D inflation does not support hard entities of either type. If inflation is applied, a warning message is

issued to indicate the hard entities were ignored.

• 2D inflation supports hard points only.

• Sweeping does not support hard points.

• The Uniform Quad/Tri, Uniform Quad, and MultiZone mesh methods do not respect hard entities unless

their topology is protected. For all three methods, “protected topology” includes embedded vertices

or edges with contacts, Named Selections, loads, boundary conditions, or results; spot welds; or surface

bodies with differing thicknesses. For Uniform Quad/Tri and Uniform Quad only, sheet bodies with dif-

fering material definitions are also protected topology. The boundaries at protected topology will not

be crossed.

• For the MultiZone mesh method only, the faces that contain the hard entities must be selected as source

faces for the hard entities to be respected.

• Hard edges may exist accidentally in a CAD model due to Boolean operations with tight tolerances or

other such operations. These accidental hard edges may be undesired, in which case you should remove

them through defeaturing within the DesignModeler application or a CAD system.

Baffle Meshing

The Meshing application provides support for meshing 0-thickness walls, or baffles, as non-manifold faces

of a solid body. For such models, you do not have to adjust the mesh size to capture the thin regions.

Characteristics and limitations of baffle meshing include:
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• Baffle meshing is supported by the Patch Conforming Tetra, Patch Independent Tetra, and MultiZone

mesh methods only. If you apply any other mesh method to a body containing baffles, the mesh

method will be suppressed, and the reason (not supported) will be reported in the Active read-only

field in the Details View. In such cases, the body will be meshed with the Patch Conforming Tetra mesh

method.

• When the MultiZone mesh method is used, the body with a baffle must be meshed with a free mesh

of tetrahedral elements. For this reason, you must set the Free Mesh Type to Tetra for bodies with

baffles.

• The Patch Conforming Tetra and Patch Independent Tetra mesh methods support inflation of baffles.

The MultiZone mesh method does not support inflation of baffles.

• When the Patch Conforming Tetra mesh method is used, inflation layers will stair step at free boundary

edges of the baffles.

• When the Patch Independent Tetra mesh method is used and Collision Avoidance (p. 77) is set to Stair

Stepping, inflation layers will stair step at free boundary edges of the baffles. However, if Collision

Avoidance is set to Layer Compression, full prism columns appear at the free boundary edges.

• Program Controlled inflation is supported (that is, if you select Program Controlled inflation, baffles

are automatically selected to be inflation boundaries unless they are in a Named Selection).

• Only both-sided growth cases for inflation are supported.

• Pyramid transitions are supported.

• Prism/pyramid elements are not supported for meshing crossed/intersecting baffles.

• There is a single set of nodes on the internal face.

Figure: Cylinder Containing Baffles (p. 258) shows a model of a cylinder that contains a series of baffles.

Figure: Cylinder Containing Baffles

In Figure: Section Cut Showing Baffle Meshing (p. 259), the model was meshed using Program Controlled in-

flation. Since the baffles were not in a Named Selection, they were automatically selected to be inflation
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boundaries. A section plane was activated to view a section cut through the model, and the baffle faces

were selected in the Geometry window.

Figure: Section Cut Showing Baffle Meshing

Figure: Detail of Inflation on Baffles (p. 260) shows a detailed view of the inflation layers on the baffles.
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Figure: Detail of Inflation on Baffles
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Mesh Control Interaction Tables

This section presents the effects of applying combinations of mesh controls on the same part or body.

Topics include the meshing implication when one mesh method is applied in combination with another

mesh method, and the effects of applying various mesh controls in combination with the various mesh

methods.

Interactions Between Mesh Methods

Interactions Between Mesh Methods and Mesh Controls

Interactions Between Mesh Methods

The tables below present the effects of applying one mesh method in combination with another mesh

method, and include:

• Using combinations of surface mesh methods

• Using combinations of solid mesh methods

• Applying a single 3D inflation control on more than one solid body when a combination of mesh

methods has been scoped to the bodies

• Applying a 3D inflation control on a solid body when more than one mesh method has been scoped

to the body

Note

• CutCell cannot be used in combination with any other mesh method.

• Refer to Conformal Meshing Between Parts (p. 7) for information about conformal meshing

and mesh method interoperability.

The table below describes the automatic sequencing of surface mesh methods when two mesh methods

are being used. If all three methods are being used, the automatic sequence is:

1. All Triangles

2. Quad Dominant

3. Uniform Quad(/Tri)

Note

If you are performing direct meshing, you control the sequence. Refer to Direct Meshing (p. 239)

for usage notes.

Surface Mesh Method
Surface Mesh Method

Uniform Quad(/Tri)Quad DominantAll Triangles

All Triangles firstAll Triangles firstN/AAll Triangles
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Surface Mesh Method
Surface Mesh Method

Uniform Quad(/Tri)Quad DominantAll Triangles

Quad Dominant firstN/AAll Triangles firstQuad Dominant

N/AQuad Dominant firstAll Triangles firstUniform Quad(/Tri)

The table below describes the automatic sequencing of solid mesh methods when two methods are being

used. If more than two methods are being used, the automatic sequence is:

1. MultiZone

2. General Sweep

3. Thin Sweep

4. Hex Dominant

5. Patch Conforming Tetra

6. Patch Independent Tetra

Note

• If you are performing direct meshing, you control the sequence. Refer to Direct Meshing (p. 239)

for additional usage notes.

• During automatic sequencing of solid mesh methods when inflation has been applied, Post

inflation is always applied last and uses as its input mesh the complete currently existing

part mesh.

Solid Mesh Method

Solid Mesh

Method MultiZone

Patch Inde-

pendent

Tetra

Patch Con-

forming

Tetra

Thin Sweep
General

Sweep

Hex Domin-

ant

MultiZone

first

Hex Domin-

ant first

Hex Domin-

ant first

Thin Sweep

first

General

Sweep first
N/A

Hex Domin-

ant

MultiZone

first
1

General

Sweep first

General

Sweep first

General

Sweep first
N/A

General

Sweep first

General

Sweep

MultiZone

first

Thin Sweep

first

Thin Sweep

first
N/A

General

Sweep first

Thin Sweep

first

Thin Sweep

MultiZone

first

Patch Con-

forming

Tetra first

N/A
Thin Sweep

first

General

Sweep first

Hex Domin-

ant first

Patch Con-

forming

Tetra

MultiZone

first
N/A

Patch Con-

forming

Tetra first

Thin Sweep

first

General

Sweep first

Hex Domin-

ant first

Patch Inde-

pendent

Tetra

N/A
MultiZone

first

MultiZone

first

MultiZone

first

MultiZone

first
1

MultiZone

first

MultiZone

1–While mixing Sweep and MultiZone mesh methods, pre-meshed faces may be used in these ways:

• Mapped faces can be supported as side faces when MultiZone or Sweep is used to mesh subsequent

bodies. The pre-meshed faces may have been generated using either General Sweep or MultiZone.
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There are limitations on how the face is mapped. Simple mapped faces (that is, 4-sided) are supported;

however, more complicated sub-mapped cases may cause problems.

• Mapped faces can be supported as source faces.

• Free faces (where mesh does not have a quad mapped pattern) can be supported as source faces only.

The table below describes how inflation is handled if you apply a single 3D inflation control on more than

one solid body when a combination of mesh methods has been scoped to the bodies.

Supported Inflation AlgorithmMethod 2Method 1

Post inflation onlyPatch Independent TetraPatch Conforming Tetra

Pre inflation only
1

MultiZonePatch Conforming Tetra

No inflation allowed; inflation is suppressedMultiZonePatch Independent Tetra

No inflation allowed; inflation is suppressedPatch Independent Tetra (+

Method 3 of MultiZone )

Patch Conforming Tetra

No inflation allowed; inflation is suppressedAny other methodGeneral Sweep

No inflation allowed; inflation is suppressedAny other methodThin Sweep

No inflation allowed; inflation is suppressedAny other methodHex Dominant

1– In such cases involving MultiZone, the value of the Inflation Algorithm control displays as Pre but an

O-grid-based algorithm specific to MultiZone is used. As with the Pre inflation algorithm, the surface mesh

is inflated first and then the rest of the volume mesh is generated.

The table below describes how inflation is handled if you apply a 3D inflation control on a solid body when

more than one mesh method has been scoped to the body. In such cases, the method control that appears

lowest in the Tree is respected and therefore inflation is handled as it would normally be handled for that

method.

Supported Inflation Algorithm(s)Lowest Method in Tree

Post or Pre inflationPatch Conforming Tetra

Post inflation onlyPatch Independent Tetra

Pre inflation only
1

MultiZone

No inflation allowed; inflation is suppressedGeneral Sweep

No inflation allowed; inflation is suppressedThin Sweep

No inflation allowed; inflation is suppressedHex Dominant

1– In such cases involving MultiZone, the value of the Inflation Algorithm control displays as Pre but an

O-grid-based algorithm specific to MultiZone is used. As with the Pre inflation algorithm, the surface mesh

is inflated first and then the rest of the volume mesh is generated.

Interactions Between Mesh Methods and Mesh Controls

The tables in this section present the effects of applying various mesh controls in combination with the

various mesh methods, and include:

• Using mesh controls with the patch conforming mesh methods

• Using mesh controls with the patch independent mesh methods
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The table below describes the effects of applying the mesh control on the left with each of the patch con-

forming mesh methods.

Patch Conforming Mesh Methods
Mesh Con-

trol Hex Domin-

ant
Thin Sweep

General

Sweep

Patch Con-

forming Tetra

Quad Dom-

inant

All Tri-

angles

Size control affects elements on body and lower topological entities.
Body Sizing

Control

Size control affects elements on face and lower topological entities.
Face Sizing

Control

Size control affects element edge lengths on edge.
Edge Sizing

Control

Inserts elements of specified size within sphere. Restrictions for General Sweep.

Sphere of In-

fluence Con-

trol

Inserts elements of specified size within body. Only available when Advanced Size Function

is on. Similar sweeping restrictions.

Body of Influ-

ence Control

Inserts spheres of influence on contact faces in regions within contact tolerance. Similar

sweeping restrictions.

Contact Siz-

ing Control

Refines elements as post-process. Hex, wedge, and pyramid element regions are converted

to tetrahedron.

Refinement

Control

Mapped faces are meshed before any other faces. Interval assignment may affect edge divi-

sions. No sphere of influence support. No mesh based defeaturing or pinch support.

Mapped Face

Control

Not suppor-

ted

Edge meshes are matched for sheet, 2D, and 3D bodies. Face meshes are

matched across bodies. Match controls cannot be applied across multiple

parts. Additional restrictions apply.

Match Con-

trol

Supported

Supported

on sources

and targets.

Not suppor-

ted
Supported

Pinch Con-

trol

Not suppor-

ted

Not suppor-

ted

Supported

on source.
Supported

Inflation Con-

trol

Not supported

Inserts sphere

of influence at

Not supportedGap Tool

gap; then per-

forms aniso-

tropic tet re-

finement

across gap.

The table below describes the effects of applying the mesh control on the left with each of the patch inde-

pendent mesh methods.

Note

When using any other meshing control with the Uniform Quad/Quad Tri, MultiZone, or Patch In-

dependent tetra mesh method controls, the other meshing control will be suppressed regardless

of where the controls appear in the tree.
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Patch Independent Mesh Methods

Mesh Control
CutCell

Patch Inde-

pendent

Tetra

MultiZone
Uniform Quad or

Uniform Quad/Tri

SupportedSupported

Supported, except for the

Behavior option. Restrictions
Not supported

Body Sizing Con-

trol for sweeping/mapped

meshing and free blocks.

SupportedSupported

Supported, except for the

Behavior option. Restrictions
Not supported

Face Sizing Con-

trol for sweeping/mapped

meshing.

SupportedSupported

Supported, except for the

Behavior option. Restrictions
Not supported

Edge Sizing Con-

trol for sweeping/mapped

meshing.

Not supportedSupportedNot supportedNot supported
Sphere of Influ-

ence Control

Not supportedSupportedNot supportedNot supported
Body of Influence

Control

Not supportedSupported
Supported. Restrictions for

sweeping/mapped meshing.
Not supported

Contact Sizing

Control

Not supported
Refinement Con-

trol

Not supported
Not suppor-

ted

Mapped faces are meshed before any other faces.

Interval assignment may affect edge divisions. NoMapped Face

Control sphere of influence support. No mesh based defea-

turing or pinch support.

Not supportedMatch Control

Not supportedPinch Control

SupportedSupported
Supported. Restrictions for

sweeping/mapped meshing.
Not supportedInflation Control

Not supportedGap Tool
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Miscellaneous Tools

The miscellaneous meshing tools described in the following sections include:

Generation of Contact Elements

Renaming Mesh Control Tool

Mesh Numbering

Mesh Connection

Generation of Contact Elements

To model contact between parts in an assembly, you must define specific contact conditions.

One of those conditions is tolerance, which controls the extent of contact between parts in an assembly.

Tolerance is set as a percentage of the bounding box of the assembly. The bounding box is the smallest

volume that the assembly will fit in. You can change the tolerance (between -100 and 100) in the Options

dialog box under the Mechanical application's Connections category.

The higher the number, the tighter the tolerance. A loose tolerance generally increases the number of contact

faces and areas of contact between parts, while a tight tolerance will decrease the number of contact faces.

Each face of the part is checked against the faces of other parts in the assembly. A contact pair is generated

between any faces within the tolerance. When solving, the elements for the two faces that make up the pair

are compared. If any of the faces are within the tolerance, contact elements are generated for them.

Recommendations for Defining Contact for CFD Analyses

CFD users should be aware of the following recommendations:

• By default, contact detection is computed upon geometry import when Physics Preference is set to

CFD. If you do not want contact detection to be computed, you must change the Auto Detect Contact

on Attach setting in the Mechanical application to No. This setting is available in the Options dialog

box under the Mechanical application's Connections category.

• For CFX users, it is best practice to set the Group By option to None when defining Global Contact

Settings. This is true because CFX only accepts contact pairs having a 1-to-1 correspondence. Setting

Group By to None ensures the 1-to-1 pairing needed for contact regions in these cases.

Renaming Mesh Control Tool

You can rename any of the mesh control tool objects to include the name assigned to the part or body. To

do this, use a right mouse button click on the object and choose Rename Based on Definition from the

context menu. For example, if you scope a Refinement tool to a body named Tube and choose Rename

Based on Definition, the mesh control tool name changes from Refinement to Refinement on Tube. The

name change is reflected both in the tree and as a label on the body.
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Mesh Numbering

The Mesh Numbering feature allows you to renumber the node and/or element numbers of a generated

meshed model consisting of flexible parts. The feature is useful when exchanging or assembling models

and could isolate the impact of using special elements such as superelements. For details, refer to Mesh

Numbering in the Mechanical help.

Mesh Connection

The Mesh Connection feature allows you to join the meshes of neighboring surface bodies in a multibody

part that may not share topology. The connection can be edge-to-edge or edge-to-face. For details, refer to

Mesh Connection in the Mechanical help.
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Ease of Use Features

The features described in this section are intended to assist you in meshing.

Updating the Mesh Cell State

Generating Mesh

Previewing Surface Mesh

Previewing Source and Target Mesh

Previewing Inflation

Showing Program Controlled Inflation Surfaces

Showing Sweepable Bodies

Showing Problematic Geometry

Showing Geometry in Overlapping Named Selections

Showing Removable Loops

Inspecting Large Meshes Using Named Selections

Clearing Generated Data

Showing Missing Tessellations

Showing Mappable Faces

Updating the Mesh Cell State

In contrast to the Generate Mesh feature (which only produces the mesh), the Update feature determines

whether the geometry needs to be updated, refreshes the geometry if necessary, generates the mesh if

necessary, and also writes the output data for any connected cells:

• The Generate Mesh feature is useful when you are investigating the impact of different settings on

the mesh but you are not ready to export the mesh files.

• The Update feature is useful if you make a connection in the ANSYS Workbench Project Schematic from

a Mesh cell to a system that requires a new type of output data (for example, if you make a connection

from the Mesh cell to a Fluid Flow (CFX) or Fluid Flow (FLUENT) analysis system). In such cases, the

Mesh cell will go out-of-date. To bring the Mesh cell up-to-date, you can perform an Update on the

Mesh cell from within the Project Schematic, or follow the procedure below from within the Meshing

application.

To update the Mesh cell:

1. Select the Mesh object or any mesh control object.

2. Right-click to display the context menu.

3. Select Update in the menu.

Note

As an alternative to steps 2 and 3, you can click the Update button on the Mesh toolbar.

269
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



Generating Mesh

You can generate the mesh for all unsuppressed bodies, individual unsuppressed bodies, or individual un-

suppressed parts. This includes single body parts, multibody parts, individual bodies, or multiple selected

bodies across different parts or within the same part.

Note

• Selecting Generate Mesh generates a mesh based on the current mesh settings. It does not

write the output data for any connected cells. Generate Mesh is useful when you are invest-

igating the impact of different settings on the mesh but you are not ready to export the

mesh files. Refer to Updating the Mesh Cell State (p. 269) for related information.

• Using direct meshing, you can selectively pick bodies and mesh them incrementally. After

meshing a body, you can mesh the whole part or assembly or continue meshing individual

bodies. Refer to Direct Meshing (p. 239) for additional information.

Suppressing and Unsuppressing Bodies in a Model

When there is a combination of suppressed and unsuppressed bodies in a model, the Meshing application

meshes only the unsuppressed bodies. This is true regardless of mesh method. In addition, all influence of

the suppressed bodies on neighboring bodies and their meshes is suppressed. For example, if a size control

is applied to a suppressed body, the size control will not affect that body, nor will it influence neighboring

bodies. Because suppressing and unsuppressing bodies in a multibody part can change the meshes in

neighboring bodies, it invalidates the mesh state for the whole part, and the mesh will need to be regenerated.

When the mesh is regenerated, only the affected parts are re-meshed. Suppressing an entire part (or simul-

taneously suppressing every body in a part) will not affect the mesh state.

To generate the mesh for all unsuppressed bodies:

1. Select the Mesh object or any mesh control object.

2. Right-click to display the context menu, or choose the Mesh drop down menu from the toolbar.

3. Select Generate Mesh in the menu. All unsuppressed bodies are meshed. The mesh is displayed when

you select the Mesh object

To generate the mesh for individual unsuppressed bodies - from the object tree:

1. Select the Body objects.

2. Right-click to display the context menu.

3. Select Generate Mesh in the menu. The bodies are meshed. The meshes are displayed when you select

the Mesh object.

To generate the mesh for individual unsuppressed bodies - from the Geometry window:

1. Select the Mesh object.

2. Select the bodies in the Geometry window.

3. Right-click to display the context menu.

4. Select Generate Mesh On Selected Bodies in the menu. The bodies are meshed. The meshes are

displayed when you select the Mesh object in the tree.
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To generate the mesh for individual unsuppressed parts - from the object tree:

1. Select the Part objects.

2. Right-click to display the context menu.

3. Select Generate Mesh in the menu. The parts are meshed. The meshes are displayed when you select

the Mesh object.

To generate the mesh for individual unsuppressed parts - from the Geometry window:

1. Select the Mesh object.

2. Select the parts in the Geometry window.

3. Right-click to display the context menu.

4. Select Parts> Generate Mesh in the menu. The parts are meshed. The meshes are displayed when

you select the Mesh object in the tree.

After successfully generating a mesh, you can view statistics about it. These statistics include mesh metric

information that you can use to evaluate the mesh quality. For more information, see Statistics Group (p. 101).

To re-mesh:

1. Select the Mesh object.

2. Right-click to display the context menu and select Clear Generated Data in the menu.

3. Confirm that you want to clear the mesh by clicking the Yes button.

4. Right-click on the Mesh object to display the context menu again and select Generate Mesh in the

menu.

Note

The order of topological entities is not guaranteed during a CAD source refresh. In cases in which

you mesh, refresh, and re-mesh, the mesher may not produce exactly the same mesh if the refresh

caused the topological entities to be reordered. As a result of this reordering, the mesher meshes

the entities in a different order as well, producing a slightly different result.

Previewing Surface Mesh

You can preview the surface mesh for all unsuppressed parts, individual unsuppressed parts, or individual

unsuppressed bodies. This includes single body parts, multibody parts, individual bodies, or multiple selected

bodies across different parts or within the same part. You can also export the previewed surface mesh file

in FLUENT format, as described in Exporting a Previewed Surface Mesh in FLUENT Format (p. 273).
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Note

• This feature is not supported for the Patch Independent and MultiZone mesh method

controls. It is also not supported for thin model sweeping (that is, use of the Sweep mesh

method control with Src/Trg Selection set to Manual Thin or Automatic Thin) or for CutCell

meshing. (Refer to The CutCell Meshing Workflow (p. 231) for alternative approaches for CutCell.)

• Influence of a swept body is an example of a size source that is fully integrated into the

Advanced Size Function, which means that it will contribute to the final mesh distribution

obtained by the mesher when the Advanced Size Function is on. However, the results obtained

by either the Preview Surface Mesh or Preview Inflation feature when the Advanced Size

Function is on may not accurately represent inflation layers and the surface mesh size distri-

bution close to a swept body when compared to the results obtained by the Generate Mesh

feature, particularly if there is bias along the sweep axis and/or the hex elements on the in-

terface of the inflation boundary are very thin.

• Refer to Direct Meshing (p. 239) for general information about direct meshing and limitations

related to using the Preview Surface Mesh feature with direct meshing.

To preview the surface mesh for all unsuppressed parts:

1. Select the Mesh object or any mesh control object.

2. Right-click to display the context menu, or choose the Mesh drop down menu from the toolbar.

3. Select Preview> Surface Mesh in the context menu or Preview Surface Mesh in the drop down

menu. The surface mesh is displayed for the model when you select the Mesh object.

To preview the surface mesh for individual unsuppressed parts - from the object tree:

1. Select the Part objects.

2. Right-click to display the context menu.

3. Select Preview> Surface Mesh in the menu. The surface mesh is displayed for the parts when you

select the Mesh object.

To preview the surface mesh for individual unsuppressed parts - from the Geometry window:

1. Select the Mesh object.

2. Select the parts in the Geometry window.

3. Right-click to display the context menu.

4. Select Parts> Preview Surface Mesh in the menu. The surface mesh is displayed for the parts when

you select the Mesh object in the tree.

To preview the surface mesh for individual unsuppressed bodies - from the object tree:

1. Select the Body objects.

2. Right-click to display the context menu.

3. Select Preview> Surface Mesh in the menu. The surface mesh is displayed for the bodies when you

select the Mesh object.
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To preview the surface mesh for individual unsuppressed bodies - from the Geometry window:

1. Select the Mesh object.

2. Select the bodies in the Geometry window.

3. Right-click to display the context menu.

4. Select Preview Surface Mesh On Selected Bodies in the menu. The surface mesh is displayed for the

bodies when you select the Mesh object in the tree.

After successfully previewing the surface mesh, you can view statistics about it. These statistics include mesh

metric information that you can use to evaluate the mesh quality. For more information, see Statistics

Group (p. 101).

Exporting a Previewed Surface Mesh in FLUENT Format

Follow the steps below to export a previewed surface mesh in FLUENT format:

To export a previewed surface mesh in FLUENT format:

1. Follow the procedure to preview a surface mesh.

2. Select File> Export from the main menu to export the surface mesh.

3. In the Save As dialog box, choose a directory and specify a file name for the file. Then choose FLUENT

Input Files from the Save as type drop-down menu and click Save.

A .msh file suitable for import into FLUENT will be created in the requested directory.

Previewing Source and Target Mesh

This feature allows you to preview the source and target meshes for scoped bodies. You can preview the

source and target mesh on individual bodies or multiple selected bodies across different parts or within the

same part. This feature applies only to a Method control set to the Sweep option.

Note

• This feature is not supported for thin model sweeping (that is, use of the Sweep mesh

method control with Src/Trg Selection set to Manual Thin or Automatic Thin).

• Refer to Direct Meshing (p. 239) for general information about direct meshing and limitations

related to using the Preview Source and Target Mesh feature with direct meshing.

To preview the source and target mesh:

1. Scope the body or bodies of interest.

2. Right-click on the Mesh object and insert a Method control.

3. In the Details View, set Method to the Sweep option.

4. Right-click on the Sweep Method option in the tree to display the context menu, or choose the Mesh

drop down menu from the toolbar.

5. Select Preview> Source and Target Mesh in the context menu or Preview Source and Target Mesh

in the drop down menu. The source and target meshes are displayed when you select the Mesh object.
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Previewing Inflation

The Preview Inflation feature helps you identify possible problems with inflation before you generate the

mesh. You can preview inflation on single body parts, multibody parts, individual bodies, or multiple selected

bodies across different parts or within the same part. You can also export the previewed inflation mesh file

in FLUENT format, as described in Exporting a Previewed Inflation Mesh in FLUENT Format (p. 275).

Keep the following information in mind when using the Preview Inflation feature:

• This feature is not supported for the Patch Independent Tetra and MultiZone mesh method controls.

It is also not supported for CutCell meshing.

• Match controls are not enforced when previewing inflation.

• In certain cases, Preview Inflation may return an invalid mesh. Generate Mesh may return a valid mesh

with inflation, a valid mesh without inflation (because inflation failed), or result in a mesh failure (because

tet meshing failed). For these reasons if Generate Mesh fails, using either the Preview Surface Mesh

or Preview Inflation feature to locate the worst quality element is also likely to locate the cause of the

mesh failure.

• Influence of a swept body is an example of a size source that is fully integrated into the Advanced Size

Function, which means that it will contribute to the final mesh distribution obtained by the mesher

when the Advanced Size Function is on. However, the results obtained by either the Preview Surface

Mesh or Preview Inflation feature when the Advanced Size Function is on may not accurately represent

inflation layers and the surface mesh size distribution close to a swept body when compared to the

results obtained by the Generate Mesh feature, particularly if there is bias along the sweep axis and/or

the hex elements on the interface of the inflation boundary are very thin.

• This feature applies only when the Inflation Algorithm control is set to Pre (p. 75).

• After successfully previewing inflation, you can view statistics about it. These statistics include mesh

metric information that you can use to evaluate the mesh quality. For more information, see Statistics

Group (p. 101).

• Refer to Direct Meshing (p. 239) for general information about direct meshing and limitations related to

using the Preview Inflation feature with direct meshing.

To preview inflation:

1. Apply inflation to the desired boundaries.

2. Select an object in the Tree Outline (the Mesh object, a mesh Method object, or an Inflation object)

and right-click to display the context menu.

3. Select Preview> Inflation in the menu. In response, Workbench generates the inflation layers only

and displays them in the Geometry window. You may need to click the Mesh object in the Tree Outline

before you can view the inflation layers.

Figure: Previewed Inflation Mesh (p. 275) shows a model of an auto manifold to which inflation was applied.

The Preview Inflation feature was selected, and the inflation layers were generated and displayed in the

Geometry window.
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Figure: Previewed Inflation Mesh

Figure: Section Plane View of Previewed Inflation Mesh (p. 275) shows a different view of the auto manifold

model. For this view, a Section Plane was defined so that the inflation layers could be viewed internally.

Figure: Section Plane View of Previewed Inflation Mesh

Exporting a Previewed Inflation Mesh in FLUENT Format

Follow the steps below to export a previewed inflation mesh in FLUENT format:

To export a previewed inflation mesh in FLUENT format:

1. Follow the procedure to preview inflation.

2. Select File> Export from the main menu to export the inflation mesh.

3. In the Save As dialog box, choose a directory and specify a file name for the file. Then choose FLUENT

Input Files from the Save as type drop-down menu and click Save.

A .msh file suitable for import into FLUENT will be created in the requested directory.

Showing Program Controlled Inflation Surfaces

If you select Program Controlled as the value for the Use Automatic Inflation (p. 69) control, all surfaces in

the model are selected to be inflation boundaries, except for those that are members of Named Selections

groups. To view the faces that have been selected for inflation:

1. Select the Mesh object in the Tree Outline.

2. Right-click to display the context menu.

3. Select Show> Program Controlled Inflation Surfaces in the context menu.
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Showing Sweepable Bodies

You can display bodies that are “sweepable” according to the criteria detailed under Mesh Sweeping (p. 195).

To display sweepable bodies:

1. Select the Mesh object or any mesh control object.

2. Right-click to display the context menu.

3. Select Show> Sweepable Bodies in the menu. All sweepable bodies are displayed.

Note

This feature is not supported for CutCell meshing.

Showing Problematic Geometry

If problematic geometry causes meshing to fail, Workbench alerts you by:

• Displaying a Problematic Geometry message annotation in the Geometry window

• Displaying messages in the Messages window to describe the problem

• Creating a Named Selections group called “Problematic Geometry” in the Tree Outline to identify the

problem areas

For related information on viewing problematic geometry, refer to Show Problematic Geometry in the

DesignModeler help and Troubleshooting (p. 293).

Showing Geometry in Overlapping Named Selections

When the same entity is a member of more than one Named Selection, those Named Selections are said to

be “overlapping.” If you are exporting a mesh into the ANSYS FLUENT, POLYFLOW, CGNS, or ICEM CFD format

(or faceted geometry for use in TGrid), and overlapping Named Selections are detected, the export fails and

the Meshing application issues an error message to alert you to the overlap problem. You must resolve the

overlapping Named Selections before proceeding. To assist you in this task, you can display the geometry

in the overlapping Named Selections in the Geometry window.

To display geometry in overlapping Named Selections:

1. Select the Mesh object.

2. Right-click to display the context menu.

3. Select Show> Geometry in Overlapping Named Selections in the menu. The overlapping geometry

is highlighted in the Geometry window.

To proceed with the export, first resolve each of the overlapping Named Selections (for example, by removing

a duplicate entity from all but one of the overlapping Named Selections). After you resolve each overlapping

Named Selection, select Show> Geometry in Overlapping Named Selections and only the remaining

overlapping entities will be highlighted in the Geometry window. Once you have resolved all of the over-

lapping Named Selections, the Show> Geometry in Overlapping Named Selections menu option will no

longer appear in the menu and you can retry the export.
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Showing Removable Loops

You can use the Show Removable Loops feature prior to meshing to view loops that will be removed ac-

cording to the criteria defined by the global Sheet Loop Removal and Loop Removal Tolerance controls.

This feature applies only to sheet models, and it responds only to the settings of the global loop removal

controls. For example, if you set loop removal controls locally and your model contains loops that will be

removed according to your local criteria, the Show Removable Loops feature will return nothing if the

global Sheet Loop Removal control is off (set to No).

To view removable loops:

1. Select the Mesh object in the Tree Outline.

2. Right-click to display the context menu.

3. Select Show> Removable Loops in the context menu.

Note

This feature is not supported for Uniform Quad/Tri, Uniform Quad, or CutCell meshing.

Inspecting Large Meshes Using Named Selections

You can use Named Selections to inspect only a portion of the total mesh. Although this feature is available

regardless of mesh size, it is most beneficial when working with a large mesh (greater than 5 - 10 million

nodes). For details, refer to Inspecting Large Meshes Using Named Selections in the Mechanical help.

Clearing Generated Data

You can clear generated data from the database using a right-mouse click menu item. You can either clear

all mesh and results data (if applicable) from a model, or clear the mesh data on the selected part or body

only.

Note

When you clear the mesh, the status of the part or body will indicate that it is not meshed.

To clear all mesh and results data from a model:

1. Select the Mesh object in the Tree Outline.

2. Right-click to display the context menu.

3. Select Clear Generated Data in the context menu.

4. When asked whether you want to clear the data, click Yes.

To clear the mesh data from the selected part or body - from the object tree:

1. Select the part or body in the Tree Outline.

2. Right-click to display the context menu.

3. Select Clear Generated Data in the context menu.
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4. When asked whether you want to clear the mesh, click Yes.

To clear the mesh data from the selected body - from the Geometry window:

1. Select the Mesh object.

2. Select the bodies in the Geometry window.

3. Right-click to display the context menu.

4. Select Clear Generated Data On Selected Bodies in the context menu.

5. When asked whether you want to clear the mesh, click Yes.

To clear the mesh data from the selected part - from the Geometry window:

1. Select the Mesh object.

2. Select the part in the Geometry window.

3. Right-click to display the context menu.

4. Select Parts> Clear Generated Data in the context menu.

5. When asked whether you want to clear the mesh, click Yes.

Showing Missing Tessellations

Geometry with missing facets can lead to incorrect geometry representation by the mesher. Using the Show

Missing Tessellations feature, you can highlight geometry with missing facets, which will allow you to detect

and resolve problems prior to mesh generation.

Note

This feature is available only for the CutCell  and Patch Independent Tetra mesh methods.

To highlight missing tessellations:

1. Select the Geometry object in the Tree Outline.

2. Right-click on the Geometry object or in the Geometry window to display the context menu.

3. Select Show Missing Tessellations in the context menu.

If a face without tessellations is found:

• The boundary of the face will be highlighted in the Geometry window.

• A warning message will be displayed in the Messages window advising you to use the Show Problem-

atic Geometry context menu option to locate the problem areas.

• A Named Selections group called “Problematic Geometry” will be inserted into the Tree Outline to

identify the problem areas. One Named Selection will be created for each problematic face, and will

contain the boundary of that face (i.e., the edges). If multiple problematic faces are found, the name of

each Named Selection will be suffixed with a unique integer.
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Note

• Although the Named Selections group described above will be inserted automatically the

first time you select the Show Missing Tessellations option, if you modify or delete any of

the Named Selections, those Named Selections will not be recreated if you select Show

Missing Tessellations subsequently.

• If any bodies with problematic faces are suppressed when the Show Missing Tessellations

option is selected, Named Selections groups will be created for those faces but will be sup-

pressed as well.

Showing Mappable Faces

You can display faces that are “mappable” according to the criteria detailed under Mapped Face Meshing

Control (p. 168).

To display mappable faces:

1. Select the Mesh object or any mesh control object.

2. Right-click to display the context menu.

3. Select Show> Mappable Faces in the menu. All mappable faces are highlighted in the Geometry

window.

4. Right-click on the Mesh object or mesh control object and select Insert> Mapped Face Meshing. In

the Details View, the Geometry field shows the number of faces that are mappable and therefore

were selected.

To edit the selected set of faces, click the Geometry field in the Details View to activate it. Then in the

Geometry window, select the mappable faces that you want to use in the mapped face meshing control.

Click Apply in the Details View to complete your selection. Then proceed with the procedure described in

Mapped Face Meshing Control (p. 168).

Note

This feature is not supported for CutCell meshing.
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Virtual Topology

Uses of virtual topology include:

• Before performing analysis of a CAD model, you may want to group faces/edges together to form virtual

cells. In such cases, virtual topology can aid you in reducing the number of elements in the model,

simplifying small features out of the model, and simplifying load abstraction.

• You can split an edge to create two virtual edges. For example, in the case of a rectangular face in

which a single edge on one side of the face corresponds to two edges on the opposite side of the face,

you can split the single edge so that node alignment across the face can have similar spacing.

The following sections cover these topics:

Introduction

Creating Virtual Cells

Creating Virtual Split Edges

Introduction

A CAD Model has two parts:

1. Topology: The connectivity of a CAD model, meaning: vertices are connected to edges, which are

connected to faces, which are connected to volumes. Each one of these entities is referred to as a cell.

2. Geometry: The geometry of the CAD model is the underlying mathematical definition of the aforemen-

tioned cells.

A virtual cell in the Mechanical application or the Meshing application modifies the topology of only the

local copy in the Mechanical application or Meshing application. Your original CAD model remains unchanged.

New faceted geometry is also created with virtual topology. However, the mesher may project the nodes

back to the original geometry where applicable.

For information about the virtual topology operations that you can perform, refer to:

• Creating Virtual Cells (p. 281)

• Creating Virtual Split Edges (p. 285)

Creating Virtual Cells

You can manually designate faces and edges for inclusion into a virtual cell, or you can have the Mechanical

application or the Meshing application automatically create virtual cells based on settings that you specify.

The geometry under a virtual cell is represented by the underlying cell's graphic resolution. All cells must

be adjacent to one another to create virtual topology.
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Note

• There are geometric limitations to creating virtual cells, including those related to cells that

would have too much curvature, or other limitations in trying to represent a group of cells

by a single cell.

• The tessellation of models from CATIA4 may not be appropriate for virtual topology, which

could prevent the creation of virtual cells for these models.

Creating Virtual Cells Manually

1. Insert a Virtual Topology object in the tree.

2. Choose a face or edge selection filter, then pick adjacent faces or edges that you want to include in

the virtual cell.

3. Insert a Virtual Cell object in the tree.

Creating Virtual Cells Automatically

1. Insert a Virtual Topology object in the tree.

2. Make adjustments as needed to any of the following settings in the Details View:

• Behavior - Determines the level of aggressiveness of the Merge Face Edges? setting. The choices

are Low, Med, High, and Edges Only. The Edges Only setting will only merge edges with a very

conservative behavior.

• Generate on Update - Sets whether you want to include the settings in this Details View when

you update geometry.

• Merge Face Edges? - The property is relevant only during the virtual face creation process. It applies

only to manually-created virtual faces and can be modified at any time, but the modification will

have no effect on previously-created virtual faces.

– Yes: If the Merge Face Edges? property is turned on, the program will attempt to merge

bounding edges of a newly manually-created virtual face and create virtual edges. The criterion

used to merge edges is based on the Behavior setting.

– No: If the Merge Face Edges? property is turned off, only a virtual face will be created out of

selected faces.

3. Click right mouse button on Virtual Topology object and choose Generate Virtual Cells from the

context menu. A Virtual Cell object is automatically inserted in the tree for each region containing

only surface bodies that meets the criteria established by the settings in step 2.

Notes on Virtual Cell Creation

• Scoped objects except other virtual cells may need to be relinked to the new virtual cells when that

virtual cell is comprised of entities in the scoped object. When the virtual cell is deleted the object may

need to be rescoped to the original entities.

• All scoped objects except for mesh controls and other virtual cells will be protected during automatic

virtual cell generation. This will allow users to load their models and run auto virtual topology without

deleting loads. All faces within a protected object may be merged with faces in the same protected

object and not in any other protected object.
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• If Generate on Update is set to Yes and you update the geometry, all Virtual Cell objects that were

created automatically will be deleted and recreated based on the new geometry. Any loads that were

attached to geometry within the deleted Virtual Cell objects will need to be reattached to the new

geometry.

• If Generate on Update is set to No and you update the geometry, all Virtual Cell objects that were

created automatically should remain persistent barring major topology changes of the model being

updated. Reapplication of loads may not be necessary.

• For any virtual cells that were generated, you can choose whether the nodes will be projected back to

the underlying geometry (in contrast to the virtual cell’s faceted geometry). To do so, click the desired

virtual cell in the tree and then in the Details View, set the Project to Underlying Geometry option to

Yes or No. Computational expense increases when the option is set to Yes. The default is Yes for ana-

lytical geometry; otherwise, the default is No.

Virtual Cell Logic and Usage

The Virtual Topology feature is a cell dependency operation where existing virtual cells can be used to create

new virtual cells both manually and automatically. Within the cell hierarchy, a virtual cell depends on another

virtual cell if the latter is used to create the former.

Virtual Face Dependency

A virtual face depends on a virtual edge if during the face creation the virtual edge is used to create virtual

face loops. A virtual face depends on another virtual face if the latter was used to create the former.

The following image represents the Merge Face Edges in the off position.

Figure: Merge Face Edges Off

The following image represents the Merge Face Edges in the on position.
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Figure: Merge Face Edges On

Virtual Edge Dependency

A virtual edge depends on a virtual face if during the edge creation an owner loop belongs to the said face.

A virtual edge depends on another virtual edge if the latter was used to create the former.

Virtual Cell Context Menu Options

The context menus vary depending on whether you select an independent cell or a dependent cell.

• Independent Cell Options

– Suppress: Only active for a single selection and not active if the selected cell has dependents.

– Delete: Use to delete all selected cells. Not active if any selected cell has dependents.

• Dependent Cell Options

– Delete All Virtual Cells:  Use to delete only the cells (the virtual topology group itself, including

any virtual split edges, will not be deleted). This option is available on the virtual topology group

only and becomes active when there is at least one virtual cell created.

– Delete Cell and Dependents: This option is available on the virtual cell only and is only active if

the cell has dependents. It cannot be used for multiple selections and the result of the operation is

that the cell and its dependents will be deleted.

– Suppress Cell and Dependents: This option is available on the virtual cell only and is only active

if the cell has dependents. It cannot be used for multiple selections and the result of the operation

is that the cell and its dependents will be suppressed.

Note

– If a virtual cell is suppressed via the Suppress Cell and Dependents option, it will be

programmatically unsuppressed if any of its dependents are unsuppressed.

– If a virtual edge was created from a virtual split edge, you cannot suppress or delete the

virtual split edge without first deleting the virtual edge. Conversely, if a virtual split edge

was created from a virtual edge, you cannot suppress or delete the virtual edge without

first deleting the virtual split edge.
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Virtual Cell Tree Display

If a virtual cell is used to create another virtual cell, it will become disabled upon creation and, therefore,

will disappear from the tree view. If the newly created virtual cell is deleted/suppressed, the original cell will

then become active and will reappear in the tree view.

Creating Virtual Split Edges

When preparing geometry for meshing, it may be advantageous to split an edge into two virtual edges

separated by a vertex. For example, in the case of a rectangular face in which a single edge on one side of

the face corresponds to two edges on the opposite side, you can split the single edge so that node alignment

across the face can have similar spacing. This can be achieved by creating Virtual Split Edge objects. You

can also modify the split interactively by dragging the newly created vertex along the length of the original

edge thus altering the split location.

Splitting an Edge

1. Insert a Virtual Topology object in the tree.

2. Choose the edge selection filter and then in the Geometry window, pick the edge that you want to

split. The selected edge can be either a “real” edge or a previously-defined virtual edge.

Note

To simplify specification of the split location, when picking the edge to split you should

position your cursor at the point on the edge where you want the split to occur. Then select

Virtual Split Edge at + as described in step 3.

3. Insert a Virtual Split Edge object into the tree using either of these methods:

• To define the split location according to your cursor location on the edge, right-click in the Geometry

window and select Insert> Virtual Split Edge at + from the context menu, or choose Virtual Split

Edge at + on the Virtual Topology context toolbar.

• To define the split location by specifying it in the Details View, right-click in the Geometry window

and select Insert> Virtual Split Edge from the context menu, or choose Virtual Split Edge on the

Virtual Topology context toolbar.

4. If you inserted the Virtual Split Edge object by selecting Virtual Split Edge at +, the Split Ratio is

filled in automatically by the software. If not, you must specify a value for Split Ratio.

The Split Ratio defines the location of the split by specifying the ratio between the distance from the

start point of the edge to the split location and the overall length of the edge. Specify a value from 0

to 1. For example, a value of 0.5 will split the edge into two edges of equal length. A value of 0.75 will

split the edge into two edges where the first edge is three quarters of the length of the original edge,

and the second edge is only one quarter of the length of the original edge. A value of 0 or 1 is valid

only if the selected edge is a closed edge. In the case of a closed edge, such as a circle, the edge will

be split into two edges, and the new vertex will be placed along one of the new edges.

You can change the location of the split by clicking in the Split Ratio field and specifying a new value.

To modify an edge split interactively, select any portion of the original edge or its vertex split location

in the Geometry view. Then, while pressing F4 on the keyboard, drag the mouse along the length of
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the edge to redistribute the Split Ratio. The display indicates the initial 3-D location of the split, to-

gether with a preview of its new location and Split Ratio.

Virtual Split Edge Dependency

Existing virtual edges and/or existing virtual split edges can be used to create new virtual split edges.

Within the split edge hierarchy, a virtual split edge depends on a virtual edge if the latter is used to create

the former. Similarly, a virtual split edge depends on another virtual split edge if the latter is used to create

the former.

Locking Locations of Dependent Virtual Split Edges

In cases involving virtual split edge dependency, you can choose whether the locations of dependent splits

are locked or unlocked when the location of the parent split is modified. If unlocked, the location of the

dependent split moves to maintain its defined split ratio when the parent is modified. If locked, the location

of the dependent split persists when the parent is modified. Regardless of the setting, the location of the

dependent split will move if preserving its location would invalidate the split (see Figure: Overridden Locked

Dependent Splits (p. 288) for an example).

Note

For parametric updates, all virtual split edges are treated as unlocked.

1. Highlight the Virtual Topology object in the tree.

Note

Locking must be set globally on the Virtual Topology object. It cannot be set locally on

individual Virtual Split Edge objects.

2. In the Details View, set the Lock position of dependent edge splits option to Yes (default) or No.

The following figures illustrate locking. Figure: Original Virtual Split Edge with Dependent Virtual Split Edge (p. 286)

shows an example in which a split at .5 was defined on original edge ab, creating two new edges—ac and

cb. A second split at .5 was then defined on edge cb, creating two new edges—cd and db.

Figure: Original Virtual Split Edge with Dependent Virtual Split Edge
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Figure: Unlocked Dependent Splits (p. 287) shows the expected behavior when Lock position of dependent

edge splits is set to No, and the split located at point c is changed from .5 to .1. Notice that point d has

moved to maintain its defined split ratio at .5 of cb.

Figure: Unlocked Dependent Splits

Figure: Locked Dependent Splits (p. 287) shows the expected behavior when Lock position of dependent

edge splits is set to Yes, and the split located at point c is changed from .5 to .1. Notice that in this case

point d has not moved, and the split ratio is now .72222 of cb.

Figure: Locked Dependent Splits

In Figure: Overridden Locked Dependent Splits (p. 288), the split located at point c was changed from .5 to .9.

Even with locking set to Yes, in this case point d was moved because preserving its location would have

invalidated the split (i.e., if its original location had been preserved, point d would no longer be located on

edge cb).
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Figure: Overridden Locked Dependent Splits

Virtual Split Edge Context Menu Options

The context menus vary depending on whether you select an independent split edge or a dependent split

edge.

• Independent Split Edge Options

– Suppress:  Only active for a single selection and not active if the selected split edge has dependents.

– Delete: Use to delete all selected split edges. Not active if any selected split edge has dependents.

• Dependent Split Edge Options

– Delete All Virtual Split Edges:  Use to delete only the split edges (the virtual topology group itself,

including any virtual cells, will not be deleted). This option is available on the virtual topology group

only and becomes active when there is at least one virtual split edge created.

– Delete Virtual Split Edge and Dependents: This option is available on the virtual split edge only

and is only active if the virtual split edge has dependents. It cannot be used for multiple selections

and the result of the operation is that the virtual split edge and its dependents will be deleted.

– Suppress Virtual Split Edge and Dependents: This option is available on the virtual split edge

only and is only active if the virtual split edge has dependents. It cannot be used for multiple selec-

tions and the result of the operation is that the virtual split edge and its dependents will be sup-

pressed. (To unsuppress, you must unsuppress the virtual split edge and its dependents manually

one-by-one.)

Note

– If a virtual split edge is suppressed via the Suppress Virtual Split Edge and Dependents

option, it will be programmatically unsuppressed if any of its dependents are unsuppressed.

– If a virtual edge was created from a virtual split edge, you cannot suppress or delete the

virtual split edge without first deleting the virtual edge. Conversely, if a virtual split edge

was created from a virtual edge, you cannot suppress or delete the virtual edge without

first deleting the virtual split edge.

– When a geometry is suppressed, the virtual split edges associated with that geometry

are also suppressed.
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Notes on Virtual Split Edges

• When you insert a new Virtual Split Edge object or click on an existing Virtual Split Edge object in

the tree, a sphere appears at the location of the corresponding split ratio in the Geometry window. If

you change the location of a split the sphere location is adjusted accordingly.

• When the Sweep mesh method is used, the guiding edges must have consistent lengths to obtain a

regular mesh in the sweep direction. You can define virtual split edges to achieve consistent lengths

for these edges.

• If your Geometry view is configured to display Shaded Exterior and Edges, you can conveniently review

virtual split edges by clicking the Virtual Cell group. In this mode, split edges will be highlighted in

two different colors (automatically assigned) to draw attention to the splits.

• You cannot use the virtual split edge feature to split edges belonging to line bodies.

289
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Notes on Virtual Split Edges



Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.290



Named Selections and Regions for CFX

There are a number of places in the ANSYS Workbench and CFX applications where geometric faces and

regions of mesh can be grouped together and assigned names. While this provides a large amount of flex-

ibility, it can lead to confusion. In the 13.0 release, there is more control over which groups of names are

loaded into CFX to help simplify this issue. This document describes the ‘best practice’ for region definitions

for the 13.0 release and is targeted mainly at CFD users of the DesignModeler, Meshing, and CFX applications.

Defining Names in the DesignModeler Application or the Meshing Application

When creating or importing geometry in the DesignModeler application or editing a mesh in the Meshing

application, Named Selections can be defined in terms of one or more CAD faces. If it is desirable for these

Named Selections to be available in CFX-Pre, then they must adhere to these simple rules: Named Selections

should not overlap or be defined as multi-dimensional and all Named Selections must have unique names.

Importing DesignModeler Named Selections into the Meshing Application

If the Named Selections defined in the DesignModeler application are required in the Meshing application,

you must set the appropriate geometry import options to ensure the Named Selections will be transferred

properly:

1. From the ANSYS Workbench Menu Bar, select Tools> Options.

2. In the left pane of the Options dialog box, select Geometry Import.

3. In the right pane of the Options dialog box, select the Named Selections check box and either clear

the Filtering Prefix field (to import all names) or set it to the appropriate filter if required.

The next time that you attach geometry containing Named Selections and launch the Meshing application,

the application will start, load the geometry, and load any Named Selections previously defined for that

geometry. The preferences you set on the Options dialog box are local settings and affect only you.

If a mesh is generated, the Named Selections defined in the DesignModeler application will be available

when the mesh is imported into CFX-Pre.

Note

For detailed descriptions of the geometry import options, see the CAD Integration section in the

ANSYS Workbench help.

Using Multiple Mesh Methods

Named Selections can be defined in the Meshing application, the DesignModeler application, or supported

CAD systems. When the resulting mesh is loaded into CFX-Pre, all of these Named Selections are available.

Control over which names are imported with the mesh is available in the Mesh Import options.

It is possible to define Named Selections that conflict with some virtual topology, or do not conform to the

CFX Topology Model in some other way. Such Named Selections will not be imported into CFX-Pre.
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If a Named Selection is created that contains characters not supported in CFX-Pre names, these names will

be modified on import to remove the illegal characters.

Invalid Named Selections

The use of Virtual Topology within the Meshing application can invalidate Named Selection definitions.

Consider the case where a Named Selection ‘Region1’ is defined in terms of 4 CAD faces (1, 2, 3 and 4). If

this geometry is then loaded into the Meshing application and Virtual Topology is used to merge 2 of these

faces (3 and 4), the original Named Selection can no longer be resolved. In CFX-Pre, the Named Selection

will be modified so that it only refers to the ‘resolvable’ faces. Hence, in CFX-Pre, the Named Selection ‘Region1’

would be defined in terms of faces 1 and 2 only.
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Troubleshooting

This section is intended to provide you with tips and strategies for handling problems that may occur during

meshing.

Recommended First Course of Action for Meshing Failures

If your mesh generation fails, your first course of action should be to examine any messages that the

mesher returns to the Messages window. In some cases, you can right-click on the message and select

Show Problematic Geometry to highlight any entities associated with the message in the Geometry window.

If the entities are very small, you can refer to the status bar at the bottom of the window to view statistics

related to the entities. Then create a Named Selection to retain information about the problematic entities.

In some cases, the mesher creates a Named Selection for you called “Problematic Geometry.” These Named

Selections are usually created in cases where an unhandled error occurs. Continue reading below for more

information about messaging.

Understanding Messaging

The Messages window prompts you with feedback concerning meshing operations. Every message returned

from the mesher is not necessarily an error. Messages come in three forms:

• Error: Requires action from you to obtain a mesh.

• Warning: Guides you in best practices or alternative courses of action. A warning does not require you

to fix any problems, but may give an indication of a subsequent related error.

• Information: Helps you make better decisions related to meshing your model or provides you with in-

formation about the approach the mesher used to mesh your model.

Once messages are displayed, you can:

• Double-click a message to display its contents in a pop-up dialog box.

• Highlight a message and then press the key combination CTRL+C to copy its contents to the clipboard.

• Press the Delete key to remove a selected message from the window.

• Select one or more messages and then use the right mouse button click to display the following context

menu options:

– Go To Object - Selects the object in the Tree Outline that is responsible for the message.

– Show Problematic Geometry - Highlights the geometry in the Geometry window that is responsible

for the message. This option is not always available.

– Show Message - Displays the selected message in a pop-up dialog box.

– Copy - Copies the selected messages to the clipboard.

– Delete - Removes the selected messages.

– Refresh - Refreshes the contents of the Messages window as you edit objects in the Tree Outline.

293
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



Understanding States

Sometimes the mesher returns an invalid mesh. Refer to the state of the body in the Tree Outline to determine

whether a body was meshed:

• A check mark  denotes a body in a fully defined but unmeshed state.

• A check mark with a hash  denotes a meshed body.

• A question mark  denotes a body that needs more information before it can be sent to the solver.

When your model contains an active unmeshed body, the Mesh object in the Tree Outline is preceded by

a lightning bolt to indicate a body is out-of-date and requires action:

When your model is fully meshed (i.e., all bodies are in a meshed state), the Mesh object is preceded by a

check mark to indicate that the meshing data is fully defined and ready for the next stage of your analysis

(i.e., an update in the Meshing application or a solve in the Mechanical application):

Shape Checks and Meshing Failures

Meshing may fail if the mesh quality does not meet the criterion of the defined shape checks. The following

approaches are recommended to improve the mesh quality and obtain a valid mesh:

1. Use the Preview Surface Mesh and/or Preview Inflation features.

With this approach the boundary mesh is generated even if the mesh would violate the defined shape

checks. Once the previewed mesh is generated, use the mesh metrics bar graph to determine the

location of bad quality elements. Generally, fixing the bad quality surface mesh is the best way to fix

the volume mesh because bad quality mesh is usually a result of the geometry over-constraining the

mesh topology. Using defeaturing controls (such as Loop Removal (p. 99) and Automatic Mesh Based

Defeaturing (p. 99)), pinch controls, and virtual topologies are all good strategies to remove geometry

features that may cause problems for the meshing algorithms.

Note

Not all mesh methods support the use of Preview Surface Mesh and Preview Inflation.

2. Use a different shape check setting.

Some shape checks have a stricter set of criterion than others. By using a different shape check setting

a mesh might be generated, and the mesh metrics bar graph can be used to find the mesh violating

the stricter shape checks. In this way, locating the problem is the first step to fixing it.
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Note

You can turn off most shape checks altogether by setting Shape Checking (p. 85) to None.

For additional information about the shape checking acceptance criterion used by ANSYS Workbench, refer

to ANSYS Workbench and Mechanical APDL Application Meshing Differences (p. 50).

Handling Direct Meshing Failures

Direct meshing may lead to unexpected results in cases where a mesh control change affects only one body.

This may in turn lead to sweep mesh failure because the source and target meshes no longer align or the

resultant change makes a body unsweepable. If desired, you can set the Allow Direct Meshing option to

No to disable direct meshing and allow the mesh control changes to ripple through the entire part.

Direct meshing is not persistent on a geometry update, so you may need to go through your body meshing

steps manually if the single mesh update does not satisfy your meshing requirements.

Handling Patch Conforming Tetrahedral, Quad Dominant, and All Triangle

Meshing Failures

Some mesh failures are due to an inappropriate defeaturing tolerance (either default or user input ) or dirty

geometry. Use the following guidelines to determine which issue is the cause of the failure:

With Use Advanced Size Function (p. 59) turned off:

1. Determine whether the model is a multiple part assembly, a multibody part, or a single body part.

2. If a message provides “Problematic Geometry” information, use it to determine which portions of the

model fail. Quite often, one or more faces fail to mesh.

3. If a face fails to mesh, check whether the face is “regular”; that is, make sure that it is not too skinny

or has skinny sections with misaligned edge spacings which would make it difficult to get a good

mesh. Use of virtual topologies, pinch controls, etc. may help in these situations.

Handling General Sweep Meshing Failures

In the event of a sweep mesh failure, the following approaches are recommended:

1. Check for contradicting edge sizings.

2. For Src/Trg Selection, use a manual setting instead of automatic.

For detailed information about the requirements and characteristics of sweep meshing, refer to Mesh

Sweeping (p. 195).

For additional information, refer to Figure 7.36: "Strategies for Avoiding Stretched Elements" in the Mechan-

ical APDL help.

Handling Thin Sweep Meshing Failures

In the event of a thin sweep mesh failure, first refer to Thin Model Sweeping (p. 199) for detailed information

about the requirements and characteristics of thin sweep meshing.
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The Preview Source and Target Mesh and Preview Surface Mesh features do not support the thin model

sweeper. Thus, if a failure occurs, you must use the feedback in the Messages window to determine the

problem:

• If Src/Trg Selection is set to Automatic Thin, determine whether the correct source/target faces are

being used. You can review the source/target faces by right-clicking the appropriate message. If incorrect

source/target faces are being used, select the Manual Thin option on the sweep method and pick the

correct faces manually.

• In many cases, the messages tell you to use virtual topology to merge an edge/face. Thin sweeping

requires one division through the thickness. Side edges must connect directly from source to target to

comply with this rule.

• If a message tells you the target faces are not meshed, try swapping the source/target faces.

• In cases where a thin sweep body and a general sweep body are neighbors, the general sweep body

has higher priority and is meshed first. The general sweep operation may place nodes on the side

area/edge of the thin sweep body. If you receive a message describing this situation, you must apply

additional mesh controls to prevent it.

• If both source and target areas are meshed, thin sweep will fail. In this case, you must find some way

to eliminate the situation.

• Thin sweep may issue warning messages telling you that the source you picked was swapped with the

target, and that some controls on the target faces were ignored as a result. These types of warning

messages are for your reference only.

Handling CutCell Meshing Failures

Failure in the CutCell meshing algorithm is almost always related to faceting issues in relation to the value

of Min Size (p. 64). Make sure that the value of Min Size truly represents the smallest size that you want the

curvature and proximity size function to capture. Consider the following:

1. It is strongly recommended that you ALWAYS adjust the value of Min Size (p. 64) as appropriate for

your problem. Make sure that Min Size is 1/2 of any small feature or gap that you need to capture.

Similarly, Min Size should be about 1/10 of the diameter of the smallest pipe. For very simple cases,

make sure to increase Min Size appropriately. Failure to do so may result in an over-refined mesh with

a huge number of facets.

2. Use local (scoped) size controls to ensure two layers of elements in any gap/thickness. If the scoped

sizing is smaller than the Min Size, you must adjust the Tessellation Refinement accordingly. If you

add a hard size that is smaller than the Min Size, make sure that the tolerance specified by the Tessel-

lation Refinement control is now 10 times smaller than the specified hard size.

3. If you receive a warning about missing tessellations, it may help to lower the tessellation tolerance by

50%.

4. In some cases, small defects in the faceting may lead to bad quality meshes. In many of these cases,

a minor modification of the Min Size or tessellation tolerance can rectify the problem.

5. Export the faceted geometry to TGrid. Inside TGrid, merge all nodes and perform faceted stitch starting

with a low tolerance (0.0001) and increasing the value as needed. Display free edges to see if there

are holes in the faceting.

Handling CutCell Inflation Problems

CutCell does not support very thick inflation layers, so instead of using an Inflation Option (p. 71) of First

Layer Thickness or Total Thickness, use aspect ratio-based inflation.
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CutCell may not properly capture acute angles. If there are very acute angles in the geometry, it is likely

that the CutCell surface mesh will become very jagged. At these locations, the surface mesh is not smooth

and hence inflation layer generation may fail due to poor quality. To avoid these problems, try using the

DesignModeler application to add chamfers or fillets to very sharp edges prior to meshing.

Tips for Using Virtual Topology

Virtual topology surfaces made up of two loops are not automatically mappable. For a faceted surface made

up of two loops to be map meshed, a Mapped Face Meshing control must be scoped to it or it must be a

side area of a general sweep body.
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Tutorials

There are various types of tutorials available for the Meshing application. Included within this help are the

following tutorials:

Tutorial 1: Can Combustor

Tutorial 2: Single Body Inflation

Tutorial 3: Mesh Controls and Methods

For access to additional Meshing application tutorials, go to http://www.ansys.com/tutorials.

Tutorial 1: Can Combustor

This tutorial creates a mesh for a can combustor, which can be found in gas turbine engines. The geometry

is complex and consists of five separate solid bodies. It will be imported as a complete geometry from a

Parasolid file.

The diagram below shows the geometry schematically with part of the outer wall cut away.
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The following geometry and meshing features are illustrated:

• Parasolid import

• Multibody part formation

• Named Selection creation

• Program Controlled inflation

This tutorial requires you to have a copy of the Parasolid file Combustor.x_t . If you do not have this file,

you can download it from the ANSYS Download Center, which is accessible from the ANSYS Customer Portal

at http://www1.ansys.com/customer. You will need to navigate through the Download Wizard and select

the ANSYS Meshing Tutorial Input Files download, which is listed in the ANSYS Documentation and

Examples section.

After you have the Parasolid file, you can proceed to Geometry Import (p. 300).

Geometry Import

Creating the Project

1. Open ANSYS Workbench and add a standalone Mesh system to the Project Schematic. Save the project

as Combustor.wbpj .

2. Now add geometry to the project. On the Project Schematic, right-click the Geometry cell in the Mesh

system and select New Geometry... to open the DesignModeler application, specifying the units as

centimeters.
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Note

If you have previously set the default unit by selecting either Always use project unit or

Always use selected unit in the DesignModeler application, the units pop-up window will

not appear.

To access the units pop-up window upon subsequent openings of the DesignModeler ap-

plication, open the Options dialog box by selecting Tools > Options from DesignModeler's

main menu. In the Options dialog box, select DesignModeler > Units and set Units >

Display Units Pop-up Window to Yes. For details, see Units in the DesignModeler help.

Importing the Geometry

The geometry is imported complete, from a Parasolid file.

1. Select File > Import External Geometry File... from the main menu.

2. In the file browser that opens, locate and open the file Combustor.x_t .

3. Click Generate  to import the combustor.

The Tree Outline should now show that you have 5 Parts, 5 Bodies. To produce a single mesh that contains

all of the bodies rather than one mesh per body, the parts must be combined into a multibody part.

1. On the toolbar at the top of the window, click Selection Filter: Bodies . This means that you can

select only solid bodies in the next operation, which helps to make the selection process easier.

2. Click Select Mode  and select Box Select from the drop-down menu.

3. In the Geometry window, select all five bodies by holding down the left mouse button and dragging

a box from left to right across the whole geometry to select all five bodies. To be selected, all of the

entities must lie completely within the box that you have drawn. When you release the mouse button,

the status bar located along the bottom of the window should change to show that 5 Bodies are se-

lected.

When using Box Select, the direction that you drag the mouse from the starting point determines

which items are selected. Dragging to the right to form the box selects entities that are completely

enclosed by the box, while dragging to the left to form the box selects all entities that intersect, or

touch, the box.

4. Right-click on the Geometry window and select Form New Part.

The Tree Outline should now show that you have 1 Part, 5 Bodies.

The geometry does not need further modifications. It is now complete. From the DesignModeler application's

main menu, select File > Save Project to save the project and then File > Close DesignModeler to return

to the Project Schematic. Notice the Geometry cell appears in an up-to-date state .

Now that the geometry is complete, you can proceed to Mesh Generation (p. 302).
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Mesh Generation

Launching the Meshing Application

On the Project Schematic, right-click the Mesh cell in the Mesh system and select Edit... to launch the

Meshing application.

Creating Named Selections

You will create five Named Selections in this tutorial. Detailed instructions are provided for creating the first

Named Selection. Less detailed instructions are provided for creating the subsequent Named Selections, but

you should create them in a similar fashion, using additional zoom and/or rotation options from the toolbar

as needed.

1. To create a Named Selection for the fuel inlet, select the six tiny faces on the cone near the bottom

of the combustor. The easiest way to select them is as follows:

a. Click over the axes in the bottom right corner of the Geometry window in the position shown in

the figure below. As you move the cursor into this position, the black “-Z”-axis will appear (it is

not shown by default). This will put the geometry into a good position for picking the required

faces.

b. On the toolbar, click Box Zoom .

c. In the Geometry window, zoom the geometry by holding down the left mouse button and

dragging a box across the area where the six tiny faces are located. Then release the mouse button.

d. On the toolbar, click Face .

e. Press and hold the CTRL key while picking the six faces, which are shown in green in the figure

below (the colors in your geometry may differ from those shown in this tutorial).

f. After selecting all six faces, release the CTRL key. Right-click in the Geometry window and select

Create Named Selection from the menu.
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g. In the Selection Name dialog box, type fuel_inlet and click OK.

2. To create a Named Selection for the air inlet, select the eight faces at the very bottom of the geometry

having the lowest Z-coordinate, as shown below. Name this Named Selection air_inlet.

3. To create a Named Selection for the secondary air inlet, select the six small circular faces on the main

body of the combustor, as shown below. These introduce extra air to aid combustion. Name this Named

Selection secondary_air_inlet.

4. To create a Named Selection for the outlet, select the rectangular face with the highest Z-coordinate.

Name this Named Selection outlet.
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Note

There is one more Named Selection to create, but the faces that you need to select are not

easily seen. The next several steps help to make the selection process easier.

5. In the Tree Outline, click the Named Selection called air_inlet. In the Details View, change the value

of Visible to No.

Look into the combustor inlet. You should see eight curved vanes surrounding the fuel inlet, as shown

below. Rotate the view slightly and note that every other vane passage is blocked by faces.

6. From the main menu, select Tools> Options. In the left pane of the Options dialog box, click the plus

sign to expand the Mechanical options. Highlight Graphics, and then in the right pane, make sure

that Highlight Selection is set to Both Sides and click OK.

7. On the toolbar, click Face .

8. Press and hold the CTRL key while picking the eight faces of the vanes, as shown below.
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9. After selecting all eight faces, release the CTRL key. Right-click in the Geometry window and select

Hide Face(s) from the menu.

10. To create the last Named Selection, select the four faces that block the vane passages, as shown below.

Name this Named Selection internal.

Note

You are done creating Named Selections. The next several steps toggle visibility of all faces

back on.

11. In the Tree Outline, click the Named Selection called air_inlet. In the Details View, change the value

of Visible to Yes.

12. Right-click in the Geometry window and select Show Hidden Face(s) from the menu.

Setting Up the Mesh

This is a complex geometry which will be used to run a simulation with complex physics. To keep the com-

putational time down for the purposes of the tutorial, the default sizing settings will be retained and a very

coarse mesh will be generated. If you wanted to get accurate results for the geometry, a much finer mesh

and a much longer solution time would be required.

1. In the Tree Outline, click the Mesh object.

2. In the Details View, set Physics Preference to CFD and Solver Preference to CFX.
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3. In the Details View, click to expand the Sizing group of controls and notice the default sizing settings.

Setting Up Inflation

It is a good idea to put inflation on the walls.

1. In the Details View, click to expand the Inflation group of controls.

2. Set Use Automatic Inflation to Program Controlled.

As a result of this setting, all faces in the model are selected to be inflation boundaries, with a few exceptions.

For the purposes of this tutorial, the important exception is Named Selections—the faces in Named Selections

will not be selected to be inflation boundaries.

Generating the Mesh

Finally, you can generate the mesh by right-clicking Mesh in the Tree Outline and selecting Generate Mesh.

After a few moments, the meshed model appears in the Geometry window, as shown below.

In the figure below, a section plane was activated to view a section cut through the model.
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This completes the mesh generation. Note that you may have received a warning about a problem with in-

flation layer generation. This warning is common when using an automated inflation setup with coarse mesh

as the inflation layers do not have adequate room for orthogonal inflation layer growth. This warning(s) can

generally be ignored unless you are very concerned with near wall physics. Should this be the case, more

selective inflation and/or the use of local size functions should resolve the issue.

From the Meshing application's main menu, select File > Save Project to save the project and then File >

Close Meshing to return to the Project Schematic.

You can exit ANSYS Workbench by selecting File > Exit from the main menu.

Tutorial 2: Single Body Inflation

This tutorial demonstrates various ways to apply single body inflation. The 3D inflation capability provided

by the Meshing application is mainly used in CFD/Fluids meshing. It provides high quality mesh generation

close to wall boundaries to resolve changes in physical properties.

Essentially, there are two methods for applying inflation: globally, using Named Selections; and locally, by

scoping an inflation method. This tutorial covers using these methods along with various other settings for

defining inflation on a single body.

The following topics are covered:

• Comparing two Collision Avoidance (p. 77) settings (Layer Compression and Stair Stepping), which

determine the approach that is to be taken in areas of proximity

• Previewing inflation, which can be used to examine proximity handling, determine the quality of inflation

layers, and detect potential quality issues

• Creating a new Named Selection, and automatically applying inflation to all the faces in it

• Scoping inflation to a body and selecting a Named Selection as the inflation boundary
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• Comparing three Inflation Option (p. 71) settings (Smooth Transition, Total Thickness, and Last Aspect

Ratio), which determine the heights of the inflation layers

• Changing Solver Preference (p. 59) and how its value affects default inflation behaviors

This tutorial requires you to have a copy of the ANSYS Workbench project file newquart.wbpj  and the

project folder newquart_files and its contents. If you do not have these files, you can download them from

the ANSYS Download Center, which is accessible from the ANSYS Customer Portal at http://www1.an-

sys.com/customer. You will need to navigate through the Download Wizard and select the ANSYS Meshing

Tutorial Input Files download, which is listed in the ANSYS Documentation and Examples section.

After you have the project files, you can proceed to Tutorial Setup (p. 308).

Tutorial Setup

Opening the Project

1. Open ANSYS Workbench.

2. Select File > Open... from the main menu.

3. In the file browser that opens, locate and open the file newquart.wbpj .

Now that the tutorial is set up, you can proceed to Mesh Generation (p. 308).

Mesh Generation

Launching the Meshing Application

On the Project Schematic, right-click the Mesh cell in the Mesh system and select Edit... to launch the

Meshing application.

Setting the Unit System

On the main menu, click Units and select Metric (mm, kg, N, s, mV, mA).

Program Controlled Inflation Using the Fluent Solver

This part of the tutorial demonstrates the use of Program Controlled (p. 69) inflation with the Fluent solver.

Notice that three Named Selections are defined already: Symmetry, Inlet, and Outlet. You will create a fourth

later in this tutorial.

1. In the Tree Outline, click the Mesh object.

In the Details View, notice that Solver Preference (p. 59) is set to Fluent.

2. Click to expand the Sizing group of controls and change Curvature Normal Angle (p. 63) to 12.

3. Click to expand the Inflation group of controls.

Notice that Program Controlled (p. 69) and Smooth Transition are selected and Transition Ratio (p. 72)

is set to 0.272 by default.

With Program Controlled (p. 69) inflation, inflation will be added to all external faces for which a Named

Selection has not been defined.
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When Solver Preference (p. 59) is Fluent, the default Transition Ratio (p. 72) is 0.272 because the

solver uses a cell-centered scheme. This is in contrast to the CFX Solver Preference (p. 59), which is

covered later in this tutorial.

4. Change Maximum Layers (p. 73) to 5.

5. In the Tree Outline, right-click Mesh and select Preview > Inflation. Previewing inflation helps to

identify possible problems with inflation before generating a full mesh.

After a few moments, a preview of the inflation layers appears in the Geometry window, as shown

below.

Because the Fluent solver was used, the meshing process used the Layer Compression method for

Collision Avoidance (p. 77) by default.

6. Zoom and reposition the model to get a better view of the compressed layers in the area of interest.
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Notice the heights of the inflation layers, which are determined by the setting of the Inflation Op-

tion (p. 71) control. The Smooth Transition option, which was used here, uses the local tetrahedral

element size to compute each local initial height and total height so that the rate of volume change

is smooth.

Each triangle that is being inflated will have an initial height that is computed with respect to its area,

averaged at the nodes. This means that for a uniform mesh, the initial heights will be roughly the

same, while for a varying mesh, the initial heights will vary.

7. On the toolbar, click Zoom To Fit .

8. In the Tree Outline, right-click Mesh and select Clear Generated Data.

9. Click Yes to clear the data.

Program Controlled Inflation Using the CFX Solver

This part of the tutorial demonstrates the use of Program Controlled (p. 69) inflation with the CFX solver.

1. In the Details View, change Solver Preference (p. 59) to CFX.

Notice the value of Transition Ratio (p. 72) has changed from 0.272 to 0.77 automatically.

When Solver Preference (p. 59) is CFX, the default Transition Ratio (p. 72) is 0.77 because the solver

uses a vertex-centered scheme. Increasing the ratio creates a thicker boundary layer.

2. In the Tree Outline, right-click Mesh and select Generate Mesh.

After a few moments, the mesh appears in the Geometry window, as shown below.

The inflation layers look different in this mesh because the CFX solver uses the Stair Stepping method

of Collision Avoidance (p. 77) by default.

3. Zoom and reposition the model to get a better view of the stair stepped layers in the narrow region.
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4. On the toolbar, click Zoom To Fit .

5. In the Tree Outline, right-click Mesh and select Clear Generated Data.

6. Click Yes to clear the data.

Program Controlled Inflation Scoped to All Faces in a Named Selection

This part of the tutorial demonstrates the use of Program Controlled (p. 69) inflation scoped to all faces in

a Named Selection that you create.

1. Rotate the body so that it is positioned as shown below.
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2. Click Face .

3. On the keyboard, press and hold CTRL.

4. There are 10 faces that you need to select. Click the first eight faces, as shown below.

5. To select the remaining two faces, rotate the body so that it is positioned as shown below.
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6. Click Face .

7. Press and hold CTRL.

8. Click the last two faces as shown below.
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9. Right-click in the Geometry window and select Create Named Selection.

10. In the Selection Name dialog box, type Wall and click OK.

11. In the Tree Outline, click Wall to display the new Named Selection in the Geometry window.

12. In the Tree Outline, click Mesh.

13. In the Details View, change Solver Preference (p. 59) to Fluent.

14. Change Use Automatic Inflation to All Faces in Chosen Named Selection (p. 70).

15. For Named Selection, select Wall.

16. Change Inflation Option (p. 71) to Total Thickness.

The Total Thickness option creates constant inflation layers using the values of the Number of Lay-

ers (p. 73) and Growth Rate (p. 73) controls to obtain a total thickness as defined by the Maximum

Thickness (p. 73) control. Unlike inflation with the Smooth Transition option, with Total Thickness

the thickness of the first inflation layer and each subsequent layer is constant.

17. Set Maximum Thickness (p. 73) to 5.

18. In the Tree Outline, right-click Mesh and select Generate Mesh.

After a few moments, the mesh appears in the Geometry window, as shown below.
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19. Zoom and reposition the model to get a better view of the inflation layers in the narrow region.
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20. On the toolbar, click Zoom To Fit .

21. In the Tree Outline, right-click Mesh and select Clear Generated Data.

22. Click Yes to clear the data.

Scoped Inflation

This part of the tutorial demonstrates scoping inflation to a body and selecting a Named Selection to act as

the inflation boundary.

1. On the toolbar, click Body .

2. Select the body in the Geometry window.

3. Right-click in the Geometry window and select Insert > Inflation.

In the Details View, notice that inflation will be scoped to 1 Body.

4. In the Details View, set Boundary Scoping Method to Named Selections.

5. From the Boundary drop-down menu, select Wall by highlighting it in the drop-down menu and then

pressing Enter.

6. Change Inflation Option (p. 71) to Last Aspect Ratio.

The Last Aspect Ratio option creates inflation layers using the values of the First Layer Height (p. 74),

Maximum Layers (p. 73), and Aspect Ratio (Base/Height) (p. 74) controls. With this option, the heights

of the inflation layers are determined by the aspect ratio of the inflations that are extruded from the

inflation base. The aspect ratio is defined as the ratio of the local inflation base size to the inflation

layer height.

7. Set First Layer Height (p. 74) to 0.5.

8. You are now finished setting the scoped (local) inflation controls. In the Tree Outline, click Mesh to

return to the global inflation controls.

9. In the Details View, change Solver Preference (p. 59) to CFX.

10. Change Use Automatic Inflation to None (p. 69).

11. In the Tree Outline, right-click Mesh and select Preview > Inflation.

After a few moments, the mesh appears in the Geometry window, as shown below.
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12. Zoom and reposition the model to get a better view of the inflation layers.
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This completes the tutorial. From the Meshing application's main menu, select File > Save Project to save

the project and then File > Close Meshing to return to the Project Schematic.

You can exit ANSYS Workbench by selecting File > Exit from the main menu.

Tutorial 3: Mesh Controls and Methods

This tutorial creates a mesh for a piston. The geometry will be imported as a complete geometry from a

Parasolid file. The tutorial uses the model of the piston to demonstrate various mesh controls and methods

that are available in the Meshing application.

The following topics are covered:

• Parasolid import

• Batch meshing

• Automatic mesh method (Patch Conforming Tetrahedral and Sweep)

• Virtual topology

• Pinch

• Mapped face meshing

• MultiZone mesh method

• Local (scoped) sizing

• Section planes

This tutorial requires you to have a copy of the Parasolid file PISTON.x_t . If you do not have this file, you

can download it from the ANSYS Download Center, which is accessible from the ANSYS Customer Portal at

http://www1.ansys.com/customer. You will need to navigate through the Download Wizard and select the

ANSYS Meshing Tutorial Input Files download, which is listed in the ANSYS Documentation and Examples

section.

After you have the Parasolid file, you can proceed to Tutorial Setup (p. 318).

Tutorial Setup

Creating the Project

1. Open ANSYS Workbench and add a standalone Mesh system to the Project Schematic.

2. Notice the name of the system defaults to Mesh and is editable. Type Piston and press Enter to rename

the system Piston.

3. Save the project as Piston.wbpj .

Importing the Geometry

The geometry is imported complete, from a Parasolid file.

1. Now add geometry to the project. On the Project Schematic, right-click the Geometry cell in the Mesh

system and select Import Geometry > Browse....

2. In the file browser that opens, locate and open the file PISTON.x_t .
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The geometry is complete and does not need modifications. Notice the Geometry cell in the Mesh system

has an up-to-date state .

Now that the tutorial is set up, you can proceed to Mesh Generation (p. 319).

Mesh Generation

Running the Meshing Application in Batch Mode

Meshing in batch requires less RAM.

1. On the Project Schematic, right-click the Mesh cell in the Mesh system and select Update to mesh the

geometry in batch mode.

After a short wait, the meshing process is complete. Notice the Mesh cell in the Mesh system has an

up-to-date state .

Launching the Meshing Application

Launch the Meshing application to view the mesh and define mesh controls.

1. Right-click the Mesh cell in the Mesh system and select Edit....

2. When the Meshing application opens, click the Mesh object in the Tree Outline to view the meshed

model in the Geometry window as shown below.

Since no mesh controls have been set, the Automatic mesh method was used by default. When the

Automatic method is used, bodies are swept if possible, and the remaining bodies are meshed with

the Patch Conforming Tetrahedral mesh method.
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Setting the Unit System

On the main menu, click Units and select Metric (m, kg, N, s, V, A).

Showing Sweepable Bodies

This part of the tutorial demonstrates how to view the bodies that were swept. As an alternative, you can

view sweepable bodies prior to meshing.

1. In the Tree Outline, right-click Mesh and select Show > Sweepable Bodies.

The sweepable bodies are highlighted in the Geometry window.

2. To hide all non-sweepable bodies for a better view of the sweepable bodies, right-click on the Geometry

window and select Hide All Other Bodies.

Only the bodies that were meshed with the sweep method appear in the Geometry window, as shown

below.
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3. Right-click on the Geometry window and select Show All Bodies.

All bodies re-appear in the Geometry window.

4. In the Tree Outline, right-click Mesh and select Show > Sweepable Bodies again.

5. Right-click on the Geometry window and select Hide Body.

Now only the sweepable bodies are hidden. Those bodies that remain in the Geometry window were

meshed with the Patch Conforming Tetrahedral method.

Creating Virtual Cells Manually

Each surface patch is respected when the Patch Conforming Tetrahedral mesh method is used. This part of

the tutorial demonstrates how to define virtual topology to merge patches and thus not constrain the mesh

to conform to the patches.

1. Rotate and zoom the geometry so that the model is positioned as shown below. Notice how the mesh

conforms to the small patches.

2. In the Tree Outline, right-click Model (A3) and select Insert > Virtual Topology.

3. Click Face .

4. On the keyboard, press and hold CTRL.

5. Select the five faces as shown below.
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6. On the toolbar, click Virtual Cell .

7. In the Tree Outline, right-click Mesh and select Update.

Notice the mesh in the area of the virtual cell no longer conforms to the original patches.

8. In the Tree Outline, right-click Virtual Topology and select Delete All Virtual Cells.

9. Click Yes to delete the virtual cells.

Creating Virtual Cells Automatically

This part of the tutorial demonstrates how to create virtual topology automatically.
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1. In the Tree Outline, right-click Virtual Topology and select Generate Virtual Cells.

A list of virtual faces and virtual edges appears in the Tree Outline. Collapse the list.

2. Right-click Mesh and select Update.

Notice the mesh in the area of the virtual cells no longer conforms to the original patches.

3. On the triad located in the lower right corner of the Geometry window, click the sphere to return the

view to isometric.

Defining Pinch Controls Manually

Thin regions of the model, such as those in the figure below, can create poor quality mesh and/or increase

the mesh size. This part of the tutorial demonstrates how to use the pinch feature to remove small features

at the mesh level in order to generate better quality elements around those features. Pinch provides an al-

ternative to virtual topology, which works at the geometry level.

1. On the toolbar, click Body .

2. In the Geometry window, select the top of the piston as shown below.

3. Right-click in the Geometry window and select Hide All Other Bodies.

4. Rotate and zoom in on the underside of the geometry so that the model is positioned as shown below.

Notice the thin regions at the bottom of the model.
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5. In the Tree Outline, right-click Mesh and select Insert > Pinch.

6. On the toolbar, click Edge .

7. On the keyboard, press and hold CTRL.

8. For the Master Geometry, select the two edges (highlighted in green) as shown below.

9. In the Details View, click to Apply your selection.

10. Click Edge.

11. Press and hold CTRL.

12. For the Slave Geometry, select the two edges (highlighted in green) as shown below.
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13. In the Details View, click to Apply your selection.

14. Set the Tolerance to 0.001.

15. On the toolbar, click Update .

16. In the Tree Outline, click Mesh.

Notice the pinch feature removed the thin, poor quality mesh at the location of the pinch, thereby

reducing the element count.

The pinch feature used the value of Tolerance to determine which small features to remove from the

mesh. In this case, two sets of edges were selected for the pinch control and a Tolerance of 0.001 was

specified, so the pinch feature removed the elements between the two sets of edges that met the

specified criteria (i.e., the “thin” elements, where "thin" is defined by the specified Tolerance).

17. On the triad located in the lower right corner of the Geometry window, click the sphere to return the

view to isometric.

18. Right-click the Geometry window and select Show All Bodies.

Defining Mapped Face Meshing

This part of the tutorial demonstrates how to use mapped face meshing controls. Mapped face meshing

controls attempt to generate a mapped mesh on selected faces. The Meshing application determines a

suitable number of divisions for the edges on the boundary face automatically. If you specify the number

of divisions on the edge with a Sizing control, the Meshing application attempts to enforce those divisions.

1. On the toolbar, click Body .
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2. In the Geometry window, select the bottom of the piston as shown below.

3. Right-click in the Geometry window and select Hide All Other Bodies.

4. Rotate and zoom the geometry so that the model is positioned as shown below.

5. In the Tree Outline, right-click Mesh and select Insert > Mapped Face Meshing.

6. In the Geometry window, select the face as shown below.
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7. In the Details View, click Apply.

8. In the Tree Outline, right-click Mesh and select Update.

Notice the changes in the mesh.

9. In the Tree Outline, right-click Mesh and select Insert > Mapped Face Meshing again.

10. In the Geometry window, select the small face as shown below.

11. In the Details View, click Apply.

12. In the Tree Outline, right-click Mesh and select Update.

Notice the changes in the mesh of the small face.
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13. In the Geometry window, right-click and select Show All Bodies.

14. On the triad located in the lower right corner of the Geometry window, click the sphere to return the

view to isometric.

Using the MultiZone Mesh Method

This part of the tutorial demonstrates how to obtain a MultiZone mesh for one of the bodies in the piston.

1. In the Tree Outline, right-click Virtual Topology and select Delete All Virtual Cells.

2. Click Yes to delete the virtual cells.

3. On the toolbar, click Body .

4. In the Geometry window, select the bolt on the bottom left as shown below.

5. Right-click in the Geometry window and select Hide All Other Bodies.
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6. Rotate and zoom the geometry so that the model is positioned as shown below.

7. Click Face .

8. On the keyboard, press and hold CTRL.

9. Select the top three faces as shown below.

10. Right-click in the Geometry window and select Insert > Virtual Cell.

11. Rotate the bolt so that it is positioned as shown below.
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12. Click Face .

13. On the keyboard, press and hold CTRL.

14. Select the bottom and bottom ridge of the top of the bolt as shown below. There are five faces to

select—one for the bottom and four that make up the ridge.

15. Right-click in the Geometry window and select Insert > Virtual Cell.

16. Position the bolt as shown below.
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17. Click Face .

18. On the keyboard, press and hold CTRL.

19. Select the bottom three faces of the bolt as shown below.

20. Right-click in the Geometry window and select Insert > Virtual Cell.

21. In the Tree Outline, right-click Mesh and select Insert > Method.

22. In the Geometry window, select the bolt.

23. In the Details View, click Apply.

331
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Using the MultiZone Mesh Method



24. In the Details View, change Method to MultiZone.

25. Change Src/Trg Selection to Manual Source.

There are three source faces to select.

26. Click Face .

27. On the keyboard, press and hold CTRL.

28. Select the first two faces as shown below.

29. Reposition the bolt so you will be able to pick the topmost face.

30. Click Face .

31. On the keyboard, press and hold CTRL.

32. Select the third face as shown below.
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33. In the Details View, click to Apply your selections.

34. On the toolbar, click Update .

Notice the changes to the mesh. By inserting the MultiZone method for the bolt, a mesh composed

of mostly hexahedral elements was obtained.

Defining Local Sizing

The mesh obtained in the previous section of the tutorial is rather coarse. This part of the tutorial demonstrates

how to define a local sizing control for a finer mesh and increased solution accuracy.

1. In the Tree Outline, right-click Mesh and select Insert > Sizing.

2. On the toolbar, click Body .

3. In the Geometry window, select the bolt.

4. In the Details View, click Apply.

5. Set Element Size to 0.001.

6. In the Tree Outline, right-click Mesh and select Update.

Notice the changes to the mesh.
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Defining a Section Plane

This part of the tutorial demonstrates how to activate a section plane to view a section cut through the bolt.

1. Reposition the bolt as shown below.

2. On the toolbar, click New Section Plane .
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3. Press the left mouse button and drag a line down the center of the bolt to slice it in half. Rotate the

geometry to view the section cut.

This completes the tutorial. From the Meshing application's main menu, select File > Save Project to save

the project and then File > Close Meshing to return to the Project Schematic.

You can exit ANSYS Workbench by selecting File > Exit from the main menu.

335
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Defining a Section Plane



Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.336



Index

Symbols
0-thickness walls, 257

A
accessing Meshing functionality, 17

active assembly - initial size seed meshing control op-

tion, 66

advanced global meshing controls, 85

advanced size function - sizing global meshing control,

59

curvature, 61

fixed, 62

influence of, 53

proximity, 61

specifying options, 62

with specialized meshing, 56

air gap meshing, 250

algorithm

meshing according to, 4

algorithms - tetrahedral meshing algorithms , 125

arbitrary match control

description, 179

aspect ratio (base/height) - inflation global meshing

control, 74

aspect ratio for quadrilaterals

mesh metric, 107

aspect ratio for triangles

mesh metric, 106

assemblies of parts vs. multibody parts, 7

automatic defeaturing, 99

automatic inflation - inflation global meshing control,

69

automatic meshing, 53

automatic method - in method control, 125

automatic virtual topology, 281

auxiliary meshing tools - listed and described, 267

axis sweeping, 147

B
baffle meshing, 257

batch mode, 47

bias (sweeping) - in method control , 147

bias factor - in local sizing control, 160

bias type - in local sizing control, 160

body of influence - local mesh sizing tool option, 160

C
CAD instances, 254

can combustor tutorial, 299

CFD/fluids meshing strategies, 15

CFD/fluids meshing with tetrahedrons, 185

CFX-Mesh method

replacing, 20

CGNS format export, 22

clearing generated data, 277

collision avoidance - inflation global meshing controls,

77

component system

Mesh, 17

conformal meshing, 7

mesh method interoperability, 7

contact

sizing - mesh control tool, 166

contact meshing, 251

contact sizing

description, 166

curvature normal angle - local mesh sizing tool option,

160

curvature normal angle - sizing global meshing control,

63

CutCell Cartesian meshing, 228

global meshing controls, 84

missing tessellations, 278

orthogonal quality, 117

cyclic match control

description, 178

D
Default Method, 192

Default Physics Preference, 192

defaults global meshing controls, 57

defeaturing

automatic mesh based, 99

defeaturing global meshing controls, 90

Defeaturing Tolerance, 156

determination of physics, analysis, and solver settings,

19

direct meshing, 239, 270

E
ease of use meshing features - listed, 269

edge behavior - in local sizing control , 160

edge bias - in local sizing control, 160

edge splits

virtual, 285

element midside nodes - advanced global meshing

control, 87

element option

in sweep method mesh control, 147

element quality

337
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



finding worst quality elements, 101

mesh metric, 106

element shape

meshing according to, 6

element size - local mesh sizing tool option, 160

element size - sizing global meshing control, 66

elements - statistics global meshing control, 101

exporting - procedure

previewed inflation mesh, 275

previewed surface mesh, 273

exporting faceted geometry

to TGrid, 22

exporting meshes

ANSYS FLUENT mesh format, 22

ANSYS ICEM CFD format, 22

CGNS format, 22

Mesh Application File format, 22

overlapping Named Selections, 276

POLYFLOW format, 22

extended ICEM CFD meshing, 47

Extra Retries For Assembly, 192

extra retries for assembly - advanced global meshing

control , 89

F
Fill Small Holes, 156

fillet ratio - inflation global meshing controls , 83

first aspect ratio - inflation global meshing control, 74

first layer height - inflation global meshing control, 74

FLUENT mesh export, 22

fluids meshing strategies, 15

fluids meshing with tetrahedrons, 185

full assembly - initial size seed meshing control option,

66

G
gap tool

description, 188

generate pinch on refresh - pinch global meshing con-

trol , 95

generating mesh - procedure, 270

generation of contact elements, 267

geometry

vs. topology, 281

Geometry window, 18

global meshing settings - listed and defined, 57

Graphics window, 18

growth rate - inflation global meshing control , 73

growth rate - local mesh sizing tool option, 160

growth rate - sizing global meshing control, 65

growth rate type - inflation global meshing controls ,

82

H
hard divisions - in local sizing control, 160

hard entities, 256

hex dominant option - in method control, 146

histogram of mesh metrics, 101

I
ICEM CFD

batch mode, 47

extended meshing, 47

interactive meshing, 47

interactive mode, 47

writing ICEM CFD files, 47

ICEM CFD mesh export, 22

importing meshes

ANSYS CFX, 20

ANSYS FLUENT, 20

ANSYS ICEM CFD, 20

ANSYS POLYFLOW, 20

imprinting

classifications for MultiZone, 219

effects on meshing, 7

matched vs. non-matched, 7

incremental meshing, 239

incremental meshing of bodies, 270

inflation advanced options - inflation global meshing

controls, 77

inflation algorithm - inflation global meshing control,

74

inflation controls

with all triangles mesher, 244

with MultiZone, 244

with patch conforming mesher, 244

with patch independent mesher, 244

with quadrilateral dominant mesher, 244

with sweeper, 244

inflation global meshing controls, 67

inflation mesh control tool, 185

inflation option - inflation global meshing control , 71

Inflation options on the Options dialog box, 192

initial size seed - sizing global meshing control , 66

inspecting large meshes, 277

instances, 254

interactions - mesh control, 261

interactive ICEM CFD meshing, 47

interactive mode, 47

interoperability

mesh method, 7

J
Jacobian ratio

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.338

Index



mesh metric, 108

L
launching the Meshing application, 17

layer compression - inflation global meshing controls,

77

legacy data, 20

linear elements, 87

local meshing settings - listed and defined, 121

loop removal global meshing controls, 99

loop removal tolerance - loop removal global meshing

control, 99

loops

removing, 277

showing removable loops, 277

M
manual creation of virtual cells, 281

mapped face meshing

description, 168

limitations, 176

match control

arbitrary, 179

cyclic, 178

description, 177

match meshing - and symmetry, 251

matched vs. non-matched imprinting, 7

max face size - sizing global meshing control , 64

max size - sizing global meshing control, 65

maximum angle - inflation global meshing controls ,

82

maximum corner angle

mesh metric, 114

maximum layers - inflation global meshing control , 73

maximum thickness - inflation global meshing control

, 73

Merge Edges Bounding Manually Created Faces, 192

merge face edges - automatic virtual topology, 281

Mesh Application File format export, 22

mesh based defeaturing global meshing controls, 99

mesh connection, 268

mesh control interaction tables, 261

mesh control tools

description, 121

instances, 254

patterns, 254

precedence, 121

renaming, 267

mesh controls and methods tutorial, 318

mesh data

clearing, 277

mesh method interoperability, 7

mesh metric

histogram, 101

mesh metric - statistics global meshing control , 101

aspect ratio for quadrilaterals, 107

aspect ratio for triangles, 106

element quality, 106

Jacobian ratio, 108

maximum corner angle, 114

orthogonality quality, 117

parallel deviation, 113

skewness, 114

warping factor, 110

Mesh Metrics bar graph, 101

mesh morphing - advanced global meshing control ,

89

mesh numbering, 268

mesh refinement, 250

mesh sweeping

general sweeping, 195

thin model sweeping, 199

Mesh system, 17

meshing

advanced size function, 53

algorithms - tetrahedral, 125

automatic, 53

auxiliary tools, 267

by algorithm, 4

by element shape, 6

capabilities in Workbench, 1

CFD/fluids, 185

clearing generated data, 277

conformal meshing, 7

control interactions, 261

controls, 53

determination of physics, analysis, and solver set-

tings, 19

direct, 239, 270

ease of use features - listed, 269

exporting - procedure

previewed inflation mesh, 275

previewed surface mesh, 273

fluids, 185

generating mesh - procedure, 270

global controls - listed and defined, 57

implementation in Workbench, 3

importing meshes, 20

inspecting large meshes, 277

local mesh controls, 121

loop removal, 277

mesh sweeping

general sweeping, 195

thin model sweeping, 199

339
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Index



Meshing application - basic workflow, 11

Meshing application - basic workflow for CFD, 12

Meshing application - basic workflow for combining

CFD/fluids and structural meshing, 13

Meshing application - basic workflow for Fluids, 12

Meshing application - description, 11

Meshing application - exporting meshes, 22

Meshing application - launching, 17

Meshing application - working with legacy mesh

data, 20

Meshing application interface, 18

Meshing Options panel, 1

Named Selections, 291

non-conformal meshing, 7

options

inflation, 192

meshing, 192

overview, 191

sizing, 192

virtual topology, 192

overlapping Named Selections, 276

overview, 1

parameters, 49

previewing inflation - procedure, 274

previewing source and target mesh - procedure,273

previewing surface mesh - procedure, 271

replacing a Mesh system with a Mechanical Model

system, 17

showing geometry in overlapping Named Selections

- procedure, 276

showing inflation surfaces - procedure, 275

showing mappable faces - procedure, 279

showing missing tessellations, 278

showing problematic geometry - procedure, 276

showing removable loops, 277

showing sweepable bodies - procedure, 276

specialized - 0-thickness walls, 257

specialized - air gap meshing, 250

specialized - baffle meshing, 257

specialized - CAD instance, 254

specialized - contact meshing, 251

specialized - CutCell, 228

specialized - hard entities, 256

specialized - inflation controls, 244

specialized - listed, 195

specialized - match meshing and the symmetry

folder, 251

specialized - mesh refinement, 250

specialized - mixed order meshing, 250

specialized - MultiZone, 212

specialized - non-manifold faces, 257

specialized - pyramid transitions, 251

specialized - rigid body contact meshing, 251

specialized - rigid body meshing, 251

specialized - spot weld, 256

specialized - sweeping, 195

specialized - thin solid meshing, 254

specialized - winding body meshing, 251

specialized - wire body meshing, 251

troubleshooting, 293

tutorials, 299

can combustor, 299

mesh controls and methods, 318

single body inflation, 307

types - listed, 4

updating the Mesh cell state - procedure, 269

Workbench vs. Mechanical APDL, 50

workflow, 3

workflow - basic meshing, 11

workflow - CFD meshing, 12

workflow - combining CFD/fluids and structural

meshing, 13

workflow - Fluids meshing, 12

Meshing application

basic meshing workflow, 11

basic workflow, 11

basic workflow for CFD, 12

basic workflow for fluids, 12

combining CFD/fluids meshing and structural

meshing, 13

description, 11

determination of physics, analysis, and solver set-

tings, 19

interface overview, 18

strategies for CFD/fluids meshing, 15

tutorials, 299

can combustor, 299

mesh controls and methods, 318

single body inflation, 307

Meshing Options panel, 1

meshing support for hard entities, 256

meshing support for pattern instances, 254

meshing support for spot welds, 256

method mesh control tool

description, 122

interactions - uniform quad/quad tri, 261

midside nodes

advanced global control setting, 87

method control setting, 122

mixed order meshing, 122

min size - sizing global meshing control, 64

minimum edge length - sizing global meshing control

, 67

mixed order meshing, 122, 250

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.340

Index



multibody parts vs. assemblies of parts, 7

MultiZone, 212

imprinting classifications, 219

MultiZone option - in method control, 150

N
Named Selections

and regions for CFX applications, 291

exporting faceted geometry to TGrid, 22

inspecting large meshes, 277

program controlled inflation and, 69

nodes - statistics global meshing control, 101

non-conformal meshing, 7

non-manifold faces, 257

num cells across gap - sizing global meshing control ,

63

Number of CPUs, 192

number of layers - inflation global meshing control , 73

Number of Retries, 192

number of retries - advanced global meshing control ,

88

O
Options dialog box

inflation, 192

meshing, 192

overview, 191

sizing, 192

virtual topology, 192

orthogonal quality

mesh metric, 117

overriding of mesh control tools, 121

P
parallel deviation

mesh metric, 113

Parameter Workspace

Meshing application and, 49

parameters

Meshing application and, 49

part - initial size seed meshing control option, 66

patch conforming tetrahedral meshing algorithm , 125

patch independent tetrahedral meshing algorithm ,

126

missing tessellations, 278

patterns, 254

physics preference default global meshing control , 57

pinch control

defining pinch control automation, 90

defining pinch controls locally, 181

defining pinch controls manually, 181

pinch global meshing controls, 90

pinch tolerance - pinch global meshing control , 95

POLYFLOW format export, 22

POLYFLOW import, 20

post inflation - inflation global meshing control, 74

pre inflation - inflation global meshing control, 74

precedence of mesh control tools, 121

previewing inflation - procedure, 274

previewing source and target mesh - procedure, 273

previewing surface mesh - procedure, 271

program controlled inflation, 69

projecting nodes to underlying geometry, 281

proximity accuracy - sizing global meshing control , 63

proximity size function sources - sizing global meshing

control, 64

pyramid transitions, 251

Q
quadratic elements, 87

quadrilateral dominant option - in method control ,155

quality metrics, 101

R
refinement, 250

description, 167

Relevance, 192

relevance center - sizing global meshing control , 65

relevance default global meshing control, 59

removing loops, 277

renaming mesh control tool, 267

replacing a Mesh system with a Mechanical Model sys-

tem, 17

replacing CFX-Mesh method, 20

rigid body behavior - advanced global meshing control,

89

rigid body contact meshing, 251

rigid body meshing, 251

S
shape checking - advanced global meshing control ,85

sheet loop removal - loop removal global meshing

control, 99

Show Meshing Options Panel at Startup, 192

showing geometry in overlapping Named Selections -

procedure, 276

showing inflation surfaces - procedure, 275

showing mappable faces - procedure, 279

showing missing tessellations, 278

showing problematic geometry - procedure, 276

showing removable loops, 277

showing sweepable bodies - procedure, 276

341
Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Index



single body inflation tutorial, 307

sizing

description, 157

sizing global meshing controls, 59

skewness

mesh metric, 114

smoothing - sizing global meshing control, 66

smoothing iterations - inflation global meshing controls,

84

soft divisions - in local sizing control , 160

solver preference default global meshing control , 59

span angle center - sizing global meshing control , 67

sphere of influence - local mesh sizing tool option, 160

splitting

edges, 285

spot welds, 256

stair stepping - inflation global meshing controls, 77

statistics about quality, 101

statistics global meshing controls, 101

straight sided elements - advanced global meshing

control, 88

strategies for CFD/fluids meshing, 15

sweep option - in method control, 147

sweeping - mesh

general sweeping, 195

thin model sweeping, 199

symmetry - and match meshing, 251

system

Mesh, 17

T
tessellations

missing, 278

tetrahedral meshing algorithms, 125

TGrid

exporting faceted geometry to, 22

thin model sweeping, 147

thin solid meshing, 254

topology - vs. geometry, 281

transition - sizing global meshing control, 67

transition ratio - inflation global meshing control , 72

triangle option - in method control , 155

troubleshooting, 293

tutorials , 299

can combustor, 299

mesh controls and methods, 318

single body inflation, 307

U
uniform quad option - in method control, 157

uniform quad/quad tri mesh control interactions, 261

uniform quad/tri option - in method control, 156

Unmeshable Areas, 192

updating the Mesh cell state - procedure, 269

Use Advanced Size Function, 192

use automatic inflation - inflation global meshing con-

trol, 69

use post smoothing - inflation global meshing controls,

84

use sheet thickness for pinch - pinch global meshing

control , 94

V
virtual cell

creation, 281

effect on topology, 281

projecting to underlying geometry, 281

virtual split edge

creation, 285

virtual topology

overview, 281

topology vs. geometry, 281

W
warping factor

mesh metric, 110

winding body meshing, 251

wire body meshing, 251

Workbench

meshing capabilities, 1

Workbench meshing vs. Mechanical APDL meshing, 50

workflows , 11

worst quality elements, 101

Write ICEM CFD Files, 156

writing ICEM CFD files, 47

Release 13.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.342

Index


	ANSYS Meshing User's Guide
	Table of Contents
	Capabilities in Workbench
	Meshing Overview
	Meshing Implementation in ANSYS Workbench
	Types of Meshing
	Meshing by Algorithm
	Meshing by Element Shape

	Conformal Meshing Between Parts

	Usage in Workbench
	Basic Meshing Application Workflows
	Overview of the Meshing Process in ANSYS Workbench
	Overview of the Meshing Process for CFD/Fluids Analyses
	Combining CFD/Fluids Meshing and Structural Meshing

	Strategies for CFD/Fluids Meshing in ANSYS Workbench
	Accessing Meshing Functionality
	Overview of the Meshing Application Interface
	Determination of Physics, Analysis, and Solver Settings
	Working with Legacy Mesh Data
	Exporting Meshes or Faceted Geometry
	Mesh Application File Export
	FLUENT Mesh Export
	Classes of Zone Types in ANSYS FLUENT
	Standard Naming Conventions for Naming Named Selections
	Zone Type Assignment
	Example of ANSYS FLUENT Workflow in ANSYS Workbench

	POLYFLOW Export
	CGNS Export
	ICEM CFD Export
	Exporting Faceted Geometry to TGrid

	Extended ANSYS ICEM CFD Meshing
	Writing ANSYS ICEM CFD Files
	Rules for Interactive Editing
	Limitations of ANSYS ICEM CFD Interactive

	Working with Meshing Application Parameters
	ANSYS Workbench and Mechanical APDL Application Meshing Differences

	Mesh Controls Overview
	Global and Local Mesh Controls
	Understanding the Influence of the Advanced Size Function

	Global Mesh Controls
	Defaults Group
	Physics Preference
	Solver Preference
	Relevance

	Sizing Group
	Use Advanced Size Function
	Curvature Size Function
	Proximity Size Function
	Fixed Size Function
	Specifying Size Function Options
	Curvature Normal Angle
	Proximity Accuracy
	Num Cells Across Gap
	Proximity Size Function Sources
	Min Size
	Max Face Size
	Max Size
	Growth Rate


	Relevance Center
	Element Size
	Initial Size Seed
	Smoothing
	Transition
	Span Angle Center
	Minimum Edge Length

	Inflation Group
	Use Automatic Inflation
	None
	Program Controlled
	All Faces in Chosen Named Selection

	Inflation Option
	Transition Ratio
	Maximum Layers
	Growth Rate
	Number of Layers
	Maximum Thickness
	First Layer Height
	First Aspect Ratio
	Aspect Ratio (Base/Height)
	Inflation Algorithm
	View Advanced Options
	Collision Avoidance
	Fix First Layer
	Gap Factor

	Maximum Height over Base
	Growth Rate Type
	Maximum Angle
	Fillet Ratio
	Use Post Smoothing
	Smoothing Iterations


	CutCellMeshing Group
	Active
	Feature Capture
	Tessellation Refinement

	Advanced Group
	Shape Checking
	Element Midside Nodes
	Straight Sided Elements
	Number of Retries
	Extra Retries For Assembly
	Rigid Body Behavior
	Mesh Morphing

	Defeaturing Group
	Pinch
	Pinch Control Automation Overview
	How to Define Pinch Control Automation
	How to Define or Change Pinch Controls Manually
	Usage Information for Pinch Controls

	Loop Removal
	Automatic Mesh Based Defeaturing

	Statistics Group
	Nodes
	Elements
	Mesh Metric
	Element Quality
	Aspect Ratio Calculation for Triangles
	Aspect Ratio Calculation for Quadrilaterals
	Jacobian Ratio
	Warping Factor
	Parallel Deviation
	Maximum Corner Angle
	Skewness
	Orthogonal Quality



	Local Mesh Controls
	Method Control
	Method Controls and Element Midside Nodes Settings
	Setting the Method Control for Solid Bodies
	Automatic Method Control
	Tetrahedrons Method Control
	Patch Conforming Algorithm for Tetrahedrons Method Control
	Patch Independent Algorithm for Tetrahedrons Method Control

	Hex Dominant Method Control
	Sweep Method Control
	MultiZone Method Control

	Setting the Method Control for Surface Bodies
	Quadrilateral Dominant Method Control
	Triangles Method Control
	Uniform Quad/Tri Method Control
	Uniform Quad Method Control


	Sizing Control
	Using the Local Sizing Control
	Defining Local Mesh Sizing on a Body
	Defining Local Mesh Sizing on a Face
	Defining Local Mesh Sizing on an Edge
	Defining Local Mesh Sizing on a Vertex
	Descriptions of Local Sizing Control Options

	Notes on Element Sizing

	Contact Sizing Control
	Refinement Control
	Mapped Face Meshing Control
	Setting Basic Mapped Face Meshing Controls
	Understanding Advanced Mapped Face Meshing Controls
	Restrictions Related to Vertex Types
	Restrictions Related to Edge Mesh Intervals
	Selecting Faces and Vertices
	Effect of Vertex Type on Face Meshes
	Setting Advanced Mapped Face Meshing Controls

	Notes on the Mapped Face Meshing Control

	Match Control
	Cyclic Match Control
	Arbitrary Match Control

	Pinch Control
	Defining Pinch Controls Locally
	Changing Pinch Controls Locally

	Inflation Control
	Gap Tool

	Options
	Accessing the Options Dialog Box
	Common Settings Option on the Options Dialog Box
	Meshing Options on the Options Dialog Box

	Specialized Meshing
	Mesh Sweeping
	Thin Model Sweeping

	MultiZone Meshing
	MultiZone Overview
	MultiZone Support for Inflation
	MultiZone Support for Defined Edge and Face Sizings

	MultiZone Algorithms
	Using MultiZone
	MultiZone Source Face Selection Tips
	MultiZone Source Face Imprinting Guidelines
	Internal Loops
	Boundary Loops
	Multiple Internal Loops
	Multiple Connected Internal Loops
	Internal Cutout Loops
	Parallel Loops
	Intersecting Loops

	Using Virtual Topology to Handle Fillets in MultiZone Problems

	MultiZone Limitations and Hints

	CutCell Meshing
	The CutCell Meshing Process
	The CutCell Meshing Workflow

	Direct Meshing
	Inflation Controls
	Mesh Refinement
	Mixed Order Meshing
	Air Gap Meshing
	Contact Meshing
	Winding Body Meshing
	Wire Body Meshing
	Pyramid Transitions
	Match Meshing and the Symmetry Folder
	Rigid Body Meshing
	Thin Solid Meshing
	CAD Instance Meshing
	Meshing and Hard Entities
	Baffle Meshing

	Mesh Control Interaction Tables
	Interactions Between Mesh Methods
	Interactions Between Mesh Methods and Mesh Controls

	Miscellaneous Tools
	Generation of Contact Elements
	Renaming Mesh Control Tool
	Mesh Numbering
	Mesh Connection

	Ease of Use Features
	Updating the Mesh Cell State
	Generating Mesh
	Previewing Surface Mesh
	Exporting a Previewed Surface Mesh in FLUENT Format

	Previewing Source and Target Mesh
	Previewing Inflation
	Exporting a Previewed Inflation Mesh in FLUENT Format

	Showing Program Controlled Inflation Surfaces
	Showing Sweepable Bodies
	Showing Problematic Geometry
	Showing Geometry in Overlapping Named Selections
	Showing Removable Loops
	Inspecting Large Meshes Using Named Selections
	Clearing Generated Data
	Showing Missing Tessellations
	Showing Mappable Faces

	Virtual Topology
	Introduction
	Creating Virtual Cells
	Creating Virtual Split Edges

	Named Selections and Regions for CFX
	Troubleshooting
	Tutorials
	Tutorial 1: Can Combustor
	Geometry Import
	Mesh Generation

	Tutorial 2: Single Body Inflation
	Tutorial Setup
	Mesh Generation

	Tutorial 3: Mesh Controls and Methods
	Tutorial Setup
	Mesh Generation


	Index

